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I Introducing DeskProto

1.1 Disclaimer

All milling devices (whether or not Numerically Controlled) are dangerous
devices: when working with a milling machine it is possible to damage either
the workpiece or the machine, or even to injure yourself. So do take care, and
always check your milling paths before sending them to the machine - in case
you are a novice user have an experienced colleague check them.

Delft Spline Systems, the software distributor, the dealer or any other
intermediate parties are in no way responsible for any damage or injury,
direct or consequential, relating to the use of this software.

Copyright © 1995-2024  Delft Spline Systems
This computer program is protected by copyright law. Unauthorized
reproduction or distribution of this program is prohibited.

DeskProto ® is a registered trademark of Delft Spline Systems.
Windows ® is a registered trademark of Microsoft Corporation.
MacOS ® is a registered trademark of Apple Inc.
Linux ® is a registered trademark of Linus Torvalds.
All other trademarks are owned by their respective owners.
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1.2 Licenses and Copyrights

DeskProto is protected by copyright law. Unauthorized reproduction or
distribution of this program is prohibited.
Copyright © 1995-2024, Delft Spline Systems

DeskProto uses the following external libraries (installed during Setup as
DLL files):

The Boost C++ libraries.
Copyright © 1998-2005, Beman Dawes, David Abrahams, 
Copyright © 2004-2007, Rene Rivera.
Used and distributed under the Boost Software License V1.0.
www.boost.org

The Clipper library for clipping and offsetting lines and polygons
Copyright © 1995-2013, Angus Johnson
Used and distributed under the Boost Software License V1.0.
angusj.com

The Crypto++ library of cryptographic algorithms 
Copyright © 1995-2013, Wei Dai
Used and distributed under the Boost Software License V1.0.
www.cryptopp.com

The HIDAPI library for communication with HID devices.
Copyright © 2009, Alan Ott, Signal 11 Software,
used and distributed under the HIDAPI license.
github.com/signal11/hidapi  

The Minizip library for reading and writing ZIP archives.
Copyright © 2017, Nathan Moinvaziri
used and distributed under the Minizip license.
github.com/zlib-ng/minizip-ng

The QT cross-platform application framework.
Copyright © 2016, The QT Company Ltd. and other contributors
used and distributed under the GNU Lesser General Public License
(LGPLv3).
www.qt.io

The SVG++ library of functions to work with SVG files 
Copyright © SVGPP.org (Oleg Maximenko)
Used and distributed under the Boost Software License V1.0.
svgpp.org

https://www.boost.org
https://angusj.com/
https://www.cryptopp.com
https://github.com/signal11/hidapi
https://github.com/zlib-ng/minizip-ng
https://www.qt.io
https://svgpp.org/
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The complete license texts for all these libraries can be found in the
DeskProto About box.
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1.3 Essentials

What does DeskProto offer
DeskProto is a CAM program (Computer Aided Manufacturing) for 3-axis,
4-axis and 5-axis CNC milling machines, offering Desktop Prototyping.
DeskProto allows you to to create CNC toolpaths for 2D vector drawings, for
3D geometries, as well as for 3D reliefs based on digital images. It can be
used for product design, jewelry, woodworking, medical applications, arts,
education, hobby, etc. DeskProto can be combined with any CAD program,
and with any CNC milling machine.

Four Editions of DeskProto are available: Free, Entry, Expert and Multi-
Axis, offering different (sub)sets of DeskProto’s functionality. An edition
comparison table can be found on www.deskproto.com 

How does it work
Starting point for DeskProto is a CAD file (it is not possible to design in
DeskProto: CAM is only about calculating toolpaths). Three types of CAD
data are supported, each with a slightly different work-flow: 
Vector-data: 2D drawing containing lines and arcs, stored as DXF, AI, EPS
or SVG file.
Geometry-data: 3D geometry defined as a collection of triangles (facets)
that describe its outer surface (polygon data), stored as STL, 3MF or DXF
file.
Bitmap-data: 2D image containing colored pixels, stored as BMP, JPG, GIF,
PNG or TIF file.
So in fact DeskProto offers three CAM programs for the price of one !

DeskProto will load the CAD file and display its contents. It is possible to
load more than one file. At this point you can scale, translate, rotate etc.
After entering some milling parameters (cutting tool, required accuracy, etc)
DeskProto will calculate the toolpaths and save them in an NC file. Send this
NC file to your CNC milling machine and you will have your part ready
within a short time.

What hardware/software is needed
DeskProto is available for Microsoft Windows, for Apple MacOS and for
Linux. DeskProto is a 64 bits application.

For Windows it needs Win10 or newer. 
Minimum required hardware is a PC with 4 GB RAM and 100 GB free disk
space: faster/more is better. The graphics card needs to support OpenGL
V2.1 or newer. A special build for Win XP (SP3, 32 bits) is available on
request.  ????  Win 7 ??

For MacOS it needs Mojave (10.14) or newer. 

https://www.deskproto.com/products/comptable.php
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Here as well minimum hardware requirement is 4 GB RAM and 100 GB free
disk space: faster/more is better.
The MacOS version does not include the "Custom Wizards" nor the option
"Send Toolpaths directly to machine" (each of these a rarely used feature).
As Apple's implementation of OpenGL is incomplete the commands "Print
Image" (File menu) and "Generate Contour" (in the dialog to graphically set
the Operation Area) do not work in the MacOS version,

For Linux it has been developed and tested using Ubuntu 20.04 (64 bits), still
it should also work on a recent version of most other popular Linux
distributions. 
Here as well minimum hardware requirement is 4 GB RAM and 100 GB free
disk space: faster/more is better.
The Linux version does not include the "Custom Wizards" nor the option
"Send Toolpaths directly to machine" (each of these a rarely used feature).

The screenshots in this Manual / Help file have been made using Windows,
still for MacOS users and for Linux users these images will be completely
clear as all screens are very similar in each of these operating systems.
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1.4 Specifications

Required operating system (Microsoft Windows):
Windows 10 or newer (64 bits).
A special build for Win XP (SP3, 32 bits) is available on request.  ????

Required operating system (Apple MacOS)
MacOS Mojave (10.14) or newer (64 bits).

Required operating system (Linux)
Ubuntu 20.04 or newer (64 bits). It should also work on most other popular
Linux distributions. 

Required hard disk space:
Minimum 1 GB: about 100 MB for program only, plus at least 900 MB for
projects

Required internal memory:
As much as possible, recommended at least 4GB

Required graphics:
A 3D graphics card (or on-board graphics) that supports OpenGL V2.1 or
newer,
The screen resolution of the computer needs to be at least 1024x768 pixels.

Supported Project files:
DPJ, version 2.0
DPJ, version 3.0 / 3.1
DPJ, version 4.0 / 4.1
DPJ, version 5.0
DPJ, version 6.0 / 6.1
DPJ, version 7.0 / 7.1
DPJ, version 8.0
Version 1  DPJ files (Windows 3.11) are no longer supported.

Project files exist in two versions: with and without calculated toolpaths.

Supported Vector file types:
DXF AutoCAD Drawing Interchange File
limited to points, lines, polylines, arcs, circles and ellipses (2D)
EPS Encapsulated PostScript and
AI Adobe Illustrator
SVG Scalable Vector Graphics
limited to points, lines, polylines, arcs, circles and ellipses (2D)
Entities in these files that are not supported will be simply ignored by
DeskProto.
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Supported Geometry file types:
STL STereoLithography
ASCII & binary
3MF 3D Manufacturing Format
limited to only the 3D Model information
DXF AutoCAD Drawing Interchange File
limited to triangles and rectangles (3D)
VRML Virtual Reality Modeling Language
limited to triangles and rectangles

Supported Bitmap file types:
BMP Windows BitMaP
Used by the bitmap operation to load a bitmap
GIF Compuserve Graphic Interchange File
Used by the bitmap operation to load a bitmap
JPG Joint Photographic Experts Group
Used by the bitmap operation to load a bitmap
PNG Portable Network Graphics File
Used by the bitmap operation to load a bitmap
TIFF Tagged Image File Format
Used by the bitmap operation to load a bitmap

Supported NC program files (toolpath data):
NC-program Numeric Controlled
only ASCII, format and file extension are different per machine.

Other supported file-types:
DPW DeskProto Wizard
defines one custom wizard
DPS DeskProto Script
contains a DeskProto script.
DPT DeskProto Toolpath
contains all toolpaths for one DPJ file

Maximum File size
The DeskProto code does not have a maximum for any file. In practice the
maximum is limited by the computer's resources. DeskProto is a 64 bits
application, so the maximum STL file-size mainly depends on how much
RAM memory is present: when the Operating System needs to swap the
calculations will become too slow for most users.
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1.5 Wizard

For novice users it may be difficult to complete the DeskProto process of
generating an NC program file based on your own CAD-data. And even for
experienced users some complicated models that DeskProto can produce
remain difficult to prepare. For these reasons DeskProto features Wizards: a
series of dialog screens that guide you step-by-step through the complete
process. The DeskProto wizards also tell you where each setting can be found
in the ‘normal’ user interface, to enable you to do it without wizard the next
time (if desired). The wizards can be started from the File menu (File >> Start
Wizard) and from the Start Screen.

So the DeskProto Wizard is meant to let you execute a task by guiding you
through the steps needed.  The first wizard screen (see Choosing the type of
Wizard) presents a list of all Wizards that are available, after selecting one
and pressing next the actual wizard is started.
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The illustration above shows a typical wizard screen.
On top six icons that indicate the sequence of pages in this wizard. These
icons function as tabs: when colored they can be used to navigate to a
different page of the wizard by clicking on the icon.
The number of pages of each wizard (and the number of options on each
page) depends on which Edition you are running.
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Along the bottom the standard Wizard buttons: Back, Next, Cancel, Help
and (not on the illustration) Finish.
The button Apply (on the left) will refresh your screen and apply the
currently selected settings. This leftmost button may also show Calculate,
which will calculate the toolpaths for that tab page with the currently selected
settings.

Important are the yellow question marks in front of each question: position
the cursor over one of these, and DeskProto will show a Wizard Tooltip with
Help information for this question. Including information where to find this
setting in the dialog based user interface.

All functionality offered by the wizards is also available in the normal user
interface: the wizards are only meant to make things easier for you, they do
not add new options. After finishing any wizard you can fine-tune the settings
that the wizard made.
When you open an existing project that was made by the wizard, DeskProto
will again use the wizard interface. However after fine-tuning in the dialog
based interface that is no longer possible.

In addition to these 'normal' wizards a powerful feature is present called the
Custom Wizard: a wizard written in a Script language and later added to
DeskProto. This makes it possible for any user and reseller to create a custom
wizard for a specific application and/or a specific fixture. More information
via the link.
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1.6 Support

If you encounter problems while working with DeskProto, please try the
following:

1. Search for a solution in the on-line Help system. The help is very detailed:
every option in every dialog is explained.

2. Look in the FAQ (Frequently Asked Questions) on the DeskProto website.

3. Look in the Forum on the same website. The forum page offers a special
search option for the forum, as the website's search option (top right corner
of each website page) does not cover the forum.

4. Carefully read the appropriate sections in the Manuals (printed or PDF
download).

5. In case no solution found: ask the Dealer who supplied DeskProto to you.

In case this does not work you can of course contact Delft Spline Systems.
When you send us a project please do so using the ZIP file that you can
generate via Create Problem Report (Help menu). Sending only the DPJ file
is insufficient as that file does not contain the CAD-data nor your
cutter/machine/postprocessor definitions.

https://www.deskproto.com/support/faq.php
https://www.deskproto.com/forum/forum.php
https://www.deskproto.com/download/manuals.php
https://www.deskproto.com/order/resellers.php
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1.7 Delft Spline Systems

Delft Spline Systems is a Dutch software house, founded in 1984, specialized
in the development and the use of CAD/CAM software. The first product of
the company, the SIPSURF CAD/CAM package, was released in 1986, ran in
MS-Dos, and was specialized in designing freeform surfaces. For products
containing freeform surfaces it is absolutely necessary to create physical
models in order to really evaluate the design, so from the start SIPSURF has
featured a module to easily calculate CNC toolpaths. At that time creating
physical models to evaluate CAD data was called Rapid Prototyping.

Since that time Rapid Prototyping has been recognized as vital for product
development, a few years it has even been a buzz word. Based on a long
experience of Rapid Prototyping and NC milling, Delft Spline Systems has
been able to develop the unique DeskProto package, meant for product
designers. 

Since that time we have found that DeskProto is very well suited for many
other applications as well. Key feature is the ease of use: DeskProto does not
aim at CNC specialists (like most other CAM software), but instead at
professionals in a different application. Like in jewelry, arts, design,
education, prostheses,  woodworking, food and sweets, and so on. This is
phrased in our motto

"CNC machining for non-machinists"

We hope you will enjoy using DeskProto, and we expect it will help you in
producing high quality parts within a short time.

When you want to stay informed about new DeskProto Developments you
can subscribe to our Newsletter emails by checking that option when
downloading DeskProto from our website. 
The news will reach you even more quickly when you follow the DeskProto
pages on Facebook and/or Instagram.

Delft Spline Systems
Utrecht, The Netherlands
Tel: +31 30 296 5957

Website: www.deskproto.com

Email info@deskproto.com

The DeskProto software © is owned by Delft Spline Systems.
DeskProto ® is a registered trademark of Delft Spline Systems.

https://www.facebook.com/DeskProto
https://www.instagram.com/deskproto/
https://www.deskproto.com
mailto:info@deskproto.com
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II Screen layout

The computer screen presented by DeskProto looks like the screenshot
shown above. In this chapter a short explanation will be given of each
element on the screen. The image shows a Windows screen. Using MacOS or
Linux the screen looks a bit different, still the same elements are present and
can clearly be recognized. From top to bottom, the following elements are
present:

· The top line is called the Title bar. It contains the name of the current
project, the word DeskProto, information  about your license, and a few
operating system icons.

· The Menu bar is the next horizontal line. It contains in black characters
the names of the available pull-down menus. In MacOS the menu bar has a
different location, and offers an extra menu (left of File) called DeskProto.
That will all look familiar for Apple users.

· The button bar or Toolbar is the horizontal line below, containing a
number of buttons for commands that need to be at hand. DeskProto
offers these buttons in five sizes (size to be set in the View menu), the
illustration shows Medium size buttons.

· The View window. The large screen-area below the button bar (on the
right side of the screen) is used to display the 3D data in one or more
views. The border of this window contains the Thumb-wheels.
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· The Project Tree window at the left of the view window displays the
Project Tree, showing the structure of the current project.

· The NC Files window at the bottom left shows the NC Program files that
have been saved for this project.

· Finally the bottom line or Status bar displays extra information on the
DeskProto commands, and some standard Windows messages.

This division of the main screen into three tiles (View, Project tree and NC
files) can be changed. You can do so exactly as for the complete window:
move your cursor over the border between two tiles (called the splitter), see
the cursor change, press the left mouse button and move.  The NC files
window and the Project tree window also can be completely made invisible
using the small arrow buttons (the black triangles next to the splitters).

Just as for most dialog screens, in Windows you can Resize the complete
DeskProto screen using the standard icons on the right end of the title bar.
Two standard sizes and Custom are available (the exact shape and color of
these buttons differs per Windows version):

·   The minimize button on the title bar will minimize: no window
visible, only a button on the Taskbar.

·   The maximize button on the title bar will maximize: full screen
window.

·   The custom size button restores the latest custom size. In
custom size mode you can change the size by positioning the cursor on one
of the borders or corners of the dialog window (note that the cursor
changes to an arrow), pressing the left mouse button and then moving the
cursor.

In MacOS you can use the  three colored buttons on the left
side of the title bar (red, yellow and green), for closing, minimizing, and
zooming (expanding to full-screen) the window. After zooming to full screen
the title bar with the colored buttons will have disappeared, you can again see
it by moving your cursor to the upper border of the screen.

In Linux the three buttons on the title bar look like this: .
Functionality is the same as in Windows.
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2.1 Title Bar

The Title bar is located along the top of a window.
It's exact appearance depends on your version of Linux/MacOS/Windows,
and on the Theme that you have selected. In Windows this bar may be semi-
transparent, which is called the Aero interface.

To move the window, drag the title bar.  You can also move other dialogs in
DeskProto by dragging their title bars.

A title bar may contain the following elements:
· Name of the current DeskProto project, or "Untitled" if the project has not

yet been saved (here "Teapot.dpj")
· Name of the application (here "DeskProto 8.0")
· License type: commercial, educational, hobby, etc. (here "Dealer license:

Not For Resale").

In Windows these buttons are present (the exact shape and color of these
buttons differs per Windows version):
· Application Control-menu button (the orange icon "DP")

· The Minimize button  to reduce the DeskProto application
window to a taskbar button

· The Maximize button  to enlarge the DeskProto application
window to fill all available screen space.

· The Restore button  to return the DeskProto application window
to its size and position before you chose the Maximize or Minimize
command.

· The Close button  to exit DeskProto and close it's window.

In MacOS the buttons are different:

·  These three buttons are for closing the dialog (red),
minimizing it (yellow), and zooming (expanding to full-screen mode,
green). The icons on these buttons are visible only when the cursor moves
over them.

In Linux the buttons on the Title bar look like this:
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·  Functionality of these three buttons is the same as in
Windows, see above.

The Windows images were made in Win10, the MacOS buttons in Catalina,
the Linux buttons in Ubuntu 18.04
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2.2 Menu Bar

The menu-bar is the main route to all the commands that are available in
DeskProto. This is why both the Help file and the Reference manual are
structured following these pull down menus. Each item in the menu-bar
represents a pull down menu, which can be made visible by clicking the left
mouse button with the cursor on the item. The menu shown above is present
both in Windows and in Linux. The following menus are present:

File File management and Print options.

Edit Standard Windows options Edit and Properties.

View Display and View control options.

Parameters Options to change the parameters for project, part and
operations

Create Toolpath calculation and saving options.

Options Customization of libraries, defaults and other settings.

Help Online Help options

Note that in the illustration above one character is underlined for each menu-
item. This is a feature in Windows: the underlined character can be used to
control the program without a mouse. Pressing Alt + F (at the same time) will
open the File menu for instance. 
In most versions of Windows the underlining will be invisible: you can press
the Alt button to make it visible.

The menu bar in MacOS (Apple) contains one extra menu: the DeskProto
menu. This is the first menu, before File: in MacOS for each application the
first menu has the name of the application.

DeskProto About / Activate / Upgrade / Check f Upd / Preferences

The commands in this menu are present in Windows as well: in the Help
menu and the Options menu.
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2.3 Toolbar

The toolbar is the series of buttons displayed across the top of the application
window, below the menu bar.  The toolbar provides quick access to many
tools used in DeskProto. All these functions can also be accessed via the
menus.

To hide or display the Toolbar, choose Toolbar from the View menu. A check
mark appears next to this menu item when the Toolbar is displayed. 

The next command in the View menu is "Toolbar Button Size", with which
you can choose between five sizes of buttons. The best choice will depend on
the resolution of your screen: on a high-res screen you may want larger
buttons, as the button sizes are in pixels. The size of the buttons can also be
changed in the Preferences: on the Advanced tab you can set a scaling factor
for the complete user-interface.

Below a list of all buttons with for each button an explanation of its
functions.

Open a New project. Same command as New in the File
menu

Open an existing project.  DeskProto displays the Open
dialog, in which you can locate and open the desired DPJ-
file.

Save the open project with its current name as DPJ file.  If
you have not yet named the project, DeskProto displays the
Save As dialog.

Load or Add a Vector file into the project.

 

Load or Add a Geometry file into the project.

Load a Bitmap file into the project (adding is not possible:
max 1 bitmap file loaded).
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Calculate the toolpaths for all visible operations of the
current part.

Show a Simulation of the result that you can expect after
machining the part.
This is a "toggle button": a button that can be switched on
(depressed) and off (normal state), showing its current
state.

Show an Animation of the toolpaths: your will see a cutter
move over your part, following and drawing the toolpath.
This is a toggle button as well.

Write the NC program for all visible operations of the
current part.

Send toolpaths to machine for all visible operations of the
current part.
This button is visible ONLY when this option has been
configured (in the Preferences). For some configurations
the button will show a different icon.

Print the image as present in the current view.

Preview how the image would be printed.

Show or hide the Part information dialog.
This is a "toggle button": a button that can be switched on
(depressed) and off (normal state), and show's its current
state.

Change the Layout out of the views.

Change which Items should be visible in the active view
(the Scene).

Change the Viewpoint (camera position) of the active view.

Set the viewpoint of the active view to Top view (XYZ  0 /
0 / 0 ).
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Set the viewpoint of the active view to Front view ( -90 / 0 /
0).

Set the viewpoint of the active view to Left side view ( -
90 / 90 / 0).

Set the viewpoint of the active view to Bottom view ( 0 /
180 / 0).

Set the viewpoint of the active view to Back view ( -90 /
180 / 0).

Set the viewpoint of the active view to Right side view ( -90
/ -90 / 0).

Set the viewpoint of the active view to Isometric view.

Set the viewpoint of the active view to Default view.

Restore the previous viewpoint settings.

Restore the next viewpoint settings (enabled only after
Restore previous view, to undo that restore action).

Change mouse-function to rotation.
The four mouse-buttons are "toggle buttons", showing
depressed in case selected. De-selecting can be done only
by pressing one of the other mouse-buttons. Always one of
these four buttons is selected.

Change mouse-function to panning.

Change mouse-function to zooming.

Change mouse-function to zoom window: zooming in by
selecting a specific area in the active view.

Change mouse-function to measuring: click two points on
the screen to find the distance between (shown on the
status bar).
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Note that one of these five mouse-functions is active at any
moment, so choosing one means deselecting the previous
one. DeskProto also offers other tools: the red thumb-
wheels on the screen are for rotations, the yellow for pan
and the blue wheel is for zoom. A handy alternative is using
the middle mouse button (the mouse-wheel): rotating this
wheel zooms the view, and moving the mouse with the
wheel pressed pans the view.

Set the Zoom percentage to 100% to show the complete
material block.

Display the Help Topics dialog.
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2.4 View Window

The view window shows the CAD-data that you are working with, the
toolpaths that you create, and much more. In the screenshot above the most
important items to be displayed are indicated. Note that this screen is about
geometry machining: for vector projects and bitmap projects other items can
be visible.

The wireframe block in orange is the Material block that you start with for
this Part.
The wireframe block in green is the Area to be machined for one Operation
Both blocks can be shown shaded by making them Translucent in the Items
Visible dialog
Drawn in metallic blue is the Geometry that you loaded (the STL file).
Vector data and bitmaps are displayed in gray.
The lines in red are the Toolpaths: the path that the tip of the cutter will
follow to create your part.
Start and end of the toolpath are shown as small red arrows.
Some of the toolpaths are in purple: these are done at reduced speed because
of a High chipload. 
And the dashed lines in gray are positioning movements in Rapid.
The green View orientator at the bottom left helps to orient by showing the
directions of the axes.
The dark blue orientator shows the position of the WorkPiece zero point.
The six Thumb-Wheels in the window border can be used to change the
camera position.
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The list above covers the most used items in the View Window. Many more
items can be displayed though: these can be defined using the Items Visible
dialog. This dialog contains a large number of checkboxes to switch the
various items on and off.

Mind the two different orientators: the green Orientator does not indicate the
WorkPiece zero point: that is shown by the blue Orientator.

Double-clicking in the View window will open the Items visible dialog.
Right-clicking in the View window will make a small menu pop up, called the
context menu, offering you a few relevant commands (right-clicking on a
Mac with a one-button mouse can be emulated by pressing the Ctrl (Control)
key while clicking the mouse button).
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2.5 Project Tree

In DeskProto the structure of the Project is shown in the project tree, which
is placed on the left of the screen. In the above example the project 'Torso'

contains two Parts (icon  ), one with five Operations and one with
two. 
Three different Operation types can be present: Vector operation (icon

 ),  Geometry Operation (icon  ), and Bitmap operation (icon

 ).
When one of these Operations or Parts is in an error status this is shown by

the  error icon.

The lamp icon  indicates if a line in the Tree is visible (yellow) or

 not (gray). Only one Part can be current (visible) at a time. Of the
Operations in that part none, several or all can be visible. Click on a lamp
icon to change the status of that line. The Project line has no lamp icon as
that line cannot be turned off. For Operation lamp icons two keyboard/mouse
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shortcuts are present: Ctrl+Click means "Make Visible and Hide Others",
Ctrl+Shift+Click means "Make All (in)visible" (on a Mac use the Command
key instead of Ctrl).

If you do not see a Project tree window, activate the option Project tree in
the View menu by selecting it.  The Project tree icon in the menu will get a
blue background and the Project Tree will be displayed. De-activating this
option (by again selecting it) will make the Tree window disappear. The size
of the Window can be changed by dragging it's borders with the mouse.

Shortcuts:
The black arrow button in the border of the View Window opens and closes
this Tree Window.

The project tree offers you a number of functions:

Editing parameters
Double-clicking on a line in the tree will open the dialog to edit the
parameters of the Project, Part or Operation.

Making a part current
To see a particular part (in case you have defined more than one part) you
should make it current. To make a part current just click with the left mouse-
button on the gray lamp icon of that part. You can also use the Context menu
(see below). When a part is not current, its icon is grayed.
There is always exactly one part that’s current. No more, no less.
You cannot make a Part "un-current" by clicking on a yellow lamp icon: you
can only make a different part current.

Making an operation (in)visible
To be able to see how the toolpaths look for a particular operation, this
operation should be visible. To make an operation visible just click with the
left mouse-button in the tree on the gray lamp icon of that operation to make
it yellow (turn the light on). Clicking on the yellow lamp icon of a visible
project will make it invisible. When an operation is not visible, its icon is
grayed.
Of the operations in a Part none, one, several or all can be visible.

Displaying parameters in the status bar
When you single-click on one of the items in the project-tree, that particular
item is highlighted (shown with a blue background), meaning that it is
selected. At that moment some of the parameters of that item will be shown
in the Status bar.

Context menus
When you right-click on an item in the tree a small menu pops up called the
context menu, offering you a number of functions (right-clicking on a Mac
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with a one-button mouse can be emulated by pressing the Ctrl (Control) key
while clicking the mouse button).
The available functions will be different for each line of the tree, and will
include the following options:

Open the parameters dialog of that tree-item.

Add a Part to the project. The settings of the default part are used.
Add an Operation to that part. The settings of the first default operation are
used. There are Add options: for a Vector Operation, a Geometry Operation
and a Bitmap Operation.
Copy an operation or a part will add an item that is identical to the current
one.

Remove a Part from the project. This is only possible when there will be at
least one part left after it has been removed.
Remove an Operation from that part. This is only possible when there will be
at least one operation left in the part where it belongs to after it has been
removed.

Move Parts and Operations in the Tree can be used when the sequence is
important (for instance first roughing, then finishing). Note that moving
several parts is easier in the Project parameters dialog, and moving several
operations is easier in the Part parameters dialog.

The other options in the context menu will be self explaining.
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2.6 NC Files

The NC File List shows a list of NC program files that have been saved for
this project. For each file its Name and Date are listed. This may be easy for
you to manage NC files for this project.

The NC Files window can made visible or invisible by checking or
unchecking the option NC File List in the View menu. This same effect can
be achieved by pressing the  black arrow button in the title bar of this
window. Note that the NC Files window can only be visible when the Project
Tree Window is visible too.

Hovering over the filename (positioning the cursor there without clicking)
will make DeskProto show the complete file specification of the NC file in a
tooltip: see the screenshot above.

Double-clicking a file will open the file using the default program that has
been set for that file-type in File Explorer. For instance double-clicking a
.TXT file will open it in Notepad. You can configure your machine's control
software to open your NC files, or a text editor in case you want to check the
file's contents.
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By right-clicking on any line in this window you can open a Context menu,
offering the following options:
· Remove the file-name from the list
· Delete the file
· Open the file - same effect as the double-click just described
· Open the file location - which will show the NC program in File Explorer
· Send the file to your machine (only in case that option has been

configured)
· Add a file - for instance to add a TXT file with your own project

documentation.
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2.7 Status Bar

The status bar is displayed at the bottom of the DeskProto window, and gives
status information about various relevant items. To display or hide the status
bar, use the Status Bar command in the View menu. A check mark appears
next to the menu item when the Status Bar is displayed.

The left side of the status bar shows the name of each menu command and
each toolbar button when the cursor is hovers over that command or button 
(a sort of extra Help information). Menu commands are also described when
you use the arrow keys to navigate through the menus.
The left side of the status bar is also used to display the results of the
measuring tool.

In the middle area the most important parameters of the selected tree-item
are displayed: CAD filename and machine for the Project, dimensions for a
Part, cutter and precision for an Operation.

At the right side of the status bar the coordinates of the current mouse
position are displayed, however only when the geometry is displayed in one
of the six main views. These coordinate values shown are in “Translated”
coordinates: the coordinates as used in the NC file. This is a very handy
option that enables you to quickly check dimensions and positions on the
screen.

For advanced users: when mouse function "Measuring" is active the
coordinates that are shown can be changed by pressing a keyboard key while
moving the cursor:
Alt: the coordinates are shown without the translation that is set in the Part
parameters.
Shift: the coordinates are shown in the alternate unit system, so in inches
when you work in mm, in mm when you work in inches.
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III Menu commands

3.1 DeskProto Menu (MacOS only)

In every MacOS application the first menu has the same name as the
application, containing some standard options for the application. The image
above shows the DeskProto menu. 
In Windows and in Linux these commands are all present as well, however
there you can find them in other menus.

In this document the commands are listed conform the menu structure in
Linux and Windows,
MacOS users can find more information about these six DeskProto
commands via the links below: 
About DeskProto
Preferences
Activate License
Upgrade information
Check for Update
Quit DeskProto

Services, Hide and Show are standard MacOS options, not related to
DeskProto
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3.2 File Menu

The File menu contains all options for File management and for Printing,
conform Windows conventions.
On the right side of the menu you can see "shortcuts" for a number of
commands: for instance "Ctrl+O" means to keep the Ctrl key pressed and
then press the O key: DeskProto will perform the Open Project command (on
a Mac use the Command key instead of Ctrl). No need to use your mouse ! 

Note that not all options are present in the DeskProto Free edition and Entry
edition.

3.2.1 New Project

This File menu command creates a new project in DeskProto. 
This project will be called "Untitled" until it has been saved.
You can select one of three project types:  Vector project,  Geometry project,
 Bitmap project,
by selecting one in a sub-menu.

The difference is the type of operation that will be present:
· a Vector project features a Vector operation, and is meant to process

Vector Data (like a 2D DXF file)
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· a Geometry project features a Geometry operation, and is meant to
process Geometry Data (like a 3D STL file)

· a Bitmap project features a Bitmap operation, and is meant to process
Bitmap Data (like a JPG file)

Combined projects (like geometry and vector) are possible by adding
operations once the project has been opened.

One of these three project types is the default, shown in bold characters.
You have selected this default when you first started DeskProto, in the Initial
Settings dialog.
It can be changed later by editing the default Part (Options menu) and
changing the type of operation that is present.

When starting DeskProto automatically opens a new default project, so no
need to again use "New Project" at program start.
As a next step you can then load the CAD file(s) you want to use: Vector
data, Geometry data and/or Bitmap data.

You can open an existing project with the Open Project command.

Shortcuts:

Toolbar:

Keys: CTRL+N  (Windows, Linux)  +N  (MacOS).

3.2.2 Open Project

This File menu command opens an existing project. The currently open
project will be closed, and the standard Windows Open File dialog will be
displayed, showing all DeskProto project files (*.DPJ).

You can’t open more than one project at a time.
You can create a new project with the New command.
A 'Close' option is not present: you can close your current project using either
'New', 'Open' or 'Exit'.

Important to know is that you can not load a CAD Data file using the Open
command: it can only open DeskProto projects. In order to load a vector file,
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geometry or bitmap file you need to use the command Load Vector File,
Load Geometry File or Load Bitmap File. Even easier is to use one of the
Wizards.

Shortcuts:

Toolbar:

Keys: Ctrl+O  (Windows, Linux)  +O  (MacOS).

When opening a project file, the CAD file(s) that were used will be opened
and loaded again: the DPJ file does not store the CAD-data but only links to
the external CAD files. The CAD file must thus be found at the same place as
where it was when the project file was saved. So when sending someone a
project file make sure to also send all CAD files.

If the CAD file cannot be found (for instance when the DPJ file was copied
from a different computer system) then DeskProto will check if a CAD file
with the correct name can be found in the current directory (same as the DPJ
file) or in the default Data directory. If yes, DeskProto will ask you if it can
use that file instead, see the File Not Found dialog.

3.2.3 Open Recent Project

This File menu command will show a list containing the latest projects that
you have opened (maximum 20).
Click on any project in the list to again open it. 

This list is called the Recent File List. Alternative name is MRU, which
stands for Most Recently Used.
It is a convenient standard option in current software.

3.2.4 Save Project

This File menu command saves the open project to its current name and
directory, in a DeskProto project file (.DPJ).  When you save a project for
the first time, DeskProto will display the Save As dialog so you can name
your project.  

If you want to change the name and directory of the open project before you
save it, choose the Save As command.
Also if you want to save the DPJ file with toolpaths you need to use the Save
As command.
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Note that the project file does not contain the CAD-data, only links to the
CAD-files. When you need to save the geometry after it has been changed
use the Save Geometry As command. Similar for Save Vector Data As and
Save Bitmap Data as.

Shortcuts:

Toolbar:

Keys: Ctrl+S  (Windows, Linux)  +S  (MacOS).

3.2.5 Save Project as

This File menu command saves and names (or renames) the open project,
using the Save As dialog. 

In this dialog you can:
· Name your project. 
· Select a new location for the project file.
· Select the type of DPJ file to be written: Standard or With toolpaths).

When you have loaded only one CAD file DeskProto will suggest to use the
name of that file for the project to be saved.

To save a project with its existing name and directory, use the Save
command.

3.2.6 Load/Add Vector File

The File menu command Load Vector File displays the standard Windows
Open File dialog in which you can select the vector file you want to load. It
will be showing all Vector file types that DeskProto can read: DXF, SVG, AI
and EPS (AI en EPS need to be version Adobe Ilustrator 8 files). 
After browsing the file it's contents will be loaded, at project level (so
accessible for all parts and for all operations).

Shortcuts:

Toolbar:
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When you already have loaded vector data, this command will change to
Add Vector File and the new vector curves will be Added. For an overview
of all Vector files that you loaded, or when you want to replace your current
Vector file with a new, go to the Parameters menu, choose the option Project
Parameters and go to tab Vector.

When Adding a second vector file an extra dialog will pop up: the Vector
Data Transformation dialog. This dialog enables you to position the new
vector  curves relative to the current CAD data.

3.2.7 Save Vector Data as

This File menu command displays the standard Windows Save File dialog in
which you can define the vector file you want to write. 
This command makes it possible to:
1- save vector data in a CAD file with one or more Transformations applied
2- merge several vector files to one combined new CAD file. 
3- save vector data in a different format (so use DeskProto as a converter for
vector drawing files).

Of course this is only possible in case you have previously loaded Vector
data.

About 1: 
Before the standard Save dialog an extra dialog will pop up: the Save Vector
Data Options dialog, which enables you to apply Transformations that you
have set in the Part Parameters.

About 3:
For importing Vector files DeskProto supports four file formats: DXF, EPS,
AI and SVG.
However, for exporting Vector files only DXF and SVG are supported.

3.2.8 Load/Add Geometry File

The File menu command Load Geometry File displays the standard
Windows Open File dialog in which you can select the geometry file you
want to load. It will be showing all Geometry file types that DeskProto can
read: STL, 3MF, DXF and WRL.
After browsing the file it's contents will be loaded, at project level (so
accessible for all parts and for all operations).

Shortcuts:
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Toolbar:

When you already have loaded a geometry, this command will change to
Add Geometry and the new geometry will be Added, to form one combined
new geometry. For an overview of all Geometry files that you loaded, or
when you want to replace your current geometry with a new, then go to the
Parameters menu choose the option Project Parameters and go to tab
Geometry.

When Adding a second geometry file an extra dialog will pop up: the
Geometry Transformation dialog. This dialog enables you to position the new
geometry relative to the current CAD data.

3.2.9 Save Geometry Data as

This File menu command displays the standard Windows Save File dialog in
which you can define the geometry file you want to write. 
This command makes it possible to:
1- save geometry data with one or more Transformations applied
2- merge several geometry files to one combined new file. 
3- save geometry data in a different format (so use DeskProto as a converter
for geometry files).

Of course this is only possible in case you have previously loaded Geometry
data.

About 1: 
Before the standard Save dialog an extra dialog will pop up: the Save
Geometry Data Options dialog, which enables you to apply Transformations
that you have set in the Part Parameters.

About 3:
DeskProto supports six file formats for geometry files, you can select one in
the Save as Type box.
STL STereoLithography File ASCII
STL Binary
3MF 3D Manufacturing Format
DXF AutoCAD Drawing eXchange File Polyface Meshes
DXF 3D Faces
VRML Virtual Reality Modeling Language Version 1.0
VRML Version 2.0
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STL is preferred as being most widely used, and the binary version results in
a much smaller file size than ASCII. So Binary STL is the default file type
here

3.2.10 Load Bitmap File

The File menu command Load Bitmap File displays the standard Windows
Open File dialog in which you can select the bitmap file you want to load. It
will be showing all Bitmap file types that DeskProto can read: BMP, JPG,
GIF, PNG and TIF.
After browsing the file it's contents will be loaded, at project level (so
accessible for all parts and for all operations).

Shortcuts:

Toolbar:

DeskProto supports only one open bitmap file per project. So adding a second
bitmap file (like for geometry files and vector files) is not possible.
Reason is that geometry data and vector data comes with a position in 3D
space, so combining several files can make sense.
Bitmap files do not have such position in space. In DeskProto the image will
be positioned at the top of the block, with its bottom left corner at point X=0
Y=0 in CAD coordinates.

If needed you can combine several bitmap files to one large image (using any
graphics program) and import that new image file in DeskProto.

3.2.11 Save Bitmap Data as

This File menu command displays the standard Windows Save File dialog in
which you can define the bitmap file you want to write. 
This command makes it possible to save bitmap data in a different format (so
use DeskProto as a converter for bitmap files).

Of course this is only possible in case you have previously loaded Bitmap
data.

DeskProto supports four file formats for exporting bitmap files: BMP, JPG,
PNG and TIFF. You can select one in the Save as Type box.
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3.2.12 Print Image

This File menu command prints an image of the DeskProto View Window.

This command presents a Print dialog, where you may specify the range of
pages to be printed, the number of copies, the destination printer, and other
printer setup options.

Shortcuts:

Toolbar:

Keys: CTRL+P  (Windows, Linux)  +P  (MacOS).

3.2.12.1 Print Preview

This File menu command displays the image of the page to be printed.
Two versions of this command are present in DeskProto:
· Print Image Preview, which shows the View Window as it would appear

when printed.
· Print Project Data Preview, which shows the Project Data as it would

appear when printed.

When you choose this command, a print preview window will pop up in
which the page will be displayed as it will be printed.  The print preview
toolbar offers you options to view either one or two pages at a time; move
back and forth through the document; zoom in and out of pages; and initiate
a print job.

On most MacOS versions this command cannot be used as Apple does not
offer the full OpenGL functionality.

Shortcuts:

Toolbar:   (for Print Image Preview)

3.2.12.2 Print Page Setup

This File menu command selects a printer and a printer connection.
Two versions of this command are present in DeskProto:
· Print Image Page Setup, for printing the View Window.
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· Print Project Data Page Setup, for printing the Project Data.

This command presents the standard Windows Print Setup dialog, where you
specify the printer and its connection. The available options will depend on
the Printer driver that you have selected.

Note that some CNC milling machines also use a Windows Printer Driver and
thus a Print Setup Dialog. Do NOT select such milling machine here, instead
use the DeskProto Preferences. This command is only for printing on paper.

3.2.13 Print Project Data

This File menu command prints all the data in the project, that means all the
project parameters, the parameters of all of its parts, and the parameters of all
of their operations. See the example image below.

The printed pages can be used for backup and documentation purposes.

This command presents a Print dialog, where you may specify the range of
pages to be printed, the number of copies, the destination printer, and other
printer setup options.

3.2.13.1 Print Preview

This File menu command displays the image of the page to be printed.
Two versions of this command are present in DeskProto:
· Print Image Preview, which shows the View Window as it would appear

when printed.
· Print Project Data Preview, which shows the Project Data as it would

appear when printed.
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When you choose this command, a print preview window will pop up in
which the page will be displayed as it will be printed.  The print preview
toolbar offers you options to view either one or two pages at a time; move
back and forth through the document; zoom in and out of pages; and initiate
a print job.

On most MacOS versions this command cannot be used as Apple does not
offer the full OpenGL functionality.

Shortcuts:

Toolbar:   (for Print Image Preview)

3.2.13.2 Print Page Setup

This File menu command selects a printer and a printer connection.
Two versions of this command are present in DeskProto:
· Print Image Page Setup, for printing the View Window.
· Print Project Data Page Setup, for printing the Project Data.

This command presents the standard Windows Print Setup dialog, where you
specify the printer and its connection. The available options will depend on
the Printer driver that you have selected.

Note that some CNC milling machines also use a Windows Printer Driver and
thus a Print Setup Dialog. Do NOT select such milling machine here, instead
use the DeskProto Preferences. This command is only for printing on paper.
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3.2.14 Show Start Screen

The DeskProto Start Screen shown above is a help to quickly start the task
that you need.
You can open the Start Screen via the File menu  (File >> Show Start
Screen).

Shortcut:

Keys: Ctrl+B  (Windows, Linux)  +B  (MacOS).  
B stands for "Begin", as the S already is being used (for Save project).
 
It will first show the Edition that your are running, 
next your Name and Location (as owner of the license),
and the type of License, with the restrictions that apply (of any).

Three groups of tasks are presented:
· Start a new project
· Open an existing project 
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· Other tasks
Each line in these three lists is a link that will directly start that task.

Starting a New project can be done either using the Wizard interface or the
Dialog based interface. 
Default choice for this dialog is to start a New project using the Wizard: that
is what will happen when you simply press the Enter key (indicated by the
icon at this line). This is the most convenient option for novice users.
When starting a new project using dialogs you need to select which project
type. The difference between Vector/Geometry/Bitmap projects is explained
on page New project. 

The DeskProto Setup has installed a number of Sample projects and Sample
geometries on your PC. Including some great geometries like the DeskProto
picture frame: see the lessons in the DeskProto Tutorial book.
Conform Microsoft's specifications the Samples have been installed in the
\ProgramData\ folder, which may not be easy to find as it is a hidden folder
and its location is different per Windows version. Sorry about that,
unfortunately for standard users (no administrative rights) other locations are
not permitted by Microsoft. Also when using MacOS or Linux the Samples
folder may not be easy to find for you.
Using the checkbox Use samples folder will make DeskProto open the
sample folder when you need to load the CAD data.

To open an existing project two options are present:
Command Open project will allow you to open any project file by browsing
one.
Recent projects will be available only when you have used DeskProto V8
before. In this dialog only the latest 5 projects will be shown, more may be
visible when you select this option via the File menu.

In the Other tasks section, Open sample project makes it easy to find the
sample projects.
The other three 'other tasks' (Read tutorial book, View tutorial videos and
Visit user forum) require an Internet connection, as they will start your
browser and open a web page.

The checkbox Show this start screen on startup makes this screen
automatically appear at each start of DeskProto. After having de-selected this
option, you can still access the Start Screen using the command Show Start
screen in the File menu.
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3.2.15 Start Wizard

The Wizard-based user interface is an important feature of DeskProto. It
makes it possible for users without much CAM know-how to easily create the
toolpaths that they need for their projects. Each wizard is a series of dialog
screens (pages) that need to be filled in: the wizard so to speak 'takes your
hand' and guides you through the process of creating toolpaths.

When you create a project using a wizard and you save the project without
making any changes after finishing the wizard, on re-opening DeskProto will
show the project using the same wizard. So it is possible to use DeskProto
seeing only the wizard interface.
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Navigating the Wizard is done using the Wizard buttons, on the bottom of the
screen:

  Back and    Next let you navigate the wizard
pages,

  Cancel and    Help are standard buttons.
Every wizard page has its own Help information page.

  Finish will replace Next on the final page of the Wizard,

  Apply will apply the currently selected settings and refresh
your screen.

  Calculate will calculate the toolpaths with the currently
selected settings.

Navigation icons: The DeskProto wizards start with the page shown above,
called "Which Wizard?". On the top of the page you can see one icon, after
selecting one of the wizards a series of icons will be shown: one for each
wizard page. At this point these extra icons are all gray, when progressing
they will be colored: then they can be used as tab-pages to navigate (click on
a colored icon to jump to that page of the wizard).

Help information: Important are the  yellow question marks in front of
each question. When you position the cursor over such mark a Tooltip will
pop up, giving extra information about that question. It will also tell you
where to find that setting in the Dialog based interface.

The first question, "Machine to be used", in most cases needs not be changed
as your default machine will already have been selected here.

The second question, "Type of milling", presents the six wizards that you can
choose from: you need to select one before continuing.  
Not all wizards will be available for all users (some may have been grayed
out): some wizards are not available in all DeskProto Editions, and some
wizards are only available in case you selected a machine with a rotation
axis. 
Also: in the Free edition and the Entry edition the available wizards do not
include all described options.
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Basic Vector Machining
This wizard creates 2D toolpaths for just one Vector file (DXF, EPS, AI,
SVG). It is meant for novice DeskProto users, and explains this procedure
step-by-step. You can choose to use either Profiling, Pocketing or V-Carving
toolpaths.

Basic Geometry Machining
This wizard creates 3D toolpaths for just one Geometry file (STL, 3MF,
DXF). It is meant for novice DeskProto users, and explains step-by-step the
procedure to create an NC toolpath file (NC program) based on your
geometry. The model will be machined from one side, using three operations:
Roughing, Finishing and a smoothing contour.

Basic Bitmap Machining
This wizard creates 3D toolpaths for a relief based on a Bitmap file (BMP,
GIF, JPG, PNG, TIFF file). It is meant for novice DeskProto users, and
explains this procedure step-by-step. 

Advanced Geometry  (the three advanced wizards are all for geometry
machining):

Two sides, manual flip, also called Two-sided Wizard  (not available in the
Free Edition and the Entry edition)
This advanced wizard is a unique feature of DeskProto, and makes it very
easy for you to create a compete 3D part by machining it from two sides, on
any three axis milling machine. DeskProto assists you by taking care of the
repositioning needed to machine the second half: no need to change the
workpiece zero point.

Two or more sides, automatic rotation, also called the N-Sided Wizard
 (available only in the Multi-Axis edition)
N-sided milling is meant for machines with a rotation axis (A-axis), and
allows indexed machining: this wizard generates XYZ toolpaths to machine
the part from several (N) sides, with a rotation in-between. The number of
sides can be freely chosen: for two sides the result is the same as for the
previous wizard, though now with automatic rotation.

Rotary Machining   (available only in the Multi-Axis edition)
If your machine is equipped with a rotation-axis (A-axis) you can use this
wizard to create toolpaths for a model that is machined all around: rotation
axis machining. In contrast to the previous wizard, now the material rotates
during machining (continuous rotation). 
A rotation axis is an extra piece of equipment that lets your material rotate on
the machine (just like a roast rotating on a spit above a barbecue).

Note that all functionality offered by the wizards is also available in the
dialog-based user interface: the wizards are only meant to make things easier
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for you, they do not add new options. After finishing any wizard you can still
use the dialogs to fine-tune the settings that the wizard made.

You can find the Wizard in the File menu  (File >> Start wizard)  or in the
Start Screen.

Shortcut:

Keys: Ctrl+W  (Windows, Linux)  +W  (MacOS).

3.2.16 Start Custom Wizard

A Custom Wizard (also called Script wizard) is a wizard written in a Script
language. It is stored as a separate file: a .DPW file (so it is not part of the file
DeskProto.exe like the 'normal' wizards). This is a very powerful option, as
any user (and any reseller) is able to create a custom wizard for a specific
application and/or a specific fixture.

Custom wizards are not available in MacOS and Linux, only in Windows,
sorry about that.

Using a Custom Wizard.

Script Wizards can be accessed via the File menu. 
A keyboard shortcut is available as well:  Ctrl + Shift + W.
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After selecting command Start Custom Wizard the dialog shown above will
pop up, allowing you to select which Custom wizard to use. This list is filled
when DeskProto starts, and contains all valid Wizards found in the
subdirectory \CustomWizards\ of DeskProto's ProgramData folder, for
instance in C:\ProgramData\DeskProto 8.0\CustomWizards\
As most of the wizards shown in the illustration above require a rotation axis,
the list of wizards will be much shorter for users of a Free edition, Entry
edition and/or an Expert edition of DeskProto.

A Custom wizard can also be started by:
· calling its DPW-file as a  command line parameter.
· double-clicking it's DPW-file in Windows explorer.

When you are a user of a DeskProto Custom Wizard and need any Help
information, please refer to the documentation that came with that  Wizard.

More information about creating Custom wizards can be found on the
Custom Wizard page.
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3.2.17 Run Script

Normally when you use DeskProto you will load a CAD-file, set a number of
parameters, calculate toolpaths and save an NC program file. So you
manually perform a number of actions, in a specific sequence. In some
applications the actions to be done and the parameter settings to be used are
always the same, which makes it possible to automate this task. Such
automation can be achieved by Scripting.

A Script is a list of actions to be done (commands to be executed), saved in a
file. These actions of course need to be described in a language that the
computer will understand: in a DeskProto script you need to use the
JavaScript scripting languages. For more information also see the Scripts
page.

You can start a script via the "Run Script..." command the File menu.

Shortcut:

Keys: Ctrl+R  (Windows, Linux)  +R  (MacOS).

This command will open the Run Script dialog as shown above. Here you can
browse the Script file (files are seen with extension .dps for DeskProto Script
file) and then press the Run button to start it.

Complete automation can be achieved by starting DeskProto with the name
of the Script file as command line parameter. Then this complete dialog will
be skipped: the script will be started and executed automatically. More
information about this in Command line parameters.
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Note that also a special type of Script does exist, called the Script Wizard (or
Custom Wizard), which does exactly as the name suggests. These script
wizards can not be started using this Run Script command.

Above you see the very simple script file ExampleScript.dps  that was
present in the dialog just shown. It contains (and calls) two functions, one to
load a 3D geometry file, and one to add and rotate a part. Lines starting with
"//" in JavaScript are comment lines. This is just a very simple example: you
can add any DeskProto functionality here, which makes scripting a very
powerful tool for automation. Each script file should start with a few
standards lines, which are nog displayed here.

The second example script file that has been installed is called
ScriptedBottle.dps
This script will load the bottle sample geometry, rotated and segment it (Part
Segment is the old name for the Material block, still used in the Scripts),
calculate toolpaths and save an NC file. No path for the NC Program file is
specified, so it will be saved in the default location for Write NC which is in
most cases is the (My) Documents folder.
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When using such script as command line parameter you can even add an Exit
command: then the actual user does not need to perform any user-interaction
with DeskProto.

For more information on scripting see the DeskProto Script Reference. You
can find that on the DeskProto distribution CD, or without such CD email us
to obtain a copy.

3.2.18 Exit

This command ends your DeskProto session. DeskProto will then prompt you
to save projects with unsaved changes. In Windows and in Linux it can be
found in the Help menu, in MacOS in the DeskProto menu (as "Quit
DeskProto").

Windows shortcuts:

Mouse: Click the application's Close button  (top right button of
the title bar).

Keys: ALT+F4

MacOS shortcuts:

Mouse: Click the red application's Close button  (top left
button of the title bar).

Keys: +Q

Linux shortcuts:

Mouse: Click the red application's Close button  (top
left button of the title bar).

Keys: Ctrl+Q
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3.3 Edit Menu

The Edit menu contains all options for Clipboard actions and a Properties
command, conform Windows conventions. The number of commands is very
limited though as DeskProto does not include an Undo function, and as Cut,
Paste, Select and Search actions are not applicable for DeskProto.

3.3.1 Copy

This Edit menu command is applied to the currently active item in
DeskProto.
That can either be one of the lines in the Project Tree or the image in the
View Window.

In the Tree the Project cannot be copied, so when the Project line in the Tree
is active the Copy command will make an error pop up.
In case a Part or an Operation is active it will simply be copied: a copy of the
Part or Operation will be added to the Tree. So in this case the Copying is not
to the clipboard: Copy will immediately add a line to the tree.

When the View Window is active the image in this window will be copied to
the Windows Clipboard.
The clipboard is used to cut and paste data between windows applications:
you can for instance later Paste this image into a Word document. Copying
data to the clipboard replaces the contents previously stored there. This
command has no visible effect in DeskProto.

Shortcuts:

Keys: CTRL+C  (Windows, Linux)  +C  (MacOS).

3.3.2 Properties

This Edit menu command can be used to edit the highlighted tree-item or the
active view. Depending on what is selected this command will open one of
the following five dialogs:



DeskProto Reference

Page 56

Project Parameters , Part Parameters , Geometry Operation Parameters ,
Vector Operation Parameters , Bitmap Operation Parameters , Viewpoint .
This is conform Microsoft's specifications for Windows: Edit -> Properties
should open the Properties dialog for the selected item.

Shortcuts:
Keys: Alt+Enter (Windows, Linux)  Option+Enter  (MacOS: this is what
these weird icons mean).
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3.4 View Menu

The functions in the View menu let you control what is visible on your
screen.

In the screenshot above you can see that in front of each menu options an
icon is present (or an empty space). For options that offer an on/off setting
the background of the icon is blue (or blue with a "V" icon) when the option
is on (so when that  control is visible in the user interface), and the
background is gray when the option if off.

3.4.1 Toolbar

The toolbar is the series of buttons displayed across the top of the application
window, below the menu bar.  The toolbar provides quick access to many
tools used in DeskProto. All these functions can also be accessed via the
menus.

To hide or display the Toolbar, choose Toolbar from the View menu. A check
mark appears next to this menu item when the Toolbar is displayed. 

The next command in the View menu is "Toolbar Button Size", with which
you can choose between five sizes of buttons. The best choice will depend on
the resolution of your screen: on a high-res screen you may want larger
buttons, as the button sizes are in pixels. The size of the buttons can also be
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changed in the Preferences: on the Advanced tab you can set a scaling factor
for the complete user-interface.

Below a list of all buttons with for each button an explanation of its
functions.

Open a New project. Same command as New in the File
menu

Open an existing project.  DeskProto displays the Open
dialog, in which you can locate and open the desired DPJ-
file.

Save the open project with its current name as DPJ file.  If
you have not yet named the project, DeskProto displays the
Save As dialog.

Load or Add a Vector file into the project.

 

Load or Add a Geometry file into the project.

Load a Bitmap file into the project (adding is not possible:
max 1 bitmap file loaded).

Calculate the toolpaths for all visible operations of the
current part.

Show a Simulation of the result that you can expect after
machining the part.
This is a "toggle button": a button that can be switched on
(depressed) and off (normal state), showing its current
state.

Show an Animation of the toolpaths: your will see a cutter
move over your part, following and drawing the toolpath.
This is a toggle button as well.

Write the NC program for all visible operations of the
current part.

Send toolpaths to machine for all visible operations of the
current part.
This button is visible ONLY when this option has been
configured (in the Preferences). For some configurations
the button will show a different icon.
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Print the image as present in the current view.

Preview how the image would be printed.

Show or hide the Part information dialog.
This is a "toggle button": a button that can be switched on
(depressed) and off (normal state), and show's its current
state.

Change the Layout out of the views.

Change which Items should be visible in the active view
(the Scene).

Change the Viewpoint (camera position) of the active view.

Set the viewpoint of the active view to Top view (XYZ  0 /
0 / 0 ).

Set the viewpoint of the active view to Front view ( -90 / 0 /
0).

Set the viewpoint of the active view to Left side view ( -
90 / 90 / 0).

Set the viewpoint of the active view to Bottom view ( 0 /
180 / 0).

Set the viewpoint of the active view to Back view ( -90 /
180 / 0).

Set the viewpoint of the active view to Right side view ( -90
/ -90 / 0).

Set the viewpoint of the active view to Isometric view.

Set the viewpoint of the active view to Default view.
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Restore the previous viewpoint settings.

Restore the next viewpoint settings (enabled only after
Restore previous view, to undo that restore action).

Change mouse-function to rotation.
The four mouse-buttons are "toggle buttons", showing
depressed in case selected. De-selecting can be done only
by pressing one of the other mouse-buttons. Always one of
these four buttons is selected.

Change mouse-function to panning.

Change mouse-function to zooming.

Change mouse-function to zoom window: zooming in by
selecting a specific area in the active view.

Change mouse-function to measuring: click two points on
the screen to find the distance between (shown on the
status bar).

Note that one of these five mouse-functions is active at any
moment, so choosing one means deselecting the previous
one. DeskProto also offers other tools: the red thumb-
wheels on the screen are for rotations, the yellow for pan
and the blue wheel is for zoom. A handy alternative is using
the middle mouse button (the mouse-wheel): rotating this
wheel zooms the view, and moving the mouse with the
wheel pressed pans the view.

Set the Zoom percentage to 100% to show the complete
material block.

Display the Help Topics dialog.

3.4.2 Toolbar Button Size

The Toolbar is the series of buttons displayed across the top of the
application window, below the menu bar.
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In case your have a high resolution monitor - or if you do not have clear eye-
sight - these buttons might be too small for you to clearly recognize them. Or
when you have a small monitor they might be to large as not all buttons will
be visible: the toolbar is wider than your screen.

To solve that problem you can ask DeskProto to change the size of these
buttons. 
A black dot on a blue background will clearly indicate which buttons size
currently is selected in the menu. 

These are the five size options (the default size is Medium):

Extra small  - 16 x 16 pixels

Small - 24 x 24 pixels

Medium - 32 x 32 pixels

Large - 48 x 48 pixels

Extra large - 64 x 64 pixels

When you change the size of the toolbar buttons and also want to change the
font size for all text (so resize the complete user interface - for all Windows
programs) you can do that in the Windows Display properties (for MS
Windows).

In addition to these five sizes for the buttons DeskProto offers an option to
scale the complete user interface, on the Advanced tab of the Preferences
(select "User Interface"). When you select a scaling factor that is larger than
1 the resolution of the toolbar icon images can be made even higher than
64x64 pixels (maximum 128x128).
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3.4.3 Status Bar

The status bar is displayed at the bottom of the DeskProto window, and gives
status information about various relevant items. To display or hide the status
bar, use the Status Bar command in the View menu. A check mark appears
next to the menu item when the Status Bar is displayed.

The left side of the status bar shows the name of each menu command and
each toolbar button when the cursor is hovers over that command or button 
(a sort of extra Help information). Menu commands are also described when
you use the arrow keys to navigate through the menus.
The left side of the status bar is also used to display the results of the
measuring tool.

In the middle area the most important parameters of the selected tree-item
are displayed: CAD filename and machine for the Project, dimensions for a
Part, cutter and precision for an Operation.

At the right side of the status bar the coordinates of the current mouse
position are displayed, however only when the geometry is displayed in one
of the six main views. These coordinate values shown are in “Translated”
coordinates: the coordinates as used in the NC file. This is a very handy
option that enables you to quickly check dimensions and positions on the
screen.

For advanced users: when mouse function "Measuring" is active the
coordinates that are shown can be changed by pressing a keyboard key while
moving the cursor:
Alt: the coordinates are shown without the translation that is set in the Part
parameters.
Shift: the coordinates are shown in the alternate unit system, so in inches
when you work in mm, in mm when you work in inches.

3.4.4 Part Information

The View menu command Geometry Information displays or hides the Part
Information dialog, which shows information about the geometry and the
current part.  A check mark is shown next to the menu item when the dialog
is displayed.

Shortcuts
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Toolbar:

3.4.5 Project Tree

In DeskProto the structure of the Project is shown in the project tree, which
is placed on the left of the screen. In the above example the project 'Torso'

contains two Parts (icon  ), one with five Operations and one with
two. 
Three different Operation types can be present: Vector operation (icon

 ),  Geometry Operation (icon  ), and Bitmap operation (icon

 ).
When one of these Operations or Parts is in an error status this is shown by

the  error icon.
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The lamp icon  indicates if a line in the Tree is visible (yellow) or

 not (gray). Only one Part can be current (visible) at a time. Of the
Operations in that part none, several or all can be visible. Click on a lamp
icon to change the status of that line. The Project line has no lamp icon as
that line cannot be turned off. For Operation lamp icons two keyboard/mouse
shortcuts are present: Ctrl+Click means "Make Visible and Hide Others",
Ctrl+Shift+Click means "Make All (in)visible" (on a Mac use the Command
key instead of Ctrl).

If you do not see a Project tree window, activate the option Project tree in
the View menu by selecting it.  The Project tree icon in the menu will get a
blue background and the Project Tree will be displayed. De-activating this
option (by again selecting it) will make the Tree window disappear. The size
of the Window can be changed by dragging it's borders with the mouse.

Shortcuts:
The black arrow button in the border of the View Window opens and closes
this Tree Window.

The project tree offers you a number of functions:

Editing parameters
Double-clicking on a line in the tree will open the dialog to edit the
parameters of the Project, Part or Operation.

Making a part current
To see a particular part (in case you have defined more than one part) you
should make it current. To make a part current just click with the left mouse-
button on the gray lamp icon of that part. You can also use the Context menu
(see below). When a part is not current, its icon is grayed.
There is always exactly one part that’s current. No more, no less.
You cannot make a Part "un-current" by clicking on a yellow lamp icon: you
can only make a different part current.

Making an operation (in)visible
To be able to see how the toolpaths look for a particular operation, this
operation should be visible. To make an operation visible just click with the
left mouse-button in the tree on the gray lamp icon of that operation to make
it yellow (turn the light on). Clicking on the yellow lamp icon of a visible
project will make it invisible. When an operation is not visible, its icon is
grayed.
Of the operations in a Part none, one, several or all can be visible.
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Displaying parameters in the status bar
When you single-click on one of the items in the project-tree, that particular
item is highlighted (shown with a blue background), meaning that it is
selected. At that moment some of the parameters of that item will be shown
in the Status bar.

Context menus
When you right-click on an item in the tree a small menu pops up called the
context menu, offering you a number of functions (right-clicking on a Mac
with a one-button mouse can be emulated by pressing the Ctrl (Control) key
while clicking the mouse button).
The available functions will be different for each line of the tree, and will
include the following options:

Open the parameters dialog of that tree-item.

Add a Part to the project. The settings of the default part are used.
Add an Operation to that part. The settings of the first default operation are
used. There are Add options: for a Vector Operation, a Geometry Operation
and a Bitmap Operation.
Copy an operation or a part will add an item that is identical to the current
one.

Remove a Part from the project. This is only possible when there will be at
least one part left after it has been removed.
Remove an Operation from that part. This is only possible when there will be
at least one operation left in the part where it belongs to after it has been
removed.

Move Parts and Operations in the Tree can be used when the sequence is
important (for instance first roughing, then finishing). Note that moving
several parts is easier in the Project parameters dialog, and moving several
operations is easier in the Part parameters dialog.

The other options in the context menu will be self explaining.
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3.4.6 NC File List

The NC File List shows a list of NC program files that have been saved for
this project. For each file its Name and Date are listed. This may be easy for
you to manage NC files for this project.

The NC Files window can made visible or invisible by checking or
unchecking the option NC File List in the View menu. This same effect can
be achieved by pressing the  black arrow button in the title bar of this
window. Note that the NC Files window can only be visible when the Project
Tree Window is visible too.

Hovering over the filename (positioning the cursor there without clicking)
will make DeskProto show the complete file specification of the NC file in a
tooltip: see the screenshot above.

Double-clicking a file will open the file using the default program that has
been set for that file-type in File Explorer. For instance double-clicking a
.TXT file will open it in Notepad. You can configure your machine's control
software to open your NC files, or a text editor in case you want to check the
file's contents.
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By right-clicking on any line in this window you can open a Context menu,
offering the following options:
· Remove the file-name from the list
· Delete the file
· Open the file - same effect as the double-click just described
· Open the file location - which will show the NC program in File Explorer
· Send the file to your machine (only in case that option has been

configured)
· Add a file - for instance to add a TXT file with your own project

documentation.

3.4.7 Thumbwheels

The Thumb-wheels that are drawn in the border of the View window offer
an easy way to change the camera position. You can use them by pressing the
left mouse button with the cursor on the wheel and then moving the mouse,
keeping the left button pressed. The cursor will become arrow-shaped to
guide you. You can look at the small green axis cube (the Orientator) in the
left-bottom corner  of the view to help you when rotating. The three red
thumb-wheels control the rotation (three axes), the two yellow wheels control
the pan (horizontal and vertical movement), and the blue one controls the
zoom.
Note that these rotations only change the viewing angle (camera position),
not the orientation of the part in space.

A trick that may be handy: when you keep the shift key pressed while
rotating the rotation will be done in steps of 15 degrees.

You can make the thumb-wheels visible and invisible using the Thumb-
wheels command in the View menu.
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3.4.8 Layout

The View menu command Layout... displays the Views Layout dialog in
which you can change the layout of the views in which the geometry is
drawn. You can view either 1, 2, 3 or 4 views at the same time.

Shortcuts:

Toolbar:

3.4.9 Items Visible

The View menu command Items Visible... displays the Items Visible dialog, in
which you can change what is and what is not shown in the active view (the
Scene). In case none of the boxes is checked the View Window will be blank.
You can also select which operations should be visible.

Shortcuts

Toolbar:
Mouse: Right-click in a View, and select Items Visible in the shown
context-menu.

It is even quicker to just double-click inside a View.
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3.4.10 Viewpoint

The View -> Viewpoint submenu offers the following commands to set the
Viewpoint:

Top / Front / Left / Bottom / Back / Right  to set one of the six main views.
Isometric / Use default  to set the Isometric or the Default view.
Previous to return to the previous View settings.
Next (enabled only after restore Previous view) to undo that restore.
Custom will open the Viewpoint dialog.

The same functions can be accessed more easily using the Toolbar buttons.
Note that the Viewpoint can also be set using the Thumb-wheels or the
Mouse functions.
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3.4.11 Zoom

The View -> Zoom submenu offers the following commands:

Zoom In and Zoom out both change the zooming factor with 15 %.
Zoom All sets the zooming factor to 100 % to completely show all items.
Custom... will open the Viewpoint dialog, as the zooming factor is one of the
Viewpoint settings.

Note that the Zoom can also be set using the Thumb-wheels or the Mouse
functions.

3.4.12 Mouse Function

This command determines the functionality offered by the left mouse button
inside the View Window. Five different functions are possible, of which
always exactly one is active (the five functions are toggled). In the Toolbar
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you can quickly see which function is active as that button is drawn with a
blue background.

Rotation: use the mouse (move it inside the graphics view with the left
mouse button pressed) to rotate your geometry.  Imagine that the geometry is
inside a large hollow glass sphere: with your mouse you can grab the sphere
anywhere, and rotate it round its center point, including the geometry. This
means that grabbing and moving (say) left in the upper part of the screen has
a different result than grabbing and moving left in the lower part of the
screen.
Some CAD programs (for instance Rhino) keep the Z-axis vertically aligned
on the screen while rotating. When you prefer DeskProto to do that as well
you can check "Lock Z-axis vertical on screen" in the Advanced Preferences
for the Mouse.
Note that in fact the geometry is not rotated, but the camera position
(viewpoint) instead. You can see this, as during rotation the Orientator (the
small axis cube at the bottom left of your screen) rotates with the geometry.
If you want to rotate the geometry you should use the rotation option in the
Part Parameters.

Panning: use the mouse to pan your geometry (move it on the screen, left-
right, up-down, etc). When zoomed in you can use panning to determine
which part of the geometry to look at.

Zooming: use the mouse to zoom in and out: move the mouse up is zoom out
(push away), move down is zoom in (pull in). The center of the screen
remains directed to the same position. When you want these two actions
reversed you can configure that in the Advanced Preferences for the Mouse.
Note that the icon on the toolbar button then changes as well.

Zoom Window: use the mouse to zoom into any part of the screen. Click the
left mouse button to define one corner of a bounding box, move the mouse
keeping the button pressed, and release it as you have reached the opposite
corner. The part of the screen inside the bounding box will now be displayed
as large as possible.

Measuring: use the mouse to measure the distance between two points, by
clicking these points on the screen. The result is shown on the status bar of
DeskProto's main window. Note that the result is not always the real distance
in 3D: only the horizontal distance and vertical distance as seen on the screen
(so in a plane parallel to your screen) are measured. If one point is further
away from the viewer then the other this tool does not include that
component of the 3D distance.

How many digits are shown behind the decimal point depends on the size of
the dimension: the smaller the more digits.
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The measuring tool offers several extra options for the results to be displayed,
by pressing a keyboard key while measuring:
Alt (for Apple the Option key): you get more detailed results, like "_ 53. 71
  58. 07°   \  101. 5   31. 93°   |  86. 17", in which
_ is the horizontal distance
angle of the diagonal with the horizontal line
\ is length of the diagonal
angle of the diagonal with the vertical line
| is the vertical distance
In this view the units are not specified.
Shift: the results are shown in the alternate unit system, so in inches when
you work in mm, in mm when you work in inches.
Control (for Apple the Command key): the resulting dimensions are shown
in pixels (more interesting for the developers than for users).
When you use the measuring tool in an empty project (no block dimensions,
no CAD data) 1 pixel will be shown as 1 mm.

Using the first three mouse functions the geometry is continuously redrawn
during the mouse movement. Depending on the size of your file and the
speed of both your computer and graphics card, this redrawing will take more
or less time. In case the redrawing is too slow, you can influence the number
of entities to be continuously redrawn: see Options - Preferences - Advanced
- Graphics.

An alternative for Zoom is rotating the Mouse wheel. This works no matter
which of the above buttons is active. In the Advanced Preferences for the
Mouse you can reverse the effect of the rotation direction ad also change the
zooming speed when rotating the mouse wheel.
An alternative for Pan is moving the mouse with the middle button (the
wheel) depressed. 
So when the mouse-function button “Rotation” on the screen is active for
the left mouse button, using these alternatives you have Rotate, Pan as well
as Zoom easily available without having to press any Toolbar button.

The rotation tool and the panning tool offer an extra option: when you press
the Shift button on your keyboard the two functionalities are switched. This is
done for users who have a two-button mouse (so without a mouse wheel):
when mouse function Rotation is active they can pan their view by pressing
shift, so without having to select a different mouse-function.

Note that you can also use the red, yellow and blue Thumb-wheels on the
border of the graphics screen.
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3.5 Parameters Menu

The parameters menu offers access to all milling parameters. The three main
levels Project, Part and Operation follow the structure of the Project Tree:
one Project can contain one or more Parts (for instance a left half and a right
half), and each Part can contain one or more Operations (for instance for
roughing, finishing and detailing). Operations can be one of three types:
Vector Operation, Geometry Operation and Bitmap Operation.

3.5.1 Project Parameters

This Parameters menu command displays the Project parameters in which
you can edit the parameters of your current Project.

This dialog can be reached via the Parameters menu: the first option.

Shortcuts:
You can double-click on the project-line in the project tree (the base level
item).
Or right-click on the project-line and select Project Parameters in the
context-menu.

This same dialog is used for the Default Project parameters.

3.5.2 Part Parameters

This Parameters menu command displays the Part Parameters dialog in which
you can edit the parameters of a Part.

In case a Project has more than one Part, first a dialog will be shown in which
you can select the part you want to edit.
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The part you select here will also become the current Part, and thus will be
displayed when you have finished editing.

Shortcuts
Double-click on a part-line in the project tree (one of the second level items).
Or right-click on a part-line and select Part Parameters in the context-menu.

3.5.3 Operation Parameters

This Parameters menu command displays the Operation Parameters dialog in
which you can edit the parameters of an Operation.
Operations can be either Geometry Operations , Vector Operations or Bitmap
Operations.

In case a Part has more than one Operation, first a dialog will be shown in
which you can select the operation you want to edit. 
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Shortcuts
Double-click on an operation-line in the project tree (one of the third level
items).
Or right-click on a operation-line and select Operation Parameters in the
context-menu.
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3.6 Create Menu

These options control all actions for calculating, evaluating and saving NC
toolpaths. Note the submenu called Extra which offers some extra options.
As these extra commands are very specific and not important for most users
these commands have been "hidden" in a submenu.

3.6.1 Calculate Toolpaths

With this option you can create the toolpaths for the current part.

In case all operations of the current part are visible (see Visible Operations),
all the toolpaths for the current part will be calculated and drawn. When at
least one operation of the current part is invisible, you will be asked if you
only want to use only the visible operations for calculations or if you want to
use all operations.

In case you choose No for in order to calculate all operations, they all will be
made visible after calculations.

It may be that you grow tired of this warning popping up all the time. Then
you can disable "Always show this message" by removing the mark from the
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checkbox: the warning then will no longer be displayed. You can reset it on
the Advanced tab of the Preferences.

 

While calculating, DeskProto will show a progress bar like shown above.
You can select either the small dialog left or the detailed view right using the
black arrow (triangle) button in the lower right corner.  DeskProto is a multi-
threaded application, so it can split up the calculations over multiple cores
(in case you have a multi-core PC).

Each operation is assigned it's own core (so when you project has just one
operation the calculation will not be multi-threaded). Of course no more
threads can be running at the same time than the number of cores that is
available. The detailed view of the progress bar will show maximum 8 threads
(even on a 16 core PC) as otherwise the dialog would become too large.

Shortcut:

Toolbar:

In case you want to calculate all toolpaths for ALL Parts, then you can use
the command Calculate All Toolpaths in submenu Extra.
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3.6.2 Write NC-program File

With this option you can create an NC-program-file for the current part,
which can be sent to the machine to mill a part.

DeskProto will ask you to give a Name for the NC-program file, in a standard
Save-As dialog, in which the correct file-extension for your machine has been
already entered. DeskProto will even suggest a name: the name of the project
(only when the project already has been given a name). The only things you
need to do are entering (or checking) the filename and making sure the file is
being saved in the right place.

The name for the NC file that you enter here may be automatically changed.
When you have more than one Operation and different cutters are used in
these Operations, a tool change will be needed. For machines that do not
support a tool change two or more NC files will be written (this behavior can
be set in the postprocessor). Names for these subsequent files will be
automatically generated. In case you chose the name Test.nc and the two
operations were called Roughing and Finishing, then the first file will be
called Test#1_Roughing.nc and the second file Test#2_Finishing.nc 
Note: Operation names may contain "reserved characters" that are not
permitted in file-names (for instance * / : < > ). DeskProto will replace
reserved characters and spaces by underscores ("_").

In case all operations of the current part are visible (see Visible Operations),
the NC file(s) will be written for all the toolpaths of the current part. When at
least one operation of the current part is not visible, you are asked if you only
want to use the visible operations for the NC file or if you want to use all
operations.

In case you choose No (so choose ‘all operations’), they will also all be made
visible afterwards. 
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A next message box will pop-up in case one of the Operations is part of a
Chain:

Normally the answer will be Yes, meaning that you want to write the
complete toolpath, including all Operations that belong to this chain of
Operations.

Other project warnings may be shows as well.

After that, the NC-program(s) will be created, using the post-processor that is
configured for the machine you have selected in the current part.

Shortcut:

Toolbar:

3.6.3 Send Toolpaths to Machine

For some CNC milling machines this option can be used to directly send the
toolpaths to the machine (or to the machine's control software). As this is not
possible on all machines, by default this option is not available (disabled:
'grayed out'). The option will become available after configuring an output
destination to be used, in the DeskProto Preferences.
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This feature is not available in MacOS and Linux, only in Windows, sorry
about that.

In the Preferences (Options menu) the following destinations can be
configured for this option:
· a Windows Printer driver (this is possible for a few machines only, like the

machines made by Roland)
· a port, like COM1: or LPT1:
· an external program
· none, which is the default.
DeskProto will write a temporary NC program file (TempNC.ext, conform
the machine that you selected and its postprocessor) and will open the
external program with this file TempNC.ext as command line parameter. For
the other options DeskProto will simply write all information to the selected
port or driver (instead of to an NC file).

As external program you can configure the control software of your CNC
milling machine. In fact you can select any program, so (for instance) a
milling simulation software is possible as well, or (for the diehards) a plain
text editor like Notepad++ to edit the NC-program that DeskProto has just
created.

After giving this command, the Machine Check dialog (shown above) will be
displayed to ask you if the machine is ready. After pressing 'Send' DeskProto
will start sending. 
In order to send an existing NC file you can use the command Send NC
Program File to machine.

If your machine does not support this: the standard route to get the NC
program file to the machine is to exit DeskProto and load the NC file in the
machine's control software (or transfer the NC file to the controller using the
machine’s communication software). If this software  runs on a different
computer you will first have to transfer the file to that PC, via a network or
by USB stick or CD.
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How to prepare the machine will be different for every machine. Still some
general guidelines can be given. Basically the following steps have to be
taken:
1. Fixture a block of material on the machine (look in the Geometry

Information dialog for the correct dimensions).
2. Mount the correct tool. Note: in case you use a different cutter than

entered in DeskProto an incorrect part will be produced.
3. Open the NC-program file to the control software.
4. Tell the machine where to find the material. In other words: set the

workpiece zero-point. By default DeskProto uses the left-front-top
corner of the material block as zero-point, you can change this at tab
'Zero-point' of the Part Parameters.

5. Start the machining process.

3.6.4 Estimate Machining Time

This command calls the Estimated Machining time dialog, in which
DeskProto gives a rough estimation for the machining time that it will take to
create your part. Be aware that this is a rough estimation: the actual time will
be influenced by many factors. The help information for the dialog that was
just mentioned explains why. 

3.6.5 Show Simulation

With this option you can create a Simulation for the current part.
The command will first show the block of material, so the situation before
any operation has been machined.
In the Simulated operations dialog that pops up you can select which
operations you want to be processed and press Calculate to start.

When the simulation is shown DeskProto will automatically make many other
items on screen invisible: Material block, Operation areas, toolpaths, Z-grids.
You can override that via the Items Visible dialog.

This is a toggled command: again giving the same command will make the
Simulation invisible.

3.6.6 Show Animation

With this option you can show an Animation of the toolpaths for the current
part.
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In the Toolpath Animation dialog that pops up you can control the animation
display.

When an animation is shown DeskProto will automatically make some other
items on screen invisible: geometry, toolpaths, Z-grids, simulation. You can
override that via the Items Visible dialog.

3.6.7 Extra

These Extra commands also are options for calculating and saving NC
toolpaths. As these Extra commands are very specific and not important for
most users these commands have been "hidden" in a submenu.

3.6.7.1 Calculate All Toolpaths

With this option you can create all Toolpaths for all Parts.

Where the other commands in the Create menu only concern the current
part, this one command influences all parts in the current project. 

All operations for all parts will be calculated, so also the invisible operations
(see Visible Operations).

3.6.7.2 Calculate Z-grids

With this option you can create the Z-grids (an intermediate calculation
result) for the current part.
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In case all operations of the current part are visible (see Visible Operations)
in the active view, all the Z-grids for the current part will be calculated.
When at least one operation of the current part is not visible you are asked if
you only want to use only the visible operations for calculations or if you
want to use all operations.

In case you choose No for ‘all operations’, they all will be made visible after
calculations.

3.6.7.3 Calculate All Z-Grids

With this option you can create all Z-Grids for all Parts.

Where the other commands in the Create menu only concern the current
part, this one command influences all parts in the current project. 

All operations for all parts will be calculated, so also the invisible operations
(see Visible Operations).

3.6.7.4 Send NC-program File to Machine

For some CNC milling machines this option can be used to directly send an
NC program to the machine (or to the machine's control software) from
DeskProto. As this is not possible on all machines, by default this option is
not available (disabled: 'grayed out'). The option will become available after
configuring an output destination to be used, in the DeskProto Preferences.

This feature is not available in MacOS and Linux, only in Windows, sorry
about that.

In the Preferences (Options menu) the following destinations can be
configured for this option:
· a Windows Printer driver (this is possible for a few machines only, like the

machines made by Roland)
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· a port like COM1: or LPT1:
· an external program
· none, which is the default.
DeskProto will open the NC program file, and will simply copy its contents to
the selected port or driver, or will open the external program with this file as
command line parameter.

As external program you can configure the control software of your CNC
milling machine. However in fact you can select any program, also for
instance a milling simulation software, or (for the diehards) a plain text 
editor like Notepad to edit the NC-program that DeskProto has just created.

In DeskProto the NC program file must have been saved first, in the correct
format for your machine. A standard File Open dialog will be displayed to ask
you for the file you want to transfer. After selecting the correct NC program
file the Machine Check dialog (shown above) will pop up: after pressing Send
DeskProto will start sending. 
In order to send the current toolpaths without first saving an NC file you can
use the command Send current toolpaths to machine.

If your machine does not support this: the standard route to get the NC
program file to the machine is to exit DeskProto and load the NC file in the
machine's control software (or transfer the NC file to the controller using the
machine’s communication software). If this software  runs on a different
computer you will first have to transfer the file to that PC, via a network or
by USB stick or CD.

How to prepare the machine will be different for every machine. Still some
general guidelines can be given. Basically the following steps have to be
taken:
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1. Fixture a block of material on the machine (look in the Geometry
Information dialog for the correct dimensions).

2. Mount the correct tool. Note: in case you use a different cutter than
entered in DeskProto an incorrect part will be produced.

3. Open the NC-program file to the control software.
4. Tell the machine where to find the material. In other words: set the

workpiece zero-point. By default DeskProto uses the left-front-top
corner of the material block as zero-point, you can change this at tab
'Zero-point' of the Part Parameters.

5. Start the machining process.

3.6.7.5 Export Z-grid / Simulation as

The Z-grid is a temporary representation of the geometry, used by DeskProto
to calculate the toolpaths.
The Simulation has of course a completely different aim, still the internal
representation in DeskProto is the same as for the rendered Z-grid. Both
items are represented by a large number of triangle on the outer surface:
polygon data.

As for geometry files in DeskProto the same polygon data representation is
used, it is possible to export the Z-grid and/or the Simulation as a geometry
file. For standard DeskProto use this is absolutely not needed, however it
might be useful, for instance to use external software to compare original
geometry and simulation.

In the dialog box shown above you can choose how to export the Simulation.
For exporting the Z-grid exactly the same dialog is used. The following
options can be set:

The File type is either Geometry file, Bitmap file or XYZ file.
The use of a geometry file has been described above.
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For export as Bitmap file DeskProto will convert the 3D information to 2D
by converting Z-height to gray-value. For each point in the Z-grid one pixel
will be made. The highest Z-value will be given a white pixel, the lowest level
a black pixel, and all in-between values an according in-between gray value.
This is in fact the reverse procedure as used for the Bitmap Operation.
An XYZ file is a point cloud file: a number of points in 3D space, each point
represented by its 3 coordinates.

The Subtype sets the file format that has to be used.
For Bitmap files you can choose one of four well known bitmap file types:
BMP, JPG, PNG and TIFF.
For Geometry files you can choose any of the formats that DeskProto
supports for 3D, as described in 3D Geometry.
For XYZ files only one format is supported: ASCII text file, the three
coordinates of one point per line.

The function of  File name will be clear, you need to use the Browse to fill
this field or edit its contents (both file name and location).

For rotation axis parts not all options are available.
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3.7 Options Menu

The Options menu gives access to all configuration options of DeskProto. For
normal use you will not need these options, they are present in case the
defaults should not match your wishes. The option used most will be the
Cutter library to create new cutter definitions, as in many cases the default
cutters will not match your real cutters.

3.7.1 Library of Machines
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For every setting made and for every NC program created DeskProto it will
apply a machine-definition. Which should of course match the NC milling
machine that you are going to use. A large number of predefined machine-
definitions have been included in every DeskProto. This is the Library of
machines, which has been copied to your computer during Setup. 

When you first start DeskProto you need to select one of these predefined
machines as your default machine. This is done in DeskProto's Initial
settings dialog (only visible the first time that your start DeskProto). After
that you still can change this setting in the default Project parameters. 
In case you have a machine that is not yet present in the list: in this Machine
library you can edit an existing machine definition or add a new definition for
your own machine. 

You can find the Library of machines in the Options menu. When you open
this library a warning message will be displayed that this option is meant for
advanced users only. The warning is optional: when you remove the mark
from checkbox "Always show this message" it will no longer be given. You
can restore all warning messages on the Advanced tab of the Preferences (in
group Settings).

After this warning the dialog shown above will pop up. Here you can choose
the machine you want to Edit or Copy, and also Add and Remove machines.
After pressing Add, Copy or Edit the Machine dialog will be shown,
containing all parameters to define a machine in DeskProto.

Before you start defining a new machine, be sure a postprocessor for the
machine is already available. If not, configure one first in the Library of
Postprocessors (see the next paragraph). 

A machine definition is stored as a file name .mch in the DeskProto drivers
folder (See Preferences). These files can be copied, for instance to a different
PC to make the machine available on that PC as well. You can easily find
each driver file via button "Open location", which will open the Drivers
folder in MS Explorer, MacOS Finder or Linux File Manager.

The files are in Windows .ini format, which means that they can also be
changed using a plain editor like Notepad (changing in DeskProto is safer
though). A line that starts with a semicolon (;) is a comment.

Note:
Selecting a machine here does NOT change which machine is selected for the
current project. To select a machine for your current project open the Project
Parameters dialog.
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3.7.2 Library of Postprocessors

Every NC program created by DeskProto is made using a postprocessor. This
is the part of the DeskProto software that is machine-dependent: it creates an
NC program file that is in the format required by your NC milling machine. In
computer terminology this piece of software should be called the device
driver for a particular output device, however, in CNC terminology it is
called a Postprocessor and we will use that name. DeskProto makes it easy to
define your own postprocessor (for most CAM software this is a complicated
process), CNC machinists call this a 'Configurable Postprocessor'.

Note that you can not explicitly select the postprocessor that you want to use,
as one of the milling parameters. It will be implicitly selected when you select
the milling machine. Each milling machine’s definition includes a setting for
the postprocessor to be used for that machine. So a number of machines can
share the same postprocessor.

You can find the Library of postprocessors in the Options menu. When you
open this library a warning message will be displayed that this option is meant
for advanced users only. The warning is optional: when you remove the mark
from checkbox "Always show this message" it will no longer be given. You
can restore all warning messages on the Advanced tab of the Preferences (in
group Settings).
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After this warning the dialog shown above will pop up. In this Library you
can choose the postprocessor you want to Edit or Copy, and also Add and
Remove a postprocessor. After pressing Add, Copy or Edit the Postprocessor
dialog will be shown, containing all parameters to define a postprocessor in
DeskProto.
Note: as many parameters must be entered for a postprocessor definition,
we recommend not to use Add to create a new postprocessor, but to Copy
one that resembles the new one, and then Edit any changes needed. In most
cases the postprocessor “ISO plain G-codes” is a good one to use as a start.
 Make sure to save it using a informative new name after pressing Copy.

A postprocessor definition is stored as a file name .ppr in the DeskProto
drivers folder (see Preferences). These files can be copied, for instance to a
different PC to make the machine available on that PC as well. You can
easily find each driver file via button "Open location", which will open the
Drivers folder in MS Explorer, MacOS Finder or Linux File Manager.

The files are in Windows .ini format, which means that they can also be
changed using a plain editor like Notepad (changing in DeskProto is safer
though). A line that starts with a semicolon (;) is a comment.

Note 1:
Selecting a postprocessor here does NOT change which postprocessor is used
to make an NC-program of the current part. A postprocessor automatically
will be selected by selecting a machine. To use a particular machine in your
project open the Project Parameters dialog. 

Note 2:
Postprocessor files are in a proprietary format that is defined by the software
manufacturer: each manufacturer uses a different format. So these files
cannot be exchanged between different CAM programs: MasterCAM for
instance cannot use a postprocessor made by VCarve Pro.
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3.7.3 Library of Cutters

For every NC program to be created (more accurately for every operation)
you need to select a cutter. Obviously the cutter that you select for
DeskProto’s calculations must be available for your actual milling process. A
number of predefined cutter-definitions have been included with DeskProto.
This is the Library of cutters, which has been copied to your computer during
installation. In many cases you can simply select one of the existing cutters
when editing the operation-parameters. However in case you need a special
cutter: in this 'Cutter Library' you can change an existing cutter or define
your own.

You can find the Library of cutters in the Options menu. When you open this
library a warning message will be displayed that this option is meant for
advanced users only. The warning is optional: when you remove the mark
from checkbox "Always show this message" it will no longer be given. You
can restore all warning messages on the Advanced tab of the Preferences (in
group Settings).

After this warning the dialog shown above will pop up. Here you can choose
the cutting tool you want to Edit or Copy, and also Add and Remove cutters.
After pressing Add, Copy or Edit the Cutter dialog will be shown, containing
all parameters to define a cutter in DeskProto.



DeskProto Reference

Page 92

A cutter definition is stored as a file name .ctr in the DeskProto drivers folder
(see Preferences). These files can be copied, for instance to a different PC to
make the machine available on that PC as well. You can easily find each
driver file via button "Open location", which will open the Drivers folder in
MS Explorer, MacOS Finder or Linux File Manager.

The files are in Windows .ini format, which means that they can also be
changed using a plain editor like Notepad (changing in DeskProto is safer
though). A line that starts with a semicolon (;) is a comment.

Note:
Selecting a cutter here does NOT change which cutter is selected for the
operations. To select which cutter to use: open the Operation Parameters
dialog.

3.7.4 Default Project

After choosing this option, first you will be warned that whatever you change
here will influence all new projects that you create later (so not your current
project)  The warning is optional: when you remove the mark from checkbox
"Always show this message" it will no longer be given. You can restore all
warning messages on the Advanced tab of the Preferences (in group
Settings).

The dialog that pops up is equal to the Project Parameters dialog, it will thus
not be explained here. The difference is that this function adjusts the default
project settings, that will be used for every new Project that is created.

The default project is either a Vector project, a Geometry project or a Bitmap
project. You cannot define this project type in this dialog: the default project
type is defined by setting an Operation of the preferred type as first operation
in the Default Part.

Most important setting in this dialog is the default Machine. You can select
any machine in the list to be used as default; if needed you can add and/or
edit machines in the Library of Machines.

The functionality offered in this dialog is very limited: it is not possible to
define a default geometry, nor more than one part. Only the options Use Z-
values and Preserve Direction (tab Vector), Skip backfaces and Flip normals
(tab Geometry) can be changed. The DeskProto default for these four
checkboxes is off.

Creating two or more Parts as default is not possible as that would make
things way too complicated (for instance which of the operations then would
be the actual default one...).



Menu commands

Page 93

DeskProto Reference

A default project file is not possible as that would conflict with the default
Part and the default Operations.
Note that for repeating jobs can also achieve much using Command line
parameters, by Scripting, and by auto-loading a template project file which
may have more Parts. For instance for automation of two sided machining.

Note:
The default project parameters are stored in the registry (Windows), in the
Preferences section (MacOS), in the .config section (Linux). Each user has
his/her own default settings stored.
As it is possible to completely mess up these settings, making it very hard to
use DeskProto, an extra button Restore defaults is present, that will restore
the DeskProto defaults for all parameters.

3.7.5 Default Part

After choosing this option, first you will be warned that whatever you change
here will influence all new parts that you create later (so not your current
project). The warning is optional: when you remove the mark from checkbox
"Always show this message" it will no longer be given. You can restore all
warning messages on the Advanced tab of the Preferences (in group
Settings).

The dialog that then pops up is equal to the Part Parameters dialog, it will
thus not be explained here. The difference is that this function adjusts the
default part settings, that will be used for every new Part. You can use this
for instance when you want to use more than one operation for all your parts,
always apply a specific transformation or translation method, etc, etc.

An important setting for the default part is the first operation, as that defines
the project type. When the first operation is a vector operation the default
project is a Vector project, for a geometry operation it is a Geometry project
and for a bitmap operation it is a Bitmap project.

For the default part all three groups of settings can be accessed:
· Vector settings
· Geometry settings
· Bitmap settings
even though no CAD data of that type is present here.

Note:
The default project parameters are stored in the registry (Windows), in the
Preferences section (MacOS), in the .config section (Linux). Each user has
his/her own default settings stored.
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As it is possible to completely mess up these settings, making it very hard to
use DeskProto, an extra button Restore defaults is present, that will restore
the DeskProto defaults for all parameters.

3.7.6 Default Vector Operation

After choosing this option, first you will be warned that whatever you change
here will influence all new Vector operations that you create later (so not
your current project). The warning is optional: when you remove the mark
from checkbox "Always show this message" it will no longer be given. You
can restore all warning messages on the Advanced tab of the Preferences (in
group Settings).

The dialog that then pops up is almost equal to the Vector Operation
Parameters dialog, it will thus not be explained here. The difference is that
this function adjusts the default Vector operation settings, that will be used
for every new Vector Operation. This is the option to use for instance in case
you want a specific cutter automatically selected, need a specific feedrate or
spindle speed, etc, etc. These default parameters will be stored in the registry
(Windows) / file DeskProto.plist (MacOS) / file DeskProto.conf (Linux), and
will be different for every user. 

In case more than one default Vector Operation have been defined in the
default part, first a dialog is displayed in which you can select one of the
default operations:

In this case the dialog will of course show Vector operations that you can
choose from.
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Two extra buttons are present, that are not available in the normal Vector
Operation parameters:

The default project parameters are stored in the registry (Windows), in the
Preferences section (MacOS), in the .config section (Linux). Each user has
his/her own default settings stored.
As it is possible to completely mess up these settings, making it very hard to
use DeskProto, an extra button Restore defaults is present, that will restore
the DeskProto defaults for all parameters.

The DeskProto defaults are the built in values that were also present when
you first installed DeskProto.
The default cutter might be different though: for a Vector operation
DeskProto will select the first flat end cutter in the Cutter library with a
diameter of 6 mm (metric users) or 1/4" (inch users). It such cutter is not
present the first cutter in the library will be used.

And on tab page Profiling an extra Set... button is present, in section Support
tabs, to define the Default profiling support tab settings.

3.7.7 Default Geometry Operation

After choosing this option, first you will be warned that whatever you change
here will influence all new operations that you create later (so not your
current project). The warning is optional: when you remove the mark from
checkbox "Always show this message" it will no longer be given. You can
restore all warning messages on the Advanced tab of the Preferences (in
group Settings).

The dialog that then pops up is equal to the Geometry operation Parameters
dialog, it will thus not be explained here. The difference is that this function
adjusts the default geometry operation settings, that will be used for every
new Geometry Operation. This is the option to use for instance in case you
want a specific cutter automatically selected, need a specific feedrate or
spindle speed, etc, etc. These default parameters will be stored in the registry
(Windows) / file DeskProto.plist (MacOS) / file DeskProto.conf (Linux), and
will be different for every user.

In case more than one default operation has been defined in the default part,
first a dialog is displayed in which you can select one of the default
operations:
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In this case the dialog will of course show Geometry operations that you can
choose from.

Note:
The default project parameters are stored in the registry (Windows), in the
Preferences section (MacOS), in the .config section (Linux). Each user has
his/her own default settings stored.
As it is possible to completely mess up these settings, making it very hard to
use DeskProto, an extra button Restore defaults is present, that will restore
the DeskProto defaults for all parameters.

The DeskProto defaults are the built in values that were also present when
you first installed DeskProto.
The default cutter might be different though: for a Geometry operation
DeskProto will select the first ballnose cutter in the Cutter library with a
diameter of 6 mm (metric users) or 1/4" (inch users). It such cutter is not
present the first cutter in the library will be used.

3.7.8 Default Bitmap Operation

After choosing this option, first you will be warned that whatever you change
here will influence all new Bitmap operations that you create later (so not
your current project). The warning is optional: when you remove the mark
from checkbox "Always show this message" it will no longer be given. You
can restore all warning messages on the Advanced tab of the Preferences (in
group Settings).

The dialog that then pops up is equal to the Bitmap Operation Parameters
dialog, it will thus not be explained here. The difference is that this function
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adjusts the default bitmap operation parameters, that will be used for every
new Bitmap Operation. This is the option to use for instance in case you want
a specific cutter automatically selected, need a specific feedrate or spindle
speed, etc, etc. These default parameters will be stored in the registry
(Windows) / file DeskProto.plist (MacOS) / file DeskProto.conf (Linux), and
will be different for every user. 

In case more than one default Bitmap Operation has been defined in the
default part, first a dialog is displayed in which you can select one of the
default operations:

In this case the dialog will of course show Bitmap operations that you can
choose from.

Note:
The default project parameters are stored in the registry (Windows), in the
Preferences section (MacOS), in the .config section (Linux). Each user has
his/her own default settings stored.
As it is possible to completely mess up these settings, making it very hard to
use DeskProto, an extra button Restore defaults is present, that will restore
the DeskProto defaults for all parameters.

The DeskProto defaults are the built in values that were also present when
you first installed DeskProto.
The default cutter might be different though: for a Bitmap operation
DeskProto will select the first ballnose cutter in the Cutter library with a
diameter of 6 mm (metric users) or 1/4" (inch users). It such cutter is not
present the first cutter in the library will be used.
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3.7.9 Default Viewpoint

The default viewpoint settings are used for every new project and for every
new part. 
They are also used for the menu command and the toolbar button called Use
Default View.

After choosing this option, first you will be warned that this option will only
influence the defaults (so not your current view). The warning is optional:
when you remove the mark from checkbox "Always show this message" it
will no longer be given. You can restore all warning messages on the
Advanced tab of the Preferences (in group Settings).

To edit the parameters of the default viewpoint a special dialog is used, as the
dialogs to change the Viewpoint contains parameters that are not suitable as
default parameters: here only the rotation can be set. Zooming of the default
view will always be 100% and panning will be set to zero. 
After changing the default rotation you can restore the original DeskProto
defaults (which are stored internally in DeskProto and which can not be
changed) by pressing button Restore defaults. 
Finally: instead of typing three values for X, Y and Z rotation, you can
manually adjust the rotation in your current view until you like it, and then
copy the settings, by pressing the button Copy from Active View.

Note:
The default viewpoint settings are stored in the registry (Windows), in the
Preferences section (MacOS), in the .config section (Linux). Each user has
his/her own default settings stored.
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3.7.10 Default Items visible

The default items visible settings are used for every new project and for
every new part. 

After choosing this option, first you will be warned that this option will only
influence the defaults, so not your current View window. The warning is
optional: when you remove the mark from checkbox "Always show this
message" it will no longer be given. You can restore all warning messages on
the Advanced tab of the Preferences (in group Settings).

To edit the parameters of the default items visible a special dialog is used, as
the dialogs to change the Items visible contains parameters that are not
suitable as default parameters.
Here it is possible to set what will be shown initially. You can find an
explanation for any of these Items see Items visible dialog. Displaying Z-
grids, toolpaths or simulations is not possible in the default view, as these
items have to be calculated first.

Note:
The default items visible settings are stored in the registry (Windows), in the
Preferences section (MacOS), in the .config section (Linux). Each user has
his/her own default settings stored.
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3.7.11 Preferences

This is open the Preferences dialog, in which you can edit DeskProto's
preferences. The dialog consists of six tab pages.

In Windows and in Linux this command can be found in the Options menu, in
MacOS in the DeskProto menu.

In Windows these preferences are stored in the Registry
in MacOS in file ~/Library/Preferences/com.delft-spline-
systems.DeskProto.plist 
in Linux in file ~/.config/Delft Spline Systems/DeskProto.conf 

Note that in MacOS a file called ~/Library/Preferences/com.delft-spline-
systems.DeskProto80.plist is present as well. That is a different file,
automatically created by MacOS to remember the settings for the Open file
dialog and the Save file dialog.
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3.8 Help Menu

Finally the Help menu which gives access to the Help system and to the
About box. 
For the DeskProto Editions Entry and Expert  an extra option is present:
Upgrading...  (to a higher edition).

3.8.1 DeskProto Help

This command will open the DeskProto Help system, shown in a separate
dialog.

The Contents page of the DeskProto Help System, shown at the Contents tab
on the left of the Help Window, offers an overview of all available Help
topics, organized in 'books'. Each book can be opened by double-clicking its
line or by clicking on the arrow icon in front of the line. Five books are
available  (it may be needed to first open the line "DeskProto Reference" to
see these five lines):
· Introducing DeskProto
· Screen Layout
· Menu commands
· Dialogs
· Concepts

The same five books can be found as Chapters in the DeskProto Reference
Manual (available as PDF for download on the DeskProto website), which
contains almost exactly the same information as the Help file.

In addition to the Contents tab page three more tabs are available in the Help
dialog: 
the Index page can be used to find help on a specific subject
the Bookmarks tab to mark pages that you want to remember
the Search page to locate any word or phrase in the Help system.
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While reading the Help text, additional related information can easily be
accessed by clicking on the active items (Hyperlinks) in the text. Active
words are shown in blue and underlined, while the cursor will turn to a hand
when moved over an active item.

The online Help system that has been installed with DeskProto can be started
from the Help menu. 
Other methods to access Help are:

· The Help button on the Toolbar: 
· Pressing the F1 Function key on the keyboard (for MacOS this is Fn+F1).
· Every dialog has a Help button, providing Help information about the

use of that particular dialog.

3.8.2 Quick Start

This help page is shown when you select command "Quick start" in the
DeskProto Help menu.

Normally we advise to read about how to start using DeskProto in the
Tutorial book (either printed or as PDF download). This manual step by step
introduces you to the functions that DeskProto offers. It is recommended to
read and execute at least lessons number one and two of this Tutorial before
starting to make parts with your own CAD-data. As an alternative you can
find many instruction videos, both on the DeskProto website and on
YouTube.

However, if you are not a great manual reader and want to start at once
exploring DeskProto, at least read this Quick Start first. It is meant to
explain the basic ideas of DeskProto: you will need this information to be
able to understand what is happening. After that, novice users are advised to
first use the Wizards: these will guide them through all steps needed to
generate an NC program file. 
In all cases do not forget to use the Help file, which will explain every
DeskProto screen in detail.
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The DeskProto screen contains standard items like the title bar (top line),
menu bar, toolbar (the row of buttons below the menu) and status bar
(bottom line). The center area is divided into three tiles: the large View
window on the right, and the windows Project Tree and NC files on the left.
Follow these links for more information on any item.

The above screenshot shows the Windows version of DeskProto. The
MacOS version has an extra menu choice: the DeskProto menu, on the left
side of the File menu. In MacOS the menu is visible on the top of the screen,
so not in the DeskProto window. This is conform the MacOS standard and
won’t confuse any Apple user.

The DeskProto menu in Linux is identical to the menu in Windows, and in
most cases part of the DeskProto window. Though some Linux versions allow
the menu to be shown at the top of the screen (instead of at the top of the
dialog).

It is important to know that DeskProto offers two different user-interfaces:
the wizard-based interface and the dialog-based interface.
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[1] Wizard-based interface.
New users are advised to use the DeskProto Wizards, as these will guide
them through all the steps needed to generate an NC toolpath file using their
own CAD-data. The illustration above shows two typical wizard pages. A
wizard will set the same parameters as are available in the dialog-based user-
interface, only now they are presented in a sequential series of screens, and
only the most important parameters are shown. You can find the wizards via
the Start Screen or via the File menu.

[2] Dialog-based interface.
When using the Dialog-based interface you need to know where to find the
parameters. 
In this interface you can define parameters on three levels:
1. Project parameters include the name of the CAD-data file(s), the
machine and the number of Parts that you want to use in this project.
2. Part parameters define the part: What will be machined. These set size,
orientation, position and alike.
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Within each Part you can use one or more milling Operations.
3. Operation parameters define an operation: How the part will be
machined.
These are in fact the only real 'milling parameters'.  Three different types of
operation are available: Vector Operation, Geometry Operation and Bitmap
Operation, as for these three types of data different settings are needed.

The Project is the central concept of DeskProto. All information about a
project is stored in a Project-file (name.dpj), which is the file to be opened
when starting and to be saved when finishing. The project file contains all
milling parameters and viewing parameters, and also contains references to
the CAD-files (so the CAD-data is not included). 

You can imagine the tree-like structure of a project, which is displayed in the
Project Tree at the left side of the DeskProto screen: see the illustration
above. This sample Project “Bottle” consists of one Part called “Half bottle”
and three Operations called “Roughing”, “Finishing” and “Contour”. Each
operation line includes a lamp icon that you can switch on and off (by
clicking on the lamp) to make the operation (in)visible. The project will be
named when saving it for the first time, until then the tree displays the name
“untitled”.

Note 1: four different Editions of DeskProto are available: Free, Entry,
Expert and Multi-axis. The Free edition only offers basic CAM
functionality, Entry and Expert contain subsets of the available parameters,
Multi-Axis includes all functionality. For the rest all editions are equal.

Note 2: to open a CAD-file in DeskProto you have to use "Load Vector
file..." "Load Geometry file..." or "Load Bitmap file..." in the File menu (if
needed start a New project first). You cannot use File>Open, as you do not
yet have a DeskProto project file for this new project. The CAD-data that
you load will be available for all Parts and for all Operations.



Menu commands

Page 107

DeskProto Reference

The functions of DeskProto can be reached using the pull-down menus or
using the buttons on the toolbar. The three most important menus are:

* The View Menu offers the opportunity to change what data should be
displayed on your screen and how that should be done. Also try changing
your view by rotating the six colored thumbwheels on the screen, and by
using your mouse inside the view window. In fact most of the functions in the
View menu can be activated most easily by using the buttons in the toolbar.

* In the Parameters Menu you can edit all vector/geometry/bitmap
parameters and all milling parameters. For simple parts it is sufficient to edit
only the front Tab page for both Part and Operation parameters, the other
Tabs can come later (all parameters have suitable default values).

* The Create Menu is the most important; this is where you can start the
milling calculations and write the NC program file. 
The most important buttons for the DeskProto process are:

 

The first step is to Load CAD data:
Vector or Geometry or Bitmap (or a combination).

After setting some parameters you can then
Calculate the toolpaths and view them on the
screen.

Optionally you can show a Simulation of the
resulting part, to check your toolpaths for
correctness.

Optionally you can show an Animation that shows
how the cutter moves along the toolpath.

Finally you Write the NC file
and send it to your  CNC milling machine.

We hope that you will enjoy using this software !
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3.8.3 Create Problem Report

When asking for support, DeskProto users often send us the DeskProto
project file (DPJ file), planning to make us see what they are doing.
Unfortunately this is not sufficient: the DPJ file only contains the parameters
that you have set. And in order to reproduce the problem the CAD file(s) are
needed as well. Plus the driver files for cutters, machines and/or
postprocessors. The Create Problem Report option automatically bundles all
these files in one ZIP file, that you then can send to us.
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Creating a problem report is done in four steps (do this when your problem
project is open):

Step 1 asks you to enter your Contact details: information about how we can
reach you (we ask only the bare minimum).

In Step 2 you are asked to describe the problem, in plain text. The more
clearly you describe the problem, the more chance that we can indeed
reproduce it. And that is absolutely needed in order to start looking for a fix.
Note that you cannot actually use DeskProto while this Problem Report
dialog is opened, so you cannot walk through all steps and type them during
the process. If that is what you want you need to open Notepad, and after
finishing copy the text from Notepad to this dialog.

In Step 3 DeskProto will collect all information needed to reproduce the
problem: all files as just mentioned, and in addition some basic information
about the Windows version and the graphics card that you are using.
Step 3 can only be started after you have entered the information asked for in
steps 1 and 2.
As one of the files to be collected is the DPJ file, DeskProto will ask you to
first save this file (in case needed).

Step 4 it to finally save the report file: a ZIP file that you can email to us.
Default name for this file is DpReport_Name.ZIP  in which Name is the
Name that you just entered.
Default location is your current directory, so the folder where you just loaded
or saved your geometry and/or project.
You are however free to change file name and file location when saving.

This same ZIP file can of course be used for other purposes as well, like
sending a complete project to some other DeskProto user, or for archiving
purposes.
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3.8.4 Activate license

In Windows and in Linux this command can be found in the Help menu, in
MacOS in the DeskProto menu.

The Free Edition of DeskProto can and may be used without buying a
license. Users who need more functionality can buy a license to activate
(unlock) one of the higher Editions: Entry, Expert or Multi-Axis. 

In case you are not sure which edition you need: one of the options in the
Free edition is to evaluate (trial) these higher Editions - when trialling a
watermark (the "Trial cross") will be visible in all machined parts. On the
DeskProto website you can also find a comparison table for these four
editions.

In all cases you need to first download the DeskProto installation file from
our website www.deskproto.com and instal DeskProto on your computer.
This installation file (a Setup file for Windows, a DMG file for MacOS or an
AppImage file for Linux) is the same for all Editions of DeskProto.

A free DeskProto license is given to any user: you are welcome to use the
Free Edition of DeskProto free of charge, as log as you like.

http://www.deskproto.com
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A paid DeskProto license can be bought either via a reseller or via our
webshop. After buying you will receive the license (a PDF file) containing
two strings: a Name and a Key.
The Name contains the name of the buyer (either a person or a company)
and his/her/its location (city, village): information that will be clearly shown
at each program start.
The Key is a code of 340 characters, containing information all license
information. Each Key is valid only for the Name on that same license.

The Activate dialog is meant to activate your DeskProto license and unlock
the extra functionality for the Edition that you have bought. Both the
complete Name-string and the 340 character Key have to be entered exactly
as given, including case (upper or lower), spaces, commas, points, etc. Even
the smallest difference will make DeskProto refuse to activate. So use
Copy/Paste to enter this information in this dialog.
After filling both fields you can use the Activate button to make DeskProto
activate the license.

Make sure to carefully save and backup your license: you will again need
Name and Key when (for instance) you buy a new computer.

A registered version of DeskProto will clearly display the Name of it's owner:
in case that is not you then you are running an illegal copy!

After Activating it is also possible to Deactivate, allowing you to again
convert the program from paid license to free license. Needed for instance
when you sell your computer.
You can Activate and Deactivate as many times as you like: information
about the previous licenses will simply be deleted. 
Activating a new license is also possible without Deactivation first.

Both for Activating and for Deactivating administrative privileges are
required (Windows).

In Windows the license activation affects all users of that PC, in MacOS and
in Linux the activation information can be accessed only by the current user:
every next user will also need to again activate the license on that same
computer.

3.8.5 Upgrade information

In Windows and Linux this command can be found in the Help menu, in
MacOS in the DeskProto menu.
The command is present only when you use either the Free edition, the Entry
edition or the Expert edition.
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Displays a dialog screen that lists the advantages of the higher DeskProto
Editions 

DeskProto is available in four different Editions:
1. Free
2. Entry
3. Expert
4. Multi-Axis

The difference between the editions is the number of parameters that you can
set (both Part parameters and Operation parameters), and (for the Free
edition) the number of Parts and Operations.
The difference between the Expert Edition and the Multi-Axis edition is that
more axes are available in the latter: the A-axis and B-axes rotation axes.
On the DeskProto website you can find a complete comparison table.

Of course for registered users of DeskProto upgrades are available at a
special upgrade price.
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3.8.6 Check for Update

This command will make your DeskProto contact the website
www.deskproto.com (an internet connection is required) to see if a newer
Service Release (bugfix build) and/or a newer version is available for
download. In Windows and Linux this dialog can be found in the Help menu,
in MacOS in the DeskProto menu.

Once every few months a newer build of the program is released, containing
a number of bugfixes.
You can find the Revision number of your DeskProto in the About box.
And you can find information about the Revisions that have been released on
www.deskproto.com/support/buildhistory.php

The command Check for Updates will automatically compare the Revision
number of your DeskProto with the Revision number of the latest release, it
will tell you when a newer release is available for download, and it will ask if
you want to download it. When you answer Yes DeskProto will open the
page on the DeskProto website where you can download the Updater Setup.

Running the Updater Setup will recognize your DeskProto license and keep
that active. Only the program will be updated: drivers, scripts, language files
etc will remain as they were.
For MacOS and for Linux no special Updater Setup is possible: for these
operating systems you will need to download a new installation file.

In addition to these Bugfix updates DeskProto also checks for 'minor
upgrades' and for 'major upgrades', and will show information if these are
present.

https://www.deskproto.com
https://www.deskproto.com/support/buildhistory.php
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For DeskProto 8.0 a Minor upgrade would be the upgrade to V8.1.  When
that has been released it will also be a free upgrade for users of V8.0 as it will
recognize the same license.
For DeskProto 8.0 a Major upgrade would be the upgrade to V9.  When
that has been released it will by a paid upgrade for users of V8.0, available at
a special upgrade price.

When you are using the latest release DeskProto will tell you so.
And when no internet connection is available DeskProto will tell you that it
"Could not perform the Update check".

DeskProto by default will automatically perform this update check each
time you exit DeskProto. For this automatic check these last two messages
(about using the latest release and about being unable to check) are
suppressed.
You can switch off this automatic check in the Preferences.

3.8.7 About DeskProto

In Windows and Linux the About command can be found in the Help menu,
in MacOS in the DeskProto menu.
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The DeskProto About Box will display information about the DeskProto
version that you are running:

Version number, like 8.0

Edition - so either Free, Entry, Expert or Multi-Axis, and if the program is 32
bits or 64 bits.

Build date - the format of the build date is “yyyy-mm-dd”, and it shows that
date on which your file DeskProto.exe has been built.
Revision number - each build of the file DeskProto.exe receives a new
revision number.

Serial number - Each new (paid) license gets a new number, so the Serial Nr
of your license is unique (empty for the Free edition).

Licensed to - the Name on which this license has been registered (empty for
the Free edition)

Copyright notice - all rights reserved. You do not own the software: you own
a license to use the software
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Contact information - DeskProto is made by Delft Spline Systems in the
Netherlands

Short program description.

At the bottom of this dialog, next to the OK button you can find the button
Copyrights.
Pressing that button will show the license texts for DeskProto and for all
external libraries (Software Development Kits) that are used in DeskProto.
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IV Dialogs

4.1 Wizards

The Wizard-based user interface is an important feature of DeskProto. It
makes it possible for users without much CAM know-how to easily create the
toolpaths that they need for their projects. Each wizard is a series of dialog
screens (pages) that need to be filled in: the wizard so to speak 'takes your
hand' and guides you through the process of creating toolpaths.



DeskProto Reference

Page 118

When you create a project using a wizard and you save the project without
making any changes after finishing the wizard, on re-opening DeskProto will
show the project using the same wizard. So it is possible to use DeskProto
seeing only the wizard interface.

Navigating the Wizard is done using the Wizard buttons, on the bottom of the
screen:

  Back and    Next let you navigate the wizard
pages,

  Cancel and    Help are standard buttons.
Every wizard page has its own Help information page.

  Finish will replace Next on the final page of the Wizard,

  Apply will apply the currently selected settings and refresh
your screen.

  Calculate will calculate the toolpaths with the currently
selected settings.

Navigation icons: The DeskProto wizards start with the page shown above,
called "Which Wizard?". On the top of the page you can see one icon, after
selecting one of the wizards a series of icons will be shown: one for each
wizard page. At this point these extra icons are all gray, when progressing
they will be colored: then they can be used as tab-pages to navigate (click on
a colored icon to jump to that page of the wizard).

Help information: Important are the  yellow question marks in front of
each question. When you position the cursor over such mark a Tooltip will
pop up, giving extra information about that question. It will also tell you
where to find that setting in the Dialog based interface.

The first question, "Machine to be used", in most cases needs not be changed
as your default machine will already have been selected here.

The second question, "Type of milling", presents the six wizards that you can
choose from: you need to select one before continuing.  
Not all wizards will be available for all users (some may have been grayed
out): some wizards are not available in all DeskProto Editions, and some
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wizards are only available in case you selected a machine with a rotation
axis. 
Also: in the Free edition and the Entry edition the available wizards do not
include all described options.

Basic Vector Machining
This wizard creates 2D toolpaths for just one Vector file (DXF, EPS, AI,
SVG). It is meant for novice DeskProto users, and explains this procedure
step-by-step. You can choose to use either Profiling, Pocketing or V-Carving
toolpaths.

Basic Geometry Machining
This wizard creates 3D toolpaths for just one Geometry file (STL, 3MF,
DXF). It is meant for novice DeskProto users, and explains step-by-step the
procedure to create an NC toolpath file (NC program) based on your
geometry. The model will be machined from one side, using three operations:
Roughing, Finishing and a smoothing contour.

Basic Bitmap Machining
This wizard creates 3D toolpaths for a relief based on a Bitmap file (BMP,
GIF, JPG, PNG, TIFF file). It is meant for novice DeskProto users, and
explains this procedure step-by-step. 

Advanced Geometry  (the three advanced wizards are all for geometry
machining):

Two sides, manual flip, also called Two-sided Wizard  (not available in the
Free Edition and the Entry edition)
This advanced wizard is a unique feature of DeskProto, and makes it very
easy for you to create a compete 3D part by machining it from two sides, on
any three axis milling machine. DeskProto assists you by taking care of the
repositioning needed to machine the second half: no need to change the
workpiece zero point.

Two or more sides, automatic rotation, also called the N-Sided Wizard
 (available only in the Multi-Axis edition)
N-sided milling is meant for machines with a rotation axis (A-axis), and
allows indexed machining: this wizard generates XYZ toolpaths to machine
the part from several (N) sides, with a rotation in-between. The number of
sides can be freely chosen: for two sides the result is the same as for the
previous wizard, though now with automatic rotation.

Rotary Machining   (available only in the Multi-Axis edition)
If your machine is equipped with a rotation-axis (A-axis) you can use this
wizard to create toolpaths for a model that is machined all around: rotation
axis machining. In contrast to the previous wizard, now the material rotates
during machining (continuous rotation). 
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A rotation axis is an extra piece of equipment that lets your material rotate on
the machine (just like a roast rotating on a spit above a barbecue).

Note that all functionality offered by the wizards is also available in the
dialog-based user interface: the wizards are only meant to make things easier
for you, they do not add new options. After finishing any wizard you can still
use the dialogs to fine-tune the settings that the wizard made.

You can find the Wizard in the File menu  (File >> Start wizard)  or in the
Start Screen.

Shortcut:

Keys: Ctrl+W  (Windows, Linux)  +W  (MacOS).

4.1.1 Custom Wizard Page

Custom wizards can be added by any user, as explained on the Custom
Wizards page.
Because of that in the Help file no Help pages are available for these wizards:
for all custom wizard pages the Help button will show this same help page.
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For all pages the four buttons at the bottom of the page will be the same:
Cancel, Help, Back and Next. The meaning of each button will be clear.

The rest of the dialog has been filled by whoever made this custom wizard.
So in case of any question read the wizard's documentation, or contact the
supplier of the wizards.

Custom wizards are not supported in MacOS and in Linux.
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4.2 Parameters

4.2.1 Project

4.2.1.1 Project Parameters

The Project parameters dialog offers all settings that are available on project
level. Most important are the CNC milling machine and the CAD data files
to be used  for this project. Each of the six tab pages will be described in
detail below.

Note that the Project Parameters dialog has an extra button: Apply. Using this
button you can apply any new setting immediately, without having to first
close the dialog. Any changes will be immediately reflected in the drawing on
screen and in the Geometry information dialog.

This dialog can be reached via the Parameters menu, or by double-clicking
the Project line in the Tree
The same dialog is used for the Default Project parameters.

General parameters

Filepath



Dialogs

Page 123

DeskProto Reference

This filed shows the path and name of the currently loaded Project file. This
information cannot be changed in this dialog. To start a new project or to
save the project using a different name, use the File menu.

Machine
Here you can select the machine you want to use. DeskProto will use the
machine information to check if the part is not too large for the machine, if
the speeds that you enter are possible for this machine, if the number of axes
is available. The selected machine also defines the format of the NC Program
file, because the machine information states which postprocessor to use. You
can have a look at the machine-definition using the option Library of
machines in the Options menu.

Normally you do not have to bother with this parameter as your machine will
be the default machine (set the first time that DeskProto was started, in the
Initial Settings). If not, you can change the default machine using the option
Default Project Parameters in the Options menu.
Note: when you change the selected machine DeskProto will automatically
change values for Feedrate and Spindle speed for all operations in the project,
as the new machine may not be capable of outputting the old values.

Parts
The number of Parts present in the project can be controlled here, using the
buttons Add, Remove and Copy. Multiple parts can be used in a project to
create different models, for instance a scale model and a full size, or a front
part and a back part. 
You can influence the sequence of the parts using the two Move buttons. The
part that is selected (it’s line made blue) will be moved in the direction of the
arrow.  This does not have any effect an the resulting toolpaths, it can be
handy though in order to neatly arrange your parts in case you have many.

Vector parameters
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Vector files
This tab page shows all Vector files (if any) being used in this project. When
more than one file is present only one file is selected in this dialog (gray
background color): the buttons on the right will influence that file (except of
course the Add button).
You can change the set of files using the Add button and the Remove button
on the right, to add and remove files. 
When a vector file has been changed (for instance it has again been exported
from CAD) you can Reload it.
Very powerful is the Transform option, which will open the Vector
Transformation dialog: for each file you can define a set of transformations,
for instance in order to position two vector drawings next to one another in
3D space.
Save As offers the option to save one vector file. The Save Vector data
options dialog will op up, allowing you to select which transformations to use
for the new file.
The File Info button finally shows information of the selected vector file:
type, size, number of curves, number of points, dimensions.

Use Z-values
Vector machining in most cases will be done using two-dimensional CAD
data: a drawing that does not contain any Z-values (only X and Y, to be
shown at the top of the block).  Nevertheless DeskProto will also accept
vector files that contain Z-coordinates. When opening such file DeskProto
will ask you whether or not you want to use these Z-coordinates.  With this
checkbox you can later change this setting.
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When you use the Z-coordinates, the machining depth that you set in the
Vector operation parameters will be taken relative to the Z-level of the curve
(or point) as it has been defined in CAD.
When using Z-values, not all options in the Vector operation will be
available.
This option can also be checked for vector files that do not contain Z-values:
DeskProto then will use Z=0 (in CAD coordinates)for all points on the vector
curves. This will influence the result when both vector files and geometry
files are loaded: the CAD zero point of the geometry file then will be used for
the curves, where normally the curves will be drawn at the top of the block.

For rotary parts do NOT wrap around cylinder
Using vector data in a rotary part in most cases is about a text or a drawing
that needs to be engraved on the part. DeskProto achieves this by wrapping
the 2D vector drawing around the cylinder shaped block (for a rectangular
block around the smallest possible cylinder that encloses the complete block).
The cutter then always is oriented perpendicular to the 2D drawing, just as
for 3-axis machining.
For vector files that use Z-values this is not always the intended behavior
though: the 3D vector curve may exactly follow the geometry: in order to
machine a groove in the surface or to cut through sheet material. In such
cases you can check this option. The curves then will not be wrapped, and
the toolpath will simply follow the curves in 3D.

Preserve curve direction when loading
When loading a vector data file DeskProto checks if it can combine separate
curves (polylines) to one curve: in case the endpoint of curve 1 is the same as
the startpoint of curve 2 then for machining it is best to process them as one
combined curve. This is especially important for recognizing closed curves. 
When checking if two points are equal DeskProto applies a small tolerance
(0.001 mm), in order to correctly process 'sloppy' drawings.
This option tells DeskProto what to do if two curves share either both
endpoints or both startpoints: the curves then can be combined only if the
curve-direction of one curve is reversed. As default setting DeskProto will
indeed reverse curve direction in order to combine as many curves as
possible; checking this option forbids DeskProto to do so. This may be handy
in case you want to use the curve direction as defined in CAD for your
toolpaths.

Geometry parameters
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Geometry files
This tab page shows all Geometry files (if any) being used in this project.
When more than one file is present only one file is selected in this dialog
(gray background color): the buttons on the right will influence that file
(except of course the Add button).
You can change the set of files using the Add button and the Remove button
on the right, to add and remove files. 
When a geometry file has been changed (for instance has again been
exported from CAD) you can Reload it.
Very powerful is the Transform option, which will open the Geometry
Transformation dialog: for each file you can define a set of transformations,
for instance in order to position two geometries next to one another in 3D
space.
Save As offers the option to save one geometry file. The Save Geometry data
options dialog will op up, allowing you to select which transformations to use
for the new file.
The File Info button finally shows information of the selected geometry file:
type, size, number of facets, number of points, dimensions.

Skip Backfaces
In an STL file for each facet (triangle) a  normal vector is stored, indicating
which side of the facet is on the outside of the geometry and which side is on
the inside. The inside triangles are called backfaces. For valid STL file these
are all completely invisible, as an STL geometry should define a closed solid.
The option Skip Backfaces saves calculation time, as it makes DeskProto
simply skip all backfaces. This means that half of the triangles will be
skipped, which results in shorter calculation time. The resulting toolpath will
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be the same (for a valid geometry). If this option is selected all backfaces are
colored bright red in the drawing that DeskProto displays - for a correct STL
file no red will be visible. As nowadays almost any STL file is valid this
option is checked by default.

You can clearly see the red facets in sample file Teapot.stl, meaning that this
is not a valid STL file. The defined surface does not fully enclose a some
space, so this teapot is not a valid solid. Which is not surprising for a dataset
modeled back in 1975 (by Martin Newell at the University of Utah): the term
solid modeling then did not yet exist. For corrupt geometries like this you
may need to uncheck this option to skip the backfaces.

Flip Normals
As just explained, in DeskProto for each facet (triangle) a  normal vector is
stored, indicating which side of the facet is on the outside of the geometry.
When using a corrupt STL file this information can be wrong. In case ALL
normal-vectors point to the inside of the geometry you can use this option
Flip normals to correct the normal information. This option is available only
when Skip Backfaces has been checked, as otherwise the normal direction is
not used anyway. This is an old option, nowadays it is needed only very
rarely, as currently all new STL files are valid.

Bitmap parameters

Bitmap file
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This tab page shows the Bitmap file (if any) being used in this project (for
bitmap data only one file can be loaded in a DeskProto project).
You can change this file using the Browse button, on the right, and you can
remove it with the Remove button. 
When a bitmap file has been changed (for instance again exported from
CAD) you can Reload it.
Save As offers the option to save the bitmap file.
The File Info button finally shows information of the selected bitmap file:
type, size, number of pixels, DPI, dimensions.

The number of options is lower than for Vector files and for Geometry files,
as you can use only one bitmap file in your project.

For bitmap files no extra options are available.

Chaining parameters

Chaining is an option that allows you to combine Operations from various
Parts into one large NC Program file. Normally only Operations in the same
Part will be combined into one NC Program file. This option is used when
more than one part is involved, for instance by the N-sided milling wizard
(for indexed machining ).
Note that chaining is of course possible only in case more than one part is
present in the current project.
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Also note that Chaining is an option for advanced users: only apply this
feature this when you know how to use it.

The button Create adds an empty new chain to the list of chains.

The button Remove deletes the currently selected chain.

The combo box Chain shows the currently selected chain (if any), and makes
it possible to select other chains. Chain names are automatically generated:
Chain 1, Chain 2, etc.

The field Chained Operations shows all operations in the currently selected
chain. You can use the up and down buttons to change the sequence of the
operations in the chain.

The field Unchained Operations shows all operations in the project that are
not (yet) part of a chain. You can use the left and right arrow buttons to
move unchained operations to a chain and to remove operations from the
selected chain.

In the Operation Start/End commands you can add extra commands to be
executed in-between the two chained operations: either after the first
Operation or before the subsequent operation. For instance to rotate the
rotation axis to the correct angle before starting that operation (needed for
indexed machining).

Advanced parameters
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Many warning messages in DeskProto have a checkbox in the left bottom
corner: 'Always show this message' or 'Always show this message for this
project'. As default this checkbox is checked: the warning will be given when
needed. When you uncheck the box the warning will no longer be displayed.

For 'Always show this message' the warning will remain suppressed as long as
you use DeskProto. Some only for the current session, others even when you
again start DeskProto some time later. 
For 'Always show this message for this project' the warning will only be
suppressed for this project, also when later reopening the project (setting
stored in the DPJ file). This is called a project-specific Always show setting.

In case you want to undo suppressing the warning you cannot simply check
this box again, as the warning no longer is given. You can use this button
Restore the project-specific 'Always show' settings to achieve this, for all
project-specific warnings.

The other warnings (the general Always show settings) can be restored via a
button on the Advanced tab of the Preferences, in sections 'Settings'.
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4.2.1.2 Vector Data Transformation

DeskProto allows loading more than one Vector data file (and more than one
Geometry file). For each file DeskProto simply reads the coordinates in the
file (as defined by the CAD systems that wrote each file) and draws the CAD
data using these coordinates. 

This may result in unwanted collisions and/or overlaps. Such unwanted
situation can be corrected here, as you can give each file its own set of
transformations. For instance a translation to position two identical curve sets
next to one another. 
In the Vector Transformation dialog these Transformations can be set for a
Vector Data file.
For Vector files that also contain Z-values a third entry (Z) is present for
Scaling, Mirroring and Translating.

This dialog can be opened on the Vector page of the Project parameters,
using button Transform....
It will also pop up when loading an extra Vector file, and enables you to
position the new vector data relative to CAD data that is already present. It
offers basically the same transformations as also present in the Part
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Parameters (see there for more help), however these will be applied only to
this one vector file.

A handy tool in this dialog is the Preview button, as it will draw the new
vector curves according to the transformations that you entered in the dialog.
If this new position is not what you need, you can enter new transformation
values and again press Preview for a new drawing. When all is OK you can
acknowledge with OK.

You need to realize that in the drawing that you see the Part Transformations
will be applied as well, after the transformations that you enter here. This
means that (for instance) when in the Part Parameters a rotation of 90 degr.
round Z is applied, a translation along Y that you enter here will result in a
translation along X on your screen..

4.2.1.3 Geometry Transformation
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DeskProto allows loading more than one Geometry file (and more than one
Vector data file). For each file DeskProto simply reads the coordinates in the
file (as defined by the CAD systems that wrote each file) and draws the CAD
data using these coordinates. 

This may result in unwanted collisions and/or overlaps. Such unwanted
situation can be corrected here, as you can give each file its own set of
transformations. For instance a translation to position two (or more) identical
geometries next to one another. 
In the Geometry Transformation dialog these Transformations can be set
for a Geometry file.

This dialog can be opened on the Geometry page of the Project parameters,
using button Transform....
It will also pop up when loading an extra Geometry file, and enables you to
position the new geometry relative to CAD data that is already present. It
offers basically the same transformations as also present in the Part
Parameters (see there for more help), however these  will be applied only to
this one geometry file.

A handy tool in this dialog is the Preview button, as it will draw the new
geometry according to the transformations that you entered in the dialog.  If
this new position is not what you need, you can enter new transformation
values and again press Preview for a new drawing. When all is OK you can
acknowledge with OK.

You need to realize that in the drawing that you see the Part Transformations
will be applied as well, after the transformations that you enter here. This
means that (for instance) when in the Part Parameters a rotation of 90 degr.
round X is applied, a translation along Y that you enter here will result in a
translation along Z on your screen..



DeskProto Reference

Page 134

4.2.1.4 Save Vector Data Options

The Save Vector Options dialog enables you to apply (in the new file) the
Transformations that you have set in the Part Parameters. It will pop up after
pressing command Save Vector Data As... in the File menu, and after pressing
the Save as... button on tab Vector of the Project parameters.

It offers the five Vector transformations that can be set in the Part
Parameters (see there for more help). Note that only those transformations
can be checked that indeed have been applied.  When you check a
transformation, DeskProto will save the Vector data including that
transformation. So the new file will then contain rotated curves, scaled
curves, etc. This is ideal for instance for saving a scaled or rotated version of
your CAD file.
All Vector Data Transformations that have been set for each file on Project
level will also be applied when exporting a Vector data file, these cannot be
switched off in this dialog.

In case multiple vector data files have been loaded: when calling this
command from the file menu the total of all vector curves will be exported.
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4.2.1.5 Save Geometry Data Options

The Save Geometry Options dialog enables you to apply (in the new file)
the Transformations that you have set in the Part Parameters. It will pop up
after pressing command Save Geometry Data As... in the File menu, and after
pressing the Save as... button on tab Geometry of the Project parameters.

It offers the six transformations that can be set in the Part Parameters (see
there for more help). Note that only those transformations can be checked
that indeed have been applied.  When you check a transformation, DeskProto
will save the 3D geometry including that transformation. So new file will then
contain rotated geometry, scaled geometry, with support tabs, etc. This is
ideal for instance for saving a scaled or rotated version of your geometry file. 
All Geometry Transformations that have been set for each file on Project
level will also be applied when exporting a Geometry file, these cannot be
switched off in this dialog.
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In case multiple geometry files have been loaded: when calling this command
from the file menu the total of all geometries will be exported.

4.2.2 Part

4.2.2.1 Part Parameters

The Part parameters dialog offers all settings that are available on part level.
The parameters are applied to the CAD-data in the sequence as presented by
the Tab pages, from left to right. The further to the right, the more advanced
the parameters in the tab. Each of the tab pages will be described in detail
below.

The number of tabs that is present is different for each type of CAD-data,
because each data type comes with different settings:
Vector Settings
Geometry Settings
Bitmap Settings
When more than one type of CAD-data has been loaded you can therefore
select the set of settings that you want to edit, when no CAD-data is present
only the tab General will be visible. Some of the tab pages are identical for all
data types, some are present for just one of the three types. Every tab page
description below mentions for which type of data it is present.

The number of tabs that is present also is different for each Edition.
For instance in the Free Edition and in the Entry Edition only the first two
Tab pages are available, as these editions offers less parameters than the
other editions. 

The Part Parameters dialog has an extra button: Apply. Using this button you
can apply any new setting immediately, without having to first close the
dialog. Any changes will be immediately reflected in the drawing on screen
and in the Part information dialog.

This dialog can be reached via the Parameters menu.
Shortcuts: 
You can double-click on a part line in the project tree (one of the second
level items).
Or right-click on a part line and select Part Parameters in the context-menu.
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This same dialog is used for the Default Part parameters, only with an extra
button Restore DeskProto defaults to reset the original default parameters.

General parameters
(Vector, Geometry and Bitmap Settings)

Name
The name of the  part can be changed here. Use a meaningful name to easily
remember the purpose of each specific part: that will make it easy to interpret
the Project Tree when you have defined more than one part. This name is for
your convenience only: it is not used in the resulting NC program file (unless
you add it in a comment line using a postprocessor placeholder).

Machine settings
These are visible and/or enabled only in the Multi-Axis edition of DeskProto.
The first checkbox only for machines with a Rotation axis (4th axis), the
second checkbox only for machines with a 5th axis or with a manual Tilt
option. The manual tilt option is very rare: only a few machines support this.

Use rotation-axis
A rotation axis is a device on the machine that rotates the part during
machining. Like a roast on a spit above the barbecue. Note the difference
between an A-axis and a lathe: on a lathe the spinning of the part causes the
cutting, on a rotation axis the spinning of the cutter.

By default DeskProto generates standard XYZ toolpaths, and thus ignores the
rotation axis. 
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If "Use rotation axis" is checked, DeskProto will generate XZA toolpaths
instead, with A-value in degrees. In the View Window the difference will be
immediately visible, as the operation area no longer is a rectangular block: it
becomes a cylinder instead. 
The part will rotate when machining: continuous rotation. This in contrast to
the indexed machining, which is possible using DeskProto too, in the wizard
"Two or more sides, automatic rotation". 

For geometry-data DeskProto will rotate the 3D part when calculating the
toolpaths, bitmap data will be wrapped around a cylinder. For vector data
both options are possible, in the project parameters you can set which option
to use.

When you check “Use Rotation axis” DeskProto will automatically (when
applicable):
· set the Zero-point Z Translation to "None" for the Z-axis (resulting in a

Workpiece zero point exactly on the rotation axis)
· disable Inverse milling as that does not work for rotary machining.
· change the default setting for the Support Tabs.
· set the Operation areas to "Above rotation axis", in order not to let the tool

sink below the rotation axis.
· set the Borders to "No extra" for all operations in that part (as the part

must not be cut loose of the rotation axis)

You are free to change these settings later in case needed. For instance
sometimes the cutter needs to go below the rotation axis.
The message box shown above will remind you of these changes, you can
switch it off when no longer needed (it can be restored in the Preferences, tab
Advanced, subset Settings).
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By default DeskProto calculates for a rotation axis parallel to the X-axis,
which is officially known as an A-axis.  A rotation axis parallel to Y is
supported as well: you can configure that in the Advanced machine settings.

Use 5th axis as rotation axis tilt option
Use rotation axis tilt option
This option is available only for some machines. 
In case a 5-axis machine (with a CNC controlled 5th axis) has been selected
the first text is displayed: Use 5th axis as rotation axis tilt option.
In case a machine has been selected that supports the manual tilt option the
second text is displayed: Use rotation axis tilt option.
This option is available only in the DeskProto Multi-Axis edition. If this box
is not checked DeskProto will ignore the tilt option and generate standard
toolpaths. 

The manual tilt option concerns a special type of fifth axis: a mechanism that
tilts the complete rotation axis unit. Such fifth axis is present on some
machines offered by Roland (JWX-10, MDX-40), and is meant to machine
the inside of a ring. In fact this tilting option is a B-axis rotation. However,
DeskProto does not control the movement of this axis: it has to be manually
set. For more information and a picture see the Tilt option tab of the
Operation Parameters. This tab page is present only if this tilt option is
checked.
On trunnion-style 5-axis machines (with a CNC controlled 5th axis) the large
rotation axis can be used to tilt the small rotation axis that is mounted on top,
and then rotate the small rotation axis while machining.

Operations
The number of operations within the part can be changed by adding,
removing or copying operations, using the buttons Add, Copy and Remove.
Three different types of Operation can be added: Vector, Geometry and
Bitmap, so the Add button comes in three flavors.
When more than one operation is needed to create a part (for instance first
roughing with a large cutter and then finishing with a smaller one) the
sequence of the operations is important. Using the Move arrow buttons you
can change the sequence of the operations.

Transform parameters
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(Vector and Geometry Settings)

The availability of options 4 and 0 on this tab page will differ per edition of
DeskProto (Free, Entry, Expert, Multi-Axis).
The availability of options will also be different for Vector data and for
Geometry data
The order in which the transformations are applied will affect the result,
which is why they are numbered in the dialog. For instance scaling is done
before rotation, so when you rotate you may need to scale a different axis
than visible on the screen.

1. Scale
Scaling is the first transformation that is applied to the original geometry /
vector data. It is possible to scale differently for X, Y and Z, by un-checking
the Uniform option. You can scale either by using scale factors or by
entering the desired new dimensions. For Vector-data without Z-coordinates
only X and Y can be scaled.
The image above shows the scale factors with one decimal, DeskProto will
accept up to 5 decimals (five digits after the decimal point, like 1.12345):
accurate scaling may be needed for instance to exactly compensate for
product shrink.

Note that the imported CAD file does not contain information about the units
used, DeskProto assumes the units used in the CAD file to be the same as set
in the Preferences dialog. If this is not true it can be corrected using the scale
factor: 
Enter a scale factor of 25.4 to use a CAD file created in inches in a
DeskProto that is configured to use metric units.
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Enter a scale factor of 0.03937 to use a CAD file created in mm in a
DeskProto that is configured to use inches.

2. Mirror
The mirror option is the second transformation that is applied. It is only
useful to mirror in one direction, as mirroring in two directions is identical to
one rotation, and mirroring in three directions can be achieved by mirroring
in one direction plus a rotation. The mirror option can be useful when you
have a geometry that is one half of a symmetrical prototype. By mirroring the
geometry for the second part you can produce two parts that will exactly fit
together.
For Vector-data without Z-coordinates only X and Y can be inverted.

3. Rotation
The rotate option is the third transformation that is applied. Note the
difference between this rotation (which changes the part) and the view
rotation (which only changes the viewpoint / the camera position). Both
rotations use an identical process, so you can use the Viewpoint to find the
rotation you need, and then use these X, Y, Z rotation values to enter here.
When a custom Material block and/or Area is present (rectangular!) such
block or area can remain correct only for rotations over (multiples of) 90
degrees. For other angles the boundaries would be changed, so these are not
permitted. For Freeform areas only rotations round X and Y over (multiples
of) 180 degrees and round Z over (multiples of) 90 degrees are possible, other
rotations are not permitted.
For Vector-data without Z-coordinates only rotations round Z are possible.

4. Inverse milling (Geometry settings)
The inverse milling option useful for producing a mold: a cavity in a solid
block of material that exactly fits your geometry. In many cases it will be
easier to create an inverse geometry using the original CAD system.
However, this option comes in useful in case you only have the STL file, not
the original CAD data.

Inverse milling is not the same as mirroring the Z-axis. A mold that is created
by mirroring would produce mirror images of the original geometry. Instead
DeskProto uses a 180 degree rotation to create the inverse. As this inverting
is applied during toolpath calculations, the STL geometry on the DeskProto
screen is not inverted. To get an idea of what you are machining you can
display the rendered Z-grid or a simulation instead.

Note 1: when selecting this option, in most cases it is necessary also to
change the Ambient and set it to 'Top level'.
Note 2: when this option is checked, setting the Z-values for the Material
block and the Area to be machined still is done in un-inverted coordinates.
Inverse milling is not available in the DeskProto Free edition and Entry
edition.
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4. Panning (Vector settings)
Panning can be used to correctly position the Vector curves over a geometry
and/or a bitmap. For instance when you want to engrave a logo on a 3D part. 
The vector panning option will be disabled ("grayed out") when it does not
make sense: in case only vector data is loaded AND the XY translation (tab
Zero-point) is automatically calculated (one of the first four translation
options). The latter condition is always true in the Free edition and the Entry
edition, as there the translation cannot be set.

The button Align to... leads to the Align dialog: a handy help to set a few
useful locations.

0. Center geometry (Geometry settings)
In DeskProto all Translations are applied at the end of the calculation
pipeline, after calculating the actual toolpaths. For rotation axis machining
this is not sufficient, as the position of the geometry during calculation
influences the toolpaths that will result.  As default (when you do not check
this option) during rotation axis machining DeskProto will rotate the
geometry around the X-axis as defined in the CAD system.  As a result the
block of material may become far larger than the geometry. The complete
geometry then may even 'orbit' the rotation axis at a large distance.

When you check this option DeskProto will translate the geometry to a
position where the origin is in the exact center of the geometry.
DeskProto will still rotate around the X-axis, however this axis now will go
through this centerpoint. You can immediately see the difference as this
influences the size of the Material block: when checked it will exactly fits the
geometry. The Center Geometry option is performed before the other
transformation, hence it has been given sequence number 0.

When you need any other position of the rotation axis you can apply a
custom translation in the Geometry Transformation dialog, as that translation
will be applied before any part transformations. Or you can of course go back
to the CAD system and translate the geometry there.

In addition to this option you can still use the Translation options for a
translation to be applied after calculating the toolpaths. For rotation axis
machining you then can choose between a workpiece zero point on the
rotation axis or on the top of the cylinder block (Z=0 level).

XY Transform parameters
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(Bitmap Settings)

Bitmap dimensions
The dimensions on this tab page define the size of the Relief in XY, the size
in Z is determined by the Z-settings for Black and for White.

· Use DPI from bitmap file. Most bitmap files contain a DPI value, which
stands for Dots Per Inch. So for a 300 DPI image the size of one dot
(pixel) will be set to 1/300 inch. As the number of pixels is known this
value sets the exact size of the image, and thus for this choice it sets the
size of the relief. For files without a DPI value (for instance GIF files)
DeskProto will use 96 as default.

· Use custom DPI. This options allows you to enter any DPI value. As
explained above this value will set an exact size for the image, and thus
also of the relief.

· Calculate from precision.... As explained in paragraph Bitmap Data
DeskProto uses a Z-Grid to create the Relief. For options 1, 2 and 4 the
ratio between Pixel size and Grid cell size (the path distance) is not
necessarily a whole number. So it might be that some Grid cells 'contain'
more pixels than others. This may lead to a Moiré pattern (see paragraph
Bitmap Data), like a small ridge every few mm. Which can be fixed by
choosing this option (approximate the preferred dimension as close as
possible). One pixel will be converted to exactly ... , 1/4 , 1/3 , 1/2 , 1 , 2 ,
3 , 4 , ... grid cells, as set by the ratio Pixel size / Path distance. As the
path-distance is one of the Precision values in the Operation parameters,
when more than one bitmap operation is present you need to select the
operation the you want to use. Important: when you later change the
Precision, the size of the relief will change as well !
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· Custom. Here you can enter any dimension as required, directly in mm or
in inches.

The option Keep aspect ratio takes care that the ratio between X size and Y
size is not changed: image and relief will have the same XY ratio. So when
you change the X size with this option checked, you will see that the Y size
automatically changes too.

Panning
The position of the bitmap relief relative to the workpiece zero point can be
changed here. By default the relief is located with it's lower left corner
exactly at XY (0,0) in CAD coordinates, so at the zero point (the Z depends
on the settings of the second tab page). If this is not the correct location you
can change it by entering Translation values for X and Y here. Panning can
for instance be used to correctly position the bitmap relief over a geometry.
The button Align to... leads to the Align dialog: a handy help to set a few
useful locations.

The bitmap panning option will be disabled ("grayed out") when it does not
make sense: in case only bitmap data is loaded AND the XY translation (tab
Zero-point) is automatically calculated (one of the first four translation
options). The latter condition is always true in the Free edition and the Entry
edition.

Z Settings parameters
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(Bitmap Settings)

In order to use a Bitmap image in DeskProto it needs to be transformed to a
3D Relief. As explained in paragraph Bitmap Data, this is done by calculating
a Z-height for every pixel in the bitmap image, based on its gray value.

Relief depth
In these two edit boxes you can enter the Min and Max Z-values, to be used
for black and white. DeskProto calculates this depth starting at the top of the
block. So positive values do not make sense here (unless the option 'Project
bitmap relief on 3D part geometry' has been checked).
In the image above the minimum Z for white pixels is -2.0 and the maximum
Z for black is 0.0, which for gray values will result in the lighter the color the
lower the relief (the other way round is also possible: black lowest and white
highest). This is called gray-value to Z-height conversion.

Project bitmap relief on 3D part geometry  (not in the Free edition and the
Entry Edition)
When this option is checked, the Z-value that is calculated for the color of
that pixel is added to the Z-value of the geometry at that location. So the 3D
relief is projected onto the underlying geometry, using a vertical projection.
See the illustration below (where the relief depth for black has been set on
0.0 and for white on a positive value).
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Here a shell relief is created from a bitmap image, and projected on the
perfume bottle that you have seen more often as example part. This is of
course a great design tool to create embossed products. The picture shows a
positive relief: on top of the geometry.
Important for such positive relief is that of course material is needed to create
this relief, so the previous operations used to machine the bottle may not
machine the original bottle shape there. This can be achieved by making each
operation a bitmap operation.
The block needs to be high enough as well: the bounding box of the STL file
in this case will be too low.

The relief to be projected can also be negative: when the Z-values range from
0.0 to a negative value, the relief will be subtracted from the part geometry.
This option is activated only when a geometry has been loaded in the project,
as of course otherwise projection is not possible.

Material parameters
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(Vector, Geometry and Bitmap Settings)

The block of material to be used (the stock) is a rectangular volume, bounded
by Minimum and Maximum values for each of the three axes. Only the
CAD-data inside this block will be processed during the milling calculations,
the rest will be discarded. As you can see in the icon pictures, the bounding
box of the block will be drawn in orange lines (the green lines that you may
see are for the Area to be machined).

The illustration above shows this tab page for 3-axis machining a 3D
geometry. In other situations other options may be present:
- the options that mention Geometry are available only when a geometry file
has been loaded.
- the option "Set custom size" comes with only three edit fields, for the X, Y
and Z dimensions.
- when rotation axis machining is selected the option "Use upper half of
geometry" disappears, two extra edit fields are present for the Min and Max
R-values (Radius), and an extra option is present to set the Shape of the
block (see below).

Four or five options are available:
· Use all CAD data is the default: the block will be the bounding box that

exactly fits all CAD data. For 2D vector files a block thickness of 10 mm
will be used (minimum Z -10.0, for inch users -0.5"), unless the Machining
depth as set in the Vector Operation parameters is more. 
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· Use whole geometry uses a bounding box that exactly fits the total
geometry. In case you have only loaded one or more geometry files the
result will be the same as for Use all CAD data.

· Use upper half of geometry is meant for  symmetrical geometries that can
be machined in two halves, for instance the right side and the left side of a
power drill. Separately machine both halves and then glue them together to
create one model. This option is not present for rotation axis machining.

· Set custom size is the option to define a different block size. You can
enter the block size by typing the appropriate dimensions for X, Y and for
Z. The CAD data will be located in the center of the block.

· Set custom boundaries gives you more control when setting a different
block size, as you can now enter the block dimensions by typing the
minimum and maximum boundaries. You can always reset the values by
again selecting 'Use all CAD data". As said the Min and Max R-values are
available for rotation axis machining. It is also possible to change the
boundaries using your mouse, which can be done after pressing button Set
Graphically. 

If you want you can enter the values for the block in Translated
coordinates. When you have checked this checkbox the minimum and
maximum values of the block (the boundaries) are displayed in the
coordinates as used on the machine. These are the coordinates after the
Translation has been applied. A translation is also applied in the Free edition
and the Entry edition (where no Translation tab is present): making the
front/left/top corner of the block the zero point. Checking or unchecking this
checkbox does not influence the toolpaths. It’s just a temporary conversion in
this dialog to make setting the boundaries easier.

When rotation axis machining has been selected you can set the Shape of the
block. Three shapes are possible:
· Cylindrical, centered: the block is a cylinder, with the rotation axis as

center line. Only the X-boundaries and the R-boundaries can be set. A
minimum R lower than 0.0 is not permitted. When you enter a minimum
above 0.0 the result will be a tube-shaped block (hollow).

· Rectangular, centered: a rectangular block, with the rotation axis as
center line. Only the X boundaries and the max Y and Z boundaries can be
set. Min Y will be minus Max Y, same for Z

· Rectangular, eccentric: a rectangular block, Now all six X, Y and Z
boundaries can be set, so minimum and maximum can be set at different
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distance to the rotation axis. The rotation axis needs to be inside the block
though.

For three-axis machining and for indexed machining only rectangular blocks
are possible.

When changing the shape of a custom block from rectangular to cylindrical
DeskProto needs to calculate new boundaries (using R instead of Y and Z).
This conversion is done using the CAD zero point as center for the cylinder.
So when that CAD zero point is not in the center of the geometry the cylinder
will become large, as shown in the drawing above.

Using custom material block size in most cases will mean that the block that
you have is larger than the bounding box of the CAD data. For instance
when your actual block is higher than the CAD geometry: the roughing layers
will start counting from the top of the block, so the block thickness in
DeskProto needs to match the real block. This can be done here by entering
custom block dimensions.

You can also use a custom block that is smaller than the CAD data. For
instance when the part is too large for your machine. Say it is 500 mm long,
while your machine can do max 300 mm (along X). Then in your DeskProto
project define two parts. For the first part set a custom block with X-min 0.0
and X-max 250, and for the second part set a block with X ranging from 250
to 500. The two parts that you machine will exactly fit together to form the
complete model. It will be needed to use the option Protect Vertical surfaces
to make the splitting surfaces vertical.

The same trick can be used when your part is too high for your machine:
build the model from separately machined slabs of material. For instance
produce a model of 140 mm high, milling three separate slabs of standard
tooling board blocks of 50 mm thick, using three parts with these material
blocks: part1 Z 0-50 mm, part2 Z 50-100 and part3 Z 100-140 mm.

Note: 
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In case Inverse milling (male to female) is applied, then the block boundaries
entered here are applied on the original geometry, before the male to female
conversion.

Support parameters
(Geometry Settings)

When your material block is much larger than the part you can add support
tabs to keep the part connected to the rest of the block. These are small
blocks of material (various shapes are available), acting as connection bridges
to hold the part on its place. You then can clamp the block on its corners and
machine several parts, each on a different position, without the need to clamp
each separate part.
Tabs are also needed for two-sided machining (see the Two Sided Milling
Wizard), and for fixturing your model on a rotation axis device (to keep the
part connected to the rotary table).

This page is about Geometry support tabs, created by adding small blocks to
the geometry. Not to be confused with Vector tabs, made by changing the
machining depth in a 2D toolpath.

Each support tab is created by loading an STL file from folder C:
\ProgramData\DeskProto 8.0\Supports\
The contents of this STL file are scaled and rotated as needed, and then are
added to the part as a special type of geometry, drawn in a different color.
The difference with all other geometry is that the area below the tab is
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treated as ambient area when Skipping ambient, so DeskProto will not create
a toolpath around the tab but move over the tab instead. This also effects the
Contour only strategy: the cutter will rise and travel over the tab instead of
round it.

Four options are available:
· Don't use support tabs, which is the default and will be OK for most parts.
· Use Default tabs: DeskProto will locate these tabs at the extreme points of

the geometry (min and max X, min and max Y, applied after the rotations).
For normal XYZ machining four rectangular tabs are generated (parallel to
X and Y), for rotation axis machining two cylinder shape tabs (parallel to
and centered around the rotation axis). Tab width and thickness depend on
the size of the geometry, tab length is (at least) 1.5 times the cutter
diameter (10% of this length sticks into the geometry), to make sure that
the cutter can machine it.

· Custom tabs can be used when the default tabs do not satisfy. You can
create any number of custom tabs, using button Set.... This will open the
Set support tab dialog, which offers options to graphically set the position,
size, shape and orientation.

· Use tabs of first part is very convenient when your part is machined from
several sides: DeskProto will then create one "part" for each side, and for
each parts the same support tabs are needed. Define these support tabs
only once (for the first part), and use that same definition in all other parts.
Advantage is that any changes need to be made only once. This option is
very handy for two-sided machining. For the first part obviously this
option is disabled.

In order to keep  support tab connected to the surrounding material it is
needed to select one of the Ambient skipping options (Operation
parameters, tab Advanced), as otherwise the end of the tab still may be cut
loose.
An alternative solution is to make the end of the tab stick outside the Area to
be machined. When the end of the support tab is exactly on the edge of this
area you need to also switch off the borders in each of the operations used
for this part (Operation parameters, Tab page Borders).

Ambient parameters
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(Geometry and Bitmap Settings)

DeskProto toolpaths for Geometry and Bitmap by default will completely
cover a rectangular area. Most geometries do not have a rectangular
geometry though, so in many cases some area will be present without
geometry. This is called the ambient area. Or in other words, the area where
no geometry is present, seen from the top. On this tab page you can specify
the level (height) at which this ambient area should be milled.

· The default choice is Equal to bottom level of material, so at the
minimum Z-level of the block. This will do for most cases, as then all
material around the part will be removed. Note: when using this option, for
ballnose cutters the actual Z-level will be R (radius of the cutter) lower
than the bottom of the block, to make vertical walls possible. So take care
not to damage your machine's working table.

· Equal to top level of material will be useful when you want to make a
mold by using inverse milling: then you do not want the material around
the cavity to be removed.

· Custom, allows to specify any ambient level, by entering a Z-value edit
box. Hidden feature: When you select this option, a ballnose cutter will
not go R mm lower than the level in the Z edit box (as just explained for
'Equal to bottom'). So switching from "Equal to bottom" to "Custom" will
not change the value in the Z edit box, however may nevertheless produce
different toolpaths.

If you want you can enter the ambient level in Translated coordinates.
When you have checked this checkbox the Z-level is displayed in the
coordinates as used on the machine (after Translation has been applied).
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Checking or unchecking this checkbox does not influence the toolpaths. It’s
just a temporary conversion in this dialog to make setting the ambient level
easier.

Zero-point parameters
(Vector, Geometry and Bitmap Settings)

Setting the WorkPiece zero point for your NC programs means applying a
Translation to your toolpaths: converting from CAD coordinates to machine
coordinates. Although you can see translation as a form of transformation, it
has not been placed on the Transform tab page of these Part parameters. In
DeskProto the translation is applied after all actual calculations, just before
saving the toolpaths to an NC-program. So in the Part parameters it is shown
as last tab that influences the toolpath data. 
On screen the position of the WorkPiece zero point is shown by the blue
Orientator cube (if not then you can switch it on in the Items Visible dialog).

Default translation is option 1 for  X, Y and Z, making the front-left-top
corner of the block the Workpiece zero point. This is customary for CNC
milling and very handy: the zero position will now be with the tip of the tool
touching the top of the material, at the front-left corner of the block. So all X
and Y positions to be machined will be positive (starting at 0), and all Z
positions will be negative (starting at 0 as well).  Cutter positions may still
have a negative X and/or Y value though, as the cutter needs to move outside
the block to machine the outer surfaces.
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It is possible to use different settings for X, for Y and for Z. For each axis
five or six predefined translation options are available. For each option
DeskProto will calculate the actual translation value and show it in the edit
box after option Custom. 

XY:
- Translate To positive X&Y for material block has just been explained:
X=0.0 resp Y=0.0 will be on the edge of the block. This option is the most
convenient one because it will be easy to set the zero-position on the
machine.
- Make center of material block zero is preferred by some users as their
default option. It is a convenient option for two-sided machining using
reference pins on the working table to keep the block in position after turning
it upside-down: on the machine the zero point then needs to be positioned
exactly in the middle of these pins.
- Translate To negative X&Y for material block will set the X=0.0 resp
Y=0.0 on the other side of the block. In some cases that is more convenient
than the first option.
- Translate To positive X&Y for cutter positions will make all cutter
positions (or toolpath coordinates) have a positive X or Y coordinate. This
option is useful in case the machine can handle only positive X & Y
coordinates (for example the small Roland Modela MDX 15 and 20). Extra
attention is needed for this setting, as when using this option toolpaths for
various cutter diameters do not share the same zero point.
- None means that no translation is applied. The edit box will show 0.0, the
zero-position of the CAD data will correspond with the workpiece zero-point
on the machine.
- Custom makes it possible to use any own defined translation, to be entered
in the edit boxes. The value that you enter is the translation between CAD
coordinates and workpiece coordinates. The edit boxes as said also show the
actual translation for any of the other options, however the value then cannot
be edited.

Z:
- Make top of block zero has just been explained: Z=0.0 will be on the top
surface of the block. So the CAD data will be translated in a way that all
points have negative Z-values. This option is the most convenient one
because it will be easy to set the zero-position on the machine.
- Make center of block zero: the workpiece  zero point will then be exactly
in the middle of the block for Z.
- Make bottom of block zero will put Z=0.0 at the bottom of the block. So
the CAD data will be translated in a way that all points have positive Z-
values. Advantage of this option is that the workpiece zero point can be the
same for any block thickness. Note that in case of ballnose cutter the tip of
the cutter can still travel below Z=0, see the explanation on the Ambient
page.
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- None means that no translation is applied. The edit box will show 0.0, the
zero-position of the CAD data will correspond with the workpiece  zero point
on the machine.
- Custom makes it possible to use any own defined translation, to be entered
in the edit box. The value that you enter is again the translation between
CAD coordinates and workpiece coordinates.

For Rotation axis machining only the X and Z coordinates can be translated.
The Y coordinate value can not be translated as the tool does not move along
the Y axis during rotation axis machining. In this case also some of the Z-
options are not available either as they would not make sense.

When you have checked one of the options Use 5th axis as rotation axis tilt
option or Use rotation axis tilt option on the General tab of the Part
parameters, a different set of Translation options will be available: see the
illustration above.

As explained for the Tilt option settings (rotation axis tilt option) of the
Operation parameters, the X-translation will determine the location of the
part when the tilt angle has been applied. The workpiece zero point (X=0.0)
needs to be exactly on this 5th axis (so on the tilting rotation point). The
small illustration on the dialog shows that a larger distance between this
rotation point and the part will result in a larger Z-displacement when
rotating. So the Distance to material block must be carefully set in order to
have the toolpaths aligned for operations with and without a tilt angle.
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The Resulting Translation will be different from the Distance to material
block, as the zero point of the STL file (CAD zero) in most cases is not
located on the left edge of the block.

A Y-axis translation is not possible here: this tilt option is combined with
rotation axis (4th axis) toolpaths, where Y-translation is not applicable.

The illustration above shows the situation when on tab General the option
Use rotation axis has been checked as well: in that case not all Z
Translation options are possible.

Simulation parameters
(Vector, Geometry and Bitmap Settings)

A Simulation is a drawing on screen that shows you what the resulting
machined part will look like. This can be used to check things like the
resulting surface smoothness, error movements that would damage the part,
rest-material where the cutter cannot reach, etc. In this dialog you can set the
simulation parameters. You can read how to display the simulation on the
Simulated Operations dialog page.

The Resolution sets the accuracy of the simulation to be calculated. 
The 3-axis simulation (XYZ) applies a Z-grid, similar to many other
DeskProto calculations: the level of detail sets the number of grid cells used.
The higher the level of detail, the longer it will take to calculate the
simulation and to draw it. We call this the grid-based simulation.
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The rotary simulation uses a completely different algorithm, based on voxels
(very small 3D cubes). Here  the level of detail sets the number of voxels that
are used. The more voxels the more accurate the result (smaller cubes), and
the longer the calculation time. We call this the voxel-based simulation.

Five preset options are available to set the number of cells in the simulation
grid:

Grid-cells Voxels
Low 200 200

500 400
Medium 1000 700

2000 1200
High 5000 2000

This number of grid-cells or voxels is used for the longest side of the block to
be simulated. The number of cells along the short side of the block is
calculated proportionally. The number are lower for voxels than for grid-
cells, as voxel calculations need far more computer resources.
In most cases the default setting (Medium) will be a good choice. A higher
level of detail will be needed only when you want to zoom in onto some
detail. This will make both calculation and display of the simulation much
slower though. In addition, calculating a high level of detail will also need
much memory.

You can enter a Custom resolution in case one of these five presets does not
match your needs. For this custom resolution as well two values are present:
one for Grid based simulations and one for Voxel based. DeskProto will
automatically convert this value when you check or uncheck the option "Use
rotation axis" on the General tab page.

Compare with Geometry offers the possibility to check the difference
between the resulting part and the original STL file geometry. DeskProto will
calculate the distance between the simulation and the STL geometry, and will
apply a color on the simulation when this distance is above a certain
tolerance value.
This option is of course only active for a Geometry project. It is also not
possible for a rotary simulation.

Check if removed too much (RED) will show a red color in case DeskProto
has removed too much material. Note that the red surfaces will only be
visible when you have turned off the rendered geometry in the Items visible
dialog, otherwise the geometry will hide the red.

Check if  rest material left (GREEN) will show a green color in case too
little material has been removed because the cutter could not reach a certain
position. This may happen on many occasions, like:
- toolpath distance too large
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- small holes where the cutter does not fit inside
- sharp inner corner, which will be machined with the Radius of the cutter

A Tolerance value decides whether or not to apply such color red or green.
As a default this tolerance has been set to 0.1% of the material block size, so
the largest dimension of the block divided by 1000. When you set it to
Custom you can enter any value that you need in the edit box.

4.2.2.2 Set Geometry Support Tabs

The Set support tab dialog offers options to add, edit and/or delete geometry
support tabs. You can reach this dialog by using the Set button on the
Support tab of the Part parameter dialog or on the Material and Supports
page of one of the Geometry wizards. 
In order to make a support tab effective:
- either the end of the tab needs to be outside the Area to be machined (like
in the image above: the green line shows the area), 
- or you need to select one of the Ambient skipping options (Operation
parameters, tab Advanced). 
Otherwise the end of the tab may be cut loose.
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The dialog shows a top view drawing of your part, with all support tabs (if
any) drawn with lines. The bounding box of the tab is drawn, and the arrow
indicates the attachment point of the tab (important for tab shapes that are
not symmetrical).

Most of the functions can be accessed using the buttons in the top-right
corner of the dialog, We will explain the functionality of these buttons below,
row by row. Note that when you hover the cursor over a button a tooltip will
pop up showing relevant information.

Buttons in row 1
Eight of these are standard DeskProto buttons to set the viewpoint, of which
the use is known (as explained on page Toolbar) and needs no explanation
here.

The first button on the first row shows the Items visible icon that is
also used in the main window. This icon however opens a special version: the
'Items visible for Set Graphically' dialog. It will be clear that here you can
select the items to be shown in the drawing.

Buttons in row 2
These four buttons (on the right side) are standard DeskProto buttons as well.
These are connected to the buttons of rows 3 and 4, as of all buttons on these
three rows (except Zoom all) only one is the active button, indicating the
current mouse function. That active button is shown with a blue background
color. The meaning of the four buttons in this row will be clear:  Mouse
panning, Mouse zooming, Mouse zoom window and Zoom all. Mouse
rotation is not present: this dialog only uses the six main views.

Buttons in row 3
The buttons in this row are for the main function of this dialog: graphically
adding, editing and deleting support tabs.

Add new tab. This button will be the active button when you open
the dialog, as the first thing you will want to do is create one or more tabs.
Point the cursor to the location where you want to add a support tab (on the
outside edge of the geometry) and then click the left mouse button. The tab
will be oriented perpendicular to the closest outside edge of the geometry (in
top view), or if that is not possible it will be oriented along the line from the
click-point to the closes geometry point. Shape, dimensions and Z position
are conform the settings shown below.

Draw new tab. This button also adds a tab, now by drawing its
bounding box rectangle. So its orientation always is parallel to X or to Y, and
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its size is set by the rectangle. Only the Z-position comes from the settings
below.

Resize or rotate tab. This button offers a lot of functionality to
edit a tab. When it is active the mouse offers these functions (the cursor
shows which of these functions is active): 
When clicking on a corner point of the tab you can resize the tab. 

Keeping Shift pressed means to keep the aspect ratio of the tab
Ctrl+Shift pressed means that either the length or the width of the

tab will be changed, depending on your mouse movement (on a Mac use the
Command key instead of Ctrl).
When clicking near a corner point of the tab you can rotate the tab. 

Keeping Shift pressed means to rotate in steps of 15 degrees
Ctrl+Shift pressed means steps of 5 degrees, and 
Ctrl pressed means steps a 1 degree.

When clicking on a line of the tab you can move that line.

Move tab. This button allows to pick up the complete support tab
and move it to a different location.

Delete tab. With this button you can delete a tab. Note that when
clicking the tab is immediately deleted, without first asking for a
confirmation, and without an undo option.

Buttons in row 4
The four buttons in this row offer extra functionality.

Select tab. The tabs in the dialog are drawn with black lines. One
of the tabs can be selected: the selected tab is drawn in blue lines. When a
tab is selected the settings shown below the buttons concerns this selected
tab. You then can change the selected tab by editing these settings.

Rotate tab 90 CCW. The three rotate buttons are active only when
one of the tabs is selected. This button will rotate the selected tab 90 degrees,
Counter Clock Wise. Rotations are possible only round the Z-axis, see the
Note at the end of this page for an exception.

Rotate tab 15 CCW.  This button will rotate the selected tab 15
degrees, Counter Clock Wise.
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Rotate tab 15 CW.  This button will rotate the selected tab 15
degrees, Clock Wise.

The five lines below the buttons make it possible to set the Shape, the Size
and the Z-position of a support tab. These settings are applied when the
button Add tab is pressed, or - when a tab is selected - they can be used to
edit that tab.

The Shape of the tab can be set using a combo-box (button with a drop-down
menu). As default five shapes are available: Block, Cone, Cylinder, Pyramid
and Wedge. Default shape is a Block. The Cone, the Pyramid and the Wedge
are asymmetric: one end is much smaller than the other end. The tab will be
connected to the geometry with its smallest side, making it easy to finish the
part after removing the support tabs. It is possible to add other shapes, see the
Note below.

The Length, the Width and the Height are the dimensions of the tab - at
least for a block-shaped support tab. For the other shapes these are the
dimensions of the tab's bounding box. When changing the dimensions of the
selected block, the center point of the block will remain the same. The
default dimensions are:
Length:  1.5 times the diameter of the largest cutter that is used in the
operations of the part. 10% of this length sticks inside the geometry, the
resulting 1.35 times the cutter diameter offers sufficient room for the cutter to
move round the part.
Width:  10% of the smallest size (X or Y) of the part
Height:  half the width (however always smaller than the height of the block).
The support tab by definition is horizontal (so both ends have the same Z-
value)

The Z-position of the block cannot be seen in the top view that this dialog
shows as a default: change it to front view or side view to see the-position.
Here as well a combo-box button, offering the options Top, Centre, Bottom
and Automatic.

Button Sync all... offers the option to set Shape, Length, Width, Height
and/or Z-position for all support tabs. The pre-set values in this dialog are the
current values for a new tab, or in case a tab is selected the values of the
selected tab.

Boundaries of tab
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Here you can see the minimum and/or maximum values for X, Y and Z of the
selected support tab. The Z-values can be edited for any tab, the X and Y
values only for tabs that are oriented parallel to the X-axis or the Y-axis..

Finally the Boundaries of the geometry and the coordinates of the current
Mouse position are displayed, to assist you when entering coordinate values
for the support tab. 
All coordinate values can be displayed either in CAD coordinates or, when
your check Display translated coordinates, in NC file coordinates. The
difference is the translation that has been set on the Translate tab of the Part
parameters.

Notes:
It is possible to add your own support shape.
The base support tabs are present as STL files in files in C:
\ProgramData\DeskProto 8.0\Supports\
You can add any STL file here, and use that geometry as a support tab. For
instance a special shape that matches a fixture that you have made.
Important is that the geometry in this STL file must be sized to exactly fit
inside a cube of 1 by 1 by 1 mm: only then the dimensions that you will set in
this dialog will be correct (internally DeskProto creates the support by
copying, scaling and rotating the base support tab as defined in this file). This
1 x 1 x 1 mm is also true for inch users.

When using a DeskProto Script or a DeskProto Custom wizard it is possible
to create support tabs that are rotated around X and/or around Y. For such
tabs either editing is possible without the rotation options (when these
rotations were multiples of 90 degrees), or editing is not possible at all. In the
latter case you will not be able to open this dialog.

For software specialists: 
you can set the location of this supports folder as follows:
For Windows change registry key HKCU\Software\Delft Spline
Systems\DeskProto\8.0\Preferences\File Locations\SupportsLocation
For MacOS change line "8 0.Preferences.File Locations.SupportsLocation" in
file DeskProto.plist 
For Linux change line "Preferences\File%20Locations\SupportsLocation" in
section "[8.0]" of file DeskProto.conf.
Only edit the registry or these files when you are qualified and know exactly
what you are doing !
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4.2.2.3 Sync Geometry Support Tabs

The Sync support tab dialog offers options to synchronize the geometric
properties of all geometry support tabs.
You can reach this dialog by using the Sync all button on the Set Geomtry
Support tabs dialog. 

You can set the Shape, the Length, the Width, the Height and the Z-position
of the tabs:
pressing the Set button will change all tabs to the value shown in this dialog.

The Shape of the tab can be set using a combo-box (button with a drop-down
menu). As default five shapes are available: Block, Cone, Cylinder, Pyramid
and Wedge. The Cone, the Pyramid and the Wedge are asymmetric: one end
is much smaller than the other end. The tab will be connected to the
geometry with its smallest side, making it easy to finish the part after
removing the support tabs.

The Length, the Width and the Height are the dimensions of the tab - at
least for a block-shaped support tab. For the other shapes these are the
dimensions of the bounding box. When changing the dimensions of the
selected block, the center point of the block will remain the same.

The Z-position of the block cannot be seen in the top view that this dialog
shows as a default: change it to front view or side view to see the-position.
Here as well a combo-box button, offering the options Top, Centre, Bottom
and Automatic.
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4.2.2.4 Items Visible for Set Graphically

In DeskProto a number of dialogs are present that show a drawing of the part
in order to graphically set a parameter:
Set Material block (Part parameters)
Set Support tab (Part parameters)
Set Center (Operation parameters, for strategies Circular and Radial)
Set Area (Operation parameters)
Set Freeform area (Operation parameters).

When graphically setting a parameter it may be handy change which items
are visible in the drawing. This dialog allows you to switch each of the
available items on and off.

For more information on any of the options in this dialog see the Help page of
the Items Visible dialog for the main screen.
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4.2.2.5 Set Material Block / Area

This dialog is used for two settings in DeskProto, each with a different name.
The contents of the dialog is identical though.
The dialog Set Material Block makes it possible to graphically set the size
and position of the material block. You can reach this dialog by using button
'Set Graphically' on the Material tab of the Part parameters dialog, or button
'Detail settings' on the Material page of one of the wizards.
The dialog Set Area makes it possible to graphically set the size and position
of a rectangular area to be machined. You can reach this dialog by using
button Set Graphically on the Area tab of the Operation Parameters dialog.

The dialog shows a new drawing of your part, with a rectangle that indicates
the block or the area that you are editing. You can edit the rectangle by
'picking' one of the sides with your mouse and then moving it (as default the
button 'Adjust boundary' now is active). Only the six main views can be
displayed, as only then the block to be edited is drawn as a rectangle.

Using the buttons on the right you can change the drawing. Twelve of these
are standard DeskProto buttons to set the viewpoint and the mouse function,
of which the use is known and needs no explanation here. Note that mouse
rotation is not present: this dialog only uses the six main views.



DeskProto Reference

Page 166

The first button on the first row shows the Items visible icon that is
also used in the main window. This icon however opens a special version: the
'Items visible for Set Graphically' dialog. It will be clear that here you can
select the items to be shown in the drawing.

The first two buttons on the second row call the main functions of this dialog:
graphically setting the block or area. Note that these are “mouse buttons” as
well: of the five mouse buttons only one is active at any time.

This button sets the mouse function to Resize the current block or
area by dragging each of the four sides to a new position.

This button sets the mouse function to drag a complete new
rectangle to define a New block or area.

You can also set the new block or area by entering minimum and/or
maximum values for X, Y and Z in the six edit boxes. The boundaries of the
current part are shown to assist you, as are the coordinate values of the
current mouse position.

As a block/area is rectangular and aligned with the main axes, this resizing
only makes sense in the six main views (looking along X, Y or Z): other
viewpoint positions are not possible in this dialog. For each of the main views
of course only two coordinates can be changed: to change the third as well
you have to select a different main view using one of the six view buttons.
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4.2.2.6 Panning Alignment

This dialog is used both for the Vector settings (Align Vector Data) and for
the Bitmap Settings (Align Bitmap Data), and can be reached using the
"Align to..." button in the Part parameters: for Vector on tab page Transform,
for Bitmap on tab page XY Transform. 

When you use more than one type of CAD data for one part, it may be
needed to align these data types with one another. This dialog makes such
alignment easier.
Only alignment by panning along X and Y is supported (so aligning in a top
view), panning along Z and rotating the data are not possible here.

The thing that will be aligned is the Bounding box of the Vector curves
respectively of the Bitmap image.

This bounding box can be aligned with one of five entities:
· CAD zero point. Always possible.
· Vector data. The bounding box of all vector curves. Only available for

bitmap data, in case one or more vector files have been loaded as well.
· Geometry data. The bounding box of all geometry. Only available in case

one or more geometry files have been loaded.
· Bitmap data. The sides of the bitmap image. Only available for vector

data, in case a bitmap has been loaded as well.
· Material block. Only available in case a custom block has been defined.
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For X-Alignment three options are present:
· Left means that the Left side of the Bounding box will be aligned with the

left side of the entity.
· Center means that the Center of the Bounding box will be aligned with the

center of the entity.
· Right means that the Right side of the Bounding box will be aligned with

the right side of the entity.
The CAD zero-point does not have a side, so here the Bounding box will be
aligned with the point.

For Y-Alignment the options are called Back, Center and Front, but are in
fact the same as for X.

4.2.3 Operation

4.2.3.1 Vector Operation Parameters

DeskProto features three different types of Operations: this dialog is for the
Vector Operation - in addition also dialogs for a Geometry Operation and for
a Bitmap Operation are available.

The Vector Operation parameters are divided into 8 sections by tab pages.  In
the Free edition of DeskProto only the first three tab page are available,
offering less parameters than the Expert and Multi-Axis editions. In the Entry
edition only the Advanced tab is missing.

This dialog can be reached via the Parameters menu, third option.
Or you can double-click on a vector operation line in the project tree (one of
the third level items).
Or right-click on a vector operation line and select Operation Parameters in
the context-menu.

This same dialog is used for the Default Vector Operation parameters, only
with an extra button Restore DeskProto defaults to reset the original default
parameters.

General parameters
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Name
Here the name of the operation can be changed: use a meaningful name to
easily remember the purpose of each specific operation. The name is meant
for your convenience, normally it is not used in the NC program file. 
Two exceptions: you can write the name in the NC file (in a comment line)
using a postprocessor placeholder, and in case the NC output is in more than
one file (for instance due to a cutter change) DeskProto will add operation
names to the NC file names.
  
Cutter
You can select a cutter from the cutting tool library using the small arrow
button at the right. Adding new cutters to the library, changing an existing
cutter or just retrieving information on a cutter can be done in the Cutter
library (button Library).

Curve info
The Vector data that has been loaded consist of a number of vector curves. In
order to use curves for toolpath calculation they need to be selected first: for
Profiling, for Pocketing, V-Carving and/or for Drilling. It is possible to
combine two or more of these four toolpaths types in one Operation. In case
no curves have been selected the Vector operation is invalid as then no
toolpaths can be calculated. Selecting curves cannot be done on this tab page,
only on the four tab pages just mentioned.

Speeds
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The Speed settings are identical to the settings offered in the Geometry
Operation Parameters: see the explanation on Feedrate and Spindle Speed
there.
An option to reduce the feedrate for plunge movements can be found on the
Advanced tab.

Laser
When you have selected a laser cutter one more group of settings is present.
The S-value (which replaces the spindlespeed) sets the power of the laser.
The range is set in the Machine definition, it can for instance be a percentage
(range 0 - 100).
The Pass count is used when your laser is too weak (power too low) to
achieve the burning that you need: you then simply can make it follow the
same toolpath more than once.

Z settings parameters

The Machining depth defines the Z-coordinate for the actual toolpath. You
can describe this as the pen-down level when plotting a 2D vector drawing.
The depth is measured from the top of the block. This means that a positive
value does not make sense here. Two exceptions are present: 
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· when you have checked the option 'Use Z-values' (in the Project
parameters) the machining depth is measured from the Z-value of the
curve

· when you have checked the option 'Project vector curves on 3D part
geometry' (see below) the machining depth is measured from to the height
of the geometry.

This will be shown in the dialog: the screenshot above shows the second
exception.

The option Project vector curves on 3D part geometry (not available in the
Free and the Entry edition of DeskProto) is ideal for instance to engrave a
logo or text onto a 3D design: the 2D vector curves will be converted into 3D
toolpaths. When you check this option, the Machining depth is no longer
interpreted as a constant Z-level, however is taken relatively to the Z-level of
the geometry at that point. So a level of –1 mm results in a groove of that
depth over the 3D part.
The projection is vertical, meaning that on curved surfaces the 2D drawing
will be distorted: a circle that is projected on a sloped surface will be changed
into a ellipse. 
For this projection DeskProto will take into account the shape of the cutter in
3D.
This option is only available when geometry has been loaded, and when at
least one Geometry Operation is present before this Vector operation. This
Geometry Operation is needed to make sure that all material above the
geometry has been removed. 
When the vector data contains Z-values and in the Project parameters the
option "Use Z-values" has been checked, the use of this option "Project
vector curves on 3D part geometry" will make DeskProto ignore the Z-values
in the CAD-data.

In order to calculate such projected vector toolpath DeskProto needs to make
a Z-grid. The option Calculation Precision in XY allows you to set the
precision (the cell-size) of this Z-grid. The smaller the value entered, the
more accurate the Z-values of the toolpath will be, and the more calculation
time needed. This Z-grid will be calculated only for the area covered by the
vector file.

The Free movement height specifies the height at which the cutter can
freely move over the block, so without touching material. This is also called
the Safe height. As in the analogy with a pen plotter the machining level is
the pen-down level, the free movement height can be seen as the pen-up
level. This height is used to move the cutter from one position to another
without machining (positioning movements). It is set as the height above the
top of the block, so negative values are not permitted here. The positioning
movements will be done in Rapid mode (so at the maximum speed of the
machine).
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More information on positioning movements on the Movement tab of the
Geometry operation.

A special feature will be active when you select a laser cutter. For laser
engraving the laser has to be switched off during positioning movements.
DeskProto will do this automatically, using the commands as defined in the
postprocessor.

When the option Always stay low is checked, all positioning moves are done
at normal feedrate. When only Vector data is present the Z-level of these
positioning movements will not change: the specified height above the top of
the block. When a Geometry has been loaded as well the positioning
movement may be done below the top of the block: each movement then is
done at the Free movement height above the highest point of the geometry
over which the cutter moves. 
Always stay low can not be checked when Roughing layers are used.
For very small positioning movements DeskProto will not let the cutter rise to
Free Movement level, see the explanation on the Geometry Operation page.
This does not apply to laser cutters: then any positioning movement the laser
needs to be switched off..

Profiling parameters

Four different toolpath types can be generated based on the vector curves:
Profiling, Pocketing, V-Carving and Drilling. This tab page contains the
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settings for Profiling: the cutter will exactly follow each curve that is
selected.

Select curves allows you to specify which of the available vector curves
need to be used to generate profiling toolpaths.  
The options None and All will be clear. 
The option Layer refers to the layers in the DXF drawing (or rather the CAD
file), and provides an easy way to select all curves in a certain layer. Which is
convenient as in many design files all curves to be done by the same cutter
are combined in one layer. In case for a curve no layer information is present
in the CAD-file DeskProto will assign the curve to a layer called "(DP-
default)".
To make a Custom selection it is needed to open dialog Edit curve selection
using button Select.... 
The fifth option, to use the Selection of 1st Vector Operation, of course is
available only in case a first vector operation with such selection is present.

For Profiling it is not possible to select single point 'curves'. The drawing
above contains 8 vector curves: one single point (on the left side), five open
curves (the + consists of two curves) and two closed curves (on the right
side). Selecting All for this drawing will result in 7 curves being selected here:
all except the single point.

Three Strategy options are present, setting how to follow the curve:

Outside/left is meant to produce parts that exactly match the shape of each
curve: the profile of the part. So the cutter will move along a path that
follows the curve at exactly R mm distance (where R is the radius of the
cutter), on the outside of the curve. Outside of course can be defined only for
closed curves, for an open curve the cutter will travel on the left side of the
curve (as defined by the curve direction in the vector CAD file).
For closed curves inside this curve (so for nested curves) the cutter will travel
on the inside of the curve, creating holes in the part. The next nesting level
again will be with toolpath on the outside, and so on. DeskProto will start
machining the innermost curves and than work it's way to the outside, in
order to keep the part clamped when machining.

Inside/right is also meant to produce holes that exactly match the shape of
each curve: the profile of the hole. So the cutter will move along a path that
follows the curve at exactly R mm distance (where R is the radius of the
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cutter), on the inside of the curve. Inside of course can be defined only for
closed curves, for an open curve the cutter will travel on the right side of the
curve (as defined by the curve direction in the vector CAD file).
For closed curves inside this curve (so nested curves) the cutter will travel on
the outside of the curve, creating islands within the hole. The next nesting
level again will be with toolpath on the inside, and so on. DeskProto will start
machining the innermost curves and than work it's way to the outside, in
order to keep the part clamped when machining.

Strategy On curve means that the center of the cutter will exactly follow
each curve that was selected. The resulting shape(s) then will depend on the
diameter of the cutter that is used. Now DeskProto really acts like a pen
plotter. The cutter will exactly follow the lines as defined in the 2D vector
file, at a certain machining depth (pen-down level). For positioning moves in-
between the cutter rises to Z-free height (pen-up level).

All three strategies can also be used for vector curves that contain Z-values!
That is ideal for instance for trimming thermoformed parts. The toolpath will
copy the Z-value of each point in the curve and subtract the machining depth.
For strategies Outside/left and Inside/right the Z-value of the closest point in
the curve will be used. 
Take care: when curves and/or toolpaths at different heights share the same
XY position the algorithm may use an incorrect Z-value, so please check
your toolpaths when using this option for a 3D vector curve.

Cutting direction
For strategies Outside/left and Inside/right it is possible to choose between
Conventional, Climb and Shortest route. The  small drawings explain the
difference between these three options: it is about the relation between the
direction of milling and the rotation direction of the tool (normally
clockwise). The choice made here will affect the surface quality of the
machined profile, the best choice is different for each material. The option
Shortest route will use the direction that makes the positioning movements
from curve to curve as short as possible.
For strategy On Curve it is not possible to define Conventional or Climb, for
that strategy you can select either Original (as defined in the CAD file),
Reversed or Shortest route. In the latter case DeskProto again will optimize
to reduce the total distance for the positioning movements.

Support tabs
Support tabs can be used to keep the part connected to the rest of the block.
When cutting a closed profile at full depth in sheet material a separated part
will result: the material inside the profile is no longer is connected to the rest
of the sheet, and the cutter may send it flying away. Support tabs are
interruptions in the toolpath, acting as connection bridges to hold the part on
its place. This allows you to clamp the material on its corners and machine
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your parts, each on a different position, without the need to clamp each
separate part.

This tab page is about Vector support tabs, made by changing the machining
depth in a 2D toolpath. Not to be confused with Geometry support tabs,
made by adding small blocks to the geometry. 

Three options are present:
None will be clear: no support tabs
Default will automatically generate supports conform the Default Vector
Support tabs settings.
Custom allows you to exactly define the location and size of each tab, button
Set opens the Set Vector Support tabs dialog.
The edit box on the right will show the number of tabs, for all three options.

Vector support tabs are available only for vector curves without Z-values (2D
curves). So they also cannot be used when a 2D curves is projected on a 3D
geometry, or when for a 2D vector file the option "Use Z-values" has been
checked in the project parameters.

Pocketing parameters

Four different toolpath types can be generated based on the vector curves:
Profiling, Pocketing, V-Carving and Drilling. This tab page contains the
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settings for Pocketing: the cutter will remove all material within a closed
curve. The resulting hole in the block of material is called a pocket: hence the
name pocketing.

Select curves allows you to specify which of the available vector curves
need to be used to generate pocketing toolpaths.  
The options None and All will be clear. 
The option Layer refers to the layers in the DXF drawing (or rather the CAD
file), and provides an easy way to select all curves in a certain layer. Which is
convenient as in many design files all curves to be done by the same cutter
are combined in one layer. In case for a curve no layer information is present
in the CAD-file DeskProto will assign the curve to a layer called "(DP-
default)".
To make a Custom selection it is needed to open dialog Edit curve selection
using button Select.... 
The fifth option, to use the Selection of 1st Vector Operation, of course is
available only in case a first vector operation with such selection is present.

For Pocketing only closed curves can be selected, as an open curve does not
define a pocket. The drawing above contains 8 vector curves: one single
point (on the left side), five open curves (the + consist of two curves) and
two closed curves (on the right side). Selecting All for this drawing will result
in 2 curves being selected here: only the two closed curves.
When a curve that seems closed is in fact open you can find the error by
checking "Show points" for Vector curves in the Items Visible dialog. The
start point of the curve will be indicated by a larger dot. Closed curves do not
have a starting point, so when you see a large dot it indicates a gap in the
curve.

Two Strategy options are present to create a pocket:
The Offset strategy fills the pocket with toolpaths that follow the shape of the
outside curve (the contour that defines the pocket).
The Parallel strategy fills the pocket with toolpaths parallel to the X-axis.
Each strategy is clearly illustrated by the small icon drawing in the dialog.

Each of these two strategies has its own set of Strategy detail settings.

For Offset:
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For the start and the end of the toolpath you can select one of three options:
- Offset toolpaths normally start with the outmost path and then progress to
the middle: Outside - in,
- the reversed option is to start in the middle and progress to the outmost
path: Inside - out,
- and the third option alternates these two per roughing layer, thus preventing
positioning movements when several roughing layers are present:
Alternating per layer.
The Stepover is the distance between two parallel toolpaths. It is set as
percentage of the cutter diameter (flute diameter). So for a cutter of 10 mm
diameter, a Stepover of 50% will mean a toolpath distance of 5 mm, and 80%
will mean 8 mm. Using a flat cutter the pocket will have a flat bottom. With a
ballnose cutter cusps will remain between the toolpaths. And with conical
cutters the default Stepover value of 50% will be far too high - conical cutters
are not optimal for pocketing anyway.

For Parallel:
Again you can select one of three options for the start and the end of the
toolpath:
- Parallel toolpaths normally start minimum Y and continue to maximum Y:
Front to back, 
- the reversed option starts at the maximum Y: Back to Front,
- and the third option alternates these two per roughing layer, thus preventing
positioning movements when several roughing layers are present:
Alternating per layer.
The Stepover setting is the same for both strategies (see above), set as
percentage of the cutter diameter (flute diameter).
For parallel paths a third setting is available:
Parallel toolpaths as said are parallel to the X-axis, the option Angle with X-
axis allows you to change this.

The Cutting direction applies to the toolpaths when emptying the pocket. So
for Offset toolpaths outside-in (that start with the outmost path and proceed
to the center of the pocket) the actual cutting direction on the outer profile of
the pocket will be the reverse.

For both strategies it is possible to add a finishing toolpath that follows the
contour of the pocket. This can be done on the Roughing tab: after setting an
Allowance such Profile path can be added in order to remove the allowance
and make the pocket smooth. 

V-Carving parameters
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Four different toolpath types can be generated based on the vector curves:
Profiling, Pocketing, V-Carving and Drilling. This tab page contains the
settings for V-Carving. As this is a completely different way of using the
CNC milling machine, please read the V-Carving page before using this
toolpath type.
The settings on this page are available only when a conical cutter ( 'V-
cutter') has been selected for the operation, otherwise all settings will have
been 'grayed out'.

Select curves allows you to specify which of the available vector curves
need to be used to generate pocketing toolpaths.  
The options None and All will be clear. 
The option Layer refers to the layers in the DXF drawing (or rather the CAD
file), and provides an easy way to select all curves in a certain layer. Which is
convenient as in many design files all curves to be done by the same cutter
are combined in one layer. In case for a curve no layer information is present
in the CAD-file DeskProto will assign the curve to a layer called "(DP-
default)".
To make a Custom selection it is needed to open dialog Edit curve selection
using button Select.... 
The fifth option, to use the Selection of 1st Vector Operation, of course is
available only in case a first vector operation with such selection is present.

For V-Carving only closed curves can be selected, as an open curve does
not define a pocket to be V-Carved.
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When a curve that seems closed is in fact open you can find the error by
checking "Show points" for Vector curves in the Items Visible dialog. The
start point of the curve will be indicated by a larger dot. Closed curves do not
have a starting point, so when you see a large dot it indicates a gap.

The Cutting direction applies only when a horizontal bottom surface is
present in the V-groove, caused by the maximum depth that you have set. It
applies to the toolpaths that machine this surface (which is in fact a pocket),
not to the paths that machine the walls of the V-groove.

Two Strategy detail settings are available for V-Carving:

You can set a Depth limitation for the V-groove to be machined. 
When V-Carving the depth of the groove is determined by the angle of the
cutter and the width of the groove as defined in CAD. Field Unrestricted
depth will show the maximum depth of the V-Carving toolpath for your
settings. This information is available only after you have calculated the
toolpaths.
The default depth limitation is Use Z-depth. This means that DeskProto will
use the Machining depth (that you have set on tab Z-settings) as maximum
depth. When that depth is less than the unrestricted depth the resulting
groove will have a flat bottom.
The maximum depth limitation that you can set is the Material bottom, as
making a V-groove that is deeper than the bottom of the block is not possible.

The Stepover is the distance between the toolpaths when machining a
horizontal bottom surface. This applies only 'when needed', so only in case
such horizontal bottom is present. The value that you enter is a percentage of
the diameter of your cutter. Machining this bottom is in fact a pocketing
operation, and conical cutters are not very suited for pocketing as they will
not create a flat bottom surface. Not even with the low default Stepover
value of 5%.  You can make the bottom flat by adding a Cleanup operation,
as described below.

The last setting in this group is the Curve depth. This is a setting that needs
to be used only when you are creating the male part of an Inlay. It is a
setting to position the curves to be followed by the cutter at a certain distance
(in Z) below the top of the block. The inlay page explains in detail how this
works. 
For normal V-carving this setting should remain 0.0, meaning that the curves
are positioned on the top surface of the block. Then the V-Carving toolpaths
will create sharp corners on this top surface, where they will be visible as
designed in the artwork. 
Some other CAM programs call this Curve depth the 'Start depth'. DeskProto
does not, as the roughing layers for curves at a certain curve depth will start
at the top of the block, so that is in fact the Start depth.
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Finally you will see that an extra button is present on the V-Carving tab: Add
cleanup operation.... This button opens a dialog that allows you to add an
extra operation to this part: a 'cleanup operation'. This is meant for V-Carving
operations where the V-Carve has a flat bottom, so the button is activated
only which such flat bottom can be present: with a restricted Z-depth. 
The V-cutter that is used cannot machine a flat bottom surface, as the V ends
in a sharp tip. The cleanup operation will use a flat endmill and pocketing
toolpaths to clean it up: make this bottom surface flat. DeskProto will
automatically enter the correct settings in the pocketing operation that will be
created.
When you have added a cleanup operation the text on the button will change
to Update cleanup operation, and so will its function. The Update button
will be activated when a relevant setting in the V-Carving operation has
changed.

Drilling parameters

Four different toolpath types can be generated based on the vector curves:
Profiling, Pocketing, V-Carving and Drilling. This tab page contains the
settings for Drilling: the cutter will move along the Z-axis and drills a hole in
the block, at the XY location as defined in the drawing, and a depth as
defined on tab Z Settings.
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Select curves allows you to specify which of the available vector curves
need to be used to generate drilling toolpaths.  
The options None and All will be clear. 
The option Layer refers to the layers in the DXF drawing (or rather the CAD
file), and provides an easy way to select all curves in a certain layer. Which is
convenient as in many design files all curves to be done by the same cutter
are combined in one layer. In case for a curve no layer information is present
in the CAD-file DeskProto will assign the curve to a layer called "(DP-
default)".
To make a Custom selection it is needed to open dialog Edit curve selection
using button Select.... 

For Drilling three types of curves can be selected: 
· single points (defining the XY position of the center of the hole)
· + signs (so two single lines that together form a + sign), where the length

of each line equals the cutter diameter and the lines intersect exactly in the
middle.

· circles with a diameter that equals the cutter diameter
The drawing above contains 8 vector curves: one single point (on the left
side), five open curves (the + consist of two curves) and two closed curves
(on the right side). Selecting All for this drawing will result in 3 curves being
selected here - that is only in case the diameter of the cutter is correct for
both the + and for the circle. For a cutter with any other diameter only one
curve will be selected: the single point.

Setting a Diameter tolerance may be needed to make the above selection
process work correctly. For instance a circle of 4.0 mm diameter in an inch
drawing may have been rounded to 0.1575 inch. When DeskProto uses the
exact diameter (0.1574803 inch) it will not find that circle. Clearly you
intended to use it, which is solved by applying this tolerance.

For most toolpaths the chips that are cut off the block can freely fly away.
Not so for drilling, as then the cutter or drill is surrounded by solid material
on all sides. This means that the grooves in the cutter at some point will be
completely filled with chips, which will soon be compressed to one almost
solid mass that will make cutting impossible. The solution is to regularly
retract the cutter to a position above the block, thus freeing the chips. This
process is called Peck drilling, as it resembles what a woodpecker does. This
parameter offers two sub-settings:
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Peck depth is the Z-distance after which a (next) retraction movement needs
to be done. You will need to enter a (positive) value here: the default value of
0.0 is not permitted.
The Retraction Z-value sets the height (above the top of the block) that will
be reached in the retraction movement.

Roughing parameters

Roughing is applied when the cutter cannot reach the required Machining
depth in one cutting movement, either because the cutter's cutting length is
not sufficient or because the material is too hard to machine all at once. The
total depth then will be reached in a number of cutting passes (layers), each
on a lower Z-level.
Roughing can also be used to achieve a high quality result: when the roughing
toolpaths have removed most of the material, leaving only a thin allowance,
the load for the finishing toolpaths will be low which will reflect on the
resulting quality (less vibrations in the cutter).
Roughing is not possible in case only curves for Drilling has been selected.

When you un-check Use Layers the cutter will immediately go down to full
depth. This choice is not allowed for the first Vector operation of a part:
DeskProto does not allow the cutter to remove more material (dive deeper)
than is possible for the cutter: its maximum layering height, as explained on
the Geometry roughing page. In case you are sure that sufficient material has
already been removed to allow skipping the layers (for instance by a
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Geometry Operation) you can add an extra Vector operation to the part,
before the current operation, and make it invisible (an unused dummy
operation).

The Layer height that is specified determines how deep the cutter may go
into the full material. You can set this Layer height to the Maximum for the
cutter or to a Custom value. The custom value may not be higher than this
maximum. The default layer height equals the Maximum layering height,
which for flat cutters equals its cutting length bur for ballnose cutter is a bit
less (as explained on the Geometry roughing page). In most cases it is
preferable to use a smaller Custom  layer height, as with a tough material you
do not want the cutter to use its total cutting length. As a rule of thumb you
can set the Layer height equal to the cutter's (flute) thickness.

For Geometry toolpaths and Bitmap toolpaths the roughing layers are
completely machined, one by one, from top to bottom (unless you check the
option 'Complete all layers per island').
For Vector toolpaths the Roughing Layers are machined in a different way:
the layers are machined per separate curve, of course again from top to
bottom. Only "nested curves" are treated as one group: the complete "nest" is
done layer by layer. Like in the image above, where this sequence will be
followed: layer 1 for the D 'nest', layer 2 for the D, layer 1 for the E 'nest',
layer 2 for the E, currently machining layer 1 for the S nest (the red dot
shows the current cutter position), and so on.

The Ramping angle is used when starting to machine. The cutter will first
move to the correct XY position: exactly above the first point to be
machined, on the Free movement height Z-level. Then the cutter will move
down to that first point to be machined, which is normally done in one
vertical downward movement (plunge).
Such vertical downward movement is not ideal: many cutters do not like that,
and the chips cannot escape from the deep round hole that is created.
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Entering a Ramping angle makes DeskProto replace this vertical movement
by a series of ramping movements: go down along a sloping line. See the
small picture in the dialog for this option. You can set how steep this sloping
line needs to be by entering an angle value in degrees: this is the angle
between the sloping line and a horizontal line.
The ramping angle and the length of the vertical movement determine the
length of the horizontal component of the ramp. When this horizontal
component is less than 10% of the cutter radius DeskProto will not apply
ramping.

Setting an Allowance keeps a cutter at that distance of the actual curve when
roughing. The allowance prevents that the cutter takes away too much
material (this can happen as the cutter will vibrate and may bend when
roughing). The allowance also improves the resulting surface quality, as
during finishing the tool will remove the same small amount of material all
the time. It is the equivalent of the Skin in a Geometry operation, however
applied only to X and Y.

When an Allowance is set it is possible to Add a finishing path to the
operation. This path will follow the exact curve and remove the allowance,
using the same cutter.  In order to finish with a different cutter (for instance
smaller in case of small details) you need to use separate operations for
rouging and finishing. When Pocketing, this finishing path will be a Profiling
path (as the allowance is XY).

For this finishing profile path you can finally define the Direction of milling:
Shortest route, Conventional or Climb, see the explanation above (tabs
Profiling and Pocketing). This setting does not apply for V-Carving toolpaths.

Advanced parameters
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Start / End offers the option to add extra commands to the NC program
before the operation toolpath starts and/or after it has ended. These
commands can be movement commands and/or user defined commands.
They can be used for instance to make the cutter move to a safe position
before rotating the 4th axis, or to add comments using the Postprocessor
placeholders. Button Settings... will open the Operation Start/End settings
dialog.

The Feedrate for plunge-movements makes it possible to decrease the
feedrate when the cutter moves downwards. This may be needed when
machining in metals, as fast plunge movements may damage the cutter (many
cutters have problems with drilling). It is expressed as a percentage of the
normal feedrate for this operation. 
The rate you enter here will be used for movements that go down along an
angle that is more than (steeper than) 30 degrees. 
For downward movements along an angle less than 30 degrees the reduction
will be smaller: DeskProto will apply the rate as specified + 20.  So when you
have set the plunge rate to 40 %, these movements will be reduced to 60 %
of the normal feedrate.
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4.2.3.2 Geometry Operation Parameters

DeskProto features three different types of Operations: this dialog is for the
Geometry Operation -- in addition also dialogs for a  Vector Operation and
for a Bitmap Operation are available.

The Geometry Operation parameters are divided into 7 sections by tab pages.
The further to the right, the more advanced the parameters in the tab. In the
Free edition of DeskProto only the first tab page is available and In the Entry
edition only the first and the third tab page, offering less parameters than the
Expert and Multi-Axis editions.

This dialog can be reached via the Parameters menu, third option.
Or you can double-click on a geometry operation line in the project tree (one
of the third level items).
Or right-click on a geometry operation line and select Operation Parameters
in the context-menu.

When a geometry operation is part of a Chain with more than one geometry
operation, an extra button will be present: Apply to chain. After changing
one of the operation's parameters, for instance the Strategy, you can press
that button in order to apply this change to all geometry operations in the
chain.
Note: this button is present only in geometry operations, and it will not affect
any bitmap operations and/or vector operations in the chain.

This same dialog is used for the Default Geometry Operation parameters,
only with an extra button Restore DeskProto defaults to reset the original
default parameters.

The Geometry Operation parameters are identical to the Bitmap Operation
parameters. The Geometry Operation applies them on the Geometry, the
Bitmap Operation applies them on the Bitmap relief.

General parameters
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Name
Here the name of the operation can be changed: use a meaningful name to
easily remember the purpose of each specific operation. The name is meant
for your convenience, normally it is not used in the NC program file.
Two exceptions: you can write the name in the NC file (in a comment line)
using a postprocessor placeholder, and in case the NC output is in more than
one file (for instance due to a cutter change) DeskProto will add operation
names to the NC file names.

Cutter
You can select the Cutter to be used from the a list (that will open when you
click on the currently selected cutter). Which cutter is best depends on how
the geometry is shaped. Generally speaking:
- For freeform surfaces use ballnose cutters to reduce the staircase effect.
- For ‘straight/square’ geometries use a flat cutter to get flat horizontal
surfaces and sharp inner corners.
The larger the cutter, the smoother the resulting surface and the faster the
machining. Use small cutters only in case of small details. You can also use a
large cutter for the complete part and a small cutter later, for some detailed
areas.
Adding or removing cutters to/from the list can be done in the Cutter library
(button Library), where you can also view and edit existing cutter
definitions.

Precision
Here you can enter the accuracy to be applied. Two parameters are present: 
Distance between toolpaths (also called the Stepover)  and  Stepsize along
toolpath (each path is built as a large series of movements, each step being a
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very small straight line). In most cases both distances can be set on the same
value. The smaller these two distances, the more accurate the model,
however also proportionally more time will be needed for both calculation
and milling.  
In case you have selected to use the rotation axis, one of both precision
values should in fact be an Angle in degrees. Still, as this is easier to imagine,
a distance in mm or inch is used. DeskProto will convert this value to degrees
at the outside of the (cylindrical) area to be machined.

An example will illustrate why this is called Precision: in case the distance
between the toolpaths is set to 1 mm and a cube of 10.5 mm has to be
machined, this is not possible: the resulting cube model will be either 10 or 11
mm (DeskProto will in fact make it 11). This inaccuracy is a drawback of the
algorithm that DeskProto uses. Which is compensated by its advantages such
as calculation speed and robustness.

The precision values used will be rounded to a value that is calculated by
dividing the diameter of the cutter by an odd number. The 8 predefined
values offered in the pull-down menu match this formula. You may enter a
custom value as well, which in case it does not match the formula will be
rounded to the first smaller value that matches. The reason to use this
formula is that the resulting (physical) part will be more accurate, due to the
grid-based algorithm used by DeskProto for its calculations. Both the
geometry and the cutter are represented by a grid with the same grid-cell size,
and then the cutter diameter exactly matches an odd number of grid-cells the
results will be most accurate.

For example: When the diameter of the cutter (D) is 4.0, and you enter a
precision value of 1.0, it will be changed to 0.8 (D/5 = 0.8). The value of 1.0
that you have entered will nevertheless be saved in the project. So when you
later change the cutter, the precision will still be (close to) 1.0. For advanced
users some detail precision settings ("subsampling") are available on the
Strategy tab page. These will enable you to use a precision that is higher than
the toolpath distance.

Note 1: 
In this calculation the flute diameter of the cutter is used (so not the shaft
diameter or the tip diameter).
Note 2: 
Be careful with a large Stepsize. The cutter will move in a straight line to the
next calculated position, so a large step might damage some in-between
geometry. This is most likely to happen in case of vertical walls, and can be
corrected by the option Protect vertical surfaces.
Note 3:
When a Skin is applied in the Roughing parameters, the diameter of the
resulting virtual cutter is used in this division. Say you use a ballnose cutter
with a 6 mm diameter, and a skin of 0.5 mm.  Then DeskProto will do the
calculations with a virtual cutter of 7 mm diameter (radius 3.0 + skin 0.5 =
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3.5). This means that the first option in the combo-boxes (drop down menu)
for Precision now will be "7.0 (d/1)" As this is larger than the diameter of the
actual cutter, this first option will be deactivated (grayed out).
Same for other cutter types, though then adding the skin will change the
geometry of the virtual cutter (sharp corners will be rounded).

Speed
The Feedrate is the speed with which the cutter moves through your
material. The value you enter here must be between the minimum and
maximum feedrate values permitted for the machine you selected for the
project. 
Distinguish the feedrate from the actual cutting speed of the tool’s cutting
edge, which is determined by the rotation speed (spindle speed) and the
diameter of the cutter. 
The units used for setting the Feedrate in this dialog are set Preferences. The
units for the Feedrate used in the NC file are set in the postprocessor of the
machine that you selected for your part. If these settings are different
DeskProto will convert the value that you enter. Whether or not you can use
decimal values (numbers behind the decimal point) for the Feedrate depends
on the postprocessor settings: on the Feedrate page you can define whether
or not decimals are used.

Generally speaking a tougher material will require a lower feedrate. Same for
a smaller cutter. Very useful are the options is to let DeskProto automatically
reduce the Feedrate in high chipload conditions or for plunge movements, on
Tab page Movement of this dialog.

The Spindle speed is the rotation speed of the cutter. The unit is rpm, which
stands for rotations per minute (or rounds per minute). The value you enter
here must be between the minimum and maximum spindle speed values
permitted for the machine you selected for the project. The smaller the
diameter of the tool, the higher the spindle speed that is needed to get the
same actual cutting speed of the tool’s cutting edge.
Some of the machines that offer a laser engraving option use the
Spindlespeed value to set the laser power when the laser option is active. 

Note: 
It is possible to check Automatic Speed setting for a cutter in the Cutter
definition. In that case when the cutter is chosen the Feedrate and Spindle
Speed will be set automatically. That is quite useful for very thin cutters that
need a low feedrate and a high spindle speed as otherwise you could forget to
set the correct speeds and break your cutter.
Note:
Each Speed option is only available in case your machine supports it, if not
the option will be grayed out in this dialog. For instance on many machines
the Spindle speed cannot be set from the computer but only using a knob on
the machine. This setting (so whether or not this is possible on your machine)
can be made in the Postprocessor dialog (Options menu).
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Strategy parameters

The eight available Main strategies should be clear from the pictures drawn
in the dialog. Each main strategy (shown at the left) has its own Detail
settings at the right.

Parallel 
Parallel toolpaths is the default strategy: DeskProto will project a series of
parallel toolpaths over the geometry. This is the only strategy that is available
in the Free and in the Entry edition of DeskProto.
Detail settings for parallel are the following:  Along X-axis means toolpaths
parallel to the X-axis (so with a constant Y position), and Along Y-axis
means toolpaths parallel to the Y-axis. For each of these, two starting points
are available: start at the front side versus at the back side (reversed),
respectively start left versus start right (reversed). 
In addition an Angle with X-axis can be entered to create toolpaths that are
not parallel to X and Y, but still parallel to one another. The angle value may
not be negative: that result can be achieved by selecting Along Y-axis with a
different A-value. The Angle option is not available for rotation axis
machining.
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A very powerful detail setting for strategy Parallel is the Helix option. This
will only be shown for Rotation axis machining (so when in the Part
parameters "Use rotation axis" has been checked), replacing option "Angle
with X-Axis".  It will only be active (enabled) when:
· in the Rotary Machine settings option "A-values may exceed 360" has

been checked
· on tab page Movement either Conventional or Climb has been set as

Cutting direction
· the Parallel toolpath detail settings are either Around A or Around A

reversed
· The Area to be machined includes the complete cylinder (so range from

0.0 to 360.0 for A)
· you have a Geometry operation: the Helix is not supported in Bitmap

operations.

When this option is not checked, each toolpath around A will be at one
constant X-value. After one complete 360 degree rotation the cutter will
move along X to the next X-value and start the next toolpath. So two 90
degree corners for each rotation will result, which will slow down the milling
process. Checking the Helix option will change that and produce one long
toolpath without sharp corners: both X and A will show a continuous
movement, with the Z-value following the geometry. Perfect for shoe lasts,
fishing lures and many more rotary parts.

Using the Helix option combined with Roughing layers (and sorting) will not
give good results:  the Helix path will be interrupted when skipping what is
done in previous layers. Best is to use Helix only for finishing.
One more remark about the helix toolpath is that rotary positions on your
machine need to be exact. When a 360 degree movement on your machine
actually is 359.9 degrees, this difference will be invisible. However, after one
hundred rotations (so at A=36000 degrees) the error will be 10 degrees:
clearly visible. The result will be a twisted part, and finishing won't match
roughing.

The last detail setting for Parallel is the Surface sampling refinement: which
will be explained below.
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Crosswise

Second strategy is Crosswise. This is the same as creating two operations
where one of them uses parallel to X and the other one uses parallel to Y.
When you would use two operations there would be redundant calculations
though, resulting in longer calculation time: hence this strategy. This option is
useful in case the model you want to produce must have a very high surface
quality: the staircase effect resulting from the parallel X toolpaths will be
removed by the parallel Y toolpaths and vice-versa. 
As Detail setting you can choose which of the two directions has to be done
First, and here as well you can enter an Angle with X-axis.
The last detail setting for Crosswise is the Surface sampling refinement: see
below.

Block
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The Block strategy combines toolpaths parallel to X and Y to a sort of
rectangular 'spiral'. These are probably the most efficient toolpaths for
roughing, so the wizard will as a default select this strategy for its roughing
operations.
The Detail settings for block offer two options: inside out versus outside in,
sufficiently explained by the name and the small drawings, and Angle with
X-axis as just described.
The milling direction can be set on the page Movement tab of this dialog.
When machining Outside-in: Conventional will start left to right along X
(Counter-Clockwise), Climb will start front to back along Y (Clockwise).
The last detail setting for Block is the Surface sampling refinement: see
below.

Circular
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Circular is a completely different strategy: it does not use the rectangular
base pattern (grid) that is applied in the above strategies. In top view the
toolpath shows true circles, projected onto the 3D geometry. For each XY
toolpath position the Z-value is calculated using a special radial Z-grid. Of
course that strategy is very well be suited for round geometries, like rings or
cups.

Detail settings are:
Inside out versus outside in (same as for block strategy)
Yes or no machine the corners: this concerns the area that is inside the
rectangular area to be machined but outside the largest circle that touches all
four sides of this area. This option is available only in case the Center has
been set inside the operation area: if not it will be "grayed out".
Yes or no make it a Spiral toolpath (in top view). This is a great strategy for
high speed machines as no sharp angles are present in the toolpath.
Set the Center point of the Circle/spiral toolpaths. Standard this point is set
in the center of your Operation area, however you can also choose the Center
of the Part's material block, or any Custom XY value. These custom values
then can be either typed or graphically set using the Set button. The center
point may even be outside the block.
Here as well the milling direction can be set on the page Movement tab of
this dialog: Conventional result in a counter-clockwise direction, Climb
clockwise (for outside-in).
If you want you can display and enter the values for the center in Translated
coordinates. When you have checked this checkbox the coordinate values
are displayed in the coordinates as used on the machine (after the Translation
has been applied). Checking or unchecking this checkbox does not influence
the toolpaths. It’s just a temporary conversion in this dialog to make setting
the centerpoint easier.
Strategy Circular is not available for rotation axis machining.
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Radial 

Radial is the complement of circular: same Z-grid, however now radial
toolpaths (so perpendicular to the circular paths). The same Detail settings
apply here as well, except for the Spiral. And the sequence of the toolpaths
now is called Clockwise versus Counterclockwise.
As milling direction now Meander is advised, as Climb and Conventional will
need a positioning movement after each path.
Strategy Radial is not available for rotation axis machining.

Offset 
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Offset machining generates toolpaths as offset lines to the contour round the
area to be machined.
This area can be defined using option Skip Ambient, using a (freeform) Area
to be machined, or using a combination of both. For a rectangular custom
area the paths will be similar to the Block strategy, for a round area the paths
will be similar to the Circular strategy. The power of the Offset strategy is
that this will work for any freeform area to create toolpaths that follow the
shape of the geometry.
You can for instance set a Freeform area and then automatically generated a
contour that follows the outline of the geometry (in a top view). The result
will be the same as when using Skip Ambient, however now the Border
settings can be used. Typical application example is machining corrective
insoles (to be worn inside shoes), which can be done very efficiently with
toolpaths parallel to the sole's outer contour.

Detail settings for Offset are: 
Inside-Out versus Outside-In will be clear, and Surface sampling
refinement will be explained below. 
This strategy produces a number of "parallel" toolpaths, and Smooth
toolpath transitions concerns the transition to each next toolpath. Normally
the last point of the finished path will be connected to the first point of the
next path, resulting in two 90 degree angles in the toolpath. On fast machines
this will cause the machine to reduce the feedrate at these points. This can be
prevented by checking the option Smooth toolpath transitions: DeskProto
then will ignore these last points and first points, and instead will connect the
last-but-one point of the finished path to the second point of the next path.
The result will indeed be a smoother transition. Be careful though: ignoring
two points for each transition may cause DeskProto to remove too much
material.
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Fill Gaps: the Offset toolpaths follow the outer contour of the area to be
machined, each next toolpath at the prescribed distance from the previous
one. In the center of the area the paths from opposite sides will meet, and
there the distance between the last toolpaths may be larger then this
prescribed distance, creating gaps in the toolpath pattern. See the small
drawing in the dialog. For flat cutters this will not be a problem, for ballnose
cutters at these gaps the cusp (ridge of remaining material) will be higher than
for the rest of the geometry. To prevent this unwanted situation you can use
the option Fill Gaps: then DeskProto will add extra toolpaths to also fill these
gaps.

Waterline 

Waterline machining produces toolpaths on a constant Z-level (just like the
waterlines over a ship’s hull). Such strategy is also called contour machining
or Z-plane machining. While the difference with toolpaths on constant X or
on constant Y seems small, in reality the difference is huge as a completely
different calculation algorithm is needed. In the Detail settings an extra
parameter is present: the Waterline distance (so the distance between two
toolpaths in Z-direction). The XY toolpath distance parameter as set on the
General tab page is used when horizontal surfaces (gaps) have to be filled. 

Important is to realize that only on each prescribed height level a toolpath
will be present. Imagine for instance a geometry with a horizontal top surface
and a hole in that surface (pocket) of 9.5 mm deep. Z=0 is at the top of the
part. When you set the Waterline distance at 2 mm, toolpaths inside the
pocket will be generated at Z=-2.0 , Z=-4.0 , Z=-6.0 and Z=-8.0  So the depth
of the resulting pocket will be 8 mm, not 9.5 as in the Geometry.  You can of
course calculate a Waterline distance that will give a better result: 9.5/5 = 1.9
mm instead of 2.0 will result in a hole of exactly 9.5 mm deep.
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A second waterline parameter is the choice between Top to bottom: start at
the highest point and work down, and Bottom to top: start at lowest Z-level
on the outside of the block, and work towards the top.
Finally the Detail parameter Fill gaps is present. This option needs some
explanation. As waterline toolpaths have a fixed Z-distance in-between each
two toolpaths, at (almost) horizontal surfaces there might be a large distance
between two toolpaths: a gap. This gap may even be larger than the diameter
of the cutter: resulting in islands of material remaining after completing that
operation. The option Fill gaps checks where the horizontal distance is too
large, and fills the space with toolpaths at a distance as specified on the
General Tab. All these in-between toolpaths will have the same Z-value, so a
visible staircase effect will be the result. 
The sub-option Use geometry Z reduces this staircase effect by calculating
Z-values for all toolpaths that are created to fill the gap.
The Surface sampling refinement will be explained below. 

Contour only

The last strategy, Contour only, is in fact an additional strategy as it does not
machine the complete part: only the outline of the geometry (outer contour)
at ambient level is machined. This can be used after some other strategy: to
smoothen the model (when DeskProto creates toolpaths that are parallel to
the X- or Y-axis, at places where the outside surfaces are almost vertical the
contour can show a staircase effect). You can also use it for "Pre-roughing"
the material: Give your block the correct outside shape before you start
roughing, which will reduce the amount of chips.
You can use detail setting Offset to have the Contour line toolpath keep a
certain distance to the geometry: add a skin, however then only for X and Y.
Just as for a Roughing skin defining an offset will change the pre-set
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Precision values, as the offset is achieved by using a different cutter diameter
for the calculations.
Detail setting Ignore enclosed contours does exactly what its name suggests:
when a hole is present in the geometry the normal result for this strategy will
include a contour path within this hole (nested contours). Checking this box
will make DeskProto create a toolpath only for the outer contour.

Surface sampling refinement
The Surface sampling refinement parameter that is offered for some strategies
is meant for advanced users, as normally the default values are appropriate.
After checking the box you can use the Settings button. As a result the
Surface Sampling refinement dialog will be shown that allows you to fine-
tune the cell-size of the Z-grid, which will influence the calculation precision.

Roughing parameters

Roughing stands for quickly getting rid of most of the material without milling
very precisely. So after an roughing operation you will need a second
operation that machines the same area more accurately: the finishing
operation. In DeskProto you can use an operation either for roughing or for
finishing, so if you need both you will have use two operations, by adding one
in the General Part parameters.

Layers
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When roughing you want to make sure that the cutter does not cut too deep
into the material: deeper than the cutting length of the cutter is not permitted
(though for hard materials that will still be way too deep).
The roughing option Layer Height maximizes the cutting depth: instead of
trying to remove all material at once, this will be done layer by layer. Layers
are also known as roughing passes. The default layer height equals the
complete maximum layering height of the cutter, see the image below. In
most cases it is preferable to use a smaller Custom  layer height, as with a
tough material you do not want the cutter to use its total cutting length. As a
rule of thumb: set the Layer height equal to the cutter's (flute) thickness.

The image above shows why for ballnose cutters the Cutting length of the
cutter cannot be used as maximum for the layer height. When machining
layer 1 rest-material will remain at the ballnose top of the cutter, which then
in layer 2 would collide with the shaft of the cutter. In the image this collison
is shown in red. As the shaft of the cutter cannot cut this is not permitted. So
DeskProto uses a maximum layering height that is smaller than the cutting
length of this cutter. When this max layer height is smaller than the radius of
the cutter (and when roughing layers are applied) DeskProto will show a
warning that "the selected cutter may not be suitable for roughing layers".

For conical cutters the situation may be worse, as for such cutters often only
the conical section can cut (so no vertical cutting edge as in the above
image). For such cutters DeskProto will show the above warning when
applied in a roughing operation: the user then can decide whether or not this
is acceptable. Many jewelers for instance use only conical cutters ("V-bits"),
however for machining wax models this bit of rest material is no problem at
all. The warning is optional, so a jeweler can simply uncheck the "Always
show" checkbox for this warning.

The first Geometry operation of each part always uses layers.  This is done
automatically and cannot be overruled: DeskProto does not allow the cutter
to remove more material than possible for the cutting length of the cutter. For
subsequent operations you can un-check Use Layers: the cutter will then
machine at full depth all the time. 
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When you absolutely need a first operation without layers, and you are very
sure that sufficient material has already been removed to do this, you can add
an extra Geometry Operation to the part, before the current operation, and
make it invisible (an unused "dummy" first operation).
Note:
The first layer starts at the top of the material block. When your actual block
is higher than the part you can define a custom Material block in DeskProto,
having a higher Maximum Z value, to match the real block.

The option Complete all layers per island gives an alternative to the
standard sequence of machining layer after layer. As default DeskProto will
completely machine each layer before starting with the next layer. In some
cases that is not what you want: when the cutter machines on various
locations that are completely separated (for instance more than one geometry
or more than one freeform area). Each location then can be seen as an
'island', as a positioning movement is required to travel to the next island.
DeskProto then will need to perform many such positioning moves, which
makes the machining time longer than needed. Checking this option will
make DeskProto machine island per island: so it will complete all layers of an
island before moving to the next island.

The island status is determined using a rectangular XYZ bounding box round
the toolpaths. So when for two actual islands  the two bounding boxes
overlap DeskProto will not recognize their island status.

Other Options

Entering a Skin Thickness results in a model that is thicker: a skin is added
everywhere around the model, as an extra allowance. In this way the chance
that the cutter takes away too much material is reduced (this can happen as
roughing typically will be done using a low precision, and as the cutter will
vibrate and may bend during roughing). Using a skin also improves the
resulting  surface quality, as then when finishing the tool only needs to
remove the same small amount of material all the time. Internally DeskProto
processes the skin by applying a different size (and shape) cutter.

It is possible to set the Skin on a negative value, making the resulting part too
small. This is interesting in some special cases, like for creating electrodes for
EDM machining (spark erosion), or for machining a foam core to apply
modeling paste on for the final cut to size.
Of course entering a value of 0.0 means that no skin will be applied.

Warning on skin use: 
The skin is also applied on vertical surfaces, which in case of high vertical
walls may lead to a problem during finishing. When finishing the cutter
machines on full depth immediately, so it will try to take off the skin of the
complete vertical wall in one go. In case the wall is higher than the cutting
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length of the tool this is a problem - for which no automatic solution is
available yet. An easy workaround to solve it is to add an operation using the
waterline strategy (between roughing and finishing), milling from top to
bottom.

The Ramping angle is used when starting to machine. The cutter will first
move to the correct XY position: exactly above the first point to be
machined, on the Free movement height Z-level. Then the cutter will move
down to that first point to be machined, which is normally done in one
vertical downward movement (plunge).
Such vertical downward movement is not ideal: many cutters do not like that,
and the chips cannot escape from the deep round hole that is created.
Entering a Ramping angle makes DeskProto replace this vertical movement
by a series of ramping movements: go down along a sloping line. See the
small picture in the dialog for this option. You can set how steep this sloping
line needs to be by entering an angle value in degrees: this is the angle
between the sloping line and a horizontal line.
The ramping angle and the length of the vertical movement determine the
length of the horizontal component of the ramp. When this horizontal
component is less than 10% of the cutter radius DeskProto will not apply
ramping.

The option to Protect Vertical Surfaces is useful when roughing with a large
value for the Stepsize along toolpath. In case the steps are large they may not
“see” all geometry in-between and remove too much material. This may
happen in case of vertical or steep surfaces in the geometry. Checking this
option will replace any tool-movement steeper than 45 degrees by separate
horizontal and vertical component movements. Take care: on many machines
this may cause unwanted vibrations as smooth paths are replaced by
staircases, so only check this option in case needed.

A more advanced option to protect the Vertical surfaces (with a more
extensive explanation) is present on tab Advanced. There you can set how
steep the surface needs to be to activate this protection, by setting a
height/step ratio. In this roughing option the height/step ratio is 1, which
means 45 degrees. When this Roughing option has been checked the
Advanced option will be disabled, as that would be overruled by the
Roughing option.

Area parameters
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The Area to be machined offers exactly what its name tells you: it limits the
toolpaths for this Operation to cover only this area. It can be used for
instance for a small area of the part that is very detailed and needs to be
machined with a smaller tool in an extra operation. The geometry outside this
area (and within the part) will not be damaged. As you can see in the icon
pictures, the bounding box of the area is be drawn in green lines.

The image above on the left shows six edit boxes. This is how the page looks
in a part that uses three-axis machining. The area definition also applies to
the Z-axis, allowing you to set a maximum machining depth and height for
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the area. That can be handy: when your part has a flat top that does not need
machining you can set the Max Z for the area a bit (say 0.1 mm) lower than
the Z of this top surface: it then will fall outside the area to be machined.
For a part that uses rotation axis machining (4th axis) the page will show
ten edit boxes (image on the right), more about that below.

The default option here is Use material block (Part). This means that the
cutter will machine the complete block, as defined in the Part parameters.

When your material block is smaller or larger than the CAD data that you
loaded it may be handy to use the bounding box of the relevant data type as
area:
In a Geometry Operation this can be done by choosing option Use geometry
area.
In a Bitmap Operation this can be done by choosing option Use bitmap
area.

Two types of custom area are available:

Custom rectangular sets a rectangular block as area (when rotary machining
this is a cylinder). This block can be defined by entering the min and max
Boundaries in the edit boxes at the right, or graphically. 
Checking the option Display translated coordinates changes the numbers
that are shown for the area boundaries: these will now be in workpiece
coordinates as used on the machine, so after Translation. Only the numbers
shown here for input are changed, not the actual coordinate values in the
toolpath: it is just a temporary conversion on screen for setting the boundaries
more easily.
The button Set graphically pops up the Set Area dialog that makes it very
easy to set any area using the mouse.

The second type is the Freeform area. This option allows the use of areas
that are not rectangular, for instance a circle or any freeform contour
(circular resp freeformed in top view). Button Set freeform pops up the Set
freeform area dialog.
For a freeform area the Min and Max X and Y values shown as Boundaries
relate to its bounding box. The min and max Z can be set as for a rectangular
area. A freeform area is not possible for a part that uses the rotation axis, in
that case the option is not shown.

Final option is Use area of 1st geometry operation, of course active only for
second and further geometry operations in the part. This is a handy option for
instance when a complex Freeform area needs to be used both for Roughing
and for Finishing.

The area may not be larger than the block of material that has been defined
for the part, for any of the axes.
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As said above, for rotation axis machining the options on this tab page are a
bit different:
- an extra option is available: Use material block above rotation axis.
Which is many cases is all you need, as the area below the rotation axis will
be machined after rotating 180 degrees further.
- extra edit boxes are present for the min and max Radius and for the min and
max Angle. Only six of these can be edited: min and max Y and Z can only
be viewed. In order to make the cutter also machine below the rotation axis
you need to enter a negative value for the minimum R (radius).
When the minimum R is higher than zero the resulting area will have a
doughnut shape

Borders parameters

In order to machine all geometry in the area to be machined, the cutter needs
to move a small distance outside this area. This is needed as otherwise the
cutter cannot reach any (almost) vertical surfaces at the outside edge. The
small images in the dialog illustrate why this is needed. In DeskProto this
extra area called the Border area, and on this tab-page you can influence the
size of the border area. 
The Z-level used for the border area is set at the Ambient tab of the Part
Parameters. 
Note that you can also make the material block or the area larger to add extra
area to be machined.

The default option is Extra for cutter, which sets the border area size
exactly to what is needed to let the cutter go around the model, in order to
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machine all outside surfaces of the part (for an area that matches the part's
bounding box). 
In the four edit boxes you can see that this value matches the Radius of your
cutter. The cutter will of course cut at its full diameter, however here we
consider the position of the center of the cutter. And for this center the max
distance to the geometry is the Radius of the cutter.
The size of the Extra for cutter area is different when you have set an Angle
in the Strategy sub-settings (toolpaths at an angle with the X-axis or Y-axis).
We have found that the border area then needs to be larger, as otherwise the
cutter cannot completely move down on all sides of the part. How much
larger depends on the Angle that has been set.

The second option, No extra, keeps the cutter positions (for the centerpoint
of the cutter) exactly inside the area to be machined. Using this option it is
still possible that the tool cuts away material that lies just outside the area, as
half of the cutter reaches outside. DeskProto will anyway check that any
geometry that belongs to the Part is not damaged. 

The option Cutter stays within area means that the whole cutter will stay
inside the area to be machined. 

The last option, Custom, makes it possible to define the border sizes yourself,
using the four edit boxes. The values may  be positive values as well as
negative. For negative values there is a limit though, as obviously some area
that can be machined has to remain. Four boxes are available only if the area
to be machined is a rectangle, for a freeform area only two border sizes can
be set: one for X and one for Y. And for rotary machining only the two X-
borders can be set.

The use of the checkbox Uniform will be clear: it forces all four edit boxes to
have identical values.

Movement parameters
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The Cutting direction is important for the surface quality of the prototype.
The default direction is Meander, which means that (for parallel toolpaths)
the first movement is from left to right, the second from right to left, etc. The
tool keeps cutting all the time, so meander is the fastest option. For rotary
toolpaths cutting direction Meander results in a first movement from 0 to 360
degrees, next from 360 to 0, etc.

However, on the surface of the model you may see a difference between the
movements going from left to right (L-R) and the movements in the opposite
direction. The  surface will be smoother when all movements go in the same
direction. Obviously there are two possibilities here: L-R and R-L. The words
Climb and Conventional refer to the relation between the direction of the
cutter along the toolpath and the rotation direction of the cutter (normally
clockwise): see the small drawings in the dialog.
Note that choosing the option Climb or Conventional in fact does not
guarantee it to be used all the time: when machining a downward sloping
surface it is possible that in fact the back of the tool cuts the surface of your
part, thus reversing the actual cutting direction.

Meander is not possible for all strategies: for strategies Block, Spiral, Offset,
Waterline and Contour meandering cannot be selected, as for these strategies
it would not make sense. That is, unless the option Sort is active. When
sorting, also for these strategies some areas may be present where the
toolpaths can be optimized by making them meander. In these cases
DeskProto offers the Meander direction with the remark "only optimizes
sorting".
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You will have to test though whether or not this works for your project: in
some special cases selecting Meander will lead to extra positioning
movements, so to a longer toolpath.

The Free movement height is the Z-level at which all ‘non-cutting’ tool
movements will be executed, also called the "Safe height". This is for rapid
positioning movements over the part, for instance from the home position to a
position above the first point to be milled. The Z level you enter here is the
number of units (mm or inches) above the top of the material block. Only
positive values are allowed: in case of a negative free movement height the
model and/or the cutter could be damaged.
When a Skin has been set (Roughing) the free movement level will be the
Skin-thickness higher

This Free movement height (ZFree) value is used in three ways:
· The first point and the last point of the toolpath for each operation are

located ZFree mm/inch above the top of the Material Block. This is
needed to make sure that the cutter is high enough when moving to and
from these points, so instance to a next operation. These movements are
done in Rapid mode, which is permitted only above the block. 

· The positioning moves during an operation are performed at ZFree
mm/inch above the max Z of the Operation Area, or (in case that is
higher) above the max Z of the geometry within the XY limits of the
Operation area. This is done in order to speed up the process when
machining some detail area at a low Z level.

· When the option Always stay low is checked, the positioning moves are
performed at ZFree mm/inch above the highest point of the geometry
and/or bitmap relief over which the cutter moves in that movement. For
machines with a slow Z-axis this will save a lot of time. Also when on your
machine switching between Rapid and Normal movement is slow this will
save time, as these movements below the top of the block are done at
normal Feedrate. Always stay low is not possible when Roughing layers
are used.

Positioning movements:
Not all positioning movements are done on this Free movement level, as for
small distances this is not needed. The following movement types are applied
- DeskProto tries if type 1 can be used, if not possible try type 2, if not
possible use type 3:

1. Direct movement.
The cutter moves in a straight line between startpoint and endpoint of the
positioning movement.
This happens when:
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- the distance is less than 1.9 times the Toolpath distance ánd no geometry
with a higher Z-level is present on the path.
As toolpath distance is used (also for type 2 as described below): for
Geometry, Bitmap and projected Vector the Precision value, for normal
Vector the Pocketing Stepover distance (or its default, being 50% of the
diameter of the cutter tip).
or when:
- the distance is less than the cutter-tip-diameter ánd the toolpath is at
constant Z ánd no geometry with a higher Z-level is present on the path.
In both cases as tip value is used: for conic cutters the tip diameter, for other
cutters the flute diameter, in case no flute is present the shaft diameter. So for
conic cutters with a sharp tip this diameter is 0.0 and thus for such cutter no
direct movements are allowed here.

2. Lowered Z-height.
The cutter moves in a horizontal line, at normal Feedrate. The Z-height is Z-
Free mm/inch above the highest point of the geometry below this line,
including startpoint and endpoint (this does not work for a bitmap relief).
This happens when:
- the distance is less than 1.9 times the Toolpath distance (so when in type
1 geometry with a higher Z-level was detected on the path) ánd the cutting
direction is Meander.
or:
- the distance is less than the cutter-shaft-diameter ánd the cutting
direction is Meander.
or:
- the distance is less than 10 times the smallest of Toolpath distance, Cutter
tip diameter ánd the cutting direction is Meander.
or:
- in the Operation parameters the option "Always stay low" has been
checked ánd the cutting direction is Meander.
Exception: "Always stay low" is not (yet) possible when roughing layers are
applied, as then for some strategies the lowered positioning movement might
travel through un-machined material.
For Vector operations without geometry checking Always stay low will only
change the Feedrate, not the Z-height.
The condition "Cutting direction is Meander" does not apply for Vector
toolpaths.

3. Free movement height.
The cutter rises to Free movement height for a positioning move at Rapid
speed.
The Free movement height is Z-free mm/inch above the top of the operation
area or, if that is higher, Z-free mm/inch above the highest point of the part
geometry that the cutter travels over. The first point and the last point of a
toolpath are at Z-Free mm/inch above the top of the Material block.
This happens in all other situations.
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Positioning movements for special cutters:
For the Special cutters that you can use in DeskProto these rules for
positioning movements cannot be used. Two differences are present:
- saw cutters (saw-blade, chain-saw) can stay low in one direction but not in
the other: in the other direction even the smallest positioning movement
requires rising above the block. 
- laser cutters may never stay low when positioning, as only at free
movement level DeskProto will switch off the laser.

One last remark about the Free Movement height, for advanced users. While
in this dialog the user-interface offers the option Always stay low, in addition
a hidden option is present, called Never stay low. When for this value "true"
is found, DeskProto will let the cutter rise to Free movement height for every
positioning movement. Even when proceeding to the next toolpath. This
hidden registry setting will overrule the automatic 'NeverStayLow'
funtionality for the special cutters. When the string is "false" (or in fact any
other text) nothing will happen.
This option cannot be checked in the user-interface, in order to use it you
need to change this:
For Windows change registry key HKCU\Software\Delft Spline
Systems\DeskProto\8.0\Custom\NeverStayLow
For MacOS change line "8·0.Custom.NeverStayLow" in file DeskProto.plist 
For Linux change line "Custom\NeverStayLow" in section "[8.0]" of file
DeskProto.conf.
Only edit the registry or these files when you are qualified and know exactly
what you are doing !

The Dynamic Feedrate control is an advanced option of DeskProto: even
many so-called high-end CAM software packages do not offer this type of
functionality. It means that DeskProto is able to reduce the feedrate when
needed, thus making it possible to select a high overall feedrate without the
danger of breaking your tool at a critical point in the process. Two separate
options are offered. In both cases you can enter a percentage for the
maximum feedrate reduction, and in both cases DeskProto will choose in-
between feedrates whenever possible, thus always running at optimum
feedrate. Note that both options can be combined, in which case for certain
movements both reductions will apply, resulting in a very low feedrate.

With the Feedrate for plunge-movements it is possible to decrease the
feedrate when the cutter moves downwards. This may be needed when
machining in metals, as fast plunge movements may damage the cutter (many
cutters have problems with drilling). It is expressed as a percentage of the
normal feedrate for this operation. 
The rate you enter here will be used for movements that go down along an
angle that is more than (steeper than) 30 degrees. 
For downward movements along an angle less than 30 degrees the reduction
will be smaller: DeskProto will apply the rate as specified + 20.  So when you
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have set the plunge rate to 40 %, these movements will be reduced to 60 %
of the normal feedrate.

It’s also possible to decrease the Feedrate for high chip loads, which
happens when the cutter has to remove much material. Due to DeskProto’s
parallel toolpaths approach, normally the cutter only has to remove a small
slice of material: a thickness of only the distance between two toolpaths (the
stepover) is removed. However, in certain cases the cutter has to remove
material over its full flute diameter, which is a much higher chip load. For
instance for the first toolpath (as often the block will be a bit larger than
needed); also when for the first time entering a pocket in the model (so when
the tool suddenly moves much lower than during the previous toolpath, as
shown in the small image next to this setting). The chip load is even higher in
such cases as the chips cannot easily fly away but will be stuck in the groove
that is machined. 

In these cases the feedrate will be reduced, the actual reduction depending on
how much deeper the tool has to cut compared to the previous toolpath at
that position. Reduction is applied according to the following rule, where D is
the cutter’s flute diameter and Rate is the percentage that was entered. The
column "Example" shows the resulting actual reductions in case a value of 20
% resp 70 % has been entered. 

Difference in depth: Reduction percentage: Example:

For rates below 60 %:
Until 0.1*D 100 % 100 %
0.1*D - D Rate + ½ * (Rate)  30 %
D - 2D Rate + ¼ * (Rate)  25 %
more than 2D Rate  20 %

For rates of 60 % or higher:
Until 0.1*D 100 % 100 %
0.1*D - D Rate + 2/3 * (100-Rate)  90 %
D - 2D Rate + 1/3 * (100-Rate)  80 %
more than 2D Rate  70 %

So (explanation of the table above): reduction is applied only in case the
cutter machines deeper than in the previous toolpath, with a margin of 
0.1*D (10 % of the cutter diameter D). When between 0.1*D and D deeper
the first reduction step is applied, between D and 2D the second, and when
the difference is more than 2D the full reduction percentage is applied. In the
toolpath drawing on screen, the paths at reduced feedrate will be drawn in a
slightly different color (purple instead of red).

When you reduce the feedrate, the spindlespeed may become too high to cut
clean chips (instead the cutter will create dust and become very hot). This
can be prevented by checking an option on tab Spindlespeed of the
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Postprocessor: option 'Apply the Dynamic feedrate control percentages also
on the Spindlespeed'. DeskProto then will reduce the spindlespeed too, with
the same percentage.

The option Reduced feedrate for high chiploads is not available for all
strategies.
Not for all cutters either: for hot wire cutting it cannot be applied, so it will
then be disabled (grayed-out).
And these Dynamic Feedrate options are of course only possible on machines
that can set the Feedrate from the PC, which is determined by the
Postprocessor.

The Number of Reduced Initial Paths.
As mentioned above this option will also reduce the feedrate for the first
toolpath of an operation. When machining a flexible material (for instance
foam) it may be needed to reduce the feedrate for more than just this one first
toolpath. This has been implemented a "hidden feature", using a setting called
NumReducedInitialPaths, which sets the number of initial toolpaths to be
reduced. The setting will work only for strategies Parallel, Crosswise and
Block.

It can be switched on by editing this setting and giving it a value from 1
(default ) to 9:
For Windows change registry key HKCU\Software\Delft Spline
Systems\DeskProto\8.0\Custom\NumReducedInitialPaths
For MacOS change line "8·0.Custom.NumReducedInitialPaths" in file
DeskProto.plist 
For Linux change line "Custom\NumReducedInitialPaths" in section "[8.0]"
of file DeskProto.conf.
Only edit the registry or these files when you are qualified and know exactly
what you are doing !

DeskProto is able to Optimize the toolpaths using a Sorting algorithm. It will
then ignore the sequence as defined by the Strategy, and instead try to
complete series of tool-movements that are located close to one another. For
instance when you machine the Picture frame sample geometry using strategy
'Parallel to X', skipping the empty inside of the frame. The cutter then would
normally need to make positioning movements from the left to the right side
of the frame all the time. Sorting will make DeskProto first complete one
side, and only then start with the other side: preventing many positioning
movements. Sorting can especially save much time in case many roughing
layers are applied.

Background information about the sorting algorithm that is used, written by
the programmer: 
In DeskProto each toolpath is a series of small lines (linear interpolations,
or G1 movements), where each movement is a straight line between two
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points. A series of connected movements (in fact a polyline) is called a
chain. A chain ends when a positioning movement (go up, position, go down)
is needed.
The third concept that is used is the tour: a tour is one complete path for the
chosen strategy, so when not interrupted for some reason. For strategy
parallel a tour is one complete path from left to right, for block one
complete path around all four sides, etc. Subsequent tours are more or less
parallel to one another.
Sorting compares the start point and endpoint of each chain with all chains
on the next tour. If on that next tour a adjacent chain (so both start points
and end points close) can be found that is closer that the next chain on the
same tour, then DeskProto will jump to the chain on the next tour.

For the waterline strategy the situation is more complex. Here DeskProto
uses the bounding box of each chain. If the bounding box of a chain does not
overlap any other bounding box (on the same Z-level) then it is an isolated
chain. After machining such isolated chain DeskProto will jump to an
isolated chain on the next Z-level (and on the same location). So when
machining a city with church towers, sorting will make DeskProto complete
the towers one by one, instead of finishing a complete Z-level before
starting on the next Z-level.

For the Contour-only strategy sorting can change the sequence of the
contours - of course only in case more than two separate contours are
present.

Advanced parameters
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Ambient skipping concerns the Ambient area: this is the area where no
geometry is present. Basically DeskProto always machines a complete
rectangular area, due to its parallel toolpaths approach. This might lead to
unneeded extra chips and unneeded extra machining time. Also: when all
material around the model already has been removed in a previous roughing
operation there is no need to again machine the ambient area when finishing.
In such situations you can optimize the toolpath by using the Ambient
skipping option. 
· By default this option is set to Machine all: the complete area will be

machined.
· Skip hor. ambient means that all extra horizontal movements on ambient

level, from the model to the edge of the area and back, will be skipped.
The tool will still go down to ambient level around the model.  You can for
instance use this for finishing, when all ambient material has already been
removed by the roughing operation.

· Skip Hor. + Ver. ambient means that both horizontal movements on
ambient level and the vertical movements towards ambient level will be
skipped.  For ballnose cutters then still a groove round the part will be
visible: when only a small part of the cutter is above the model the tip of
the ball will have a lower Z-value than the part geometry at that point.

· Skip Total ambient means that the center of the cutter will remain above
the geometry: all positions with the center of the cutter above ambient area
will be skipped.

The icon images on this tab page illustrate the differences between these four
skipping options.



Dialogs

Page 215

DeskProto Reference

For this skipping feature DeskProto will use the ambient area that is present
on the minimum Z-level of the operation area. This may differ from the
Ambient area as used in the Part parameters.

An extra option that can be checked here is called Ignore enclosed ambient.
When checked, only the ambient around (so on the outside of) the part will
be skipped. The enclosed ambient area, like for instance within holes in the
model, then will be machined.

Start / End offers the option to add extra commands to the NC program
before the operation's toolpath starts and/or after it has ended. These
commands can be movement commands and/or user defined commands.
They can be used for instance to make the cutter move to a safe position
before rotating the 4th axis, or to insert a comment line that mentions the
name of the next cutter to be loaded. Button Settings... will open the
Operation Start/End settings dialog.

Vertical surfaces
The algorithm used by DeskProto to calculate toolpaths does not really
support true Vertical surfaces. DeskProto calculates its toolpaths based on a
Z-Grid, connecting points on this grid to form the toolpath. For each XY
position in the grid only one Z value is available, which means that vertical
movements are no possible: that would require two points with the same XY
and a different Z. Each tool-movement will thus contain both a horizontal
and a vertical component, the horizontal component being the stepsize along
the toolpath. As result a vertical surface in the geometry will be machined
having a small angle in the resulting part. 
BTW this is not true for all strategies: a waterline toolpath does not have any
vertical components. For waterlines this option still can be used though: when
traveling to the next waterline a movement at an angle is present. The
horizontal component of this movement is the Distance between toolpaths.

A simpler option to protect the vertical surfaces is present on the Roughing
tab. When that option has been checked the option on the Advanced tab will
be disabled, as it would be overruled by the Roughing setting.

In case you need your model to have true vertical surfaces (and you do not
want to use waterlines) you can achieve that by using and fine-tuning this
option. You can let DeskProto assume a vertical surface in case the
‘toolpath-line’ is steeper than a certain angle. The angle is defined by the
Ratio between the height and horizontal distance (stepsize) of one movement
in the toolpath, and in the edit box you can set the Height/step ratio to be
used. See the illustration and examples below.

For every movement DeskProto will check this ratio, and for a movement
that exceeds the ratio (so when the movement is steeper), DeskProto will
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insert an intermediate point: the movement will be split into a horizontal and
a vertical component, to be executed sequentially. The result will be a
vertical surface in the part, which otherwise would have been angled. 

Example 1:  Vertical surface ratio = 8
The image below shows a geometry with a vertical wall on the left and a
sloped wall on the right. The Stepsize has been set to a value that is 1/8th of
the total height of the geometry. You can see 2 toolpaths: one drawn in black,
one in red. The black one is the one that is first calculated. When you then
apply the vertical surface ratio option and set it to 8, the toolpath will be
changed to the red one. So on the left side the toolpath will have been
corrected whereas on the right it will not, because on the left the height/step
ratio is 8/1 whereas on the right the height/step ratio is 8/2 = 4/1. In the
drawing these two ratio's are shown as purple triangles. On the left DeskProto
assumes a vertical surface and changes the toolpath, on the right side not. For
a vertical surface DeskProto will add one cutter movement at this point,
splitting the original angled movement into a vertical and a horizontal part.
These two movements will be output in a sequence that leaves extra material
on the part.

The implementation of the Vertical Surface setting is different for tab page
Roughing (image on the left) and tab page Advanced (image on the right):
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In the Advanced implementation the extra position will be added only for the
first movement (or the last for an upward toolpath), meaning that this will
only happen at the transition point between a "horizontally oriented" section
of the path and a "vertically oriented" section. See the illustration above
right, showing the result for a height/step ratio of 1.
In the Roughing implementation a much simpler version of this algorithm is
applied: with a fixed ratio of 1, and for all movements (so for all lines of 45
degrees or steeper): the illustration above, left. The result will be a staircase
shaped toolpath and a lower surface quality, so select this only when needed.

For parts without vertical surfaces this functionality is not needed, so for such
models choose Do not check for vertical surfaces.

It may be needed to experiment a bit with this option in order to find the best
ratio for your geometry.  Take care when creating parts designed with a draft
angle: in case this option is used the result might be that all draft surfaces will
be made vertical !

Example 2: now with numbers.
Assume that your part contains a vertical surface of 15 mm high, and that
you have set the Stepsize to be 1 mm. The toolpath over this vertical surface
now contains a horizontal component of 1 mm (the stepsize) - however, you
want it to be really vertical. The default height/step ratio of 20 then means
that when this tool movement goes up or down over more than 20 mm it will
be split up into two separate movements (horizontal and vertical). As your
desired vertical wall is only 15 mm high you need to set the ratio to (say) 14
to make DeskProto change these toolpaths.
This will work for any Stepsize: when you have for instance selected 0.0262
inch, then the height/step ratio of 20 means that when the tool movement will
be split when it goes up or down over more than 20 x 0.0262 = 0.524 inch.

Note that this vertical surfaces check does not work for conical cutters as the
steepness of the toolpath is analyzed: for conical cutters the toolpath never
can be steeper than the Angle of the cutter. 

Collision checks
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The two Collision check options are very useful for high parts, especially
with high vertical or steep surfaces. With such parts a problem will occur
when the vertical wall is higher than the free length of the cutter: the milling
machine’s collet will then damage the part (DeskProto only compensates for
the geometry of the cutter, not for the machine-parts that hold the cutter). 
Checking option Enable collet collision detection means that DeskProto
will let the tool move away from the part in such case, preventing the collet
to collide with the part. See the illustration below. Obviously the resulting
model will no longer be correct, as the material that cannot be reached by the
cutter will be left on the bottom of the vertical wall. However this is much
better than letting the collet damage the top of the model, as the excess
material can later be removed with a different cutter or by hand.

DeskProto will let you know when collisions have been found and prevented,
using the warning dialog shown above. This warning is optional (stored as
setting for only this project), when it is no longer shown it can be restored in
the Project parameters, on tab Advanced. The toolpaths that have been
changed will be drawn orange.

The diameter of the collet can be defined at the Machine parameters dialog. .

The option Also motor collison detection makes DeskProto perform the
same trick for the bottom of the spindle motor. This checkbox is enabled only
when the collet collision detection is enabled ánd when the motor dimensions
have been set in the Machine definition.

The illustration above shows the results of the collision check options, for the
most basic geometry that is possible: a cube of 50 x 50 x 50 mm. The cutter is
a flat cutter, diameter 4 mm, free length 30 mm (so the cutter sticks out 30
mm below the collet). Left the toolpaths without collision detection (the
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collet will now severely damage the part). In the middle the toolpaths when
the collet collision detection is enabled. Note the orange color that clearly
indicates where the toolpaths have been changed to avoid collisions. The
image on the right shows the result when the Motor collision detection has
been enabled as well. This is for a motor diameter of 60 mm and a toolholder
height of 15 mm

The orange toolpaths shown above will not always be completely present, as
they may fall outside the material block and outside the Area to be machined.
DeskProto normally adds a Border area ("Extra for cutter") around the Area,
however this border only adds the cutter radius, so most orange toolpaths will
fall outside.

Tilt option parameters

The rotation axis Tilt option is a feature where the complete rotation axis
can be oriented in an upward angle, like the road surface of a drawbridge.
While the axis is tilted it still can be controlled as 4th axis and process rotary
toolpaths. This allows the cutter to also machine the inside of a ring: see the
illustration below. Such tilting rotation is in fact a second rotation axis: a 5th
axis (B-axis). So in the machine definition it can be found in the Rotary
machine settings.  Two versions are possible: a CNC controlled 5th axis, and
a tilt option that has to be set manually.

Manual tilt option
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The illustration below shows the manually controlled tilt option that is
present on some wax milling machines for jewelers. Shown is the Roland
JWX-10 "Jewela" machine.

The Tilt Option tab is visible only in case in the Part parameters the option
"Use rotation axis tilt option" or "Use 5th axis as rotation axis tilt option" has
been checked (and in case the machine has a 5th axis configured). 

In the bottom-left corner of this photo you can (just) see a rotation knob:
after unlocking the rotation mechanism you can use this knob to manually tilt
the complete rotation axis (A-axis) unit.  This machine supports locking on
fixed intervals of 15 degrees.
As this manual rotation is round an axis parallel to Y, this rotation is called a
B-axis. The total number of axes then is 5 (X, Y, Z, A and B), so this is in
fact a (very primitive) 5-axis machine.

The Tilt Angle that you can enter here is the rotation value that will be used
for this Operation. As you can see in the illustration, this rotation offers you
the possibility to machine in places where the cutter normally cannot reach:
for instance the inside of a ring model.
In addition to these 15 degree intervals you can also enter a Custom rotation
value here.
Keep in mind that you need to manually set this machine to the same angle as
entered in this dialog.

CNC-controlled 5th axis
For 5-axis CNC machines that have a CNC-controlled 5th axis, DeskProto
supports only trunnion style machines, as explained in the Rotary machine
settings. On such machine the large rotation axis can be used to orient the
small rotation axis in a tilted position. So this tilt option can also be used on
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these machines. Provided that you can indeed use the small rotation axis as
4th axis.
Important is that DeskProto will not automatically write the rotation
command for the fifth axis (setting the tilt angle) to the NC file: you will have
do add that by entering it in the operation's Start/End commands.

Note that the position of the part after this rotation depends on the distance
between the part and the actual B-axis (so the axis of rotation). The larger
this distance, the more Z-movement while rotating. This distance can be set
on the Zero-point tab of the Part parameters, as at angle 0 this distance is in
fact the X-translation. You will see that this Zero-point tab looks differently
when this Tilt option has been selected.
Setting the correct X-translation here is important: only with a correct
translation all resulting toolpaths from operations with different tilt angles will
be correctly positioned (all working with the same Workpiece zero point).

The Tilt option is available only for Geometry operations, so not for Vector
and Bitmap.

4.2.3.3 Bitmap Operation Parameters

DeskProto features three different types of Operations: this dialog is for the
Bitmap Operation -- in addition also dialogs for a  Vector Operation and for a
Geometry Operation are available.

The Bitmap Operation parameters are identical to the Geometry Operation
parameters (except for the Tilt option: that is not available for bitmap). The
Bitmap Operation applies them on the Bitmap relief, the Geometry Operation
applies them on the Geometry. 

So for information on any of the Bitmap tab pages, jump to these
Geometry operation Help pages:
General
Strategy
Roughing
Area
Borders
Movement
Advanced

This dialog can be reached via the Parameters menu, third option.
Or you can double-click on an bitmap operation line in the project tree (one
of the third level items).
Or right-click on a bitmap operation line and select Operation Parameters in
the context-menu.
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This same dialog is used for the Default Bitmap Operation parameters, only
with an extra button Restore DeskProto defaults to reset the original default
parameters.

4.2.3.4 Select Curves

Purpose of this dialog is to select the vector curves to be used for this
operation (or to edit that selection). 
It is present in four different versions: once for Profiling, once for
Pocketing, once for V-Carving and once for Drilling. All four versions
offer the same functionality, except for the options in the "Settings" field.
The above image shows the version for Profiling, the settings for the other
versions are shown below.

The Select Curves dialog can be reached by pressing button "Select..." on
respectively the Profiling tab, the Pocketing tab, the V-Carving tab and the
Drilling tab of the Vector Operation parameters.

A top view drawing is present (no other views), in which all loaded curves
will be drawn in gray. 

Button to open dialog Items visible for Set Graphically, in which you can
select which items should and should not be included in this drawing. It will
be clear that item "Vector curves" now cannot be switched off.
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Button Toolpaths will show (and if needed first calculate) the toolpaths in
this top-view drawing. Pressing the button again will remove the toolpaths
from the drawing. This is of course possible only after one or more curves
have been selected.

 
The use of buttons Previous view and Next view will be known from the
Toolbar. These are of course active only when the view has been changed
(Previous view) and when the Previous view button has ben used (Next
View).

The leftmost button on the second row is the Select button. It is one of the
five buttons to set which Mouse function has to be used in this dialog. Four of
these are known from the Toolbar, this leftmost button is the most important
button in this dialog. When it is active you can select a curve by pointing
the cursor at it using the mouse: when pointing correctly the curve will turn
purple, for "selectable". You then can select it by clicking: its color will then
change from gray to light blue, for "selected".
Extra options when using the Select button: 
· Draw a box from left to right around multiple curves to select them all
· Draw a box from right to left over multiple curves to select them all
· Keep the Shift key (on the keyboard) pressed while clicking to keep

adding curves to the selection
· Keep the Ctrl key (on the keyboard) pressed while clicking to remove

curves from the selection (on a Mac use the Command key instead of Ctrl)
· Type Ctrl-A to select all curves.

Button Calculate toolpaths (large button with text) will calculate and show
toolpaths for the selected curves (just as the button with an icon).

Below this button DeskProto will show how many curves have been selected.

Not all curves can be selected:
- Profiling will not accept single points
- Pocketing and V-Carving will accept only closed curves
- Drilling will accept only single points, +-signs sized equal to the cutter
diameter and circles that (almost) equal the cutter diameter.
Curves that are not acceptable will be drawn in light gray, for "can not be
selected".
Vertical lines in the vector data (curves with all points having the same X and
Y, and different Z values) cannot be selected in any of these four toolpath
types.
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Under tab Settings you can set the most important parameters for that
toolpath type: the above image from left to right shows the settings for
Profiling, Pocketing, V-Carving and Drilling. These are the same as present in
the Vector Operation parameters, making them also available in this dialog
will allow you to quickly see the resulting toolpaths for any setting. For the
Help information about these settings click on the above link for that toolpath
type.

A very handy tool is available under tab CAD Layers. Here all layers in the
available Vector data are listed (if any), with a light bulb icon that can be
used so show or hide the curves in that layer.
Many DXF files contain layers, meant to make it easier to access the data by
viewing at it layer by layer. Like in this DeskProto sample file
2D_DpBeerTray.dxf : one layer contains all contours, the second layer
contains all text.  Viewing the curves per layer makes it very easy to select
the correct curves, as curves that need the same settings typically will have
been grouped in one layer. Remember that the light bulbs only set the
visibility in this dialog, you still need to select curves with the mouse.
Note that these CAD layers are completely unrelated to the Roughing layers
that DeskProto uses when roughing.

A similar list with light bulbs is shown under tab CAD Files. This list contains
all files with vector data that you have loaded, and the light bulbs make it
possible to select from which vector files the curves will be shown.
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4.2.3.5 Set Vector Support Tabs

When machining a 2D vector profile in sheet material you can set the depth
of the toolpath equal to the material thickness, making a cut that goes
completely through the sheet. When cutting a closed profile this will result in
a separated part: the material inside the profile toolpath no longer is
connected to the rest of the sheet.
When the material is clamped only at it's corners, that separate part will be
completely loose, may go wild, and can be damaged and/or cause damage.
Which is of course an unwanted situation.
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DeskProto offers Support tabs to solve this problem. Such tab keeps both
sides of the toolpath connected by raising the cutter for a small section of the
toolpath, leaving a small bridge of material that later can be removed
manually. The two images above clearly illustrate how this works: left the
toolpath, right a simulation.
In the first image these tabs are shown: the dark blue dot shows the center of
the tab, the light blue area indicates the length of the tab.

This tab page is about Vector tabs, made by changing the machining depth in
a 2D toolpath. Not to be confused with Geometry support tabs, made by
adding small blocks to the geometry. Vector support tabs are available only
for vector toolpaths without Z-values (2D curves). So they cannot be used
when a 2D curves is projected on a 3D geometry, or when for a 2D vector
file the option "Use Z-values" has been checked in the project parameters.

The dialog Set Vector Support Tabs allows you to set the number of tabs,
the location of each tab and the tab size. You can open this dialog on the
Profiling page of the Vector Operation Parameters.  The drawing will show a
top view of all vector curves, with the selected curves drawn in black.
Support tabs can be set only on curves that have been selected for profiling,
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in the same operation. The location of a tab is shown by a blue dot, see the
screenshot above.

The buttons in the top right corner offer the following options:

Button to open dialog Items visible for Set Graphically, in which
you can select which items should and should not be included in this drawing.
It will be clear that item "Vector curves" now cannot be switched off.

Button Show Toolpaths will show (and if needed first calculate) the
toolpaths in this top-view drawing. Pressing the button again will again
remove the toolpaths from the drawing.

Button Add tab will be active as default when you open this dialog.
It sets the mouse function to adding tabs: move the cursor over the drawing
to highlight one of the black profile curves (it will become violet) and left-
click: on that location a blue dot will be added on the profile.

Button Delete tab sets the mouse function to deleting tabs: move
the cursor over the drawing to highlight one of the existing blue dots, then
left-click in order to remove it.

Button Move tab sets the mouse function to Moving tabs: move the
cursor over the drawing to highlight one of the existing blue dots, then left-
click: while keeping the mouse button pressed you can move the blue dot.
Moving is possible only along the profile curve.

The meaning of all other buttons is the same as on the main screen, so needs
not explanation here.

Other options on the right side of this dialog:

Tab length
The length of the tab is the distance along the curve along which some
material will be left. That is not the same as the length of the elevated
toolpath fragment: that needs to be increased by the cutter radius on both
ends. In the image the length of each tab is shown by a light blue background
color round the curve.
You can set the tab length either as a Percentage of the cutter diameter (so it
will work for any size cutter and any size part), or as a Fixed distance in mm
or inch.  
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Tab height
The height of the tab is the thickness of the remaining material. Easiest is to
define this thickness as a Percentage of the sheet thickness (so of the
material block height), second option to define it as a Fixed value. A
thickness of 0.0 (or 0%) is not permitted, and the tab may not be higher than
the material block (so max percentage is 100%).

The above options have shown how to manually set support tabs. It is also
possible to make DeskProto set tabs automatically, using the parameters in
the Auto generation group:

Positioning distance
The distance between two tabs: DeskProto will automatically set tabs along
each selected profile using this distance. Here again you can either use a
percentage (of the cuter diameter) or a fixed value.

Distance overrides
In some cases one auto positioning distance is not enough, for instance when
the operation contains both long profiles and short profiles. DeskProto allows
you to set a Minimum number of tabs per profile to make sure that even the
shortest profile gets (for instance) two tabs, and/or to set a Maximum
number to prevent a long profile to get to many tabs.

The defaults for the above parameters can be set in the Default Vector
Operation parameters (Options menu): on tab Profiling a button "Set..." is
present to set the default values for support tabs. That button will open the
Default Profiling tabs dialog.

Generate
This button will make DeskProto remove all current tabs and set a complete
series of tabs based on the parameters that you selected.
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4.2.3.6 Default Vector Support Tabs

The use of Vector support tabs is explained on the help page for dialog Set
Vector Support tabs. 
In that dialog they can be set manually or they can be generated
automatically using the auto positioning parameters.

On the Profiling page of the Vector operation parameters it is also possible to
select Default tabs. This dialog Default Vector Support tabs allows you to set
the parameters to be used when generating these default support tabs.
It can be accessed via the Default Vector Operation parameters

The parameters are the same as in dialog Set Vector Support tabs and you can
find all relevant information on that Help page.
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4.2.3.7 Create Cleanup operation

A Cleanup operation is meant to clean the flat bottom of a V-Carved groove.
 In a V-Carving operation such groove is machined by a V-Cutter with a
sharp tip, so this bottom will not be a flat surface: it is completely filled with
the cusps (small ridges) between the V-Cutter toolpaths.  See the illustration
below.
This dialog is meant to create an extra operation that will cleanup this
bottom: make it a flat surface using a flat cutter.

You can reach this dialog using button "Create cleanup operation..." on the
V-Carving tab of the Vector operation parameters.
Once a cleanup operation has been created for this V-Carving operation the
name of the button will change to "Update cleanup operation". After pressing
the Update button this dialog won't be shown again: only the settings of the
cleanup operation will be updated to match any changes in the V-carving
operation.

The cleanup operation of course only is effective when a flat bottom is
present in the V-grooves. And the flat area also must be so large that the flat
cutter that you select can indeed be used to make it flat. If not DeskProto will
show an error when you calculate toolpaths: "The operation 'Vector
operation Cleanup' of part 'Part' has no valid toolpaths".
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On the left side of this simulation you see the result of the V-Carving
toolpaths for this design (Times New Roman font, 45 degree V-bit, depth
limitation -2 mm). On the right side the result after also using the cleanup
operation (flat cutter D 2 mm). Note that this flat cutter cannot completely
cleanup the bottom surface: it cannot machine the sharp inner corners.

The new operation will be a Pocketing operation, for which three settings are
shown in this dialog:

The Name of the new operation.
This is the name of the current V-Carving operation with the word "Cleanup"
added. This naming convention is how DeskProto knows that these two
operations are connected, so do not rename (or rename both).

The Cutter to be used in the new operation.
Here your can only select one of your cutters with a flat top: using a different
cutter type would not create a clean flat bottom.

The XY allowance (that will be set on the Roughing tab of the new
operation) is the distance that the flat cutter needs to keep away from the
curves. It is calculated from the Angle of the V-cutter and the Depth of the
V-carved groove (note that in DeskProto this angle is the grinding angle, not
the included angle). The formula is simple:  
XY allowance = Depth * tan(Angle).
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The above image on the right shows the situation when a curve depth has
been set (for inlays). Now the formula is:
XY allowance = (Depth - Curve depth) * tan(Angle).

No need to worry about these formulas as DeskProto takes care of these
calculations.

4.2.3.8 Surface Sampling Refinement

The DeskProto toolpath calculations for Geometry data are based on a Z-
grid, and the size of the grid cells sets the precision of the toolpaths. For
every cell in the grid the highest Z-value of all the geometry within that cell
will be stored: the surface is sampled. In other words: the DeskProto
algorithm is based on Surface Sampling.

In the Geometry Operation parameters you enter the Precision by setting the
“Distance between toolpaths” and the “Stepsize along toolpath”. The
smallest of the two will be used as Grid-size (cell size) of the Z-grid. While in
most cases this works OK, sometimes it is needed to overrule this default and
use a smaller Grid-size. This is called subsampling or sampling refinement, as
for each toolpath point more than one grid-cell will be used. This dialog can
be used to define the Refinement factor.

You can reach this dialog by using the button Settings on the Strategy tab of
the Operation parameter dialog (not available for all strategies).

The Surface Sampling Refinement dialog allows you to fine-tune the grid-size
or calculation precision. The higher the Refinement Factor, the more accurate
the toolpaths and the longer the calculation time (quadratic). A higher factor
also means that DeskProto will need more internal memory (RAM). A
refinement factor 1 will result in a Z-grid with a cell-size that equals the
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settings for Distance between toolpaths and Stepsize along toolpath. A
Factor 2 will halve the cell-size and thus double the Z-grid resolution for
both X and Y, so will subdivide each grid cell into 4 smaller cells, etc.

Note 1: This setting is in fact only meant for advanced users, to be applied in
special circumstances only !!
Note that higher factors will mean much longer calculation times !

Note 2: The default factor as said is 1 (None). However, for strategies
Waterline and Contour Only the default factor is 3 as this is needed to
achieve smooth toolpaths. This explains why the calculation times are longer
for those strategies.

4.2.3.9 Set Freeform Area

A Freeform area is meant to save machining time by exactly defining the area
that needs to be machined. This area can be defined in this dialog, by creating
a closed (freeform) contour line in the Top view of the part. In the image
above one of the visible items is a orange rectangle: this shows the Material
Block. The Freeform area needs to be completely inside this rectangle. For
this contour you can also set a Min and a Max Z-value, the resulting volume
is called a Freeform area. You can reach this dialog by using the button “Set
Freeform” on the Area tab of the Operation parameters dialog.
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On the right side of the drawing four rows of buttons are present.

The first button will open dialog Items visible for Set Graphically,
in which you can select which items should and should not be included in this
drawing.
The use of the other buttons on the first row will be known from the Toolbar.

The four buttons on the second row (aligned right) will also be known from
the Toolbar.  Mouse rotation is not present: this dialog only used the six main
views. Together with the third and fourth row these are the mouse function
buttons, of which just one is active (pressed). You can see which button is
active as it has a light blue background (in the image the leftmost button on
the third row).

The eight buttons on the third row are special for this dialog: these are the
drawing tools used to graphically draw and/or change the area. These are
mouse function buttons as well: of the mouse function buttons (13 in total)
only one is active at any time. You will see that the shape of the cursor
changes when you select a different mouse function button. Each button
comes with a tooltip text that explains what this tool can do.

Draw a Polygon as new Freeform contour: each mouse click will add
one point. The polyline that you draw is always closed, therefore it is
calle Polygon. End the function with a right mouse-click. Extra key
functions:
ALT (on Apple the Option key): snap points to geometry points
SHIFT: create lines at 15° angles
CTRL (on Apple the Command key): create lines at 1° angles
CTRL + SHIFT: create lines at 5° angles

Draw a Rectangle as new Freeform contour: click the left mouse
button, move the mouse and release. This function is in fact also
present in the rectangular area dialog. 
SHIFT: When you press the shift button during this input DeskProto
will lock horizontal and vertical 1:1, forcing a square.

Draw an Ellipse/Circle as new Freeform contour: click the left mouse
button, move the mouse and release. The ellipse or circle that is drawn
is in fact a polygon. 
SHIFT: When you press the shift button during this input DeskProto
will lock horizontal and vertical 1:1, forcing a circle.
When you activate this tool by pressing the button you will see that an
extra input field appears:
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the Number of points that you enter here is the number of points that
will be used for this polygon. For low numbers the resulting boundary
will not be a circle.

Adjust Boundary of a Freeform contour: you can move the points and
the sides of the contour by dragging with the mouse. You can also
resize and rotate the complete polygon. Watch the cursor to see if you
will drag a point, drag a line or (when clicking outside the polygon)
rotate the polygon.
Extra key functions for points:
ALT (on Apple the Option key): snap points to geometry points
CTRL (on Apple the Command key): resize the polygon
SHIFT: resize the polygon and keep the aspect ratio
SHIFT+CTRL: resize the polygon and keep, keep X or Y size.
Extra key functions when clicking outside points:
SHIFT: create lines at 15° angles
CTRL (on Apple the Command key): create lines at 1° angles
CTRL + SHIFT: create lines at 5° angles

Move a Freeform contour: simply pick and drag the complete contour
line. 

Delete a Freeform contour. 

Add new point to the Freeform contour: click with your mouse to add
a point. The side of the polygon will be split up into two new sides.
ALT (on Apple the Option key): snap points to geometry points

Delete point from the Freeform contour: click with your mouse to
delete a point. Watch the cursor when moving the mouse: when a
minus sign shows you are on target.

These buttons are only active in the Top view and the Bottom view. In the
other views only the Min Z and the Max Z level can be graphically set
(button Adjust Boundary). You can also set the area’s Z-values by entering
them in the Z edit boxes. The boundaries of the current part are shown to
assist you, so are the coordinate values of the current mouse position.

Button Select contour from project is activated only when in the project
one or more Vector files have been loaded, and when at least one closed
vector curve is present. When you check this option you will see that the
vector curves in this project are added to the drawing, drawn in gray. Light
gray for open curves (cannot be used here), and dark gray for closed curves.
Position the cursor on such closed curve and it will turn purple, click to select
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and it becomes black. Selecting more than one curve is possible by keeping
the Shift key (on the keyboard) pressed while selecting.
This large button "Select contour from project" is the thirteenth mouse
function button, so when selected it will have a blue background.

The buttons on the fifth row are Undo and Redo. The freeform area dialog is
the only place in DeskProto that offers Undo functionality, as while drawing
this functionality is more needed than when working with settings in dialogs. 

Undo the last action using any of the drawing buttons. 

Redo the last action that was undone

Nine levels of Undo are supported plus one level of Redo, so a total of 10
situations is stored.

The freeform area is defined by its contour, which is a 2D vector curve.
Using the buttons described above your can draw a new contour. Other
options are to use an existing curve and to make DeskProto generate a curve.

A very powerful option is offered by button Generate contour: DeskProto
then will automatically generate a freeform area contour that follows the
outside contour of the current geometry. This will also work for multiple
geometries, and for geometries that contain holes. It will also work for a
bitmap relief, though then first the Bitmap Contour tolerance dialog will pop
up, as for bitmap data some extra settings are needed.

This contour line to define the freeform area can be imported from a 2D
vector file. The button Import… will open a standard File Open dialog to
browse the correct file. This can be very handy in case you can export your
3D geometry and a 2D contour from the same CAD program.
The reverse action Export...  will save the current freeform contour(s) in a
vector file.

The Freeform area supports multiple contours: so you can draw more than
one freeform area in this dialog. 
Nested areas are supported as well: The outer contour defines an area to be
machined, the inner contour defines an area to be skipped. And inside the
inner contour you can again draw a new outer contour, and so on. See the
illustration below.
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4.2.3.10 Set Center

In order to calculate toolpaths in a circular, spiral or radial toolpath a Center
point is needed. For these strategies the center point can be set in the Detail
settings, where you can enter the X and Y coordinates for this center point. 

At that same location (Operation parameters, tab Strategy) you can also press
the button Set in order to open this dialog to graphically set the center.
The center point may be located outside the area to be machined, even
outside the material block.
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The dialog is in fact almost identical to the other dialogs for graphical input:
Set Area and Set Freeform Area.
Only the functionality is different, and is in fact very limited: 

The Mouse function Set Center allows you to click a point to set the
XY coordinates for the center point. The large + sign in the drawing shows
the current location of the center point. This only works in the Top View and
in the Bottom View: in any of the other views only one of both coordinates is
changed when clicking.

The first button will open dialog Items visible for Set Graphically,
in which you can select which items should and should not be included in this
drawing. 
The use of the other buttons will be known from the Toolbar.

4.2.3.11 Bitmap Contour Tolerance

The dialog to set a Freeform area offers the option to generate a contour.
For a geometry operation that is a contour line around the complete
geometry. However, for a bitmap operation a contour round the complete
bitmap is not useful as that will be a simple rectangle. So for a bitmap
operation DeskProto offers a more refined tool, in which you can set the
contour round all pixels below or above a certain gray level. The idea is to
create a contour round the actual relief, excluding the background (the
bitmap's 'ambient'). In this dialog the threshold gray level can be set.

For a negative relief the backgrond (the "ambient area") will be the color
with the highest Z-value, for a positive relief it will be the color with the
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lowest Z-value. Which of these two is black and which is white depends on
the Part parameters Z-settings that you made for this bitmap.

However, the background of the image in many cases is not just pure black or
pure white: it will also include almost black pixels, and almost white
respectively. That can be solved by entering a value for the Color tolerance.
The value that you enter as Color tolerance is a percentage. Of all gray values
between black and white, which percentage do you want included in the
freeform area. 0% means that only pure black or pure white will be
considered as background when generating the contour. In practice you will
have to experiment a bit to find the tolerance that produces the contour that
you need.

An example: the sample bitmap file Radetzky.jpg that is included in every
DeskProto installation.
The background color of this image is not pure black, so selecting black and a
Color tolerance of 0% or 1% does not result in a contour line around the
relief.

In order to get the contour line shown in the image it was needed to
experiment with the tolerance value: this contour was generated by selecting
white and a Color tolerance of 89%.  BTW exactly the same result is
achieved by selecting black and a color tolerance of 11%.
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4.2.3.12 Operation Start/End Settings

This dialog is meant for advanced users only, as you can conclude from the
warning in red.
It enables you to add extra command lines to your NC program file, both at
the Start (so just before the calculated toolpath of this operation) and at the
End (after its toolpath). For instance to let the cutter travel to some safe
position after finishing the operation. Or to let a rotation axis rotate to a
certain angle before starting to machine the operation. 

You can reach this dialog by pressing the button "Settings" for start/end on
the Advanced tab of the Operation parameters dialog, for all three types of
operations (Vector, Geometry and Bitmap).

Up to seven Before Operation commands (Start commands) can be
specified. These will be written as extra lines in the NC program file, just
before the toolpath of this operation. Each line is optional, and will only be
written when checked (so checking none will mean that no Start commands
are inserted) :
· User defined can be used to issue any command, like for coolant or for

some other device. Note that the line will be written exactly as defined in
this edit box: so take care what you enter ! You need to know the language
that your machine requires: this line will not be translated by the
postprocessor. A powerful option in a user defined command is the use of
placeholders, see below.

· Move Z-axis to adds a Z-movement command to the NC file: to the
specified position (in mm or inches) in workpiece coordinates. Note that
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these lines are written to the file in the same sequence as present in the
dialog: first the Z-movement, and then the Y, the X, the A, and finally the
B movement. 

· Move Y-axis to adds a Y-movement command to the NC file: to the
specified position (in mm or inches) in workpiece coordinates.

· Move X-axis to adds a X-movement command to the NC file: to the
specified position (in mm or inches) in workpiece coordinates.

· Move A-axis to adds a command to rotate the A rotation axis to Angle
degrees.

· Move B-axis to adds a command to rotate the B rotation axis to Angle
degrees. 

· User defined 2, see the explanation given above.

As the edit field for user defined commands is very small an extra button [...]
is present on that line. This will open the NC code dialog, that offers much
more room to add and edit command lines, and also an option to show the
result of the placeholders ('Show example'). As said, e advise that  are used
only by advanced users !
For each of the Move commands an extra checkbox Rapid is present:
checking that box means that the movement will be done in rapid mode.

The screenshot above shows a few possible uses:

- Two rotation commands are used for indexed machining: machining a part
from several sides: three-axis toolpaths for each side, with a rotation in-
between. For instance the N-sided milling wizard uses the A-axis start
command for this aim: milling from four sides will involve four 'parts', each
time with a 90 degree rotation in-between. It also applies a Z-axis command,
to make the cutter move upward to a safe height before the A-axis starts
rotating, as otherwise the block might hit the cutter while rotating. The
toolpaths for all operations (in several parts) then can be written to one large
NC file using Chaining.

- In the four edit boxes for User defined commands you can use
placeholders. These are special bits of text that you can enter, which will be
replaced with some parameter setting when the NC program file is written.
For instance the text "{TOOLNAME}" will be replaced by the name of the
cutter that is needed for this operation. 
A placeholder that forces a new line in the NC program is available as well. A
list of all available placeholders can be found at page Postprocessor
placeholders (despite the name they can also be used in this dialog).
For machines that support the use of comment lines in the NC code the User
defined fields is can of course also be used to enter comment lines.
When your machine supports macros you can use the User defined field to
call a macro. We have for instance seen a macro to reset the A-axis to a
value between 0 and 360 after completing a helix toolpath.
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The screenshot shows adding a comment line (this machine considers any
text between bracket as comment) with the name of the cutter to be loaded.
When the CNC-controller shows this comment on screen the operator will
know which cutter needs to be used.

In the four "User defined" edit fields a space will be shown as a "middle
dot" ( · ), like in the example screenshot after "Load". This is done as
otherwise spaces would easily be overlooked.  When editing this field you
will again see a space.

The seven After Operation commands are the same as the Before
commands just described, only these will be written to the NC file after the
toolpath of this operation.

Note: the five Move-to commands are not available for some machines. A
machine that always needs three coordinates per command (without
specifying which is for X, Y or Z) cannot accept a line with for instance only
a Z-axis coordinate: it won't know for which axis it is meant. DeskProto
cannot simply use the current position for the other two axes, as at the start
of the toolpath it does no know the current position. For such machines all
Move commands will be grayed out.

Note: The A-axis and B-axis commands are available only when the machine
for this part has such rotation axis defined in its machine-definition, if not
they will be grayed out. So the illustration above is made with a four-axis
machine selected: the B-axis is not available.
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4.2.3.13 NC code

This dialog is a sub-dialog of the Operation Start/End settings dialog. You can
reach it by pressing the small button [...] that is shown next to each User
Defined edit field. Its purpose is to provide a larger area for editing these
User defined commands.

User defined commands can be used to enter any command, like for coolant
or for some other device. Note that the line will be written exactly as defined
in this edit box: so take care what you enter ! You need to know the language
that your machine requires: this line will not be translated by the
postprocessor (except the placeholders, see below).
We advise that user defined commands are inserted only by advanced users
!!

The image above shows the use of two "Placeholders": {OPERNAME} and
{TOOLNAME}. These are special bits of text that you can enter, which will
be replaced with a parameter value when the NC program file is written. For
instance the text "{TOOLNAME}" will be replaced by the name of the cutter
that is needed for this operation. 
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A list of all available placeholders can be found at page Postprocessor
placeholders (despite the name they can also be used in this dialog).
A placeholder that forces a new line in the NC program is available as well:
{N}. DeskProto will automatically create such NewLine placeholder when
you start a new line in this edit box.

When you press button Show example the dialog will show an example of
the resulting NC code, as shown by the large arrow in the illustration above.

For machines that support the use of comment lines in the NC code the User
defined fields can be used to enter comment lines. The image above is for a
machine that interprets lines between brackets as comment: these comment
lines will tell the operator which operation will follow, and which cutter
needs to be used. Other machines treat for instance all text after a semicolon
(";")  as comment.

When your machine supports macros you can use the User defined field to
call a macro. We have for instance seen a macro to reset the A-axis to a
value between 0 and 360 after completing a helix toolpath.

When editing these User defined commands spaces will be shown as a
"middle dots" ( · ), like in the example screenshot on both sides of the "=".
This is done as otherwise spaces would easily be overlooked. When pressing
Show example the actual spaces will be shown.
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4.3 Libraries

4.3.1 Library

Three different libraries are present in DeskProto: one for machines, one for
postprocessors and one for cutters.
Each library is displayed in a dialog like this:

A library is just a collection of definitions. You can either Add, Remove,
Copy or Edit an item. The definitions are saved to disk in the Drivers folder,
which can be set at the General tab page of the Preferences dialog box. They
are saved to disk when you click the Close button of this dialog, one file for
each driver.

When you add or copy an item, you can set all the values including the
filename. When you edit an item you can set all values except the filename.
If you want to change the filename of a cutter, postprocessor or machine you
can use your operating system to do so (for instance using Windows
Explorer). You need to do this when DeskProto is not running (so close
DeskProto first) because otherwise the old filename will be saved again when
closing the library. The file with the new name will be automatically loaded
when you restart DeskProto.

Further see Library Of Machines, Library Of Postprocessors and Library Of
Cutters.
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All these definitions are stored in files (machines in .mch files, postprocessors
in .ppr files and cutters in .ctr files), to be stored in the Drivers directory of
DeskProto. Button Open location will open that folder in
Explorer/Finder/FileManager. All these files are plain ASCII text files, that
can also be edited using a plain text editor.

4.3.2 Machine
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All settings in the screenshot above are for a "generic" machine definition, to
be used for any machine that runs on ISO G-codes. When you use this
machine definition you will need to edit the speeds and dimensions to match
the properties of your own machine.

The Name is the name that will appear in any DeskProto dialog for selecting
a  machine. It needs not be the same as the filename. Use a name that clearly
indicates which machine you mean. Each machine must have a unique name.

The Filename will be used to store the  machine definition, using the file
extension .MCH . When editing an existing machine you can no longer
change the Filename. You can add, remove and copy machines by
adding/removing/copying MCH files to/from the DeskProto Drivers folder (as
set in the Preferences). The Drivers folder can be found by pressing cancel
here and then button 'Open location' in the underlying dialog.

Button Notes... will open the Notes dialog, in which you can enter extra
information that you want to store in this machine definition. Details like
when it was created, and who created it.

The Postprocessor that you select for this machine will be used to make the
actual NC programs: see the Postprocessor library. The postprocessor is the
most important setting in the machine definition, as it determines the format
of each NC file to be written. Button Library... will open this postprocessor
library.

Most other values that you enter in the Machine dialog are in fact less
important, as they will be used only to check whether the parameters that you
will enter for a project do not exceed the machines' capabilities. So most of
these values do not influence the resulting toolpath (only the Spindle
dimensions do, and some of the Rotary/Laser/Advanced settings).

The Working area is used for validation, to see if all the toolpaths will fit
within the reach of the machine. Also, when drawing the working area of the
machine a box of these dimensions is drawn. Note that these dimensions
often do not match the size of the working table: for many machine the table
is larger than the working area.

Check the option Use for Automatic Tool Changer (ATC) when your
machine  has such ATC. The Number of tools is the number of tools that this
machine can store and select automatically.
Normally this applies only to machines that have an Automatic Tool Changer.
However, some machine without an ATC still are able to process a
toolchange command: by asking the operator to perform a manual
toolchange. For such machines we advise to check this option and to set the
Number of tools to 99.  This number of tools value is used for validation only:
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DeskProto will give an error when the cutter to be loaded has a number that
is higher than this Number of tools.

The Feedrate and Spindle speed Min and Max values set here are used to
validate the speed settings in the operation parameters. The default values are
used for every new operation. And also when you select a different machine
for a project: the speed values for all its operations then will be set to these
defaults. In case your postprocessor uses the feedrate command for rapid
movements, that rapid feedrate is determined by the maximum feedrate that
is set here.
The units for the Feedrate can be set in the Preferences.

The Spindle Dimensions are used for the Collision checks that you can
enable in the Operation parameters: toolpaths will be changed (in case
needed) to prevent such collisions. The result is that some un-machined
material will remain at these locations.
The Collet diameter is used for the collet collision detection: to prevent the
collet from damaging the model. 
The Motor diameter is used for the motor collision detection: this is a similar
check for the spindle motor.
When you check Define motor you can enter dimensions for the Motor
diameter and for the Toolholder height. The illustration in the dialog shows
which dimensions need to be entered.

The Rotation axes... button leads to the Rotary machine settings.
The Hot wire... button leads to the Hot wire machine settings.
The Laser... button leads to the Laser machine settings.
The Advanced... button leads to the Advanced machine settings.



Dialogs

Page 249

DeskProto Reference

4.3.3 Rotary Machine Settings

This dialog is a part of the Machine definition of DeskProto, and can be
reached via the Rotary Settings button on the Machine definition dialog. The
rotary settings configure the availability and dimensions of the optional A and
B rotation axes.

4th axis:
The fourth axis is a device that rotates the part during machining, meaning
that you can machine from all sides. Image it like a roast that is rotating
above a barbecue. Such 4th axis is a very common option on CNC milling
machines. When the rotation axis is parallel to X (as in DeskProto) it is called
an A-axis.

The option Has rotation axis needs to be checked in order to make rotation
axis machining available for this machine. If not, the option "Use rotation-
axis" in the Part parameters will be grayed out, and in the Start/End
commands no A-axis commands are present.
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The Maximum block radius (in previous versions called 'Distance to
working table of machine') is used to check if the block of material is not too
large for the machine. For most desktop machines this is the distance
between the actual rotation axis center line and the machine table below: this
value determines the maximum block diameter (or in fact the radius) for
which the block still can be rotated on this machine.

On some machines the rotation axis can only revolve a limited number of
times, and has to then rewind. Either because of mechanical limitations or
because of software limitations. Other machines allow you to keep rotating in
one direction: for such machine you can check the option A-values may
exceed 360 degrees. Note that the angle value that is sent to the machine will
then keep growing: for instance after 100 rotations it will be A = 36000 (in
degrees).
When this option is not checked the values for A (when setting the area to be
machined) may not be lower than -360 degrees and not higher than 360
degrees. For such machines a helix toolpath is not possible.

As said above: when rotating in one direction all the time the final A-value
can be a very high number. Normally DeskProto remembers that current
position, so the next NC file (for instance for the next operation) will start
with this very high value as A-position.
However, when the first NC file has been finished, some machines will
automatically reset the A-position to the value between 0 and 360 that
represents the same position. For instance A=770 then will be reset to A=50,
as 770 = 2x 360 + 50. Other machines will keep the final A-value as current
position.
When you your machine is a resetter you need to check the option to
Truncate to a value between 0 and 360 degrees for each new NC file.
Otherwise when you start the second NC file your machine will keep rotating
for a long time in order to first reach that high A-value; as only then the
actual toolpath can be started.

One more detail for which CNC machines with a 4th axis show different
behavior is whether or not the machine always takes the shortest route. Say
you have a toolpath where the subsequent steps are for points with these A-
values:  0 | 30 | 60 | 270 | 300 | 330 | 360. Some machines will run this by
keeping the same rotation direction (with increasing A-value) all the time,
also when rotating from 60 to 270.  Other machines however will say that
decreasing A from 60 to -90 is a shorter route to exactly the same position,
and will automatically select that route. Which may destroy your part in case
that was not the intended toolpath. For such machines you need to check the
option Subdivide angles larger than 180 degrees. DeskProto then in the
example above simple inserts one extra point in the toolpath (halfway 60 and
270), making the intended route the shortest for each step in the toolpath.

Rotary machining in DeskProto in fact only uses three axes: X, A and Z: in
the NC file no Y-coordinate will be present. This means that before starting
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such NC file the cutter needs to be moved to Y=0: exactly above the rotation
axis.
The option Write Y=0 in first movement command for rotary machining
adds this movement to Y=0.0 to the NC file. The default is that this option is
NOT checked, as the movement can be dangerous: it will be done at the
current Z-level, and if the Z is too low it might drive the cutter straight into
the block (DeskProto cannot first insert a Z-movement as it does not know
what Z-value to use). So when using this option make sure that the cutter is
positioned high enough to let the cutter move over the block.

The 4th axis in DeskProto by default is an A-axis, so a rotation axis that is
parallel to the X-axis. 
However, on many desktop machines the rotation axis is parallel to Y, as that
will allow a longer rotation axis for these machines. You can use DeskProto
on such machine by checking the option Machine with 4th axis parallel to
Y (swap X and Y coordinates in the NC file). Checking this option will add
an extra Orientator cube to your drawing:
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The two orientators match the two machines as shown above. The orientator
on the left shows the default situation in DeskProto, which for a standard
machines equals the situation on the machine. When the X and Y coordinates
are swapped the NC file will be conform the orientator on the right: with the
rotation axis parallel to Y. All settings in DeskProto then are conform the left
orientator, the NC file is conform the right orientator. These orientators are
visible only when the item 'View orientator' has been checked in the Items
visible dialog.

Note that when you would simply swap X and Y values the resulting
coordinate system would change from right-handed to left-handed, and the
machined parts would be mirror images of the parts in CAD. In order to
prevent that DeskProto will reverse the sign of all new X-coordinates
(multiply the original Y-value with -1.0) when this option is checked. For
rotary toolpaths that won't make a difference as that axis is not used. For
standard three-axis machining you need to correctly position the origin on
your machine.
Only the coordinate values are swapped: the new X-coordinate value will be
formatted using the settings in column X on tab movement of the
postprocessor dialog, same for Y.

Formally speaking such rotation axis parallel to Y is called a B-axis.
However, many machine suppliers still use the A coordinate value to control
it (as it is the 4th axis). When you have checked the option to Swap X and Y
coordinates DeskProto as default will keep writing A-coordinates. Checking
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Use B command for this 4th axis (so also swap A and B) will make
DeskProto use B-coordinate values instead.

For the 5th axis DeskProto supports two different types.

The first type of 5th axis is a CNC controlled B-axis: so an axis identical to
the 4th axis, but then parallel to Y instead of parallel to X. You can enable
such 5th axis in DeskProto by checking the option Has second rotation axis
(CNC-controlled B-axis). When both the 4th axis and this 5th axis are
configured the result is a five-axis milling machine. DeskProto only supports
five-axis machines where the part rotates. This is called a trunnion style 5-
axis machine configuration, or a double swivel table configuration. Machines
where the cutter rotates (swivel head) are not supported.

The photo above shows such trunnion style machine: this means that the
two rotation axis units are built on top of one another. On the photo it seems
as if the small rotation axis is parallel to Z. That can be easily fixed though:
when the large rotation axis turns 90 degrees the result will be one axis
parallel to X and one parallel to Y. In DeskProto the workpiece zero point
needs to be set on the exact location where the two rotation axes intersect.

In DeskProto this 5th axis can be used for indexed machining, using Start
commands in the Operation parameters to issue the rotation commands for A
and B. In the Tutorial manual and the instruction videos you can see how this
works.

The second type of 5th axis is a special feature: the Rotation axis tilt
option. Only a few machines support this (for instance the Roland JWX-10
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and MDX-40). As the image on the dialog shows: the complete 4th axis unit
will be tilted, like a draw-bridge being opened. As this rotation is around the
Y-axis, technically speaking this is a B-axis rotation. The advantage is that
when machining a ring this rotation allows you to also machine the inside of
the ring. On these two machines this tilt-angle needs to be manually set:
unlock the rotation option, rotate to the desired angle and again lock it. The
Tilt option tab of the Operation parameters includes a photo of the Roland
JWX-10 machine carving a wax ring.

The tilt option can also be used on Trunnion-style 5-axis machines (as shown
in the photo above). As said, when on this machine the large rotation axis
rotates 90 degrees the small axis can be used as a standard rotation axis (the
"fourth axis") in DeskProto. And with the large axis on say 45 degrees it can
be used as tilted rotation axis. The tilt angle then needs to be set in the
operation's Start/End commands to have it included in the NC file.

One extra parameter is available for the Tilt option: the Distance to rotation
axis, which sets a vertical distance between the A-axis and the B-axis.This
setting only needs to be used for machines where the A-axis and the B-axis
do not intersect. Like in the illustration above (this is the Inside Ring Engrave
Option by Fourth Axis® in Australia).  For most machines (the two just
mentioned and also the trunnion-style CNC-controlled machines) this
distance is 0.0 and this setting can be ignored.
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4.3.4 Hot Wire Machine Settings

This dialog is a part of the Machine definition of DeskProto, and can be
reached via the Hot wire Settings button on the Machine definition dialog.
The hot wire settings configure the availability and characteristics of a Hot
wire cutting module on your machine.

The option Has hot wire option needs to be checked in order to make hot
wire cutting available for this machine. If not you will not be able to select a
Hot wire cutter (in the Geometry operation parameters).
In order to use this option you need to make sure that hot wire settings have
been configured in the postprocessor that is selected for this machine.

For machines that have the Hot wire unit and spindle motor on different
positions (mostly machines where both options are permanently present) you
can define the Hot wire position by entering an X-offset to the milling
cutter. DeskProto calculates toolpath positions for the cutter, these offsets
tell the program what to add or subtract for X to get the hot wire at that
position.
In the above example the hot wire unit is located 100 mm to the left of the
spindle motor's centerline (with an X-axis from left to right). That means that
in order to get the hot wire on the same location as the cutter all X-
coordinates in the NC file for a hot wire operation will be be corrected by
adding 100 mm.
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For machines without a spindle motor this option can remain unchecked.

4.3.5 Laser Machine Settings

This dialog is a part of the Machine definition of DeskProto, and can be
reached via the Laser Settings button on the Machine definition dialog. The
laser settings configure the availability and characteristics of a Laser
engraving module on your machine.

The option Has laser option needs to be checked in order to make laser
engraving available for this machine. If not you will not be able to select a
Laser cutter (in the Vector operation parameters).
In order to use this option you need to make sure that laser settings have been
configured in the postprocessor that is selected for this machine.

For machines that have the Laser unit and spindle motor on different
positions (mostly machines where both options are permanently present) you
can define the Laser position by entering an X-offset and a Y-offset to the
milling cutter. DeskProto calculates toolpath positions for the cutter, these
offsets tell the program what to add or subtract for X and Y to get the laser
unit at that position.
In the above example the laser unit is located 100 mm to the left of the
spindle motor's centerline (with an X-axis from left to right). That means that
in order to get the laser beam on the same location as the cutter all X-
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coordinates in the NC file for a laser operation will be be corrected by adding
100 mm.

For machines where the laser unit replaces the spindle motor this option can
remain unchecked.

The values that you need to enter for Laser power in most case are NOT the
actual power (in Watts). Most laser controllers use a fixed range
(independent of the actual power), like from 0 to 255 or from 0 to 1000. 
Other controllers prefer a percentage, so values  from 0 to 100. Consult the
documentation of your laser unit to find out what it needs.
The minimum power value of 0 cannot be changed, as that will be used to
switch the laser off.
The values that you enter here are used when setting the S-value in the
Vector Operation parameters.

4.3.6 Advanced Machine Settings

This dialog is a part of the Machine definition of DeskProto, and can be
reached via the Advanced Settings button on the Machine definition dialog.

The Machining time correction factor is exactly what its name suggests: a
factor that is used for this machine to multiply the theoretical machining time
with, in order to get an estimated real Machining time. This factor has to be a
value larger than 1, as the actual machine time cannot be smaller that the
theoretical time. You can find the explication why such conversion may be
needed on page Estimated Machining time.
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The second advanced machine setting is an optimization for the toolpaths:
Strip curved movements at constant Z-level. This optimization makes the
NC file shorter by deleting some intermediate points on the toolpath. 
Each DeskProto toolpath is built using a large number of short straight lines,
the length on each line-segment - determined by the Stepsize along toolpath.
A long straight toolpath will also be calculated as a series of such small steps,
though for such straight movement in fact all intermediate points will be
skipped: one long line will result in the same cutter movement. This
optimization for straight lines is done automatically in DeskProto.
This easy approach is not possible for curved toolpaths like Circular and
Spiral, as DeskProto does not support arc movements. A circular toolpath
also is built using a large number of short straight lines, however here deleting
a point slightly changes the toolpath. Still when machining a flat horizontal
surface such small changes do not matter at all. 
 
For some machines deleting points will make the movement faster and also
smoother, as the controller of that machine does not have enough calculation
power to calculate each small movement in time to keep the machine on
speed. The result will be a non-smooth, slow movement.  For such machine
you may check this option, then DeskProto will delete half of the points on
the circular toolpath. The result will be a faster and smoother movement of
the cutter.

For some other machines checking this option will have a contrary result and
make the movement slower. This will happen for machines with a very fast
controller, that checks the angle between two consecutive line segments on
the toolpath and only keeps up full speed in case these segments are almost
parallel. Deleting intermediate points will increase the angle between the
remaining line segments and force the machine to slow down on every
corner. So for these machines you should not check this option.

4.3.7 Postprocessor

The postprocessor determines the format of each NC file to be written.
Compare this with a printer driver, which translates the contents of a print
file to the language that the printer understands. Same for the postprocessor:
each machine manufacturer uses his own language for NC files (even when
the ISO standard is followed small differences are present), and the
postprocessor translates to that language.
This dialog allows you to configure a postprocessor to write exactly the
language that your machine requires.
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The postprocessor dialog is divided into 8 or 9 tab pages. It is not always
possible to completely display all tabs within the available space. DeskProto
will then add two arrows at the right side of the tabs, allowing you to select
which tabs you want to see. The image above shows how this looks in
Windows.

General settings

The Name is the name that will appear in any DeskProto dialog for selecting
a postprocessor. It needs not be the same as the filename. Use a name that
clearly indicates which postprocessor you mean. Each postprocessor must
have a unique name.

The Filename will be used to store the  postprocessor definition, using the
file extension .PPR . When editing an existing postprocessor you can no
longer change the Filename. You can also add, remove and copy
postprocessors by adding/ removing/copying PPR files to/from the DeskProto
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Drivers folder (as set in the Preferences). The Drivers folder can be found by
pressing cancel here and then button 'Open location' in the underlying dialog.

Button Notes will open the Notes dialog, in which you can enter extra
information that you want to store in this postprocessor definition. Details
like when it was created, and who created it.

When the output file needs Line-numbering, you can switch it on the
checkbox. In this group you can define:
· Start at line - first line in the NC file with a line number (the first few

lines often may not be numbered)
· Start command - command to be written before the actual line number (in

G-code usually an "N")
· End command - command to be written after  the actual line number

(usually empty - not used)
· Start value - the first line-number to be issued
· Increment - the difference between subsequent numbers (so an increment

of 5 will result in line numbers 1, 6, 11 etc).
· Leading zeroes sets the number of positions to be used for the line-

number: value 0 (default) will output the number only, like in N123, a
value of 5 will make DeskProto use 5 positions, resulting in N00123. 

· Finally the option Stop at line makes it possible to have one or more
unnumbered lines at the end of each file. For value 0 entry all lines are
numbered, for value 1 the last line is without number, etc. Only un-
numbered End command lines (see next tab page) are possible, so the Stop
value may not be larger than the number of End-commands on the next
tab page.

In NC-program File, setting a Maximum size is needed for some very old
milling machines, like for instance a Deckel Dialog 4. These machines need
to completely read the NC file before they can start, while at the same time
they have a very limited internal memory (say 256 Kb). For such a machine
the NC program file has to be split up into parts no larger than 200 Kb or so.
After applying this option DeskProto will automatically split the NC-program
file into a series of files, which will be named like this: name, name#2,
name#3 etc.
The Extension (file-extension) is used for every NC program file that will be
created using this postprocessor. It does not influence the contents of the file,
just the file’s name.

The values you enter at the New line decimal values group will be put
behind every line of the output file. Default these are set to the values
13,10,0,0 which will do for almost any machine. The value 13 stands for
carriage-return, the value 10 stands for line-feed, and the values which are 0
will not be used by the postprocessor (unless followed by a non-zero value).
These values are standard ASCII control characters.
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Do not touch these values unless you are absolutely sure what your are doing
!

The Decimal Character will be used for any real number in the NC program
files written. For instance the X-coordinate value 3½ will be output either as
3.50 (decimal point) or as 3,50 (decimal comma).

Start / End Settings

This page contains two editing windows called Start commands and End
commands. Here you can enter the lines that every NC-program must start
with and the lines it must end with. This may include things like turning on
the spindle motor, setting the units to metric or imperial, and other global
functions. You can look at an existing postprocessor for examples. Also
looking in an existing NC program file that works OK on your machine is
helpful here. 

The screenshot above shows two lines with start commands and two with end
commands (this is just an example). The first line ("%") is the standard start
line of many G-code implementations. "G21" tells the machine to use mm as
units  (the alternative being G20 for inches), and "G90" tells to use absolute
coordinate values (the alternative being G91 for relative coordinates). 
End command "M5" tells the machine to stop the spindle, and "M30" means
end of program.

On the left side of the screenshot you will see that a "middle dot" ( · ) is
displayed between G21 and G90, instead of the space that was programmed
there. Reason is that it is often difficult to see if a line starts with a space or
not: the middle dot makes it very clear where spaces are present. When
editing this field (as shown on the right side) and when using Show example
you will again see a space.

In both edit boxes you can use placeholders. These are special bits of text
that you can enter, which will be replaced with a parameter value when the
NC program file is written. For instance the text "{MACHINENAME}"will be
replaced by the name of the machine that is being used. A placeholder that
forces a new line in the NC program is available as well: {N}. A list of all
available placeholders can be found at page Postprocessor placeholders.
For machines that support the use of comment lines in the NC code this is of
course a great place to enter comment lines, showing information for the
machine operator, like when the NC file was generated, the size of the block,
which cutter needs to be loaded, etc.

At the bottom of the page a large button Show example is present. When you
press that button the two large edit boxes will change in two example panes,
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showing what the result will look like in the NC file. The placeholders will be
processed using the settings that DeskProto finds in the first part and first
operation of the current project. The button at the same time will change to
Hide example, that can be used to return to the two edit boxes. So the button
in fact toggles between the two situations.

Movement settings

The Tab page Movement determines the format of all movement command
lines in your NC program, which will be 99.99 % of its contents.

Each movement (so each line in the NC file) is built using a Start command,
some Coordinates and an End command. To see their effect: just look at the
Example line at the bottom to see what will happen when you make a
change. 
The Start command (in the screenshot above "G01") determines that this is
a linear line interpolation command, the Coordinates determine the required
end position of this movement.
Most machines do not require an End command.
The option Only for first movement makes the Movement command
'modal': after being given once it stays valid until a different command is
given.  As a result the Start command will not be repeated every line.

Each of the Coordinate values for X, Y, Z (and A, B) may be configured
separately. A and B are between brackets as these are not used for three-axis
machines.
A Start command and an End command can be defined for each
coordinate. For instance a  character like X, Y or Z to determine the axis, or a
comma to separate the coordinates. Do not confuse this start command for
one coordinate with the Start command for the complete movement
command. Same for the two types of end-command on this page.
Positions gives the minimum number of character positions to be used. So if
positions is set to 7 and the output is 3.000 two spaces will be added, making
the result in this example  'X   3.000'. The default is 1, for 'do not add spaces'.
Decimals gives the number of units to be written behind the decimal point (or
comma), so this affects the precision of the output. This precision is also
applied when drawing the toolpaths on the DeskProto screen. As a default for
mm 3 decimals are used, and for inch 4.
The calculations of DeskProto are either in mm or inches (whichever you
configured in the Preferences). When your output should be in any other unit
you can change the Factor for the X, Y, Z coordinates. For instance a Factor
1000 will output the coordinate in units of 1/1000 mm or inch. This is used in
several NC formats, as it allows to use integers as coordinate values instead
of real numbers. 
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The factor can also be used to reverse the direction of the axis: by entering -
1.00 (minus one) instead of 1.00

Last option for the coordinates is the Default: that value will be used when a
coordinate is Required (see below) however when DeskProto does not yet
know a coordinate value. A Default field may be either empty (used for most
machines), a number (which will be interpreted as coordinate value, written
to the NC file conform the specifications in the column above), or a string
enclosed with quotes (which will be literally copied to the NC file, for
instance "X6p", for Datron machines). So note that 0 and "0" will be treated
differently.
In most cases you can simply leave this field empty, as it is needed only for a
few machines that need a non-standard proprietary format.

In all these edit fields a space will be shown as a "middle dot" ( · ), like in
the example screenshot in front of the X, the Y, the Z, the A and the B. This
is done as otherwise spaces would easily be overlooked.  When editing the
field and in the example line you will again see a space.

In all Start command and End command edit boxes you can use
placeholders. These are special bits of text that you can enter, which will be
replaced with some parameter setting when the NC program file is written.
For instance the text "{TOOLNUMBER}"will be replaced by the number of
the cutter that is being used. A placeholder that forces a new line in the NC
program is available as well. A list of all available placeholders can be found
at page Postprocessor placeholders (despite the name they can also be used
in this dialog).

Write only if changed means that coordinate values are only written in case
changed. So when only Y has been changed DeskProto may write a
command like "G1 Y20.0", meaning that the values for X and Z will remain
the same for this movement.
Also sign positive values adds a "+" in front of every positive coordinate.
Skip trailing zeros makes the file’s size smaller, by removing any
insignificant zero in a coordinate value. For instance 3.400 becomes 3.4 and
3.000 becomes 3. Again please use the example line to see what will happen.

What you enter as Separator will be inserted between the coordinates of the
movement. For instance when you enter "," (a comma) the result may look
like X10,Y20,Z30. Using a space as separator is possible too. The insertion is
done only in-between the coordinate values, so not for instance after the
movements Start command or before a Spindlespeed value that is added to
that same line.

Using the Order/Required edit field you can change the order of the X, Y,
Z, A and B coordinates in the output. Each of these five characters should be
present in this edit box, and all exactly one time.
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In this same field you can make a coordinate value Required, by adding a +
in front of the character. So when you enter +X+Y+Z+AB this means that X,
Y, Z and A are required. This is needed for machines where the position
(sequence) on the line indicates the axis for which each coordinate is meant.
For instance "G1 X10 Z10 A180" on such machine without the required field
would become "MOVE 10, 10, 180", which would send the Y to 10 and the Z
to 180. With the required field the result is "MOVE 10, , 10, 180" (note the
extra comma). What will be written for the missing coordinate value depends
on the setting on line Default, as just discussed.

As Distance unit you can choose between mm and inches for the coordinate
values to be converted to. Make sure that your machine uses the same units:
for some machines you need to explicitly give the command G20 (inches) or
G21 (mm). You can do so at the "Start commands' of the Start/End tab page. 
This postprocessor setting is independent for the Units setting in the
DeskProto Preferences.   This makes sure that inch workers still can use a
metric machine, and the other way round.
The Angle unit is only used for rotation axis machining (degrees or radians),
so it does not apply if your machine does not have a rotation axis. The setting
has been added to be complete, though in fact we have never yet seen a
machine that needs angle values in radians.

The (A) and (B) columns and the Angle units are only used in case a 4th
axis / 5th axis is both present and selected. For three axis machines you can
just ignore these columns.

Rapid Settings

Rapid movements are used to save milling time by moving as fast as the
machine can travel. These are used by DeskProto for positioning moves
above the top of the material block. 
Rapid movements can be achieved either by using a special Rapid Start
command, or by first changing the feedrate and then using the normal
Movement command, at the maximum feedrate of the machine. This
maximum feedrate value can be changed at the Machine dialog.
The option Only for first movement makes the Rapid command modal: after
been given once it stays valid until a different command is given.
Here again the Example line shows what will happen for your settings. 

Feedrate settings:
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Feedrate commands will only be output if the option Use feedrate command
is switched on.
The option Write only if changed will be on for most machines: if not the
feedrate will be output on (or for) every movement line.

The Feedrate command is constructed using a Start-command a number and
an End-command. The result can be seen in the example line at the bottom
of this tab page.
Positions stands for the minimum number of positions that are occupied by
the value of the feedrate, normally this will be 1.
Decimals stands for the number of characters behind the point (or comma).
A Factor is needed when on the DeskProto screen and in the NC file
different units are used. For instance a Factor 1000 will output a number that
is 1000 times larger than what DeskProto shows. This is done when the
machine needs to read value 50000 to set a speed of of 50 (mm/sec).

In the Start-command and the End-command you can use placeholders.
These are special bits of text that you can enter, which will be replaced with
a parameter value when the NC program file is written. For instance the text
"{F}" will be replaced by the current Feedrate. A placeholder that forces a
new line in the NC program is available as well, which allows you to
construct a command that uses two lines. A list of all available placeholders
can be found at page Postprocessor placeholders (despite the name they can
also be used in this dialog).

In these two edit fields a space will be shown as a "middle dot" ( · ), like in
the example screenshot in front of the F. This is done as otherwise spaces
would easily be overlooked.  When editing this field an don the example line
you will again see a space.

The Method setting is self-explanatory.

The Units need to be set to the feedrate units that your machine needs. In
case these are different from the units for the DeskProto user interface
(which you have set in the Preferences) DeskProto will convert the value to
the correct units. The conversion is new in DeskProto V8 - older versions
simply copied the value as entered for an operation to the NC file.

The correct feedrate for rotation axis movements (so cutting movements
that also include a rotation of the A-axis) is a difficult issue. In standard G-
code the feedrate is defined only as linear speed, so a good controller should
use the linear feedrate that has been set and then calculate how fast the
rotation axis needs to rotate in order to reach the prescribed speed. That is a
difficult task though, as the linear length of a rotary movement depends on
the distance to the rotation axis: the further from this axis, the larger the
length (for the same angle). Unfortunately most machines cannot make such
calculation. 
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DeskProto offers two alternative methods for rotary feedrate:
Use inverse time feedrate for rotary movements - instead of the speed,
specify the time needed for the total movement. DeskProto knows the length
of the movement, so it is easy to calculate the total time to complete this
movement at the prescribed feedrate. The machine then can set the correct
speed for each of the moving axes. This is the best option: so in case your
controller supports inverse time feedrate: select this option !
Use angular feedrate for rotary movements - specify the rotary feedrate in
degrees per time unit. This solves the feedrate issue for movements that only
include an rotation axis movement, however for combined movements
(rotation axis + linear axis) the problem will persist. Still some machines
expect this type of feedrate.

Only one of both options can be checked (or none). In case one of these
options is checked in extra tab page will appear in the postprocessor dialog:
"Rotary feedrate". Both options - both extra tab pages -  will be explained
below.

The Example line shows what the result will look like, using the feedrate
found in the first operation of the current project.

Inverse Time Feedrate settings

This tab page will only be visible when on tab page Feedrate the option "Use
Inverse Time Feedrate for rotary movements" has been checked. It concerns
the feedrate that will be used for cutting movements that include a rotation of
a rotary axis.

When setting the feedrate in linear/time units it is difficult to determine how
fast the rotation axis needs to rotate, when using angular/time units it is
difficult to determine how fast the linear axis needs to move. A good solution
is to instead define the time that may be used for the total movement. The
controller then can easily calculate how fast each of the axes needs to move. 

For historic reasons the parameter for this option is not the time but the
inverted time  (1 divided by the total time). The resulting F-values in the NC
file will seem weird as they can be very high - do not worry as such high
values are perfectly normal.

The Time for each movement can easily be calculated by DeskProto, as 
Distance / Linear feedrate
Important is that when roughing layers are applied the (linear) Distance to be
machined will be measured at the Maximum Z of the current roughing layer.
This is needed as the linear speed through the material at that Z-level will be
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(much) higher than for the tip of the cutter, as there the distance to the
rotation axis is larger.

Inverse time is a modal command: it needs to be switched on and off.
The Switch commands can be defined here:
- the On command in standard G-code is G93.
When switched on every movement command needs to contain a Feedrate
(or rather time) value.
- the Off command in standard G-code is G94   (in fact this is the command
to set Linear feedrate).

For Units only the Time unit can be selected: either minutes or seconds.

The settings for Command and for Method are identical to those on the
Feedrate page.

The Example line shows what the result will look like, using a value of 1.

Angular Feedrate settings

This tab page will only be visible when on tab page Feedrate the option "Use
Angular Feedrate for rotary movements" has been checked. It concerns the
feedrate that will be used for cutting movements that include a rotation of a
rotary axis.

Some machines require the feedrate for rotary movements (either for
movements that only rotate the A-axis or for movements that combine a
rotary move with a linear component) to be set in Angle per time units.
On this page you can set the Units to be used:
for the Angle either degree or radian
for the Time either millisecond, second, minute or hour.

After selecting this option DeskProto will convert the linear feedrate (set in
the Operation parameters) to an angular feedrate, for every movement that
includes an angle. Important is that when roughing layers are applied the
(linear) Distance to be machined (needed for this conversion) will be
measured at the Maximum Z of the current roughing layer. This is needed as
the linear speed through the material at that Z-level will be (much) higher
than for the tip of the cutter, as there the distance to the rotation axis is
larger.

In case your machine also supports the Inverse time feedrate (see above) that
method is preferred, as the Angular feedrate method is not accurate for
movements that combine a rotary and a linear component in one movement.
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The settings for Command and for Method are identical to those on the
Feedrate page.

The Example line shows what the result will look like, using a value of 1.

Spindle speed settings

Spindle commands will only be output if the option Use spindlespeed
command is switched on.

The Spindlespeed command is constructed using a Start-command a number
and an End-command. The result can be seen in the example line at the
bottom of this tab page.
Positions stands for the minimum number of positions that are occupied by
the value of the feedrate.
Decimals stands for the number of characters behind the point (or comma).
A Factor is needed when on the DeskProto screen and in the NC file
different units are used. For instance a Factor 0.01666 will output a number
that is 60 times smaller than what DeskProto shows. For instance 167
revolutions per second instead of 10000 revolutions per minute (though we
have never seen a machine that requires such conversion).

In the Start-command and the End-command you can use placeholders.
These are special bits of text that you can enter, which will be replaced with
some parameter setting when the NC program file is written. For instance the
text "{S}" will be replaced by the current Spindlespeed. A placeholder that
forces a new line in the NC program is available as well, which allows you to
construct a command that uses two lines. A list of all available placeholders
can be found at page Postprocessor placeholders (despite the name they can
also be used in this dialog).

In these two edit fields a space will be shown as a "middle dot" ( · ), like in
the example screenshot in front of the S and the M3. This is done as
otherwise spaces would easily be overlooked.  When editing this field and on
the example line you will again see a space.

The option Apply the Dynamic feedrate control percentages also on the
Spindlespeed is about an option on the Movement tab of the Geometry
operation parameters. The Dynamic feedrate control options on this tab
page allow you to reduce the feedrate in certain circumstances. When the
feedrate is reduced the spindlespeed may become too high, so the cutter no
longer can cut clean chips. This postprocessor option makes DeskProto
reduce the spindlespeed as well, with the same percentage.
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The Method setting is self-explanatory.

The Units to be used cannot be set: for the Spindle speed the unit always is
RPM  (Rounds per Minute, or Revolutions per Minute).

The Example line shows what the result will look like, using the spindle
speed found in the first operation of the current project.

Toolchange settings

DeskProto will create one combined NC program file for all operations in a
part. However, for every operation a different cutter can be used, so in case
you are using various cutters in one part (which would thus mean in one NC
program) you have to define what must happen at a tool change. Select one
of the three options. 

Use change-command in NC program can be used in case the milling
machine is equipped with an automatic tool change system (ATC =
Automatic Tool Changer). To define the actual command you can use one,
two or three lines, as some controllers require separate lines to select the next
cutter and to actually load it. For each of these lines you can select whether
or not the Tool Nr has to be present on the line. The Example line on the
bottom of this dialog will show the result. 

In the illustration above two lines are used, each mentioning the tool number
(Note that this is just an example: probably not valid for your machine). The
first line in this example ("T1 M06") is pretty standard G-code: T for the tool
number to be loaded, and M6 to start the ATC operation. Note the space just
before the “M6” (spaces are shown as "high dots"). For many G-code
machines this first line will be sufficient. The second line "G43 H1" sets the
tool length compensation for this next cutter, which for this machine
apparently is not done automatically. "Z1.0" after G43 moves the cutter to
Z=1.0 for a visual check of the tool compensation, and "M08" switches the
Coolant on. As you can see you can configure the postprocessor to meet your
own preferences.

In all edit fields you can use placeholders. These are special bits of text that
you can enter, which will be replaced with some parameter setting when the
NC program file is written. For instance the text "{TOOLNUMBER}" will be
replaced by the tool number current cutter. A placeholder that forces a new
line in the NC program is available as well, so if needed you can use more
than three lines. A list of all available placeholders can be found at page
Postprocessor placeholders (despite the name they can also be used in this
dialog).
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In all these edit fields a space will be shown as a "middle dot" ( · ), like in
the example screenshot in front of the M06. This is done as otherwise spaces
would easily be overlooked.  When editing this field and in the example line
you will again see a space.

Note:
For this method be sure that the ‘Number of tools’ of the machine is set
correctly. You can do that in the Machine definition. Also be sure that the
cutters that you use in DeskProto have the correct "Number in machine"
parameter. You can set that in the Cutter dialog. You also have to check if
the correct cutter is indeed loaded on this position of the machine’s tool
changer: DeskProto just loads Tool No “N” without knowing if it is indeed
the right cutter.

Note 2:
Some machines that do not have an Automatic Tool Changer still accept a
tool change command. These machines will then start some process that
allows you to manually change the cutter. For such machines the Number of
tools in the Machine definition needs to be set high enough, we usually enter
99.

Use pause-command in NC program lets you change the cutter manually,
however within the same NC program. The Pause command will stop the
machine for this purpose. You must define the pause command in the pause
field. For most machines such command is not available though. It needs to
be a special Pause for toolchange command: a standard Pause will only wait
for the prescribed time (which is of course dangerous when changing a tool)
and will not allow tool length compensation (needed because the new cutter
will have a different length).

Use new NC program will cause a next NC program to be created. If your
machine does not support a tool change or if you do not know, it is best to
choose this option. After ending the first file you can then change the cutter,
correct the zero position for the length of the new cutter, and start the second
NC program file.
When writing toolpaths that need multiple NC program files, names for the
subsequent files will be automatically generated by DeskProto. In case you
chose the name Test.nc and the two operations were called Roughing and
Finishing, then the first file will be called Test#1_Roughing.nc and the second
file Test#2_Finishing.nc 

Note:
Use new NC program is the safest, and thus it is the DeskProto default for
this option
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The Example line shows what the result will look like, using the tool number
found in the first operation of the current project.

Laser settings

DeskProto supports machines with a laser engraving option. Such option
means that instead of a cutter a laser is used, with its beam pointed
downwards (vertically). Where the laser beam hits the surface of the material
that will burn, and the resulting discoloration can be used to 'engrave' text
and/or graphics. The burning can also be used to cut a path through thin
material: laser cutting. DeskProto supports laser engraving / laser cutting only
for vector operations.

Laser engraving is possible only when on this page the option Use is switched
on and when a laser option has been configured in your machine definition.
You then can activate it by selecting a laser cutter in the vector operation
parameters.

The Laser mode commands are the commands to switch the machine to laser
mode (Start) and to switch back to CNC machining (End). In the example
above no such command is present, as on that machine laser mode is
switched on by loading cutter number 100 and again switched off by
selecting a different cutter.
The M8 and M9 in the edit fields in this example are to use the laser's air
assist: blow air over the area in order to remove the smoke and the debris and
to cool the material. Without this air assist the smoke may pollute the laser's
lens, and the laser or part may become too hot. M7 and M8 are the most used
commands to turn on air assist, M9 to switch all coolant off.

So on the machine laser engraving can be enabled either by selecting a
special cutter or by using this special laser mode command.  However, in
DeskProto laser engraving can be enabled only by choosing a laser cutter (in
a Vector operation). When the postprocessor includes a toolchange command
DeskProto will write that command, telling to load the laser cutter. Which is
not needed for machines that use a laser mode command: for these machines
you can check the option Suppress Tool Change command.

On many machines the Spindlespeed command ("S") is used as Laser on/off
switch.  For these machines you can simply select the option Use
Spindlespeed command. Setting the S-value to 0 will switch the laser off,
setting a different value will switch at on, at a certain power level. In a laser
toolpath DeskProto will automatically set the S-value to 0 for all positioning
movements.
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When your machine needs different commands to control the laser power
you can select Use custom commands and enter the required commands for
On and Off.
The third option is None, which can be used for machines that automatically
control the laser power: laser off for rapid moves. Some machines even will
lower the laser power when the feedrate drops at sharp corners.

The Example line on this tab page shows the two Laser on/off command
lines.

This is a second example, with completely different settings, to show that the
settings may be very different per machine.
The image above shows the settings created for an Eding CNC controller.
These including both commands and comments.

The Laser mode Start command for this machine is:
; Switch on the air assist{N}m8{N}; Use dynamic power control, minimum power 10%.{N}m12 s10
which will result in 4 lines in the NC file:
; Switch on the air assist
m8
; Use dynamic power control, minimum power 10%
m12 s10
The lines that start with a semicolon for this controller are comment lines,
and {N} is a placeholder that inserts a new line.

The Laser mode End command is:
; End laser engraving mode{N}m12{N}; Wait 5 sec before switching off the air assist{N}g4 p5{N}m9
with these lines as result:
; End laser engraving mode
m12
; Wait 5 sec before switching off the air assist
g4 p5
m9
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As Laser on/off switch his machine uses a custom command: M11. The Start
commands needs the S-value, which is inserted using placeholder {S}.

The example line shows both the Laser On and the Laser Off command.

Hot wire settings

DeskProto supports machines with a hot wire cutting option. Such option
means that instead of a cutter a hot wire is used: a horizontal wire, parallel to
the Y-axis of the machine. This wire is heated and can cut EPS foam by
melting it. The wire follows a 2D toolpath, moving along X and Z. DeskProto
supports hot wire cutting only for geometry operations and for bitmap
operations.

Hot wire cutting is possible only when on this page the option Use is switched
on and when a hot wire option has been configured in your machine
definition. You then can activate it by selecting a hot wire cutter in the
operation parameters.

The hot wire mode commands are the commands to switch the machine to
hot wire mode (Start) and to switch back to CNC machining (End).
DeskProto does not offer an option to set the power or the temperature of the
wire; if needed such command can be included in the Start command, with a
fixed value.
In the screenshot above no mode commands are present, as on that machine
hot wire mode is switched on and off manually.

On the machine hot wire cutting can be enabled either manually or by using
this special laser mode command.  However, in DeskProto hot wire cutting
can be enabled only by selecting a hot wire cutter (in the operation
parameters). When the postprocessor includes a toolchange command
DeskProto would write that command, telling to load the hot wire cutter.
Which is not needed for most hot wire machines: for these machines you
need to check the option Suppress Tool Change command.

Many hot wire cutters use names for the three Axes of the machine that do
not match the XYZ convention as used for CNC machining. Hot wire cutting
basically is a 2D process, so on many machines only the X and the Y are
used. The X axis is the same as for CNC milling, however the Y coordinate
on the machine is in fact the Z-coordinate in DeskProto (the height of the hot
wire). For these machines DeskProto needs to use the "Y" as Character for
the Z-axis. We have also seen machines that use character "C" for the height
of the hot wire.
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The hot wire is attached to the machine on two sides, and advanced hot wire
machine support an option to make each side follow a different path. For
such complicated "3D" path an NC file is needed with four coordinate values
for each G1 command, we have for instance seen machines that use X, Y, U
and V coordinates. X and Y for one end of the wire, U and V for the other
end. 
DeskProto does not offer the option to use different paths for both ends of
the wire. When a machine still needs 4 coordinates for a simple 2D path you
can configure DeskProto to Use two slave axes: for the machine just
mentioned you need to enter "U" as slave of X and "V" as slave of Y.  The G-
code command "G1 X100.0 Y200.0" then will be written as "G1 X100.0
U100.0 Y200.0 V200.0".

It will be clear that changing coordinate characters in the NC file only is
possible when characters are used to indicate the axes. For many
postprocessors that is not the case, meaning that axes cannot be renamed in
the NC file. Because of this these Axes options are available only for G-code
based postprocessors.

The Example line on this tab page shows what the movement command in
G-code will look like with the options that you configured here.
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4.3.8 Cutter

The screenshot above shows the definition for a very strange cutter. It has
been configured only for this screenshot: in order to have all dimensions
activated and also visible in the preview drawing.

The Name is the name that will appear in any DeskProto dialog for selecting
a  cutter. It needs not be the same as the filename. Use a name that clearly
indicates which cutter you mean. We advise to show in this Name whether
you mean radius or diameter for any number (you will forget if  'Ball6' means
R6 or D6). Each cutter must have a unique name.

The Filename will be used to store the  cutter definition, using the file
extension .CTR . When editing an existing cutter you can no longer change
the Filename. You can also add, remove and copy cutters by
adding/removing/copying CTR files to/from the DeskProto Drivers folder (as
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set in the Preferences). The Drivers folder can be found by pressing cancel
here and then button 'Open location' in the underlying dialog.

Button Notes will open the Notes dialog, in which you can enter extra
information that you want to store in this cutter definition.  Details like when
it was created, and who created it.

DeskProto offers seven Types of cutter, six of which are variants of three
basic types: flat (square cutter), ball nose (spherical tip) and conical (V-
shaped cutter or tapered cutter). Both conical and ball nose can be given a
flat tool-tip, conical can be given a ball nose tooltip as well. For that last type
(Conical with ball tip) check the image on the bottom of this help page for the
exact meaning of 'Tip diameter'.
For cutter type Special an extra dialog is present, to configure the Special
Cutter settings.

Depending on the type that you select, some of the Dimensions will be
disabled. For example a flat cutter does not have a cutting angle. In order to
support 1/8 inch (3.175 mm) cutters with your DeskProto configured to use
mm, all dimensions in this dialog can be set with 3 decimals accuracy.

For each type you can check the option Multiple diameter, to define a tool
of which the shaft (the part that fits in the collet chuck) is thicker than the
flute (the part that actually cuts). This is a commonly used model for small
cutters. When correctly defined, DeskProto will make sure that the thick
shaft does not damage your model at (almost) vertical surfaces.

Just look at the drawing in the Preview to see the cutter that you have
defined.

The image below gives an explanation of most terms used for the
Dimensions.
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The Free length is the length of the part of the tool below the collet. So this
is not the total length of the cutter. The free length is not constant, as it
depends on how far you insert the cutter in the collet. DeskProto uses this
parameter only for the collet collision check. In the Preview image the free
length is shown by a horizontal black line.

The meaning of Shaft diameter will be clear. For single diameter tools the
Flute diameter is identical to this value.

The Slope Angle is available only for multiple diameter cutters. It defines the
transition between the thick shaft and the thinner flute, which for most of
these cutters has a conical shape. DeskProto needs this information to make
sure that the thick shaft and the sloped part will note collide with your part.

The Flute length is only available for multiple diameter tools, as it is the
length of the small diameter part which is called the flute of the cutter.

The Flute diameter (or flute diameter) is the nominal diameter of the cutter,
used for the calculations (do not confuse Diameter with Radius!). It can be
set only for multiple diameter tools, as otherwise it is the same as the shaft
diameter.
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The Cutting length is the length of that part of the tool that actually cuts: it
will be used to calculate Layers as the tool may not sink into the material
deeper than this value (in case you do not select Roughing then DeskProto
will automatically do so for the first Operation). In the Preview image the
cutting length is shown by a red color.

The Tip diameter is the diameter of the flat tip for cutter types with a flat
tip. For conical cutters with a ball tip see the explanation of this setting at the
bottom of this help page.
For Ball nose cutters (also called 'bull-nose cutters") this setting is named
Corner radius, as that is the way that Ball nose cutters with a flat tip are
defined. For instance a Ball/Flat cutter with diameter 10 and corner radius 2
will have 6 mm diameter flat area at its tip.
A special cutter type can be defined by choosing “Ball nose with flat tip” and
setting the Corner radius larger than half the Flute diameter (which normally
is nonsense). This creates a special cutter with a curved tip, as shown in the
preview drawing. Such cutter also is called a 'Lens type cutter'.

The Cutting angle is for conical cutters only: it is the angle between the
cutting edge and the center-line of the tool (so the side angle, or ‘grinding
angle’). Do not confuse this with the ‘included angle’ that is also used in
cutter definitions. 
You can also use this parameter to define special tapered cutters having a
draft angle of say 3 degrees.
Here as well: just try and look what happens in the Preview.

Next to each of the last three edit boxes a calculator icon is present, which
is activated (color red) for all conical cutters. Clicking this icon will make
DeskProto calculate the value of this setting, based on the other two. For
instance: the cutting length will be calculated based on the Tip diameter and
the Cutting angle, assuming that the cutting edge stops at the end of the
angled part of the cutter.

The Preview shows you the currently defined cutter-definition in a drawing,
which is a very convenient help when setting the parameters in this dialog. A
preview can of course only be drawn when a correct set of dimensions have
been entered first (for invalid setting a red cross will be shown). The area in
dark red shows the cutting length, the horizontal line at top indicates the
bottom of the collet and thus shows the free length.

The Tool number indicates on which position of the Automatic Tool
Changer (ATC) this cutter needs to be loaded. So this is used only when your
machine supports a  Tool change command. The number will be used for
any toolchange command written in the NC-program file.
Important:
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This number can be different for each machine and even for each situation,
as the operator has to load the correct cutter in the correct location of the
ATC.

The Maximum spindlespeed is used only for validation of your projects
(some larger cutters may not rotate at a high rpm as they are insufficiently
balanced).

The option Automatically set speeds when selecting this cutter may be
very handy when you have standard milling conditions. For instance when
you always machine in wax (jewelry wax models) you may want to always
use the same low feedrate and high spindle speed for a certain thin cutter. 
Then you can define these two speeds here, and in the Operation parameters
DeskProto will automatically set these values for Feedrate and
Spindlespeed when this cutter is selected.

For cutter type Conical with ball tip an extra remark is needed, to exactly
explain the dimensions of this cutter type. We have found that cutter
manufacturers use two different methods to define the tip diameter. See the
image above, drawn for a conical cutter with a tip diameter of 2 mm.
· on the left: the 2 mm is the diameter at the tangency point of angled

cutting side and tip radius (the green 2 mm dimension). The conical part
stops at 2 mm diameter, and then a ball is added with a diameter that
makes it tangent to the cutting side. The diameter of that ball will be a bit
larger than 2 mm.

· on the right: the 2 mm is the diameter of the (half) sphere is used as tip
(the red 2 mm dimension). Now the diameter of the ball is 2 mm, and the



DeskProto Reference

Page 280

cutting side is made tangent to that ball. The diameter of the tangency
point is a bit smaller than 2 mm.

DeskProto uses the first definition (left side of the image): the diameter of the
sphere is a (tiny) bit larger than the "tip diameter". The smaller the cutting
angle, the smaller the difference.

4.3.9 Special Cutter settings

Most of the cutters in DeskProto (defined in the Cutter definition dialog)
rotate round a vertical axis: basically a cylinder shaped cutter that is clamped
in the collet and cuts by rotating round the central axis of this cylinder.
In this dialog you can define a few Special cutters. You can reach it by
pressing button Settings for type Special in the Cutter definition dialog.

Be careful:  DeskProto has been designed for standard cutters. The special
cutters in this dialog have been added on user request, for special
applications. The number of users is low, and thus these toolpaths have not
been tested as extensively as paths for normal cutters. So carefully check
your results before starting your machine !

Six special cutter types are available, of which the first four are milling
cutters: they function by cutting small chips off and thus making the block
smaller. The Other two cutter types do not make chips, instead they burn or
melt the material . These two need a machine that offers this special tool, and
therefore such cutters can be selected only when the tool has been
configured: both in the current machine definition and in the current
postprocessor.
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Most special cutters also cannot be used in all three operation types (vector,
geometry and bitmap).

These special cutters can be very large (compared to the part). As a result it
can happen that in the Toolpath animation, when the 'True cutter' is shown,
the cutter is not drawn completely as it partially falls outside the 3D Viewport
(the 3D space that is rendered).

Chainsaw

A chainsaw can convert solid wood to chips much quicker than a 'normal'
cutter can. So when you want to produce large wooden parts as fast as
possible it makes sense to use a chainsaw for roughing.
You can define this special cutter by entering dimensions for its Diameter,
Thickness and Maximum layer height. Diameter and Thickness are
explained in the drawing, the Maximum layer height tells how deep the
chainsaw may sink into solid material (equivalent to the cutting length of a
normal cutter).

Selecting this cutter will not only set the shape of the cutter, it will also make
sure that inside the material the cutter may move only along a straight path: it
may not move sideways and also not change direction. All positioning
movements therefore need to be done above the material (a setting called
Never Stay Low is applied internally), and as Strategy only Parallel is
possible.
Chainsaw cutters therefore cannot be used in vector operations.

Circlar saw / Disk cutter
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Here the same settings and limitations apply that have been explained for the
chainsaw.
Note that this cutter type is not about a T-slot cutter or side-milling cutter,
with a small horizontal sawblade on a vertical shaft that can be loaded as a
normal cutter. This is about a cutter as shown on the photo, which is used for
a very fast roughing operation.
Circular saw cutters also cannot be used in vector operations.

Rounded disk cutter
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Again the same settings and limitations apply that have been explained
explained for the chainsaw.
We have seen this type of cutter in special machines, for instance to produce
shoe lasts, as shown in the photo.
Rounded disk cutters also cannot be used in vector operations.

Horizontal cutter
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This cutter type will mainly be used in combination with a rotation axis, as a
method to create very efficient (roughing) toolpaths.  We have seen this on a
few machines. You need to make sure that the cutter is long enough as
DeskProto does not check that.

The only dimension that you can set for this cutter type is its Diameter.
The Length of this cutter cannot be set: DeskProto simply assumes that the
cutter is long enough to machine the full width of the part in one movement
(setting "Auto").
A Maximum layer height does not apply either, as for this cutter type
roughing layers are not applied
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As no roughing layers are applied this provides a very efficient way of
roughing, without creating many chips. Though a manual intervention is
needed to remove the top part of the block after it has been cut loose. Extra
care is needed too: normally after a roughing operation you can immediately
start finishing, as all excess material has been removed. This type of roughing
does not guarantee that, so some extra roughing may be needed before you
can start finishing.

The resulting toolpath in fact is a 2D toolpath: only X and Z are used: for the
Y as said the cutter needs to be long enough to machine the complete part. In
the resulting NC file DeskProto will automatically suppress this third
coordinate.  This suppressing does not apply to rotary machining: then the
third coordinate is A, and that will surely be used!

Note that the Z=0 level that you set on the machine for this cutter refers to
the centerline of the cutter. So you cannot simply set Z=0 at the top of the
block by lowering this horizontal cutter till it touches the block.
Horizontal cutters cannot be used in vector operations. 
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The fourth option that you can select for a horizontal cutter is Swap Y and Z
coordinates in the NC file, to use this toolpath with a vertical cutter. 
As said: this toolpath provides a very efficient roughing method for rotary
parts, which can also be useful when your machine only has a standard
vertical cutter.That is possible by checking this option: see the photo above.
The 2D toolpath now will be an XY toolpath, and the cutter needs to be long
enough (and at the correct height for Z=0) to machine the complete part.

The resulting toolpath will be similar to a 'Contour-only' toolpath. However,
when combined with rotary machining this cutter will create many such
contour paths in one operation.
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Note that when we would simply swap Y and Z values the resulting
coordinate system would change from right-handed to left-handed, and the
machined parts would be mirror images of the parts in CAD. In order to
prevent that DeskProto will reverse the sign of all new Z-coordinates
(multiply the original Y-value with -1.0) when this option is checked. For
rotary toolpaths that won't make a difference as the cutter will remain at Z=0.
This will only effect Before- and After-commands in your project. In case
this option is combined with a rotation axis parallel to Y (a machine setting)
the swapping will be done with X and Z (in which X has already been
swapped by the machine setting). Complicated, however it works fine.

Hot wire 

The hot-wire is a completely different type of cutter: it cuts a narrow gap
through a block of PolyStyrene by melting the material. You can find more
information about this technology on page hot wire cutting. 

You can select a hot wire cutter only when a hot wire option has been
configured for your current machine and in your current postprocessor. As
this is about a horizontal hot wire this type of cutter cannot be selected in a
vector operation.

The definition of a hot wire cutter is very similar though to that of the
horizontal cutter, see the previous paragraph.
Again the only dimension that you can set for this cutter type is its Diameter.
Note that this is not about the diameter of the cutting wire, it is about the
width of the gap that is created while cutting.

No roughing layers are applied for the hot wire, which provides a very
efficient way of roughing: without creating many chips. Though a manual
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intervention is needed to remove the top part of the block that has been cut
loose. Extra care is needed too: normally after a roughing operation you can
immediately start finishing, as all excess material has been removed. This
type of roughing does not guarantee that, so some extra roughing may be
needed before you can start finishing.

The resulting toolpath in fact is a 2D toolpath: only X and Z are used, and
both ends of the wire follow the same toolpath. For the Y as said the hot wire
needs to be long enough to machine the complete part. In the resulting NC
file DeskProto will automatically suppress this third coordinate.  This
suppressing does not apply to rotary machining: then the third coordinate is
A, and that will surely be used!

Note that the Z=0 level that you set on the machine for this cutter refers to
the centerline of the wire. 

Laser
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One more cutter that is completely different: the laser cuts by burning the
material. It can be used to actually cut through a sheet of thin material or to
engrave a graphic image on the material (burning the surface will change the
color). In DeskProto it will mainly be used for engraving, as cutting can also
be done using a normal cutter. You can find more information about this on
page laser engraving.

You can select a laser cutter only when a laser option has been configured for
your current machine and in your current postprocessor. As the laser cuts or
engraves only at one Z-level this type of cutter can only be selected in vector
operations.
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The photo above shows a laser cutter applied to engrave on a 3D part that
just has been cut on a rotation axis. This is done by selecting the option
"Project vector curves on 3D Part geometry", which can be selected only if a
geometry operation is present before the vector operation. 

The only dimension that you can set for this cutter type is its Beam width,
also called Kerf. The Kerf is the width of the gap that is created when cutting
and the width of the line that is drawn when engraving.
The laser power and the laser position can be set in the machine definition.

4.3.10 Driver Notes

In each of the three dialogs to edit a DeskProto driver (Cutter, Machine and
Postprocessor) you can find the button Notes, that will open this dialog. The
Notes that you enter here will be stored as comment lines at the start of the
Driver file that you are editing.

These notes will not be used by DeskProto, they are just for your own
convenience. You can for instance store for a certain cutter the exact type
and where or when you have bought it. Or any other detail about this driver
that is not relevant for DeskProto but that you still want to remember.
You can also use this space for notes to store a "revision history" for the file:
when has it been changed, by whom and why.
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In the driver file (*.ctr, *.mch or *.ppr) each of the lines will be preceded by
a semicolon, which marks them as comment lines.
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4.4 OpenGL warnings

4.4.1 OpenGL driver: version

DeskProto uses a graphics language called OpenGL to display graphics
information (a drawing) in its View Window.  This language has been defined
long time ago, and over the years already many new Versions have been
defined, each time adding extra functionality to the language. DeskProto
needs OpenGL Version 2.1 or newer, when your driver version is too low
this warning will be shown when the program is started.

Apart from these differences between various versions the OpenGL language
supports "Extensions": extra functionality that is not required and thus may
and may not be present.

When this warning is given you can continue using DeskProto, however at
some points the graphic behavior will be below standard. The advise is to
download and install a new driver for your graphics card. You then need to
find out the brand and type of your graphics card, visit the website of the
card manufacturer and there look for a driver for your type card. In most
cases you can download drivers in a section called Support or Download.
When your PC and your Windows version are very old this may no loner be
possible.

In case you have a choice, select the driver that supports OpenGL.
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Like for all AMD Graphics cards (formerly ATI), where you can choose
between downloading
1- the Catalyst Software Suite
2- the WDM Integrated Driver
Here you need to select the Catalyst suite, as the obsolete WDM driver
(Windows Driver Model) does not support OpenGL. Windows then will fall
back on its old software renderer (OpenGL V1.0) to create the graphics,
which misses some features and will also make DeskProto very slow.

Important to know is that using the button "Update Driver" in the Windows
Device Manager does not always find the latest driver ! So you need to check
the card manufacturer's website.

A big advantage of OpenGL is that it makes hardware implementation
possible: let specialized hardware on the card do graphics calculations,
making it much faster than using software. The more expensive your graphics
card, the more can be done by hardware, and the faster all graphics will be
displayed.
An important feature is the Retained mode rendering, as mentioned in the
warning text. This means that the complete 3D scene is stored in the card's
graphics memory, using a 'vertex buffer'. So in order to change the
viewpoint, the software only needs to send the new camera position to the
card, the rest will all be done in hardware. You can imagine that this is much
quicker than again sending the complete scene to the graphics card for each
change (which is called Immediate mode).
Vertex buffers are available from OpenGL V 1.5

A few OpenGL related settings can be found in the Preferences. In case of a
limited driver not all functions will be available.
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4.4.2 OpenGL driver: extensions

DeskProto uses a graphics language called OpenGL to display graphics
information (a drawing) in its View Window.  This language has been defined
long time ago, and over the years already many new Versions have been
defined, each time adding extra functionality to the language. DeskProto
needs OpenGL V2.1 or newer.
Apart from these differences between various versions the OpenGL language
supports "Extensions": extra functionality that is not required and thus may
and may not be present.

A few features are present in DeskProto that depend on such extension: if not
present the function cannot be executed and this warning dialog will be
shown. This concerns the following features:
- Print Image (File menu)
- Generate Contour (Set freeform area).

A similar warning will be shown when one of these functions is called,
without the list of limitations.

Some other features will simply be disabled (grayed out) when the required
extension is missing.
For instance Anti-aliasing (Advanced Preferences).

For Windows and for Linux is may be possible to solve this by downloading
and installing a new driver for your graphics card. You then need to find out
the brand and type of your graphics card, visit the website of the card
manufacturer and there look for a driver for your type card. In most cases
you can download drivers in a section called Support or Download. When
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your PC and your Windows version are very old this may no loner be
possible.

For Apple the situation is different: MacOS simply does not support the
extensions that are needed, so installing an upgrade will not fix this.
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4.5 Activate license

In Windows and in Linux this command can be found in the Help menu, in
MacOS in the DeskProto menu.

The Free Edition of DeskProto can and may be used without buying a
license. Users who need more functionality can buy a license to activate
(unlock) one of the higher Editions: Entry, Expert or Multi-Axis. 

In case you are not sure which edition you need: one of the options in the
Free edition is to evaluate (trial) these higher Editions - when trialling a
watermark (the "Trial cross") will be visible in all machined parts. On the
DeskProto website you can also find a comparison table for these four
editions.

In all cases you need to first download the DeskProto installation file from
our website www.deskproto.com and instal DeskProto on your computer.
This installation file (a Setup file for Windows, a DMG file for MacOS or an
AppImage file for Linux) is the same for all Editions of DeskProto.

http://www.deskproto.com
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A free DeskProto license is given to any user: you are welcome to use the
Free Edition of DeskProto free of charge, as log as you like.

A paid DeskProto license can be bought either via a reseller or via our
webshop. After buying you will receive the license (a PDF file) containing
two strings: a Name and a Key.
The Name contains the name of the buyer (either a person or a company)
and his/her/its location (city, village): information that will be clearly shown
at each program start.
The Key is a code of 340 characters, containing information all license
information. Each Key is valid only for the Name on that same license.

The Activate dialog is meant to activate your DeskProto license and unlock
the extra functionality for the Edition that you have bought. Both the
complete Name-string and the 340 character Key have to be entered exactly
as given, including case (upper or lower), spaces, commas, points, etc. Even
the smallest difference will make DeskProto refuse to activate. So use
Copy/Paste to enter this information in this dialog.
After filling both fields you can use the Activate button to make DeskProto
activate the license.

Make sure to carefully save and backup your license: you will again need
Name and Key when (for instance) you buy a new computer.

A registered version of DeskProto will clearly display the Name of it's owner:
in case that is not you then you are running an illegal copy!

After Activating it is also possible to Deactivate, allowing you to again
convert the program from paid license to free license. Needed for instance
when you sell your computer.
You can Activate and Deactivate as many times as you like: information
about the previous licenses will simply be deleted. 
Activating a new license is also possible without Deactivation first.

Both for Activating and for Deactivating administrative privileges are
required (Windows).

In Windows the license activation affects all users of that PC, in MacOS and
in Linux the activation information can be accessed only by the current user:
every next user will also need to again activate the license on that same
computer.
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4.6 Edition select

DeskProto is offered to you as 'Freemium' software:
you are welcome to use the basic functionality DeskProto free of charge in
the Free edition, the advanced features are available as premium extras in
the three paid editions.

Four different Editions are available:
· Free Edition
· Entry Edition
· Expert  Edition
· Multi-Axis Edition
of which the first is free while for the other three you need to buy a license.
The Free edition can be used as free CAM software, as long as you like. As
said: it offers only basic CAM functionality. It also allows you to Trial
(evaluate) the higher editions; when running in trial mode the resulting
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toolpath will add a Trial cross (watermark), visible on each part that is
machined.

The Free Edition is available for anyone: free of charge, without any
obligations attached. It's functionality is limited, still it offers all you need for
basic CNC machining: Profiling toolpaths based on Vector Data, Parallel
toolpaths over Geometry Data, and machining reliefs based on Bitmap data.
In the Free edition a project may contain maximum one part and one
operation.
Many parameters as described in the Help file are not available in the Free
Edition. Still the most important parameters are there, and for many users this
free CAM program will be all they need.

The Entry Edition is the lowcost version of DeskProto, offering limited
options, at a very low price.
Compared to the Free edition a few important extra options are present:
Pocketing, Drilling and V-Carving for Vector operations, and Roughing for all
operation types. Projects also may contain any number of parts and
operations.

The Expert Edition includes all parameters except for the rotation axis
options. So the fourth axis and the fifth axis are not available in this edition.

The Multi-Axis Edition is the most complete version: all parameters are
present, including support for the A-axis and B-axes rotation axes.

More information about higher editions can be found in the Upgrade dialog. 
An edition comparison table can be found on www.deskproto.com 

A license for a paid edition can be activated in the Activate dialog.
After activating your license this Edition select dialog will no longer be
displayed.

https://www.deskproto.com
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4.7 Estimate Machining Time

The Estimate machining time dialog will be shown after calculating
toolpaths (unless the Always Show option has been un-checked) and it can
also be opened via the Create menu. With this option you get a rough
estimation of the machining time that it will take to create your part. Be
advised that this indeed is a very rough estimation, as the actual time will be
influenced by many factors.

Theoretically speaking it is easy to calculate the exact machining time:
DeskProto knows both the length of the toolpath and the feedrate (machining
speed), so length divided by feedrate results in an exact theoretical machining
time. 
However, the real machining time is influenced by many factors:
· How long does the machine’s controller need to calculate for one

Movement ? (for every linear interpolation it is needed to calculate the
speed for each separate axis)

· Does the machine keep up its speed (look-ahead buffer), or does it stop or
slow-down in-between each two movements ?

· How fast can the machine accelerate and decelerate ? (especially
important when stopping or slowing down after every movement).

· How fast is the data transfer from computer to machine ? (if you are using
a 9600 baud serial line this factor will seriously slow down the process).

· Does the toolpath consist of small movements or long straight lines ? (in
the first case it will in fact not even reach the desired feedrate as the
distance is too short to accelerate to full speed).

The resulting real machining time cannot even be correctly predicted for one
particular machine, as it will vary considerably depending on the
characteristics of the toolpath. 
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DeskProto will convert the Theoretical machining time to an estimated Real
Machining Time by multiplying by a machine dependent correction factor. As
previously noted, this results in a rough estimation since the actual time is
also dependent on the toolpath characteristics. The correction factor can be
set at the Advanced Machine settings. In order to fine-tune you can time a
few toolpaths and correct this factor accordingly.

This dialog will automatically pop up immediately when a toolpath has been
calculated.
In case you do not like that: remove the checkbox before "Always show this
dialog after calculating toolpaths".
You can make this dialog (re-)appear by selecting Estimate machining time in
the Create menu.
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4.8 File not found warning

When opening a project file, the CAD files that were used will be loaded
again: the DPJ file does not store the data but only stores links to the
Vector/Geometry/Bitmap files. These files must thus be found at the same
place as where they were when the project file was saved. 

If the CAD file cannot be found (for instance when the DPJ file was copied
from a different computer system) DeskProto will check if a CAD file with
the correct name can be found in:
1. the current folder (so the same folder as the DPJ file)
2. the default Data folder 
3. the Samples folder
If yes, DeskProto will ask you if it can load that file instead, using a dialog as
shown above.
You then can choose to either  Load the alternative file  or  Browse to find
the file  on some other location.

The option Apply to all files is useful in case your project file contains more
references to external files (Vector, Geometry and/or Bitmap). This option
makes it possible to use the new location for all file references in the project.
If the option is not checked then this same dialog may be shown a number of
times, once for every CAD file that could not be found.
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If the file cannot be found on any of these alternative locations this warning-
message will be displayed instead:

Here as well you can Browse to find the file on some other location. 

After pressing the Cancel button the project will continue loading, without
the missing CAD file(s).
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4.9 Initial Personal Settings

This dialog will be shown only once: when DeskProto is started for the first
time after it has been installed.

You have to select the Machine that will be used as the machine for every
new project. Click on the arrow to show the list that you can choose from.
The machines are alphabetically listed by their manufacturer's name. When
your machine is not listed: read further below.

DeskProto asks you to select a Machine, so not (like many other CAM
programs) a Postprocessor. In DeskProto the postprocessor is one of the
settings in the machine definition: when selecting a machine you also select a
postprocessor. Advantage of this construction is that several machines can
share the same postprocessor.
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The default machine that you select here can be changed later, by editing the
Default Project (Options menu).

The second question asks to set the Measurement unit you want to use
within DeskProto: mm or inch. All user-interaction will show this unit, and all
CAD-data files will be loaded using this unit (because in most of the CAD-
files the units are not specified). If needed you can later change this setting in
the Preferences.

Third question is about the Default project that you want to configure.
DeskProto offers three different types of machining: 
- Vector: load a 2D drawing file and make the cutter follow the curves in a
drawing
- Geometry: load a 3D geometry file and generate toolpaths to create that
shape
- Bitmap: load a bitmap image, convert it to a 3D relief can generate
toolpaths to machine it.
Selecting an option here tells DeskProto which type of project to open as
default New project. The other two types remain available as well; simply
select the type of project that you expect to be using most.
This default type can be changed later by editing the Default Part (Options
menu) and changing the type of operation that is present.

What to do when your machine is not listed ?
This is a very common situation (as the number of machine manufacturers
and the models that they produce is almost infinite), and in most cases it is
easy to solve. Please follow the four instructions given below.

1. Look if you can find a different model made by the same machine builder.
In most cases a machine builder uses the same NC file format for all
machines, so you may expect that the resulting NC files will be OK for your
machine as well. Try to run an NC file, and when that works well you can
later Add your machine to the list - see below.
Important: when you look for your machine in the alphabetical list you need
to look under the Manufacturer's name. For instance the Magic7 machine is
listed as "REDT - MAGIC-7", and the High-Z machines are listed as "Heiz
High-Z"

2. Look if you can find a generic machine definition for the controller or
the control software that you use. Like for the Mach3 control software you
can use the machines called "Mach3/Mach4 based machine", or for the
EdingCNC controller the machine called "EdingCNC based machine". Try to
run an NC file, and when that works well you can later Add your machine to
the list - see below.

3. Most machines will run on NC files written in standard G-codes. G-code
is the official standard for NC files, defined by ISO (the International
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Standards Organization). Unfortunately each machine builder has developed
his own flavor of this standard, and not all G-code files are compatible. Still
when your machine runs on G-code, you have a good chance that it will work
when you select the machine called "ISO plain G-codes".  Try to run an NC
file, and when that works well you can later Add your machine to the list -
see below.

4. In case the above three options do not work: in DeskProto it is easy to edit
the Postprocessor, to make DeskProto write the NC format that you need. 

When you have problems configuring a machine definition and a
postprocessor, feel free to send us an email: we can assist ! We are always
happy when we can add a machine to the list this way.

When your machine that was already on the list has an optional rotation axis,
it is possible that the machine-definition in DeskProto does not have that
option checked. It is easy to configure this in the Machine definition, on the
Rotary settings page.

Adding a machine. 
When your test (as just described) worked out well then you can add your
own machine to the list as follows:
Options > Library of machines > OK on warning > Select the machine that
you tested with and press button Copy. 
Now in the Machine definition give the new copy a proper name and
filename. Make sure that you do not change the selected postprocessor. Enter
the correct dimensions and speeds, if needed add a rotation axis in the Rotary
settings. For more information use the Help button of the Machine dialog.

The default Machine is stored in the Default Project, and can be changed
later by choosing the option Default Project Parameters from the Options
menu.
The measurement unit will be saved in the Preferences. You can later change
this setting in the Preferences dialog (Options menu).
The default project type as said can be changed by editing the Default Part
(Options menu) and there changing the type of operation that is present.

These initial settings will be stored per user of the computer, so any new user
will see this dialog when he/she starts DeskProto for the first time.
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4.10 Items Visible

In this dialog you can select which items will be included in the View
Window.
It can be opened in the View menu.

Shortcuts:

Toolbar:
Mouse: Double-click in a view, or Right-click and select "Items visible" in
the shown context-menu.

Five groups of items are present: General items, types of CAD-data, Toolpath
items, Part items and Operation items. In front of each item you find a
checkbox: checked ("V") means Visible, not checked means not visible.

Four General items are present: 

The Title will be displayed on the screen and on the printed view, in the top
left corner of the View. You can type a title in the edit box shown, if that box
is empty checking Title does not make a difference.
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The View Orientator is the coordinate system icon (green cube with axes)
displayed in the bottom left corner of each view. It helps you to understand
from which direction you are looking at the geometry. Note that this green
cube does NOT indicate the zero point.
For machines with a 4th axis parallel to Y (option Swap X and Y coordinates
in the NC file checked in the Advanced Machine settings) two View
orientators are drawn.

Checking the option Use fog applies fog to all drawings that use lines. This
technique (also called 'depth cueing') improves the perception of depth on
your two-dimensional screen by making distant lines more vague (as if
obscured by a light fog). 
On Black and White printers this may cause the lines to be printed like dotted
lines, resulting in a blurry print. Therefore you might want to temporarily
switch off the fog when printing. On computers with a video card which does
not support OpenGL this option may have no effect.

The Working Area of the milling machine can be drawn, which is the
working area of the machine selected for this project. Of course DeskProto
does not know where you will set the workpiece zero point on the machine,
so it will draw the part exactly in the middle of the working area. This will
give a good indication how the part relates to the machine. The size of the
working area for your machine can be set in the Machine dialog.

The second group shows all CAD-data items:

The Vector curves are all curves that are loaded as Vector data.
The curves are drawn in gray, only when a curve has been
selected in one or more vector operations it will be drawn in
black.
Vector curves in DeskProto are all polylines: the curve is built as
a series of straight line segments. The sub-option Show points
will indicate the end of each of these straight lines with a small
point in the drawing. As you can see in the letter D (image on the
left) no points are present on straight lines. 
The starting point of each curve is shown by a larger dot -
unless for closed curves as these do not have a starting point.
In a Rendered geometry drawing all triangles of the geometry
definition are filled with color and then shaded. This offers a
good understanding of your geometry, so it is the default way to
draw all Geometry data.
The sub-option Show downward faces will assign a different
color to any triangles that are facing down (in other words: for
which the normal has a negative Z-component). This option
makes it very easy to check for Undercuts (areas where the
cutter cannot reach), and to optimally rotate your geometry to
reduce undercuts.
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In a Wireframe geometry the triangles of the geometry are
drawn with lines.
it is possible that you can’t see the geometry very well because
all the lines make the result confusing.
In such case the sub-option Remove hidden lines can be useful.
This removes the lines of triangles that are hidden (obscured by
other triangles).
In a Points geometry only the three vertices (corner points) of
each triangle are drawn.

Bitmap concerns the Bitmap image that has been loaded. For
large bitmaps DeskProto will display a simplified version (in most
cases 512x512 pixels) of the bitmap, in order to speed up
drawing. 
The sub-option Translucent draws the bitmap image in a
translucent way, maintaining visibility of the items behind the
bitmap that otherwise would remain hidden.

 

The group that includes the Toolpath-related items is the smallest:

The toolpaths that you calculated are shown as red lines. Each
toolpath consists of a large number of small straight line segments
(linear interpolations). The option Show points lets DeskProto
draw a small red dot on every point (in the icon drawn in black to
make it easier to see them).

   The option Show arrows also adds information to the red
toolpath lines: the arrows indicate the direction of the cutter
movement.

   In some situations a very large number of positioning movements
over the part is needed, done in Rapid. In such cases is may be
difficult to see the 'real' toolpaths as these are obscured by the
dashed gray lines of these rapid paths. The Show rapid
movements option then can be unchecked in order to hide them.

These are the Parts-related items:

The Material block is drawn in orange lines. For standard three-
axis machining this is a rectangular block, for rotation axis
machining the block may also be a cylinder.

The sub-option Translucent draws the surfaces of the material
block in a translucent color (the same orange/brown as used for
the lines). This will show the block more clearly, maintaining
visibility of the CAD-data inside.
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   The 3D support tabs are a special type of geometry, set in the
Part parameters, to keep the part connected to the rest of the
block. When you check this item they will be drawn, as rendered
geometry with a different color (gray).

   This is a sub-option for the 3D support tabs, that will Show them
as wireframe (instead of rendered).

The Workpiece zero-point orientator again is a small cube with
three axes, this time drawn in dark blue and showing the position
of the zero point on the machine. The position of the Workpiece
zero point can be changed by the Translation settings on the Zero
point tab of the Part Parameters. Default position (as shown left)
is on the front/left/top corner of the material block.
The Untranslated zero-point draws a gray orientator cube with
three axes without the part translation mentioned above. This is
on the point where in the original CAD-data the zero point is
located - unless the option 'Center geometry' has been checked or
the CAD data have been translated on Project level, in the
Project parameters.
The Simulation checkbox allows you to add a Simulation of this
Part, which will clearly show what the resulting model will look
like. Checking this box will display the complete block of
material and show the Simulated Operations dialog.  Here all
operations for this part are shown, and you can choose the
operations to be processed in the simulation.

Finally the Operations-related items:
The last group shows the items that are different per Operation. So the
selection of items in this group may be different per Operation. It is for
instance possible to show the toolpaths of Operation Roughing and not show
them for Operation Finishing, while both operations are visible. When you
have selected two operations and an item is checked for one operation and
not checked for the other, the checkbox will not show a "V" but a small black
square (Windows 10, Linux) or a hyphen (Windows 11, MacOS) like in the
illustration above for the Toolpaths.

In the list of Operations you can change the visibility of each Operation by
clicking on the lamp icons (just as in the Project tree). Yellow (lamp on)
means visible, gray (lamp off) means invisible.
In the list you can also Select one or more Operations by clicking on their
line. This will make its background color light blue or gray (meaning
selected). Two or more operations can be selected by keeping the Control or
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the Shift button depressed when clicking. The Operation Items that you then
check and uncheck will apply ONLY to the selected operations.

When checked the Areas to be machines will be shown: the
rectangular bounding box of each operation area in light green
lines.

The sub-option Translucent draws the sides of the area in a
translucent green color. This will show the area more clearly,
maintaining visibility of the geometry inside.
When you check the Toolpaths checkbox the Toolpaths of the
visible operations will be shown. The toolpath that is drawn is the
same toolpath that will be sent to the machine: if there are any
problems it should be possible to detect them now.

When you check the Z-Grids checkbox the Z-grids of the visible
operations will be shown. The Z-grid is an intermediate
representation of the geometry that DeskProto uses for it's
toolpath calculations. The Z-grid will be drawn in lines.
The same Z-Grid will be show for option Rendered Z-Grids.
Now the Z-grid is drawn as a rendering, so you can clearly see
that it is a 3D bar graph representation of the geometry.

The colors that are used for the various items in the example drawings above
are the DeskProto default colors. These can be changed in the Colors tab of
the DeskProto Preferences.
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4.11 Keep settings

DeskProto stores many of the user's defaults and preferences in the storage
facility that your operating system offers(the Registry for Windows, the
PLIST file for MacOS and the CONF file fie Linux). When you again install
DeskProto you can choose whether or not you want to keep using these
settings.

This Keep Settings dialog will be shown when have reinstalled the same
version (for instance you have installed a (newer) DeskProto V 8.0  over an
existing DeskProto V 8.0). 

This Keep Setting dialog offers you two options:
- when you answer Keep settings, nothing will happen: 
DeskProto will keep using the settings as they were.
- when you answer Reset settings, DeskProto will delete the old settings and
replace them by the DeskProto system defaults.
So when you have made a giant mess of your settings this is an easy way to
delete them all.

A different dialog will be shown when you have reinstalled a newer version
of DeskProto next to an old one. For instance when you have installed a
DeskProto V 8.0 on a PC where a DeskProto V 7.1 was already present.
Then DeskProto the Migrate Settings dialog will be shown.
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4.12 Machine Check

This dialog will be shown by commands Send NC-program file to machine
and Send toolpaths to machine, both in menu Create (the first in group
Extra).

When a custom icon image has been configured for button "Send toolpaths to
machine" (see the explanation on page Preferences) that image will be used
in this dialog as well.

The dialog asks if the machine is ready: material loaded, cutter loaded, zero
point correctly set, machine ready to receive data. 
After pressing Send DeskProto will start sending, and the machine may start
cutting immediately.



DeskProto Reference

Page 314

4.13 Migrate Settings

DeskProto stores many of the user's defaults and preferences in the storage
facility that your operating system offers:
for Windows this is the Registry, conform Microsoft's guidelines. 
for MacOS this is a .PLIST file in the Library
(~/Library/Preferences/com.delft-spline-systems.DeskProto.plist) 
for Linux this is a CONF file (~/.config/Delft Spline
Systems/DeskProto.conf)
The settings are stored per DeskProto version, so settings for V7.0 and V7.1
are completely independent.

When you have just installed a higher DeskProto version on a PC where an
older version is present and for the first time start the new version, the above
dialog will be shown. You can choose whether or not you want to keep using
the settings of your old DeskProto, so whether or not to migrate them to the
new version. For instance you have installed a new DeskProto V 8.0 on a PC
where a DeskProto V 7.1 was already present, like in the image above (for
you it may show a different old version). This concerns all settings that you
made in the Preferences and in the default Project, default Part and default
Operation(s). The exact text in the dialog may be a bit different for you: it
depends on which previous version of DeskProto has been found)
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When you have reinstalled the same version (for instance a new DeskProto V
8.0 over an existing DeskProto V 8.0)  the Keep Settings dialog will be
shown.

When you answer Migrate old settings, DeskProto will read these settings
of the old DeskProto and save them as settings for the new version. This will
be done as far as possible: not all settings are compatible between different
versions.
In order to let DeskProto V8.0 use the old defaults a few driver files will be
copied as well: for the default machine and postprocessor, and for the default
cutter(s). Be warned: in case already present in the V8.0 drivers folder, this
will replace V8.0 driver files with the same name that you just installed!  The
original V8.0 driver will be renamed to name.bak1 (or name.bak2, etc)
Other machines, postprocessors and cutters that you (may) have added are
not migrated. You can manually copy these driver files, see below.

The Language setting will not be migrated as the language might not be
available in the new DeskProto. If needed you can manually change that in
the Preferences.

When you answer No thank you, nothing will happen, and the new
DeskProto will start with system default values.

Manually migrating is possible as well:

In DeskProto every Machine, Postprocessor and Cutter has it's own Driver
file: name.mch for a machine, name.ppr for a postprocessor and name.ctr for
a cutter. These files are stored in the DeskProto Drivers directory.
You can simply copy these files from the old Drivers folder to the V8.0
Drivers folder. Do not copy all files, as that may remove improvements were
made in DeskProto V8. When you sort the old drivers on date it is easy to see
which drivers you have added and/or changed.

Migrating the settings (preferences and defaults) is possible via the
Preferences, tab Advanced. Under Settings you can find buttons Export
settings... and Import settings....  In the old DeskProto you can export all
settings to a file (XML file), and in the new DeskProto you can import that
file. This will only work to migrating settings from DeskProto V6.1 or newer:
in older DeskProto versions the Export option will write a .REG file.
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4.14 Missing machine

DeskProto stores each machine definition as a .MCH file, in its Drivers folder
on the local computer. When you open an existing project on a different
computer it may happen that the project needs a machine definition that is
not present on that new computer.
In such case DeskProto will first show you the 'Machine not found' warning,
and then a dialog that allows you to select a different machine to be used.
That is very handy in case (for instance) the name of the machine on this
second computer has been spelled a bit differently and thus is not recognized
by DeskProto.

When you select a replacement machine and press OK, that replacement
machine becomes the machine that is set for the project

When you press Skip the replacement machine as shown is not used, instead
the machine that you have set as default machine in the default project
parameters is used.

It seems likely that the same replacement will be needed for other projects as
well, so DeskProto offers an option to replace automatically: the option
Autmatically apply already known replacements. When checked,
DeskProto will remember the replacement machine that you select here, and
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will automatically make that same replacement for projects to be opened later
(that need the same unknown machine).
You can again switch that option off in the Preferences: DeskProto will then
also forget all "unknown machine - replacement machine" combinations that
you have set.

The "unknown machine - replacement machine" combinations are not copied
when exporting and/or importing the DeskProto settings.

The default drivers folder is:
C:\ProgramData\DeskProto 8.0\Drivers\   (Windows)
~/Library/Application Support/Delft Spline Systems/DeskProto/8.0/Drivers/  
(MacOS)
~/.local/share/Delft Spline Systems/DeskProto/8.0/Drivers/   (Linux)
You can use that information to copy driver files from one computer to a
second one.
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4.15 Missing cutter

DeskProto stores each cutter definition as a .CTR file, in its Drivers folder on
the local computer. When you open an existing project on a different
computer it may happen that the project needs a cutter definition that is not
present on that new computer.
In such case DeskProto will first show you the 'Cutter not found' warning,
and then a dialog that allows you to select a different cutter to be used. That
is very handy in case (for instance) the name of the cutter on this second
computer has been spelled a bit differently and thus is not recognized by
DeskProto.

When you select a replacement cutter and press OK, that replacement cutter
becomes the cutter that is set for the project

When you press Skip the replacement cutter as shown is not used, instead
the cutter that you have set as default cutter in the default operation
parameters is used.
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It seems likely that the same replacement will be needed for other projects as
well, so DeskProto offers an option to replace automatically: the option
Autmatically apply already known replacements. When checked,
DeskProto will remember the replacement cutter that you select here, and
will automatically make that same replacement for projects to be opened later
(that need the same unknown cutter).
You can again switch that option off in the Preferences: DeskProto will then
also forget all "unknown cutter - replacement cutter" combinations that you
have set.

The "unknown cutter - replacement cutter" combinations are not copied
when exporting and/or importing the DeskProto settings.

The default drivers folder is:
C:\ProgramData\DeskProto 8.0\Drivers\   (Windows)
~/Library/Application Support/Delft Spline Systems/DeskProto/8.0/Drivers/  
(MacOS)
~/.local/share/Delft Spline Systems/DeskProto/8.0/Drivers/   (Linux)
You can use that information to copy driver files from one computer to a
second one.
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4.16 NC-Program File Number

This dialog pops up when you write an NC-Program file, and when you have
used the placeholder {PROGNUMBER} in the Start commands of the
postprocessor that is used.

It is meant for machines that require each NC-program to have a unique
Program Number. Here you can enter the program number to be used in this
NC file. On other machines adding this number may generate an error on the
machine. Consult your machine's manual to find if this is needed for your
machine.

The number of positions sets how many positions will be used: in most cases
this needs to be 4 or 5. This information should also be given in your
machine's manual. The file number may of course not be larger than possible
for this number of positions.  When a program number is lower DeskProto
will automatically add preceding zeroes. Finally: after writing an NC file
DeskProto will automatically increment this number for the next file to be
written.
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4.17 Newer Drivers warning

This warning is given at program start, when DeskProto has detected that one
of the Driver files (each file contains a definition for a Cutter, a
Postprocessor or a Machine) has been created by a newer version of
DeskProto.
For instance: your DeskProto V8.0 opens a cutter file that was created by a
DeskProto V9.0 (which at the time that this document is written does not yet
exist).

This newer version of DeskProto may of course offer new features (not yet
known at the time when this Help information is written).
And so this (these) driver file(s) may contain settings that you current
DeskProto will not understand. In most cases this is no problem: your current
DeskProto will simply ignore a feature that it does not recognize.

Take care though: new functionality may also be added to an existing
feature. 
An example: DeskProto V7.1 supports "placeholders", allowing you to add
information like program number, part size, date, etc to the NC file. These
placeholders were not yet available DeskProto V7.0.  Using a V7.1
postprocessor with placeholders in V7.0 makes the resulting NC file useless,
as in V7.0 the placeholders are not processed.

This warning will be shown each time that you start DeskProto, unless you
select Yes:
in that case these drivers files will have saved again, now as DeskProto V8.0
files. Any features in the file that are not compatible with DeskProto V8.0
will be deleted.



DeskProto Reference

Page 322



Dialogs

Page 323

DeskProto Reference

4.18 Old Laser Postprocessor warning

This warning is given at program start, when DeskProto has detected that in
one of the postprocessor driver files (files that contain the definition for a
Postprocessor) the setting "Set Spindlespeed to 0 for rapid positioning
movements" has been checked.

That option was available in DeskProto V7.1, on the Spindlespeeds tab page
of the Postprocessor definition. It was added to support a very basic form of
laser engraving with DeskProto V7.1

As DeskProto V8 fully supports laser engraving this setting is no longer
needed (DeskProto now automatically sets the spindlespeed to zero when
needed).

This warning will be shown each time that you start DeskProto, unless you
select Yes:
in that case these drivers files will be saved again, now as DeskProto V8 files,
so without this obsolete setting.
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4.19 Part Information

You can find the command to show this dialog in the View menu. 
It is a special dialog, as it can remain open while you are working, using other
dialogs.

Shortcuts:

Toolbar:
Again pressing this button will close the dialog.

Depending on which types of CAD data have been loaded in the project, one
to four tab pages are shown.
Each tab shows the Boundaries and the Dimensions ("Delta") , either for the
complete part or for that type of CAD data.
All coordinate values and sizes are shown for the Part that results when the
Part parameters have been applied (scaling, rotating, etc): these are the
dimensions of the part that will be created on your milling machine. 
When checkbox Use translated coordinates has been checked the final Part
translation (as set on tab page Zero-point) will be applied as well, so the min
and max values then are the NC file coordinates.

You can find the Min and Max values as present in the original CAD-data
using button File info in the Project parameters.

Material:
The dimensions of the material block that has been defined for this part. This
is important information for you, as these are the dimensions of the Block of
material that you have to prepare.
Vector:
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The bounding box of all Vector curves that have been loaded. The machining
depth that has been set in the Vector operations for this part (only for the
selected curves) is added to the Z-values of the curves. The deformation
caused when projected on a 3D geometry is not shown.
Geometry:
The bounding box of all Geometry data that has been loaded.
Bitmap:
The bounding box of the Bitmap relief that will be created. For the Z the
relief depth is used that has been set in the Part parameters The deformation
caused when projected on a 3D geometry is not shown.

In all TAB pages coordinates are given for Min, Max and Delta. The min
and max part values are handy when setting the workpiece zero point on the
machine, the delta values (dimensions) can be used to prepare the  block of
material to be machined. 

For rotation axis projects with a cylindrical block of material the Material
tab of this dialog shows values for X and D (instead of X, Y, Z).  Here D is
the diameter of the block (only shown in the Delta column). 
In case a tube shaped block has been defined the material tab shows a third
line, with R values (Radius): the delta between Rmin and Rmax is the
material thickness of the tube.

The dialog can be viewed in two ways; as a small dialog box with tab pages
(shown above), or as a large dialog box with all the information visible at the
same time (shown below). You can switch easily between those two types of
dialogs by pressing the button at the bottom on the right side (the small black
arrow).
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4.20 Preferences

This is a dialog in which you can edit DeskProto's preferences. The dialog
consists of six Tab pages. In Windows and in Linux this dialog can be found
in the Options menu, in MacOS in the DeskProto menu.

In Windows these preferences are stored in the Registry
in MacOS in file ~/Library/Preferences/com.delft-spline-
systems.DeskProto.plist 
in Linux in file ~/.config/Delft Spline Systems/DeskProto.conf 
Each user has his/her own set of preferences stored there.

Note that in MacOS a file called ~/Library/Preferences/com.delft-spline-
systems.DeskProto80.plist is present as well. That is a different file,
automatically created by MacOS to remember the settings for the Open file
dialog and the Save file dialog.

General tab page

The File-locations listed here are the folders (directories) where DeskProto
looks for the specified file types. These folders can be changed by typing the



DeskProto Reference

Page 328

new folder’s complete path-specification (i.e.: C:\Users\Smith\DeskProtoFiles
) or by using the Browse button. 

Data is the location where DeskProto will initiate the Load and Save dialog
boxes for projects and for CAD data. The default setting for this option is the
Documents (or My Documents) folder. This is a standard location in all tree
operating systems:
Windows: Documents
MacOS: ~/Documents/
Linux: ~/Documents/
In this default location no sample files and projects are present: quickest way
to find the sample files is via the DeskProto Start Screen (check "Use samples
folder" on this screen). The Sample file location is:
Windows: C:\ProgramData\DeskProto 8.0\Samples\
MacOS: ~/Library/Application Support/Delft Spline
Systems/DeskProto/8.0/Samples/
Linux:  ~/.local/share/Delft Spline Systems/DeskProto/8.0/Samples/

While working with DeskProto this Data folder (the "current directory")
may change: when loading from of saving to a different folder that folder will
become the current directory. For instance after loading CAD-data from
folder C:\Test, the default folder for loading more CAD-data or saving the
project file will also have become C:\Test.  This is very convenient, as it
makes it easy to save all files for one particular project in one folder.

The Data directory comes with the extra option Fill with last used folder on
exit, making DeskProto remember which folder you were working in the last
time you used DeskProto. 

Drivers is the location from where DeskProto will load all driver files
(machines, postprocessors and cutters). Any valid new driver files that you
copy to this folder will be automatically available after (re)starting
DeskProto. Changing this location will make DeskProto unload all drivers (it
will not delete them from disk though) and load drivers from the new location
(if available). Because the open project uses drivers from that library, the
open project will be closed before making this change. A new empty project
will be created after the new library has been loaded or created at the new
location.
Be careful though: DeskProto will not function correctly when it cannot find
it's drivers.

The default Drivers location for DeskProto is:
Windows: C:\ProgramData\DeskProto 8.0\Drivers\
MacOS: ~/Library/Application Support/Delft Spline
Systems/DeskProto/8.0/Drivers/
Linux:  ~/.local/share/Delft Spline Systems/DeskProto/8.0/Drivers/
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In Windows the default location for this type of files is in the C:
\ProgramData\  folder  (as folders in \Program Files\ can be accessed only by
users with administrative privileges). For some reason Microsoft has made
ProgramData a hidden folder: to make it visible in File Explorer ('My
Computer”) select tab page View and check the option to show "Hidden
items".
In Windows XP this folder is called: C:\Documents and Settings\All
Users\Application Data\
To make it visible in WinXP Explorer open Tools >> Folder Options >> tab
View and select the option “Show hidden files and directories”.

As this may be a bit confusing it might be difficult to restore the DeskProto
default after a change. So we have added the button Use DeskProto defaults
to make resetting the file locations easy.

DeskProto is available all 'major' languages. Use button Available languages
to select the language that you want to use for the user-interface. The default
language is English, though the Setup may have selected a different language
on your request.
For every language a sub-folder in the DeskProto installation folder is
present, containing all translation files for that language. The name of the
sub-folder is the two-letter codes for that language (conform ISO 639).

DeskProto currently supports the following languages:
de Deutsch German
en English English (this is the default, no qm files needed)
es Español Spanish
fr Français French
it Italiano Italian
nl NederlandsDutch
pl Polski Polish
ru        Russian - no longer supported, due to the trade boycott

because of the war in Ukraine. Sorry!
zh   Chinese, simplified
tw     Chinese, traditional
ja    Japanese

For each language "nn" the following file is required to be present in that
folder: DeskProto_nn.qm, containing the  translated resources. 
For instance "nl" for Dutch needs the file DeskProto_nl.qm
Complete file specification:  C:\Program Files\DeskProto
8.0\Translations\nl\DeskProto_nl.qm

In addition the following translated files are optional:
- translations for the standard Windows buttons and dialogs, in file
qtbase_nl.qm
- a translated Help file, in files DeskProto_nl.qhc and DeskProto_nl.qch
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- translations for the custom wizards, in file DeskProto_Wizards_nl.qm
If such optional file is not present (or incomplete) the missing texts will be
displayed in English.

The cutter files that are installed with DeskProto V8 already contain proper
names (translations) for all these languages.

The translated Setup will also install translated versions of the license
agreement and the Readme file:
License_nl.rtf and Readme_nl.rtf

The last Preference on this page is about Updates: the option Check for
updates when exiting the program will make DeskProto automatically
perform the Update check that is available in the Help menu. As this
automatic check is invisible when no updates are present (and also is very
quick) you will not notice that it is done. Unless of course an update is
present. Most of these updates are free, so we advise to keep this option
checked.

Units tab page

With the option Measurement unit you can choose between metric (mm)
and imperial (inches) for your DeskProto configuration. This setting will be
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applied in the user-interface and when loading and saving CAD-data: most
CAD files do not state the units used and DeskProto has to assume that they
are in the same unit as the one you define here. 

The Feedrate units to be used in the NC file are set in the postprocessor, the
option Use from postprocessor lets DeskProto use these units in the user
interface as well. 
In case you prefer different units for your user interface you uncheck that
option and set the units that you want to be used in the user interface.
DeskProto will then convert the feedrate that you enter (in user-interface
units) to the correct value in NC file units.

This double option to set the feedrate units is handy for instance for inch-
addicted users who have a machine that understands NC files in mm only.

Settings that you can check in case of unit problems:
This setting (Measurement unit), in Options> Preferences> Units tab, mm or
inch.
The Distance unit in Options> Postproc> Movement tab, mm or inch.
The Feedrate units in Options> Postproc> Feedrate tab (many more options)
When your machine uses G-codes you can also check the Start commands of
your Postprocessor: 
If working in mm:  in the G-code use G21 or G71 to set the machine to use
mm.
If working in inch: in the G-code use G20 or G70 to set the machine to use
inches.

Colors tab page
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The tab page Colors makes it possible to customize the colors used in the
DeskProto view window. Each color fields is a button that you can click on,
which will open the Select Color dialog. 
As you can see: different operations can be assigned different colors. In case
of more than 4 operations: the colors for operation No. 1 will also be used for
No. 5, 9, 13 etc. 

The option Use fog (that was present here in earlier versions of DeskProto)
has been moved to the Items Visible dialog.

In case you have made a gigantic mess of your color settings you can press
Use DeskProto defaults to restore the default settings of DeskProto for all
colors (these 'hard defaults' are stored internally in DeskProto and can not be
changed).

NC Output tab page
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These preferences are meant to configure the NC-output: they are about
exporting the toolpaths to NC files or to other destinations.

With the first preference you can fine-tune the Output path for "Write NC-
Program". Normally DeskProto exports the NC files to the same folder from
where the project and/or the geometry file were opened (the 'current'
directory). This is when the option Use data path is checked.
After unchecking this option you can type or Browse a fixed directory to be
used for writing the NC files to. This is handy in case you want all NC files to
be stored on the same place (for instance a folder on the PC next to the
milling machine, or a USB stick that will later be plugged into the machine).

The second preference, Destination, is meant for the commands Send
Toolpaths to Machine in the Create menu and Send NC-program File to
Machine in menu Create > Extra.  By default these two commands are
disabled, here you can enable them by determining which process has to be
started after giving the command. 
This feature is not available in MacOS and in Linux: only in Windows. Sorry
about that. 

Send to
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This combo box shows four types of choices: Printer Driver, a Hardware
Output port, an External program or None. Each option comes with it's own
sub-settings:

1- In case you configure None, the commands Send toolpaths to Machine and
Send NC-program To Machine will not be available (grayed out), and the
toolbar button "Send toolpaths to machine" is not present.
No sub-settings are available. This is the default situation.

2- Selecting a Hardware Port (either serial COM.. or parallel LPT..) means
that the NC-program will simply be copied to that port after the command is
given. This can be for example LPT1, or COM2. The button  "Send toolpaths
to machine" will show a machine icon (see Note 1 below), and the tooltip for
that button will show the configured destination.
For a Centronics Printer port (LPT1 or LPT2) no settings are needed. In case
of a COM-port you need to configure this port according to the specifications
of the milling machine. Use the button Setup for the standard Windows
COM port settings dialog (setting values for ‘Baud Rate’, ‘Data Bits’,
‘Parity’, ‘Stop Bits’ & ‘Flow Control’).
Note that this direct output will only work for some machines (that have an
intelligent controller). For most small machines that are connected to the PC
using a hardware port it is needed to use control software to send the
toolpaths to the machine.

3- Selecting Printer Driver can be used for machines that are accessed via
their own printer drivers (for instance most Roland machines). This also
works for USB machines that cannot be accessed via a Port. The button 
"Send toolpaths to machine" will show a machine icon (see Note 1 below),
and the tooltip for that button will show the configured destination.
Here you have to select the correct Machine name from the list of available
printers (or rather of all printer drivers that have been installed on your PC).
Take care to not select a ‘normal’ printer as this may result in hundreds of
pages to be printed on paper.
After sending the NC-file to the machine this way, the job status can be
followed using the standard Windows Printer Properties tools. On some PC's
it may be needed to select “Print directly to printer” in the Advanced Printer
properties of the selected printer driver.

4- After selecting the option External program, you can use the Browse
button to define which program has to be used. The button  "Send toolpaths
to machine" will show the desktop icon of that program (see Note 1 below),
and the tooltip for that button will show the configured destination.
Here you can browse to any program file (EXE of COM) on your computer.
After the command Send NC Program to machine, DeskProto will start this
program, with the name of the NC-program file to be used as command line
parameter. 
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The idea is to configure the control software of your CNC milling machine
here. This works for many programs, for instance:
- Kay  (configure "C:\Galaad\KAY.EXE", or "C:\Program Files (x86)
\Galaad\KAY.EXE").
- PlanetCNC  (configure "C:\Program Files\PlanetCNC\PlanetCNC64.exe",
or PlanetCNC32.exe on 32bit windows).
- WinPC-NC  (version 3.01 or newer, configure "C:
\WinPCNC_USB\WinPCNC.EXE").
However, it does not work for all control software, for instance not for
Mach3: the control software must support the use of a command line
parameter with the name of an NC file, and Mach3 does not.

In fact you can select any program, for instance a milling simulation software,
or (for the diehards) a plain text editor like Notepad, allowing you to change
the NC-program that DeskProto has just created.

Note:
It is possible to configure a custom icon to be shown on button "Send
toolpaths to machine" . That is ideal for machine builders that give (or sell) a
DeskProto license with their machine: they can make DeskProto show their
very own logo !! Configuration is easy: copy an image file called
machine.png to the folder that also contains DeskProto.exe (normally C:
\Program Files\DeskProto 8.0\ ) and that image will be shown on the button.
Scaled down to the proper size for a toolbar icon.

Button Use DeskProto defaults will restore the default settings of DeskProto
(Use data path, Documents folder, Send to "None").

Wizard tab page
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The tab page Wizard contains a preference that you can set for the Two-
Sided Milling Wizard (wizard "Advanced geometry: Two sides, manual flip"):
the size of the material block for two-sided machining. This tab page is not
available in the Free edition and the Entry Edition. Two options are available:

· Floating size. The block size needed of course depends on the size of the
part that you want to create. DeskProto offers a flexible solution here,
called Floating size: around the part a frame is added. In the edit boxes for
X and Y you can enter how much needs to be added as frame. This is the
default choice for this option.

· Fixed size is useful in case all your parts have almost the same size: you
then can use standard blocks of a certain size, to be defined in the X and Y
edit box.

Only the X and Y block size can be set here, the Z dimension is set in the
wizard.

Button Use DeskProto defaults will restore the default settings of DeskProto
(floating size, X 25, Y 10).

Advanced tab page



Dialogs

Page 337

DeskProto Reference

This tab page of the Preferences contains four or five different sub-pages,
which you can select by making it active (blue or grey background) in the list
on the left. Four sub-pages are always shown: Graphics, User Interface,
Mouse and Settings;  page SpaceMouse is available only when DeskProto
finds a SpaceMouse attached to the PC. Help for all five sub-pages is given
below.

First the Graphics preferences will be explained, shown in the picture above.

Dynamic drawing
Dynamic drawing is the drawing that is done while the left mouse button is
pressed inside the view window or while using the thumb-wheels: you see the
image change while moving the cursor. Choosing the option Draw limited
number of entities will decrease the number of entities that is dynamically
drawn, and so will increase the speed with which you can move the geometry
and other items (the term entities used here stands for points, lines and
facets). If several Items are drawn, the maximum number of entities that you
enter is split up over all visible items. In case you set the number of entities to
zero only the bounding box of the geometry will be displayed during dynamic
drawing.
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The optimum number of entities depends on the capabilities of your graphics
card: an OpenGL card featuring hardware rotation etc. can handle a large
number of entities at high speed. For a simple graphics card the number must
be set lower to achieve real time results.

Graphics options are in fact OpenGL options. More OpenGL options may
be available in the driver software of your graphics card.

Drawings on the screen are displayed using pixels, for instance a line is drawn
as a series of black pixels on a white screen. As the pixels on your monitor
are located in a rectangular grid, a curved line therefore will be displayed as a
staircase. Anti-Aliasing is a technique to make this staircase effect less
visible, by adding pixels with an intermediate color value: in the example just
mentioned this will be in various grades of gray. This shade of gray to be used
for a pixel is calculated (by Open GL) using multi-sampling: each pixel is
divided into multiple sub-pixels, for each sub-pixel a gray value is calculated,
and the average resulting gray value is used for the pixel to be displayed. 

The more samples are used, the better the resulting quality, however the more
calculation time is needed. You can set this Sample rate as a detail setting:
the combo box will show only the rates supported by your graphics card. We
advise a rate of four: higher rates will cost much time where the improvement
in quality will be marginal.
In case your graphics card does not support anti-aliasing at all, this option will
have been grayed out.

The option Use buffering when rendering the simulation is meant to
optimize the drawing speed for your typical simulations.
A simulation in DeskProto is calculated and drawn as a large set of small
triangles (defining it's outer surface). This is the same type of entity as used to
draw the geometry. Only the number of triangles in most cases is higher for a
simulation, which may make the drawing process slow.

Using Buffering means that all triangles are sent to the 3D video memory of
the graphics card as 3D data (a 'buffer'). Changing the view then will be
completely handled by the graphics card: DeskProto only needs to send the
new camera position, the graphics card will do the rest. This is what
DeskProto does when displaying geometry data, and for a simulation the
default status of this option is to have it checked. On most current PCs that
works fine.

The drawback of buffering is that it requires more graphics memory (video
RAM). When more memory is needed than available (either RAM or video
memory), Windows will need to swap to hard disk. And that will make this
nice method even slower than the un-buffered method. So when drawing a
complex simulation (on the screen of your old PC) is very slow you can try if
is helps to uncheck this buffering option.
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Without buffering the color values for all triangles for the current view
settings are generated by DeskProto, and then are sent to the card as 2D data.
The graphics card just displays the resulting 2D image, and does not keep 3D
data in it's video memory. This will of course cost time: for each new view all
triangles have to again be generated and sent over to the graphics card.

One hidden graphics option is available as well: the line width (default 1
pixel) can be changed for all lines in the drawing (curves, blocks, toolpaths).
This has been implemented as "hidden feature". Setting DrawingLineWidth
may have a value from 1 (default ) to 99. Changing this value needs to be
done before DeskProto is started.

You can access this setting as follows:
For Windows change registry key HKCU\Software\Delft Spline
Systems\DeskProto8.0\Preferences\Advanced\Graphics\DrawingLineWidth
For MacOS change line
"8·0.Preferences.Advanced.Graphics.DrawingLineWidth" in file
DeskProto.plist 
For Linux change line "Preferences\Advanced\Graphics\DrawingLineWidth"
in section "[8.0]" of file DeskProto.conf.
Only edit the registry or these files when you are qualified and know exactly
what you are doing !

Button Graphics card info will show the above screen, with information
about the graphics card on your PC..
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Button Use DeskProto defaults will restore the default settings of DeskProto
(draw one million entities, use anti-aliasing rate 4, use buffering).

The picture above shows the User Interface sub-page of the Advanced
Preferences.
The user interface displays both text and graphics, this setting concerns the
size of these items. The toolbar buttons for instance are drawn as 32x32 pixel
images (for the default toolbar button size 'Medium'), all texts and all images
in the dialogs have a fixed sizes as well. At least, on a 'standard' display. 

On high-res displays the fixed size as just mentioned will be too small for an
easy readability. Such displays are called "4K displays" (having a horizontal
resolution of around 4,000 pixels) or "UHD displays" (Ultra High
Resolution). When using a desktop size monitor the text and the buttons will
be unreadable when the standard number of pixels is used (scaling 100%). 
The trick is to set a higher scaling factor in your operating system: say 150%
or 200% (for Windows this can be done in the Display settings). DeskProto
then will automatically make sure that both the text and the images will
remain sharp by giving them a higher resolution.

In case that does not solve the problem this option Extra scaling can be used
to adjust this automatic scaling factor: the automatic factor will be multiplied
by the extra factor. So if the automatic scaling is factor is 2, you can for
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instance set the extra factor on 1.5 to configure the total scaling factor to be
3. This will help in case you have trouble reading from the screen.  Or when
you feel that all user interface items are too large you can set the extra factor
on 0.5 to configure a total scaling factor of 1.
The total scaling factor may not be lower than 1, so on a standard screen (96
DPI) an extra factor below 1.0 is not possible.
You may have to experiment a bit to find which settings are best for you - on
your monitor.

The button Use DeskProto Defaults resets the extra scaling factor to 1.

The picture above shows the Mouse sub-page of the Advanced Preferences.

Here you can configure two Mouse settings:  Zooming and Rotation.

The Mouse wheel zoom: rotating the mouse-wheel (scrolling) when the
cursor is in the View window will make DeskProto zoom in or zoom out. The
Zooming speed sets the zoom percentage for each rotation step of the
mouse's scroll-wheel. 

Scrolling from back to front will zoom in: your finger movement pulls the part
on screen closer.  Scrolling from front to back will zoom out: your finger
movement pushes the part away. Some CAD programs handle zooming
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exactly reversed, and it would be quite confusing when you combine
DeskProto with such program. So we have added the option Reverse
zooming direction in order to keep you comfortable.

The latest option (since DeskProto V8) is Lock Z-axis vertical on screen.
When you check that option the horizon of your scene will always remain
horizontal on your screen (and the Z-axis will remain vertical), no matter how
you rotate your view. So this option limits the rotation capabilities. This
option has been added as that is the way some CAD programs (for instance
Rhino) handle the view rotation. When you are used to that method it is best
that all programs that you use rotate that way, this checkbox makes this
possible for DeskProto.

The picture above shows the SpaceMouse sub-page of the Advanced
Preferences.
It will be visible only in case a SpaceMouse is connected to the PC.

These settings are meant for the 3Dconnexion SpaceMouse series of products
(formerly called Logitech SpaceMouse, now offered by Logitech daughter
company 3Dconnexion). The sub-page will be present only when on program
start DeskProto detects that such SpaceMouse is present on your computer. 
The product is also called 3D Mouse and SpaceNavigator.
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The image above shows the most basic version. The device stands on your
desk, the handle (rubber knob) on top is pressure-sensitive in six directions: 
front-to-back, left-to-right, up-and-down, pitch rotate, roll rotate, yaw rotate.
 Applying pressure in one of more of these directions will make the 3D part
on screen move and rotate in these directions. Which is a great help for CAD
designers.

This use of a SpaceMouse in fact is so straightforward and intuitive that in
fact no settings seem to be required. Still DeskProto offers a few.

Navigation functions:
Of the six degrees of freedom just described three are linear movements and
three are rotations.
Un-checking  Pan/Zoom disables the linear movement commands
Un-checking Rotate disables the rotation commands.
When you un-check both only the buttons will work - which does not seem to
make sense though.

The Mode that you set determines if the SpaceMouse actions will be applied
on the part or on the camera. Two options: 
Object mode - SpaceMouse actions are applied on the part, so when you pan
to the left the part will move to the left.
Target camera mode - SpaceMouse actions are applied on the camera, so
when you pan to the left the part will move to the right. A rotation to the right
also means a part rotation to the left - so it does not mean that you rotate the
camera.

Navigation Speed:
Just as for the scroll-wheel on the normal mouse you can set how fast the
movement of the part should be, here in response to the pressure applied to
the mouse's handle. If you do not like the default speed you will have to
experiment a bit to find the speed that you like.

Buttons:
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Each SpaceMouse features (at least) two buttons: for the basic model the left
button is button 1 and the right button is button 2. For each button you can
select the action that needs to be done when it is pressed. Each SpaceMouse
model has a different number of buttons: of course you can't use more than
your SpaceMouse offers.
If nothing is visible in this box: press button "Use DeskProto defaults" to fill
it.

DeskProto sets defaults actions for twelve buttons:
1. Menu -> Items visible dialog
2. Fit -> Zoom all
3. Top -> Top view
4. Left -> Left view
5. Right -> Right view
6. Front -> Front view
7. Bottom -> Bottom view
8. Back -> Back view
9. Roll cw -> Rotate image 90 degrees clockwise
10. Roll ccw -> Rotate image 90 degrees counter-clockwise
11. Iso 1 -> Isometric view
12. Iso 2 -> Default view

You can change any of these button definitions by selecting a different action
from the pull-down list for that button. The pull-down list contains 22 actions
that you can choose from. In this list of actions the words Tilt, Spin and Roll
are used: see the image above for an explanation. After changing one or more
button definitions you can use button "Use DeskProto Defaults" to reset to
the 12 actions shown above.

In case you are not sure which button corresponds to which number you
can simply press that button with this Preferences page opened: in the dialog
shown above DeskProto will then make the number for that button red. In the
screenshot above you can see that the "2" is displayed in red.

Button Override 3DxWare is visible only in the Windows version of
DeskProto.
To understand the function of button Override 3DxWare, it is important to
know is that DeskProto does not use 3Dconnextion's software development
kit (3DxWare), and also does not use the 3DxWare driver that 3Dconnexion
ships with this device. Reason is that this software is not compatible with the
QT toolkit that DeskProto also uses.
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Disabling the official 3DxWare driver (only for application DeskProto.exe) is
achieved by copying file
C:\Program Files\DeskProto 8.0\SpaceMouse\Win.xml   to
C:
\Users\Name\AppData\Roaming\3Dconnexion\3DxWare\Cfg\DeskProto.xml
  (where Name is the name of the user).
This copy action is done automatically, by the DeskProto Setup.

However, in the 3DxWare driver (3Dconnection Properties) a user can create
a configuration for application DeskProto, which will over-write the one that
was copied during Setup. When that happens both drivers will be active at
the same time, resulting in zooming activity during all rotation commands: the
view will rotate and zoom at the same time, while it only should rotate.
Button Override 3DxWare makes it possible to fix this problem: it will again
copy the DeskProto version of the XML file, as described above. This
disabling of the driver will only be effective for DeskProto.

This fix does not work correctly for old 3DxWare drivers (it did not work
with a V4 driver), so if it does not work for you then you may need to
upgrade your driver (it worked OK with a V10 driver).

Button Use DeskProto Defaults allows you to reset all setting on this page to
the original DeskProto defaults.
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The picture above shows the Settings sub-page of the Advanced Preferences.
 
In DeskProto many warning messages contain a checkbox called "Always
show this message".
These are optional warnings: when you remove the mark from the checkbox
and press OK, the warning will no longer be issued each time the same
situation occurs. The Always show option is available in two versions:
general and project specific. In the latter case it is valid only for the current
project, and will be stored in the project file.

What to do when you want the warning restored ?
Using button Restore the 'always show' settings  you can restore all general
warnings (so it will again set the mark in all these checkboxes).
The project specific warnings can be restored in the Project Parameters.

Missing drivers
When you open an existing project on a different computer it may happen
that the project needs a machine definition that is not present on that new
computer. DeskProto makes it possible to automatically replace the missing
machine and/or missing cutter(s) by a definition that is present on the new
computer. For instance a definition for the same cutter, however with a
slightly different name.
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These replacement options are described on pages Missing machine and
Missing cutter.

The two buttons to Disable automatic replacement... do exactly what this
text tells you.  When you press a button DeskProto will then also forget all
"unknown - replacement" combinations that you have set for this driver type.

Import/export
All DeskProto defaults and preferences are stored on your computer.
For Windows this is done in the Registry, conform the specifications for
Windows applications as made by Microsoft.
For MacOS the defaults and the preferences are stored in file
~/Library/Preferences/com.delft-spline-systems.DeskProto.plist
For Linux the defaults and the preferences are stored in file ~/.config/Delft
Spline Systems/DeskProto.conf
This makes it difficult to extract these settings, for instance for backup
purposes, or in order to give DeskProto exactly the same workspace on a
number of PC’s.

This is where the options Export settings and Import settings come in: these
tools allow you to export DeskProto’s settings to a file, and also to import all
these settings from a file that has been created previously or on a different
PC. The use of these commands is straightforward: button Export settings
will export an xml file, button Import settings will import one. The file format
used is an XML file, default filename for export is deskproto_8-
0_settings.xml

The resulting V8.0 XML files can be used for all three operating systems
(Linux, MacOS, Windows). In DeskProto V7.0 the Windows version used a
different format for this XML file. DeskProto V8.0 can import that old
format, however DeskProto 7.0 cannot import an XML file that was written
by DeskProto V8.0.  DeskProto V7.1 and V8.0 use the same format (though
of course not all settings are present for both versions).

The export option will write the current settings, so for the current version of
DeskProto.
The import option of DeskProto V8.0 accepts XML files, written by V6.1,
V7.0, V7.1 and V8.0.  DeskProto V6.0 and older versions will write a .REG
file when exporting the settings: DeskProto V8.0 cannot read such .REG file.

Note: 
the File locations (Data location, Drivers location, NC-File location) will not
be included in this Settings file. Reason is that these will be different per user:
like 
C:\Documents and Settings\Jones\My Documents\
and 
C:\Documents and Settings\Smith\My Documents\
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Note 2:
Importing and exporting only concerns the settings (that are stored in the
Registry). The driver files (machine, postprocessor and cutter definitions)
are not included.
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4.21 Simulated Operations

This dialog is visible when a Simulation is visible on screen
Removing this dialog (red cross icon or button Hide) will make the Simulation
invisible.

You can open this simulation dialog by:
- pressing the Simulation button on the Toolbar (after which you can see that
it is pressed). Pressing again will remove the simulation.
- using the Show Simulation command in the Create menu. 
- switching the simulation on in the Items visible dialog. 
DeskProto will calculate a simulation in 3D, so you can rotate, pan and zoom
it just like any other item on screen.

A simulation is made for one complete part. This Simulated Operations
dialog will pop up in which you can select which operations should be
included in the simulation. When no operations are yet processed the
simulation shows the complete block of material. After checking an operation
to be included you will need to start a calculation to see the result. Removing
an operation from the selection causes the complete simulation to be reset.

Option Check all / none offers an easy way to include resp remove all
operations in one click. When  some operations have been selected and some
have not, this checkbox shows a small black square, like shown in the image
above.

You can set the Simulation parameters in the Part parameters dialog.
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Closing the Simulated Operations dialog, again pressing the Simulation button
or switching the simulation off in the Items visible dialog will all make the
simulation disappear from the view.

Note that the simulation calculation algorithms for 3-axis toolpaths and for
rotation axis toolpaths are completely different. 
· The XYZ algorithm (3-axis toolpaths) uses a grid on the XY plane with a

Z-height for each grid-cell: the grid-based simulation.
· For the XZA simulation (rotation axis toolpaths) this is not possible, this

calculation is based on voxels (small "3D pixels"): small cubes that either
are filled with material or not: the voxel-based algorithm. 

The voxel-based algorithm is much more complicated, and so calculation
time will be higher. The quality of the resulting image on the other hand is
higher for the grid-based simulation (as for voxel-based the small cubes are
visible). 
One more difference is that the voxel-based simulation removes material only
where the cutter can actually cut, defined by its cutting length. For a finishing
operation this might be completely within the block: creating an invisible
cavity in the block, So for a voxel-based simulation it is important to simulate
the operations in the correct sequence: first roughing, then finishing.
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4.22 Start Screen

The DeskProto Start Screen shown above is a help to quickly start the task
that you need.
You can open the Start Screen via the File menu  (File >> Show Start
Screen).

Shortcut:

Keys: Ctrl+B  (Windows, Linux)  +B  (MacOS).  
B stands for "Begin", as the S already is being used (for Save project).
 
It will first show the Edition that your are running, 
next your Name and Location (as owner of the license),
and the type of License, with the restrictions that apply (of any).

Three groups of tasks are presented:
· Start a new project
· Open an existing project 
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· Other tasks
Each line in these three lists is a link that will directly start that task.

Starting a New project can be done either using the Wizard interface or the
Dialog based interface. 
Default choice for this dialog is to start a New project using the Wizard: that
is what will happen when you simply press the Enter key (indicated by the
icon at this line). This is the most convenient option for novice users.
When starting a new project using dialogs you need to select which project
type. The difference between Vector/Geometry/Bitmap projects is explained
on page New project. 

The DeskProto Setup has installed a number of Sample projects and Sample
geometries on your PC. Including some great geometries like the DeskProto
picture frame: see the lessons in the DeskProto Tutorial book.
Conform Microsoft's specifications the Samples have been installed in the
\ProgramData\ folder, which may not be easy to find as it is a hidden folder
and its location is different per Windows version. Sorry about that,
unfortunately for standard users (no administrative rights) other locations are
not permitted by Microsoft. Also when using MacOS or Linux the Samples
folder may not be easy to find for you.
Using the checkbox Use samples folder will make DeskProto open the
sample folder when you need to load the CAD data.

To open an existing project two options are present:
Command Open project will allow you to open any project file by browsing
one.
Recent projects will be available only when you have used DeskProto V8
before. In this dialog only the latest 5 projects will be shown, more may be
visible when you select this option via the File menu.

In the Other tasks section, Open sample project makes it easy to find the
sample projects.
The other three 'other tasks' (Read tutorial book, View tutorial videos and
Visit user forum) require an Internet connection, as they will start your
browser and open a web page.

The checkbox Show this start screen on startup makes this screen
automatically appear at each start of DeskProto. After having de-selected this
option, you can still access the Start Screen using the command Show Start
screen in the File menu.
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4.23 Toolpath Animation

A DeskProto screen with many toolpaths drawn may be difficult to interpret,
being one big 'mess of red lines'. The Toolpath animation option offers help,
by making the cutter draw the toolpath while moving over your screen: an
animated view of the toolpaths. 
The animation concerns one complete part, however, only the toolpaths of
the visible operations are drawn, if needed they will be calculated first. In
case more than one operation is present you will see small vertical lines
below the slider bar, indicating the start of a next operation. The default
speed of the animation will be as defined by the feedrate that you have set, 
You can reach this option via the Create menu ("Show animation") or via

toolbar button 

The dialog shows the following icon buttons:

The Slider bar allows you to quickly move to any location in the
toolpath. Simply click on the blue knob and move that to a different
position on the horizontal bar.
The Play button will start the animation.

Button Previous will move the cutter to the previous point on the
toolpath. These points can be shown by checking 'Show points' for the
toolpaths, in the Items visible dialog.
Button Next will move the cutter to the next point on the toolpath.
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Button Begin will move the cutter to the start of the toolpath for the
current operation, or (if already at the begin) to the start of the previous
operation.
Button End will move the cutter to the end of the toolpath for the
current operation, or (if already at the end) to the end of the next
operation.
Button Stop will halt the animation.

This icon is not a button. It shows that the buttons on either side are to
set the Speed of the animation.

Button Slower will reduce the speed of the animation. 
The Speed icon will be replaced to show the current speed setting, for
instance "1/2x"
Button Faster will increase the speed of the animation. 
The Speed icon will be replaced to show the current speed setting, for
instance "4x"

Below these icons DeskProto will display the name of the Operation that has
created the toolpath at the current cutter position.

The coordinate values that are shown are of the points in the toolpath, so the
points that are present in the NC file. While the cutter is moving the dialog
shows the coordinates of the point that the cutter is moving to.
The image above shows coordinates for X, Y, and Z, for a rotary toolpath the
dialog will show X, A and Z.

The units that are used to display the coordinates can be either the
DeskProto units, as set in the DeskProto Preferences or the NC-program
units, as set in the Postprocessor.  For some machines the latter values may
be quite different, for instance for machines that require coordinates in
1/1000 of a mm.

The option Show true cutter does what it says: the cutter will be drawn with
its true shape and on scale. When this option is not checked the a symbolic
'icon' is drawn to represent the real cutter. Drawing the 'true' cutter is optional
as it may obscure the toolpaths and may make the animation slower.
When you are working with a Special cutter that is very large (compared to
the part) it can happen, when the 'True cutter' is shown, that the cutter is not
drawn completely as it partially falls outside the 3D Viewport (the 3D space
that is rendered).
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4.24 Vector data - Use Z-values

For Vector data two different data types are possible: 
2D Vector data - no Z-values are present at all or all Z-values equal to 0.0
3D Vector data - Z-values are present that are not equal to 0.0. 

The vector file that you now opened is from the second type, so it contains
vector curves in 3D.
You now can select whether or not you want to use these Z-values: if you say
No all Z-values in the vector curves will be reset to 0, so the data will be
converted to 2D vector data.

When you want to use the Z-values (answer "Yes") you can enter a second
setting, about how to uses this file for rotation axis machining. This is the
checkbox "For rotary parts do NOT wrap around cylinder".
The difference between wrapping and not wrapping is explained on page
Rotation axis machining.
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4.25 Viewpoint

The View menu command Viewpoint -> Custom...  displays the Viewpoint
dialog, in which you can change the settings of the active view, which are
the settings for rotation, panning and zooming. In fact this is setting the
Camera position.

Shortcuts:

Toolbar:
Mouse: Right-click in a view, and select the Viewpoint item in the context-
menu.

In this dialog you can change the point of view from which you look at the
curves, the geometry, Z-grid, toolpath etc. You can set the values for
rotation, pan and zoom exactly, using the keyboard. The rotations are
executed in the order X, Y, Z. The effect is the same as when using mouse
rotation, mouse pan, mouse zoom or when using the thumbwheels.

Note:
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These values do not change the toolpaths, they only change the Camera
position. To rotate/pan/scale the part to be machined you should go to the
Transform tab page of the Part Parameters dialog.
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4.26 Views Layout

In this dialog you can change the Layout of the View Window: the way it is
filled with Views. It is possible to show 1, 2, 3 or 4 Views at the same time, as
shown in the dialog. Each of these Views can have different settings for
Viewpoint and for Items visible. All these settings will be stored in the project
file.

The two layouts at the right automatically set the viewpoint for all views.
Those are the ones with the characters T, F, R and the term DEF, where ‘T’
stands for Top view, ‘F’ stands for Front view, ‘R’ stands for Right view and
‘DEF’. stands for Default view.
Such a layout is very handy to get a quick impression of what a new part
looks like.

When the checkbox Sync the Items Visible settings between all views is
checked all views show the same items. So when you add an item to one view
it will be added for all views. When checking this for the first time the
settings of the active view (marked by a blue border) will be copied to the
other views.

Shortcuts:

Toolbar:

Note:
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In a Layout with more than one view, one of the views will be the current
(active) view. You can make a view current by clicking your left mouse-
button inside the view: observe the blue line that appears around the active
view. The thumb-wheels, view buttons and view commands apply only on the
current view.
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V Concepts

5.1 CAD Data

Vector data Geometry data Bitmap data

DeskProto offers CAM (Computer Aided Manufacturing): the ability to
calculate CNC toolpaths for a part that you have designed. The first step in
DeskProto in all cases is loading some CAD-data, as DeskProto does not
offer CAD (Computer Aided Design) functionality. You will need to use
other software to design your parts. 
DeskProto supports three different types of CAD-data:
· Vector data One or more curves: points in space connected

with straight line segments (or with arcs).
· Geometry data A collection of small triangles that describe the outer

surface of a 3D shape.
· Bitmap data A grid of colored pixels on a flat plane, forming

a 2D image.

The images above show all three types. For Geometry data and Bitmap data
the images are identical, because a 2D screen or page we can only disply
bitmap images: also for 3D CAD data. Bitmap data for DeskProto normally
will be a digital photo, a company logo or similar. The next image shows the
difference between 2D data and 3D data:
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Vector data Geometry data Bitmap data

When looking at the CAD-data from a different viewpoint the difference
between the Geometry data (3D) and the Bitmap data (2D is clear: a real 3D
bottle versus a flat drawing of the bottle on paper.
Vector data for DeskProto in most cases will also be a 2D drawing (though
DeskProto will also accept 3D curves as Vector data).

Vector data Geometry data Bitmap data

The images above (zoomed in on the base of the bottle) clear show the
difference between these three types of CAD-data.
Both for Vector data (points connected by straight lines) and Geometry data
(collection of triangle surfaces) you can zoom in without loosing detail. For
Bitmap data this is different: when zooming in the pixels will became large
squares, and what seemed a smooth curve becomes a staircase.

For each type of CAD data DeskProto offers a (slightly) different work-flow:
· a Vector project uses Vector operations, and offers Vector settings in the

Part parameters
· a Geometry project uses Geometry operations, and offers Geometry

settings in the Part parameters
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· a Bitmap project uses Bitmap operations, and offers Bitmap settings in the
Part parameters

The wizard interface also offers different wizards for each type of CAD-data.

A powerful feature in DeskProto is that it can combine these types of CAD
data in one project: combine a Geometry with Vector curves and /or with a
bitmap. It is even possible to project the Vector curves and the bitmap onto
the 3D geometry.
  
In the illustration above the Coat-Of-Arms relief Geometry data (a free
download from the DeskProto website) was combined with 2D Vector data
for the word "DeskProto" and an image of the clock as Bitmap data.  You
can of course use your own data for the text on the ribbon and the image on
the shield.

5.1.1 Vector Data

DeskProto can load three types of CAD data: Vector data, Geometry data
and Bitmap data.

Vector data consists of curves: points in space that are connected with
straight line segments, in most cases a 2D line-drawing. DeskProto will use
the curves in the drawing to generate the toolpaths. Ideal for 2D jobs, like
milling 2D shapes out of sheet material, or engraving on a flat surface.
In order to create Vector toolpaths you need to use a Vector Operation in
your project.
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How to load a Vector file
Vector data files can be loaded in several ways:
· File menu command Load Vector file
· Toolbar button Load Vector file
· Button Add... on the Vector tab of the Project parameters
· The Wizard Basic Vector machining.
It is possible to load more than one Vector file, using the same command: 
after you have loaded a vector file the Load Vector file command will change
to Add Vector file. 

How to save Vector data
Vector data can be exported in two ways (for export only DXF and SVG are
supported):
· File menu command Save Vector data as...
· Button Save as... on the Vector tab of the Project parameters
The first option saves all Vector data to one file (also when various Vector
files had been loaded), the second only that data of the selected vector file.
When saving the Vector data you may select which of the Part
transformations you want to apply for the exported file. You can do so in the
Save Vector Data Options dialog.

Vector curves can be either open curves, closed curves or single points. This
is important as Pocketing and V-Carving are possible only for closed curves.
When reading vector curves DeskProto will check whether or not a curve is
closed: it is closed when the end-point is identical to the start-point. Or in fact
almost identical, as DeskProto applies a tolerance: when the difference is less
than 0.001 mm the points are considered to be equal. The same tolerance is
used when separate open curves can be combined to one long curve (also see
the option 'Preserve curve direction' in the Project parameters.
When a curve that seems closed is in fact open you can find the error by
checking "Show points" for Vector curves in the Items Visible dialog. The
start point of the curve will be indicated by a larger dot. Closed curves do not
have a starting point, so a large dot indicates a gap.

The vector calculation algorithm that DeskProto uses only works for
polylines. So when opening a vector file that contains arcs, circles, ellipses,
splines or other curves each of these curves will be converted to a polyline.
The  size of each straight line-segment in the polyline depends on the radius
of the arc. If you are interested, the exact formula for arcs is:
stepsize = 2 * acos( (radius-0.001)/ radius )

As a nice extra feature DeskProto also supports 3D Vector files. Most vector
files do not contain any Z-coordinates: you will then set the Z-values in the
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Vector Operation parameters. A 3D Polyline however does contain Z-values,
and DeskProto can import these. The toolpath then will follow this 3D
Polyline, and the Z-values as entered in the Vector Operation parameters will
be taken relatively to the Z-values defined in the file.
When you open a DXF file containing Z-coordinates, DeskProto will report
that is has detected Z-values in the file, and will ask you if you want to use
them. After Yes the Vector operation will produce a 3D toolpath, after No
the Z-values will be ignored. This setting "Use Z-values" can also be found
on the Vector tab of the Project parameters.

This option "Use Z-values" can also be checked for vector files that do not
contain Z-values: DeskProto then will use Z=0 for all points on the vector
curves. This will influence the result when both vector files and geometry
files are loaded: The vector curves then will be placed on the zero level of the
geometry (in CAD coordinates). When the option is not checked the curves
will be placed on the top of the block.

When rotation axis machining two workflows are possible for 3D vector
files: 
- Wrap around cylinder (as with 2D files) 
- Do not wrap, see the page about rotation axis machining. This setting as
well can be found on the Vector tab of the Project parameters.

Text in a vector drawing that is stored as a series of ASCII character with a
font definition cannot be read by DeskProto: each character needs to be
stored as curves.

Vector File types
For Vector data DeskProto supports four file types: 
· DXF the most widely used exchange format for engineering
· SVG open source format meant for internet, supports vector, bitmap,

interactivity and animation.
· AI  widely used format by Adobe, for graphics design (only version

Illustrator 8)
· EPS graphics file format by Adobe (only version Illustrator 8)
For all four file-types DeskProto supports (so can read) only a small subset of
all entities that can be present in the file, see the lists below.

DXF
The acronym stands for AutoCAD Drawing eXchange File. 
It can contain many different entities, both 2D and 3D, DeskProto supports a
small subset only. 

Supported DXF entities for Vector data in DeskProto:
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POINT
A point in the DXF file can only be selected for a drilling operation on that
location.
LINE
A line contains a begin- and end-point, and will result in a tool movement
from begin to end (linear interpolation).
POLYLINE and LW POLYLINE
A polyline is in fact a series of lines connected to each other. This is more
efficient (endpoint line 1 = startpoint line 2) and gives more control over the
toolpath sequence. A polyline may contain arc segments as well.
ARC
An arc entity contains the centerpoint coordinates, the radius of the arc, and
angles for start and stop. DeskProto will convert the arc to a polyline (many
small line segments), as the algorithm does not support arcs.
CIRCLE and ELLIPSE
Same as the Arc: stored in DXF as Centerpoint(s) and radius, converted by
DeskProto to polylines.
SPLINE
A spline curve (Bezier, B-spine or NURBS). DeskProto will convert the
spline to a polyline when importing.

DeskProto will also import CAD-layer information (if present). When
selecting curves you can make each layer visible or invisible.

Internally DeskProto only uses polylines for vector data, so all entities will be
converted to polylines (see the information above). When saving vector data
in a DXF file it will thus contain only polylines.

Note that DeskProto also supports Geometry data in DXF files.

SVG
The acronym stands for Scalable Vector Graphics, an open standard
developed by the World Wide Web Consortium (W3C).
It can contain many different entities, DeskProto supports a small subset
only. 

Supported SVG entities for Vector data in DeskProto:
line
rect
circle
ellipse
polyline
polygon
elliptical_arc
cubic_bezier
quadratic_bezier 
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Internally DeskProto only uses polylines for vector data, so all entities will be
converted to polylines (see the information above, for DXF). When saving
vector data in an SVG file it will thus contain only polylines.

When the size in SVG file is only in pixels (no real life dimensions in the file)
DeskProto assumes 4 pixels per mm (101.6 dpi), as that comes close to most
screen resolutions.
In the SVG format the zero point is in the upper left corner of the screen,
with the positive Y direction going downwards. In DeskProto (and on the
machine) the positive Y direction goes upwards, so DeskProto needs to
mirror all Y values.

AI and EPS  (Postscript)
These acronyms stand for Encapsulated PostScript (a file exchange format)
and Adobe Illustrator (native format of a widely used graphics design
program). Both are in fact variations on the PostScript format, and for both
files DeskProto supports the same subset of entities.
Adobe changes the file formats for AI and of EPS with every new version of
Adobe Illustrator, which makes these files not really suited for data
exchange. The most widely used version is the one used in Adobe Illustrator
8, and that is the version that DeskProto supports. So AI files need to be
saved/exported for Adobe Illustrator 8 to make them readable for
DeskProto. Loading an AI file or EPS file in a newer version will result in
the error "The version of this file type is not supported".

Supported Postscript entities for Vector data in DeskProto:
POINT
A point in the Postscript file will result in a drilling operation on that location.
LINETO
A line in Postscript contains only an end-point, and will result in a tool
movement from the current position to that end (linear interpolation).
CURVETO,  CURVETO_USESTART,  CURVETO_USEEND
Also a tool movement to the defined end-point, however now a Bezier curve.
Used much in font definitions.
MOVETO
As the above commands specify the end-point but not the start-point, a
method needs to be supplied to move to a new start-point without drawing
(milling) a line. The Moveto command makes such positioning move.

DeskProto will also import CAD-layer information (if present). When
selecting curves you can make each layer visible or invisible.

Postscript also may contain many other entities, like colors and bitmaps,
which will be skipped by DeskProto.
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Viewing the Vector data
After loading, you can see the Vector data on your graphics screen. 
In case you do not see the curves, check if item “Vector curves” is checked
in the Items visible dialog. Here you can also find the option to show all
points in each vector curve.

5.1.2 Geometry Data

DeskProto can load three types of CAD data: Vector data, Geometry data
and Bitmap data.

For Geometries DeskProto only recognizes "Polygon data": the outer surface
of the geometry described using a (large) number of triangles. This type of
geometry is also called mesh data, and any 3D shape can be defined this way.
It is not the most efficient way of storing 3D data, still it has the large
advantage that it always works: the definition is so basic that no
incompatibilities between systems exist. This same format is also used for 3D
printing, and because of that it can generated by any 3D CAD system

In order to create Geometry toolpaths you need to use a Geometry Operation
in your project.
DeskProto will generate the toolpaths by projecting a flat toolpath pattern
over the 3D geometry.

How to load a Geometry file
Geometry data files can be loaded in several ways:
· File menu command Load Geometry file
· Toolbar button Load Geometry file
· Button Add... on the Geometry tab of the Project parameters
· The Wizard Basic Geometry machining and other Geometry wizards.
It is possible to load more than one Geometry file, using the same command: 
after you have loaded a geometry the Load Geometry file command will
change to Add Geometry file. 

How to save Geometry data
Geometry data can be exported in two ways:
· File menu command Save Geometry data as...
· Button Save as... on the Geometry tab of the Project parameters
The first option save all Geometry data to one file (also when various
geometry files had been loaded), the second only that data of the selected
geometry file.
You can select any of the supported Geometry file types.
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When saving the Geometry data you may select which of the Part
transformations you want to apply for the exported file. You can do so in the
Save Geometry Data Options dialog.

Geometry File types
DeskProto supports four geometry file types: STL, 3MF, DXF and VRML.
The only type that is fully supported is STL, as that file can only contain
triangles, nothing more. The other types may also contain other shapes
(entities), which are not supported. 
For loading geometry we advise to use STL files, as both DXF and VRML in
practice may give problems. We do not yet have much feedback about
working with 3MF files.

Two other file types that are often used to transfer geometry data are not
supported by DeskProto: IGES and STEP. These formats store the data in a
much more complex way, making many types of conversion error possible

STL
This file format has been created for the first 3D printer ever: the
STereoLithography system. This does well explain the acronym, though some
claim that it stands for Standard Triangle Language, or for Standard
Tesselation Language..
An STL file may be a binary file or an ASCII file, the only difference being
the storage method: the contents of both files (the series of triangles) is
identical. DeskProto can read and write both binary and ASCII STL files.

The original StereoLithography system had more severe requirements for the
STL file than DeskProto. It accepted only positive coordinate values, and a
complete and true solid needed be present as geometry (no gaps and/or
orphan surfaces). Currently negative coordinates no longer are a problem,
however for 3D printers a small gap (say a 0.001 mm gap between two
triangles) still is lethal.  DeskProto does not care about all these errors.
 
In an STL file for every triangle also a normal-vector is saved, in order to
define the inside and the outside of the part. The direction of each normal
should point outwards. When the option 'Skip Backfaces' in the Project
parameters has been checked the backsides of the triangles will not be
considered: drawn in red, and skipped in the toolpath calculations.

This normal vector contains in fact double information, as the order in which
the three points are stored can also be used to define inside and outside: in an
STL file the vertices are listed in counterclockwise order when looking at the
object from the outside.



Concepts

Page 369

DeskProto Reference

3MF
The 3D Manufacturing Format has been published by the 3MF Consortium,
as an open source file format for additive manufacturing. Just as STL it
defines the geometry as polygon data, but it includes more information about
the part than STL offers, for instance about material and color. DeskProto
does not use this extra information: only the information in group "3D
Model" is read (the geometry information).

3MF files will be smaller than STL files at 3MF is a compressed format (ZIP
file).

DXF
AutoCAD Drawing eXchange File. A DXF file can contain many different
entities, both 2D and 3D.
DeskProto only supports a specific type of geometry in the DXF file:
geometry in small triangles (facets). In DXF these supported entities are
called 3D Face and Polyface Mesh. All other entities in the DXF file will be
ignored by DeskProto when loading geometry data.
3D-Face
With 3D-faces for every triangle 3 points are stored. No normal-vector is
stored, the three points are stored in counter-clockwise order.
Polyface Mesh
With polyface meshes first a long list of points is stored, and then for every
triangle 3 indexes that each lead to a point in that list. In this way all the
points only have to be saved once, thus saving disk-space.

Other entities in the DXF file will be skipped when importing the file. In
practice many DXF-files will only contain other entities, and thus can not be
read by DeskProto.

Note that DeskProto also supports DXF files for Vector data, and then will
accept a different set of entities.

VRML
Virtual Reality Modeling Language file. Not widely used.
The standard for VRML files is almost completely covered by DeskProto,
both for VRML Version 1 and Version 2. DeskProto does not support the
entities Sphere, Cone and Cylinder, and the concept of Custom Node Type
definitions. 
VRML files have the file extension .WRL (short for "world").
It has become an obsolete filetype, only very rarely used.
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Corrupt geometries
In the past not all 3D CAD systems exported valid geometry files; loading an
invalid file may result in geometries that do not look right on the DeskProto
screen. With an up-to-date CAD program this is not likely to happen though:
current CAD systems have a correct STL export function.

A known problem with the STL files of some surface modeling CAD
programs is incorrect normal-vectors. The normal-vector of a triangle defines
which side of the triangle is the outside, so incorrect normals result in a
geometry with the backfaces on the outside, drawn in red. This can be solved
by switching the option Flip normals on in the Project Parameters dialog. 
You can also save your geometry with these flipped normals: choose the Save
Geometry As option in the File menu. 
- STL-files contain normal-vectors.
- DXF files do not contain normals, when importing a DXF file DeskProto
calculates the normal based on the three points of the triangle being stored in
a counter-clockwise order.

When some of the normals are OK and some are incorrect, then only some of
the triangles are drawn in red. This can also be solved by DeskProto. You
have to uncheck the option Skip backfaces with calculations in the Project
Parameters dialog. This causes all the triangles to be treated as if they don’t
have backfaces but 2 frontfaces so they will be rendered from both sides, and
both sides will be used for toolpath calculations as well.

Obviously files can be corrupt in many more ways. DeskProto is very tolerant
here: it will simply accept files containing cracks, holes, orphan surfaces and
many more inconsistencies. Files that would be rejected by most 3D Printing
programs.

Viewing the Geometry data
After loading, you can see the Geometry data on your graphics screen. As
rendered geometry, as wireframe, as wireframe with hidden lines removed, or
as points. To determine how to view the geometry you can check or uncheck
the items in the Items visible dialog.

5.1.3 Bitmap Data

DeskProto can load three types of CAD data: Vector data, Geometry data
and Bitmap data.

A Bitmap file contains a 2D image by storing the color value of each pixel on
the screen. So a line is stored as a series of black pixels on a white
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background. This in contrast to a vector file, where the line is stored using the
coordinates of both the start point and the end point of the line. As many
different colors can be used for each pixel, in a bitmap complex pictures are
possible. Digital photos for instance are stored in bitmap files.

DeskProto needs an image in gray values, it will automatically convert color
pictures to Black&White (B&W) when loading. In case you are interested:
the conversion formula is  gray-value = 0.30 * red + 0.59 * green + 0.11 *
blue.

A bitmap file is a 2D file: a pixel only has an X-coordinate and a Y-
coordinate, plus of course a color (gray value). DeskProto will convert this
2D file to a 3D geometry by translating the gray value to a Z-value, resulting
in XYZ information for each pixel. The result is a 3D Relief. This is called
Gray scale to Z-height conversion, or Bitmap to Relief conversion 

The B&W 'colors' range between black and white, where pure black and pure
white define the extreme Z-values to be used. These two extreme Z-values
can be set in the Part parameters, tab Z Settings. Internally DeskProto
converts the bitmap to a Z-grid, that can be used for toolpath calculations.

The bitmap image will be displayed on the top surface of the block. When
combined with other CAD data it will be positioned with its bottom left
corner at point X=0 Y=0 (in CAD coordinates), still at the top of the block.

In order to create Bitmap toolpaths you need to use a Bitmap Operation in
your project.

The two pictures above show the original bitmap image of a shell left, and
right a simulation of the resulting 3D Relief. Minimum Z has been assigned to
black, and Maximum Z to white. DeskProto does not display the resulting
Bitmap geometry, you can only see it by displaying the Z-grid, the Toolpaths
or the Simulation.
Important to know is that for large bitmaps DeskProto will display a
simplified version (512x512 pixels) of the bitmap, in order to speed up
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drawing. The actual toolpath calculations will nevertheless be done with the
original bitmap data.

How to load a Bitmap File
Geometry data files can be loaded in several ways:
· File menu command Load Bitmap file
· Toolbar button Load Bitmap file
· Button Browse on the Bitmap tab of the Project parameters
· The Wizard Basic Bitmap machining
You can only load one bitmap file per project. 

How to save Bitmap data
Geometry data can be exported in two ways:
· File menu command Save Bitmap data as...
· Button Save as... on the Bitmap tab of the Project parameters
You can select any of the supported Bitmap file types for export, except GIF.

Bitmap File types
DeskProto supports the most popular file types for bitmap files:

BMP File format defined by Microsoft for BitMaP files. Not
very efficient (large files), widely accepted.

GIF the Graphic Interchange Format is an efficient format
without data loss, though only max 256 colors are possible.

JPG or JPEG File format defined by the ISO (International
Standards Org) Joint Photographic Experts Group.
Various levels of compression are possible, all resulting in
some loss of information.

PNG the Portable Network Graphics is the best bitmap format:
with compression, no data loss, not patented (like GIF).
DeskProto also supports PNG files with a 16-bit grayscale
image (65536 shades of gray).

TIFF Tagged Image File Format, originally made by Aldus,
since 2009 controlled by Adobe. TIFF files tend to be very
large. DeskProto can read both 8-bit grayscale images
(256 shades of gray) and 16-bit grayscale images (65536
shades of gray).

WEBP Web Picture format, developed by Google (as a derivative
of WebM, a video format file), intended to make bitmap
files very small and thus perfect for website use.
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HEIC High Efficiency Image Container  (supported only in the
MacOS build, and only for import). This is the standard
format used by iPhones and iPads to store photos.

Grid complications: the Moiré effect.
In a DeskProto bitmap operation two grids are used: the bitmap is a grid, and
for calculating the toolpath the Z-grid is used. Be warned: combining two
grids that are not equally spaced may lead to ripples in the resulting relief,
caused by a Moiré effect.

The Bitmap grid is the grid of pixels, the size of each grid cell in mm being set
on tab XY Transform of the Bitmap parameters.
The Z-grid is the rectangular grid of XY positions, with a Z-value calculated
for each position, the size of each grid-cell in mm set by the Precision.
The Z-grid will be filled with Z-values that are calculated in the Bitmap
grid.

In most cases the dimensions of these different grid cells will not be not
equal, so this conversion cannot be done one to one. 
For instance: imagine a bitmap with a pixel size of 0.9 mm and a Z-grid with a
cell size of 1 mm. Most Z-grid cells then are filled with the Z-value of just
one single bitmap cell, however every 10th cell will be filled with Z-values
from two bitmap cells. And this may cause a visible ripple in the relief. Such
ripples are called the Moiré effect.

In order to prevent such Moiré problems you can select a pixel size that is
dependent from the precision. This can be accomplished using one of the two
options “Calculate from precision...” (on tab XY Transform that was just
mentioned). The edit fields for Custom will show the resulting relief size.
Note that when you later change the precision that will automatically also
change the size of the resulting relief.

Viewing the Bitmap File data
After loading, you can see the Bitmap image on your graphics screen. 
In case you do not see a bitmap, check if item “Bitmap” is checked in the
Items visible dialog. Per default the bitmap is drawn translucent, making it
possible to see items behind the bitmap. In the Items visible dialog that
translucency can be switched off.
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5.2 Project

A project is the file that you open when you work with DeskProto. It can be
compared with a document in applications like MS Word. Unlike Word,
where you can open several documents at the same time, in DeskProto
though you can have only one project opened. A project can be saved and
opened in the File Menu, as a DeskProto ProJect file with the file-extension
DPJ. DPJ files are simple text files, that can be edited using a plain text
editor.

Project Structure
The information in a project file is structured: in addition to some general
information five groups are present:
· General information
· CAD files
· Parts
· Operations
· Views
· NC files (if any)

Most important general information is the Machine (CNC milling machine)
that you want to use for this project. You can select a different machine in
the Project Parameters dialog. Other general information includes the type of
user interface that you used (Wizard-based or Dialog-based) and the Edition
of DeskProto that was used.

Each project can include one or more CAD files. Three types of CAD data
are supported: Vector data, Geometry data and Bitmap data. In the DPJ file
only links to the CAD files are stored, not the actual CAD data. In case a
project does not have link to a CAD file it is called a template project.

The Part is what you are going to machine. A project contains one or more
parts (zero parts is not possible), as for one model several parts may be
needed. For instance the left halve and the right halve of a hand drill. The
part definition consists of a number of parameters, like scaling values
(relative to the original geometry), rotation values etc. Each type of CAD
data comes with slightly different set of part parameters: the Vector settings,
the Geometry settings and the Bitmap settings. 
In fact the Part parameters define what to machine.

An Operation defines how the material will be machined. Three different
types of operation are available: Vector operations, Geometry Operations and
Bitmap operations. Each part contains one or more operations (no maximum
number, zero operations is not possible). It is called operation because it
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defines one actual machining operation. This definition also consists of a
number of parameters, like cutter, milling direction, precision values, feedrate
etc. Most times you will use more than one operation for one part. For
example you may want to quickly remove most of the material (roughing)
before you want to mill precisely (finishing).
In fact the Operation parameters define how to machine it.

The project file also contains information about the View (camera position)
for each part, and about the NC files that you have saved when working with
this project. 

In DeskProto the structure of the project is shown in the Project tree, which
is placed on the left of the screen and looks like this:

Project Types
You can create a new project by choosing the New Project option in the File
menu. You will see three sub-options for the three types of project that
DeskProto supports:
· New Vector project will create a project with a Vector operation
· New Geometry project will create a project with a Geometry operation
· New Bitmap project will create a project with a Bitmap operation
So the difference is small: the type of operation that is present defines the
project type. You can easily add and remove other operations, of any type.
When you create a new project the currently opened project file will be
closed. In case you start DeskProto a new project will be created
automatically. 
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Default project
When a new project is created, all parameters are copied from the Default
Project, the Default Part and a Default Operation. This default operation can
either be Vector, Geometry or Bitmap. The three operation types each have
their own set of default settings: the default Vector operation, default
Geometry operation, the default Bitmap operation.
All these settings are saved on your PC, every user has a separate set of
defaults. You can use these defaults to enter parameters that you want to use
as a standard, for instance the machine that you always use. A default CAD
file cannot be set though, and the default project can only contain one Part.
One of the settings of the default Part is which type of operation needs to be
loaded (Vector/Geometry/Bitmap). This defines whether the default for a
New project (in the file menu) is a Vector project, a Geometry project or a
Bitmap project.
Editing the parameters of the default Project/Part/Operation can be done in
the Options menu.

How to open a project
You can open a project by choosing the Open... option of the File menu, or
by pressing the Open button on the Toolbar. When you open a project the
currently opened file will be closed.
The folder that is shown when you first open the Open File dialog is the file
location ‘Data’, which can be changed at the General tab page of the
Preferences dialog. After that DeskProto will remember the folder you are
working is (the current folder) and will keep using that.

How to save a project
You can save a project by choosing the Save option of the File menu, or by
pressing the Save button on the Toolbar. Using this option it will be saved
under the same name you have saved it before. If you want to save it with
another name, choose the option Save As... under the File menu.
The same current folder as just explained for Open project will be used here
as well.

The DPJ file
The project information is stored in a DeskProto ProJect file (file extension
.DPJ), containing all Parameter settings and also all View settings. Note that
the project file does not contain any CAD data, only links to the CAD file(s).

Two different types of DPJ files are used:
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1 - a project file with only the settings (default)
2 - a project file with both the settings and the calculated toolpaths.
Both files have the same file extension .DPJ

The second type (with toolpaths) can be useful in case the toolpath
calculations take very long. 
You can choose between both types in the "Save as type" field of the Save
As dialog.
When opening a project file it is not needed to distinguish between both types
of DPJ file.
In fact the toolpaths will be stored in a separate file: the DeskProto Toolpath
file (file extension .DPT), which will be much larger than the (small) DPJ file.
For a project file called test.dpj  the toolpath filename will be test.dpt
The difference between such Toolpaths file and an NC program file is that
the first is in a machine-independent format.

A DPJ file without CAD data is called a template file: when opening
DeskProto will ask for a CAD file to be loaded.
The sample DPJ files do not include a line to define the machine to be used:
DeskProto will then use the default machine that you have set.

5.2.1 Part

A part is what you will machine using one setup (a block being fixtured on
the machine). For some products that is all that is needed, for other products
more parts may be needed: for instance the left side and the right side of a
hand drilling machine, to be glued together later. In case you machine one
block of material from two (or more) sides, DeskProto will see each side as a
separate Part.

The description of a part consists of a number of parameters, like scaling
values (applied to the original CAD data), rotation values and the size of the
material block to be used. These parameters depend on which type of CAD
data has been loaded: the Vector settings, the Geometry settings and the
Bitmap settings are slightly different. For a complete list of parameters see
Part Parameters dialog. To edit a part go to the Parameters menu and select
the item Part Parameters. This opens the Part Parameters dialog.
A much quicker way to open the Part parameters dialog is double-clicking on
the part's name in the Tree.

How the part should be machined is defined in its Operations. A part can
contain one or more operations: Vector operations, Geometry operations
and/or Bitmap operations.
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Current part
In case your project contains more than one part you need to make a part
current in order to see it on the graphics screen. There is always one part
that’s current: no more, no less. The light-bulb icon in the project-tree shows
which part is current: for only part the light burns (yellow) - for all other parts
(if any) the light is off (gray).
You can make a part current by clicking on the gray light-bulb icon for that
particular part. Clicking on a yellow light-bulb does not have any effect. You
can also make a part current by right-clicking on a part in the project-tree and
then mark the option ‘Make Current’ in the context-menu that will be shown.

Default part
When a new project is created it will contain one part. The parameters of that
part are copied from the default part. The default settings are saved on the
computer; each computer user has his/her own set of defaults.

You can use the default part to enter the settings that you want to use as a
standard. For instance when your geometry always needs to be rotated 90
degr round Z, or when you always need the Zero point to be at the bottom of
the block. You can also set the number of operations, for instance a Roughing
operation and a Finishing operation (in that case you will have two default
operations).

Important is the type of Operation that you use in your default part: 
· when the first operation is a Vector operation your default project will be a

Vector project
· when the first operation is a Geometry operation your default project will

be a Geometry project
· when the first operation is a Bitmap operation your default project will be

a Bitmap project

To edit the parameters of the default part, go to the Options menu and select
the option Default Part Parameters. This opens the Part Parameters dialog.
The parameters of the default part are also used when you add a new part to
the project.

5.2.2 Vector Operation

An operation gives a description of how the material should be machined.
DeskProto features three different operation types: 
· this Vector operation is meant to create toolpaths for Vector data
· a Geometry operation is meant to create toolpaths for Geometry data
· a Bitmap operation is meant to create toolpaths for Bitmap data.
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The description of a Vector operation consists of a number of parameters,
like cutter, type of toolpath (Profiling, Pocketing, V-Carving, Drilling),
milling direction, precision values, feedrate etc. For a complete list of
parameters see Vector Operation Parameters dialog.

To edit an operation go to the Parameters menu and select the item Operation
Parameters. When more than one operation is present a dialog will open to
select which Operation to edit. After selecting a Vector operation, DeskProto
will show the Vector Operation Parameters dialog. Of course a Vector
Operation must already be present in order to select one.
A much quicker way to open the Vector Operation parameters dialog is
double-clicking on the operation's name in the Project Tree.

Visible operations
To view the data or the toolpaths of a particular Vector operation you need to
make it visible. Of all operations of the current part 0, 1 or more operations
may be visible at the same time. The light-bulb icon in the Project-tree shows
if an operation is visible: the light burns (yellow) means visible, the light is off
(gray) means invisible.
You can make an operation visible by clicking on the gray light-bulb icon for
that particular operation, and make it invisible by clicking on it's yellow lamp
icon. You can also make an operation visible by right-clicking on an
operation in the project-tree and then mark the option ‘Visible’ in the
context-menu that will be shown. Another way to make an operation visible
is to click on a lamp icon in the operation-list of the Items visible dialog. To
actually see one of the items (curves, toolpaths) of the Vector operation you
have made visible, the item needs to be checked as well in this dialog.

Default Vector operation
When a new Vector operation is created, the parameters of the new operation
are copied from the default Vector operation. The default settings are saved
on the computer; each computer user has his/her own set of defaults.
DeskProto also contains a default project and a default part. When the
default part contains a Vector operation (as first operation) the default
project is a Vector project. 
You can use the default Vector operation(s) to enter milling parameters that
you want to use as a standard. For instance a specific tool and/or machining
depth.

To edit the parameters of the default Vector operation, go to the Options
menu and select the option Default Vector operation Parameters. This will
open the Vector operation Parameters dialog.
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5.2.3 Geometry Operation

An operation gives a description of how the material should be machined.
DeskProto features three different operation types: 
· a Vector operation is meant to create toolpaths for Vector data
· this Geometry operation is meant to create toolpaths for Geometry data
· a Bitmap operation is meant to create toolpaths for Bitmap data.

The description of an operation consists of a number of parameters, like
cutter, strategy, precision values, feedrate etc. For a complete list of
parameters see Geometry operation Parameters dialog.

To edit an operation go to the Parameters menu and select the item Operation
Parameters. When more than one operation is present a dialog will open to
select which Operation to edit. After selecting a Geometry operation,
DeskProto will show the Geometry Operation Parameters dialog. Of course a
Geometry operation must already be present in order to select one.
A much quicker way to open the Geometry operation parameters dialog is
double-clicking on the operation's name in the Project Tree.

Visible operations
To view the data or the toolpaths of a particular Geometry operation you
need to make it visible. Of all operations of the current part 0, 1 or more
operations may be visible at the same time. The light-bulb icon in the Project-
tree shows if an operation is visible: the light burns (yellow) means visible,
the light is off (gray) means invisible.
You can make an operation visible by clicking on the gray light-bulb icon for
that particular operation, and make it invisible by clicking on it's yellow lamp
icon. You can also make an operation visible by right-clicking on an
operation in the project-tree and then mark the option ‘Visible’ in the
context-menu that will be shown. Another way to make an operation visible
is to click on a lamp icon in the operation-list of the Items visible dialog. To
actually see one of the items (Z-grids, toolpaths) of the Geometry operation
you have made visible, the item needs to be checked as well in this dialog.

Default operation
When a new Geometry operation is created, the parameters of the new
operation are copied from the default Geometry operation. The default
settings are saved on the computer; each computer user has his/her own set
of defaults.
DeskProto also contains a default project and a default part. When the
default part contains a Geometry operation (as first operation) the default
project is a Geometry project. 
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You can use the default Geometry operation(s) to enter milling parameters
that you want to use as a standard. For instance a specific tool and/or
strategy.

To edit the parameters of the default Geometry operation, go to the Options
menu and select the option Default Geometry operation Parameters. This will
open the Geometry operation Parameters dialog.

5.2.4 Bitmap Operation

An operation gives a description of how the material should be machined.
DeskProto features three different operation types: 
· a Vector operation is meant to create toolpaths for Vector data
· a Geometry operation is meant to create toolpaths for Geometry data
· this Bitmap operation is meant to create toolpaths for Bitmap data.

The description of a Bitmap operation consists of a number of parameters,
like cutter, strategy, milling direction, precision values, feedrate etc. For a
complete list of parameters see Bitmap Operation Parameters dialog.

To edit an operation go to the Parameters menu and select the item Operation
Parameters. When more than one operation is present a dialog will open to
select which Operation to edit. After selecting a Bitmap operation, DeskProto
will show the Bitmap Operation Parameters dialog. Of course a Bitmap
Operation must already be present in order to select one.
A much quicker way to open the Bitmap Operation parameters dialog is
double-clicking on the operation's name in the Project Tree.

Visible operations
To view the data or the toolpaths of a particular Bitmap operation you need
to make it visible. Of all operations of the current part 0, 1 or more
operations may be visible at the same time. The light-bulb icon in the Project-
tree shows if an operation is visible: the light burns (yellow) means visible,
the light is off (gray) means invisible.
You can make an operation visible by clicking on the gray light-bulb icon for
that particular operation, and make it invisible by clicking on it's yellow lamp
icon. You can also make an operation visible by right-clicking on an
operation in the project-tree and then mark the option ‘Visible’ in the
context-menu that will be shown. Another way to make an operation visible
is to click on a lamp icon in the operation-list of the Items visible dialog. To
actually see one of the items (bitmap, toolpaths) of the Bitmap operation you
have made visible, the item needs to be checked as well in this dialog.
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Default Bitmap operation
When a new Bitmap operation is created, the parameters of the new
operation are copied from the default Bitmap operation. The default settings
are saved on the computer; each computer user has his/her own set of
defaults.
DeskProto also contains a default project and a default part. When the
default part contains a Bitmap operation (as first operation) the default
project is a Bitmap project. 
You can use the default Bitmap operation(s) to enter milling parameters that
you want to use as a standard. For instance a specific tool and/or strategy.

To edit the parameters of the default Bitmap operation, go to the Options
menu and select the option Default Bitmap operation Parameters. This will
open the Bitmap operation Parameters dialog.
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5.3 Process steps

5.3.1 Z-Grid

The Z-grid is an intermediate result, in-between the CAD-data and the
toolpaths. It is used for Geometry data and for Bitmap data, Vector data is
processed without a Z-grid. The Z-grid is a sort of height-map of the
geometry (or of the bitmap relief): a 3D bar graph, with a Z-value for each
XY position. The size of the grid-cells is set by the toolpath distance and the
stepsize along the toolpath. Normally you should not be bothered by this
representation of the geometry, however it might be useful to see what is
really happening. For instance in case a hole in the geometry is missing in the
toolpath, you can check the Z-grid. In case present there, the cause will be
that the cutter is too large to fit in the hole. In case not present in the Z-grid
the grid cells are too large, or some error is present is the geometry file.
Besides that it will also give an idea of how the final result will look: a rough
simulation of the part to be created. Especially when you view it as a
rendered Z-grid.

Here’s an image with a Z-grid and the rendered one (Note that for accurate
precision settings it will take some time to draw a rendered Z-grid on your
screen). 

The pictures show a line-drawing and a rendered Z-grid, you can display
these by checking them in the Items visible dialog. The grid-structure is
clearly visible. Any undercuts that are present have become solid: for each
grid-cell only the highest Z-value is stored. Especially for inverse milling this
rendered Z-grid is useful as a preview to show what will be created. 
Note the strong staircase effect that is visible. In the actual model the stairs
will be partially smoothed away due to the size of the cutter (as that cannot
create sharp inner corners).

When creating the Z-grid DeskProto calculates a large number of points on
the surface of the geometry, finds the correct grid-cell for each point (based
on X and Y) and fills that grid cell with the Z-value of the point. For each cell
only the highest grid value will be stored. This explains some characteristics
of the DeskProto toolpath: undercuts are not possible, and the resulting part
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always will be a bit larger than the CAD model. How much larger depends on
the Precision values.

When projecting vector curves or a bitmap on the geometry DeskProto will
use a Z-grid to determine the correct Z-value for each point in the toolpath.

Each operation has it's own Z-grid.

How to calculate and show a Z-grid
You can show a Z-grid by selecting the option Calculate Z-grids under the
Create - Extra menu. Another way is checking Z-Grids or Rendered Z-Grids
in the Items visible dialog.

5.3.2 Toolpath

The Toolpath is the path that the cutter will follow to create a part on the
milling machine. More specific, it is the series of positions for the tip of the
cutting tool (XY of the center of the tool, Z of the lowest point of the tool).
The start of the toolpath is drawn as a small red cone pointing downward, the
end by a similar cone pointing upward. These cones are NOT the workpiece
zero point: in the Items visible dialog an option is present to display a blue
orientator at the workpiece zero point. The image below shows both the start
point and the orientator: on slightly different positions.

The toolpath is a very important representation for a visual check before
starting the milling machine: any errors should best be found before milling
(the toolpath Animation is a good tool to find errors). Here’s an image of a
toolpath.
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Most lines are drawn as solid lines (default in red), indicating a normal speed
(Feedrate). 
Lines drawn in purple indicate that the feedrate is reduced by DeskProto's
Dynamic Feedrate Control.
Some lines are dashed in gray, indicating that they are Rapid movements
(moving as fast as possible). 
The toolpath depends on the settings made in the Operation Parameters
dialog. 

After calculating a toolpath using the command Calculate toolpaths the
toolpath item will automatically be switched on in the scene (made visible in
the Items visible dialog). To send this toolpath to the machine it should first
be post-processed to an NC-program, which is done using the command
Write NC-program file. How it will be post-processed is determined by the
postprocessor which is linked to the milling machine you use.

Options when displaying the toolpaths
As said the toolpaths are drawn as red lines, and rapid movements in dashed
gray lines. You can change these colors in the Preferences.
In the Items visible dialog the following three options can be checked:
Show points to add a dot on each point in the path (default is OFF)
Show arrows to show the direction of the toolpath (default is OFF)
Show rapid movements to show or hide all dashed gray lines (default is ON)
One more useful option is present: in an Animation you can watch the cutter
proceed over the toolpath.

How to calculate toolpaths
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You can let the toolpaths be calculated by selecting the option Calculate
Toolpaths under the Create - Extra menu. 

As a shortcut this convenient button is present on the Toolbar. 
Another way is checking the Toolpaths checkbox in the Items visible dialog.

5.3.3 Animation

Before sending the NC program file to the machine it is always good to check
the toolpaths by viewing the drawing on your screen. When many toolpaths
are present it may be difficult to interpret the drawing, even when you make
most operations invisible. To make it easier to see what exactly happens
DeskProto offers the Animation.

 

How to show an animation
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You can show an Animation by selecting the option Calculate Animation in
the Create menu. 

As a shortcut this convenient button is present on the Toolbar. 

When you open an animation all toolpaths we disappear from your screen,
and the Animation dialog (shown above) will pop up. A small cutter will be
drawn as well, on the first position of the toolpath. This is a symbolic
representation of the real cutter (so size and shape are not correct): for most
cutters a small vertical cylinder is drawn in dark gray.

Using the controls in this dialog you can start the cutter movement and make
it follow the toolpath. This is a great help, to see in advance how the cutter
will move when running this path on your machine.

5.3.4 Simulation

The NC program file is in fact the final result of DeskProto: sending it to the
machine will produce the desired part. It may be useful though to preview
this resulting model on screen, in a Simulation.

The Simulation is a 3D model, displayed on the screen, that shows you what
the resulting part will look like. This can be used to check things like the
resulting surface smoothness, error movements that damage the part (if any),
rest material where the cutter cannot reach, etc. DeskProto will calculate a
simulation in 3D, so you can rotate, pan and zoom it just like any other item
on screen. The calculation is done using only the toolpath data, so without
use of the underlying CAD data.
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The simulation is for one Part: all available operations can be included. The
illustration above shows three operations:
· a Geometry operation for roughing, where the ballnose toolpaths (or rather

the "cusps" in-between) are clearly visible: the green part on the right.
· a Geometry operation for finishing, showing a very smooth resulting

surface: only the left half has been finished.
· a Vector operation with half the DeskProto logo, 0.5 mm deep, projected

onto the bottle surface: only visible on the finished side.

In a simulation an operation cannot simply be made invisible (like for
instance for the toolpaths): just as in real life it is not possible to undo the
removing of material. Unchecking an operation will restart the simulation
with a fresh block of material.
Because of that the Operation's visibility settings in the tree cannot be used
here. A Simulation comes with the Simulated Operations dialog to select
which operations need to be included.
Only after pressing Calculate the simulation will be updated (if needed after
resetting it first).
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DeskProto uses in fact two completely different calculation algorithms: one
for 3-axis toolpaths (XYZ) and one for rotation axis toolpaths (XZA):
· the XYZ algorithm uses a grid-based calculation: a grid on the XY plane

with a Z-height for each grid-cell. 
· the XZA simulation uses a voxel-based algorithm: a calculation based on

voxels (small "3D pixels") that either are filled with material or not. 
The voxel-based algorithm is much more complicated, and so calculation
time will be higher.  The quality of the resulting image is higher for the grid-
based simulation, however that algorithm simply does not work for rotary
machining.
One more difference is that the voxel-based simulation removes material only
where the cutter can actually cut, defined by its cutting length. For a finishing
operation this might be completely within the block: creating an invisible
cavity in the block, So for a voxel-based simulation it is important to simulate
the operations in the correct sequence: first roughing, then finishing.

You can set the Level of detail of the simulation on the Simulation tab of the
Part parameters. For the grid-based simulations this sets the number of grid-
cells to be used (the size of the grid), for the voxel-based simulation the
number of voxels.

For Geometry projects the DeskProto grid-based simulation allows you to
compare the simulation with the original geometry, and indicate any
differences with a color (so this option is not available for rotary machining).
Rest material in green, too much material removed in red. On the Simulation
tab of the Part parameters the user can select whether or not to use these
colors, and also the tolerance to be used. 
In the simulation screenshot above you can for instance see that a skin has
been applied when roughing  (green rest-material), and that the cutter is too
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thick for the small inner radius at the neck of the bottle (green rest-material
just below the cap). The red color in the DeskProto logo is logical, as the logo
is not a part of the geometry and thus DeskProto concludes that too much
material has been removed. The red will only be visible in case the geometry
is switched off in the Items visible dialog.

How to calculate and show a simulation
You can show a Simulation by selecting the option Calculate Simulation in
the Create menu. 

As a shortcut this convenient button is present on the Toolbar. 
Another way is checking Simulation in the Items visible dialog.
The speed of drawing a simulation can be optimized using the Graphics
options in the Advanced Preferences.

5.3.5 NC-program

NC stands for Numerical Control (we will also use the acronym CNC, which
stands for Computerized Numerical Control). An NC-file contains an NC
program: a series of instructions for a CNC milling machine to execute. It
needs to be sent to a machine (or rather to the machine's control software) to
make that machine execute the NC program. Each file contains commands
for a specific machine (or machine-type). 

An NC-program is machine-dependent: its format will be different per
machine, as each machine (or rather each controller) will "speak a different
language". The format that DeskProto uses to write the NC-file is determined
by the Postprocessor that is configured for that machine. In the Project
parameters you can select which machine will be used.
Almost any NC program file is in plain ASCII: you can read and edit it using
a plain text editor like Notepad. DeskProto can only work with ASCII NC
files.

How to create an NC-program
The toolpaths calculated by DeskProto can be saved to an NC-program
choosing the option Write NC-program from the Create - Extra menu.

As a shortcut a convenient button is present on the Toolbar.
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DeskProto will try to combine the toolpaths of all Operations of one Part into
one combined NC program file.
Or, when Chaining has been applied, even toolpaths of Operations in several
Parts can be combined.

NC Files list
DeskProto will show you a list of all NC files that have been written for the
current project. This is shown in the NC Files window, below the Project
Tree. If this window is not visible you can check it in the View menu.

Sending NC-program to machine
For some machines it’s possible to send an NC-program to the machine from
within DeskProto (only a few machines support this). How to do this see the
option Send NC-program To Machine from the Create menu. For all other
machines you need to open the NC file in the machine's control software.
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5.4 Types of machining

5.4.1 Two-sided machining

This page is about Geometry machining (so this does not apply to Vector and
Bitmap). 
Some models can be completely machined from one side, like DeskProto's 
DpPictureFrame sample geometry. For other models, like the perfume bottle
sample geometry, machining from one side is not sufficient.
A complete bottle can be created in three ways:

1. Machine two separate halves and glue these to one another to make a
complete model. This is the easiest way, which works great for many
models. For instance for an electric hand-drill or similar tool. 

2. Use a rotation axis to rotate the model during machining. This is called
rotation axis machining.

3. Machine the model from two sides, so flip the block upside-down
halfway through process. This flipping can be done either manually or
automatically by a rotation axis. 

This help page concerns the third method: Two-Sided machining, using the
manual flip. For the automatic flip see the page on indexed machining.

Machining from two sides comes with some extra issues:
- how to hold the part after turning it upside down
- how to make sure that both sides are perfectly aligned
- how to correctly set the WorkPiece zero point for the second side, making it
match the first side.

The advanced geometry wizard "Two sides, manual flip" will help you to
create a complete model in one piece by machining it from two sides. The
total block of material to be used needs to be larger than the part, leaving a
frame around the part. This frame permits you (after machining the first side)
to again clamp the block in order to machine the second side as well (turned
upside down). See the illustrations below, where the orange part is the block
(top view).
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DeskProto will lock the Operation’s Area to be machined to the geometry's
bounding box (for X and Y). DeskProto will add a Border on all four sides so
the cutter can also machine the outside surfaces of the part. See the image
below, in which the cutter has been drawn in the border area.
Obviously the part needs to remain connected to the block when the second
side is machined. This is done by the so called Support Tabs: four small
rectangular blocks that function as bridges to connect the part to the
remaining part of the block (the frame). In the illustration above the four gray
rectangles are the Support Tabs.

DeskProto will set the width and depth (X and Y) of the material block. For
X both left and right 25 mm (or 1 inch) is added outside the support tabs,
permitting you to clamp down the block on the machining table at that spot.
For Y both front and back 10 mm (or ½ inch) is added, resulting in a block
that is sufficiently stable when machining. These dimensions need not be very
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accurate. A bit oversize is advised for the actual block, making sure that you
can machine a reference plane later in the process.

In contrast, the height of the block (Z) needs to be very accurate as otherwise
the second side will not be correctly positioned relative to the first. In
practice you can easily satisfy this requirement, as you can buy most
materials in slabs at an exact thickness. Of these slabs the top surface and the
bottom surface are exactly parallel to one another as well. 
The size of the total material block is defined in the Part parameters.

Note that DeskProto can be configured for two different block types:
floating size and fixed size. The first type is default, and determines the
block size by adding a certain frame width on all four sides, as explained
above. The second type uses, as its name indicates, a fixed block size. This is
handy when you have similar products and a stock of equally sized blocks. In
this case it is possible that the part does not fit in the block (some minimum
margin is needed as a frame): in such cases a warning message will be issued
and you need to scale down the part. The choice between both types of block
and the dimensions to be used can be set in the Preferences dialog.

DeskProto makes it easy for you to correctly position the two sides relative to
one another. Or in other words: to set the correct workpiece zero point that
makes the second side exactly fit on the first.  For this aim DeskProto uses
two rulers (stop-bars) that are exactly parallel to the machine’s axes, and that
have a known position. See the illustration below: the long ‘horizontal’ bar is
parallel to X, at a known Y position, the short ‘vertical’ bar has a known X-
position (being parallel is less important for this small bar: it is in fact an end-
stop). The workpiece zero point for both NC program files has to be set at the
exact point where both rulers meet, with the Z=0 set with the tip of the tool
touching the top of the block. This zero point remains the same after turning
the block upside down for the second side. Also see the illustration below.
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After machining the first side, you have to machine two reference planes, on
the block’s back and left side: see the red line in the illustration. The
reference plane on the left is on position X = 0 and needs not be along the
complete side (which would not be possible because of a clamp). The
reference plane on the back is on a Y-position as specified in the Report file,
and needs to be machined along the complete back. After turning upside-
down these two reference planes need to exactly touch the rulers, making
sure that the block is exactly lined up with the machine, and exactly at the
correct position.
Remember that in order to machine a plane at X=0 the tool needs to move
along Y at X=-R mm (or inch), in which -R is "minus the Radius of the
cutter". A similar radius correction needs to be used for the second reference
plane.

Note: 
The Ruler /Reference plane method just described is just one method: more
methods are available to correctly position the block after turning upside-
down. For instance using reference pins on the machining table, combined
with matching holes in the block that exactly fit these positioning pins. This is
easiest when you set the zero point exactly centered between the pins (two or
four). In DeskProto "Make center of material zero" is a pre-defined option
for the zero point X and Y (this needs to be set after completing this wizard,
for both parts).
The Two-Sided Milling Wizard can be used with any of these positioning
methods, as long as they result in the block having the same position before
and after turning upside-down.

The Report file just mentioned will be generated upon pressing button Write
report file on the last page of the wizard. It gives all information needed for
the actual machining process. DeskProto will automatically open the file in
Notepad, making it easy to print the file and/or to save it. Default filename is
Wizardlog.txt: save it using a different name to prevent it from being written
over by a next wizard.

Of course you are free to fine-tune the results of the wizard before starting on
the machine. You can still change any parameter after finishing the wizard:
also parameters that have not been set by the wizard. You may also add
operations, for instance some extra finishing with a small tool for some
specific detail. In case of using an extra operation make sure to create the
new operations by Copying an operation set by the Wizard, not by just
Adding a (default) operation. That way all settings made by the wizard will be
copied as well.
After changing any parameter you will have to again save the NC program
file that was written by the wizard.
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A wealth of information on two-sided machining is available in the
DeskProto Tutorial book (can also be downloaded as PDF): Lesson 6 is about
two-sided machining, and shows you how to machine a nice sample
geometry: a cellphone's front cover. This STL file is a free download on
www.deskproto.com  Tutorial videos are available as well.

5.4.2 Rotation axis machining

A rotation axis or 4th axis on a CNC milling machine can be applied in two
different ways:
- the part can be rotated during machining (continuous rotation)
- the part can be machined from one side (three axis machining), then rotated
and machined from a second side, etc. This is called indexed machining.
DeskProto supports both methods, obviously only in the Multi-Axis edition of
DeskProto. 
On some four-axis machines the 4th axis rotation is achieved by rotating the
spindle motor and the cutter (swiveling head). DeskProto does no support
such machines: only machines where the 4th axis rotation is achieved by
rotating the material block.

This page is about continuous rotation, which is in fact 'real' Rotation axis
machining. It can be switched on by checking the box "Use rotation axis" in
the Part parameters. That option is of course available only when the
machine that you selected for your project has a rotation axis configured in
it's machine definition.

In the DeskProto calculations the rotation axis is always parallel to the X-
axis. In case on your machine it is parallel to Y you can configure that in the
machine definition: Options > Library of machines > OK on warning > select
your machine and press Edit. One of the options in the Rotary Machine
Settings is "Has 4th axis parallel to Y". This option will swap X and Y: more
information on that help page.

Geometry data
In case only Geometry data is present DeskProto will set a Material block
that exactly fits the bounding box of the geometry. This block may either be
rectangular or cylinder shaped. The axis of this cylinder (so the actual axis of
rotation) will be the X-axis in the original CAD coordinates (the line for
Y=0 and Z=0), so you may need the option Center geometry to center your
geometry round that X-axis.
Note the easy way that is available to create a rotary project for a geometry:
using the Rotary machining wizard. 

Vector data

http://www.deskproto.com
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For Vector data two different data types are possible: 2D Vector data (no Z-
values, or all Z-values equal to 0.0) and 3D Vector data (Z-values are present
that are not equal to 0.0). In the latter case DeskProto offers the option to
ignore all Z-values, which converts the data to 2D.
In case only 2D Vector data is present, rotation axis machining is possible
only when a cylinder shape Material block has been set. DeskProto will
create a cylinder that is exactly large enough to wrap the 2D CAD data round
this complete cylinder (like a paper label on a jam jar). So for a 2D curve
with Y-size 100 mm, the diameter of the generated cylinder block will be
31.83 mm: as this cylinder's circumference is Pi * 31.83 = 100 mm.  You can
use a larger diameter cylinder by setting the material block to custom. The
machining depth is relative to the outside surface of the cylinder block.

In case 3D Vector data is present DeskProto will offer two workflows:
1- wrap the curves round a cylinder (just as for 2D data), and use the Z-value
as radius for each point on the curve. The machining depth then is relative to
this Z-value.
2- do not wrap, so keep the 3D curves as they are, in 3D space. The
toolpaths then will be calculated based on these curves, just as done in the
calculation for rotary geometry toolpaths. This option will be useful for
instance when you have cut a 3D shape and have a 3D curve over the surface
(from the same CAD system) that indicates a groove in the surface:
DeskProto then can use vector machining to cut the groove. The machining
depth is relative to the radius value of each point of the curve.

When a vector file is loaded that contains 3D curves DeskProto will ask if
you want to use the Z-values in the curves, and also if you want to to wrap or
not to wrap in case rotary toolpaths are required.

Bitmap data
In case only Bitmap data is present DeskProto will also create a cylinder
shape block and wrap the image round that cylinder. Exactly as described
above for 2D vector data.

For mixed projects the Geometry size will overrule the wrapping calculation
when calculating the block size. 
For mixed projects you can select "Project on 3D Part geometry" in the Z-
settings for the vector data and/or the bitmap data.machining. The machining
depth / Relief depth then is taken relative to the geometry surface at that XY
position.
In all cases you are of course free to change the block dimensions conform
your needs.

Rotation axis machining in DeskProto in fact still is a type of three axis
machining: instead of moving X, Y and Z at the same time, now X, Z and A
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will move. In a DeskProto NC program file for Rotation axis machining no Y-
coordinate value is present.
So before starting the cutter needs to be positioned along Y exactly above the
rotation axis, so at Y = 0.0.  You can make DeskProto do this automatically
by checking the option "Write Y=0 in first movement command for rotary
machining" in the Advanced Machine Settings dialog.
DeskProto does not do this by default as such movement may damage your
machine in case the current Z is too low, and as on some rotary machines Y-
movements are not possible.

A wealth of information on rotation axis machining is available in the
DeskProto Tutorial book (can be downloaded as PDF): Lesson 5 is about
rotation axis machining a geometry, and shows you how to machine a great
sample geometry: the head of the famous Venus of Milo statue. This STL file
is a free download on www.deskproto.com  In addition a series of nice
tutorial video's are available on the DeskProto website.

5.4.3 Indexed machining

A rotation axis (4th axis) on a CNC milling machine can be applied in two
different ways:
- the part can be rotated during machining (continuous rotation)
- the part can be machined from one side (three axis machining), then rotated
and machined from a second side, etc.

DeskProto supports both methods, obviously only in the Multi-Axis edition of
DeskProto.

This page is about indexed machining, which is possible only for geometries.
DeskProto offers indexed machining in wizard Advanced geometry, Two or
more sides, automatic rotation (also called the N-Sided Milling wizard). In
this wizard you can choose any number for N, from 2 up to 99 sides.

· The wizard will automatically generate N parts for you in the DeskProto
project tree, and will apply the correct rotation for the geometry in each
Part. The rotations are evenly spread (360 / N), if needed you can select a
higher N and then later delete some of the parts.

· Support tabs (cylinder shaped blocks left and right), to keep the part
connected to the rotary table, are optional.

· In each part one or two operations are generated (finishing, and optionally
roughing first): the wizard will link all these operations into one large
Chain in order to write one combined NC file for the complete indexed
milling process.

http://www.deskproto.com
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· The required A-axis rotation commands for the rotation axis (in-between
the operations) are entered in the operation's Start/End commands. The
wizard will also use these commands to move the Z up to a safe height
before rotating the block. This is needed because the diagonal of a
rectangular block is larger than its width and height.

DeskProto also supports indexed machining on five-axis milling machines
(five-axis continuous rotation is not supported). This works exactly the same
as with four axes: you create a series of parts, specify the correct rotations
for each part, and specify these same rotations in the Start commands of each
Operation. Only now both an A-axis rotation command and a B-axis rotation
command need to be specified. For five-axis machining these commands
need to be added manually, as no 5-axis wirzard is present.

5.4.4 Five-axis machining

DeskProto offers a limited support for five-axis machines:
- only indexed machining, no continuous rotation or simultaneous 5-axis.
This means no rotations while machining, only rotations in-between the 3-
axis toolpaths for the various orientations of the part.
- only "trunnion style" 5-axis machines are supported: machines in which
two rotary tables are combined that will rotate the block of material. See the
illustration below, where a simple trunnion-style 5-axis unit is shown,
positioned on a machining table with T-slots. The large rotation unit (the
horizontal axis) is used as tilting table, the small rotation unit (in the image
the vertical axis) can rotate the part. One more photo of such machine can be
found on the rotary machine settings page.

DeskProto does not support machines where one or both rotations are
achieved by rotating the spindle motor and the cutter (swiveling head
machines). We do not plan to extend the 5-axis options in DeskProto, as the
program needs to be easy to use: offering "CNC machining for non-
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machinists". Five-axis machining is a complex process, which does not match
with this primary aim.

The five-axis process is much more complex than for four axes, so DeskProto
cannot offer a wizard to automatically create such project for you. It works
the same as indexed machining with four axes: you create a series of parts,
specify the correct rotations for each part, and specify these same rotations in
the Start commands of each Operation. Only now both an A-axis rotation
command and a B-axis rotation command need to be specified. 

Very important is that the translation settings need to be None for all axes:
the zero point on the machine needs to be the same as in the CAD data.
On the machine this zero point needs to be set exactly on the point where
both rotation axes intersect, as DeskProto will also perform all rotations
round axes through this zero point.

These are the steps in the process:
· Define a part for each side that you want to machine, and apply the

correct rotation for the geometry in each Part.
· Define the operations that you need for each part
· Set the rotation commands for A and B (to be done in-between the

operations) by entering them in the operation's Start/End commands. The
rotation values need to be the same as just set for each part. Also enter
commands to move the Z up to a safe height before rotating the block.

· Link all operations into one large Chain in order to write one combined
NC file for the complete indexed milling process.

It will be clear that this is only meant for experienced DeskProto users. A
detailed instruction for five-axis indexed machining can be found in Lesson 9
of the DeskProto Tutorial book (can be downloaded as PDF). Including a
nice sample project.

5.4.5 Laser engraving

Many small CNC milling machines offer a laser unit as optional extra. This is
a device that emits a downward laser beam on the part that will burn the
material. It can be used to change the color and thus write/draw on the part
(laser engraving), or to completely cut the part (laser cutting).

DeskProto supports using such laser for Vector machining (so not for creating
3D geometry parts or for bitmap images). This can be done in 2D on a flat
piece of material, and also in 3D by projecting the vector curves on the 3D
geometry of a part that has been machined earlier.
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In order to use Laser engraving the following things need to be configured
first:
1. In your postprocessor you need to enable the laser option (on tab page
Laser)
2. In your machine definition you need to enable the laser option (in the
machine's Laser settings).
3. You need to define one of more laser cutters.

After that you will be able to select one of these laser cutters in the Vector
operation parameters.
This will change the following options in the settings that this dialog offers:
- the word "Spindlespeed" is replaced by "S-value", with the machine's laser
power values as min and max. That is because many machines use the S
command (in G-code) to set the laser power.
- an option "Pass count" is added, to be used when your laser is too weak to
get the desired result in one pass.
- the Machining depth is disabled, at 0 mm: this is about engraving on the
surface of the material.
- Peck drilling is disabled
- all Roughing options are disabled
- the Dynamic feedrate is disabled.

The toolpaths will be different as well: 
- During rapid positioning movements the laser will be switched off
- The toolpath needs to go up and make a rapid movement for every
positioning movement (for very small movements a milling cutter may remain
at machining level) We call this behavior "Never stay low".

And the Z=0 position needs to be set at the level where the laser's focus hits
the material.
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5.4.6 V-Carving

V-Carving is a special type of Vector machining. You can find the settings on
the V-Carving tab of the Vector operation parameters. For this toolpath type
a conical cutter needs to be used, also called "V-Cutter" or " V-bit". The trick
with such cutter is that the width of the groove that is machined depends on
the depth of the cut.

Assume that you have a 45 degree conical cutter (included angle 90 degrees)
and that the Z=0 is set with the tip of this cutter (a sharp tip) at the top
surface of the material. The image above shows how a toolpath at Z=-1 mm
results in a groove that is 2 mm wide and a toolpath at Z=-3 mm will make a
6 mm groove.

You can imagine that a 3D toolpath with a varying depth will create a groove
with a varying width. V-Carving needs closed vector curves: it calculates
toolpaths with a depth that matches the width of the pocket at each position.
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It is also possible to create sharp corners in the resulting groove: using a
toolpath that rises to the surface (Z=0) in a movement at a certain angle. 

V-Carving works very well to machine a text in a detailed font: the
screenshots above show the V-Carving toolpath for an "e" character, in font
Times New Roman (with a 45 degree conical cutter).  The varying depth
makes sure that the width of the groove will exactly match the outline of the
drawing. Note the short toolpaths on the right side towards the three sharp
inner corners.

The two images above show the toolpath and, from the same viewpoint, a
simulation of the resulting part. As you can see: the outside shape of the
groove indeed exactly matches the vector curves of this font.

It will be clear that a V-Carving toolpath will go deep when when the groove
is wide and/or when the V-cutter has a sharp point (small angle). When
needed the toolpath will go down in steps (roughing layers). DeskProto will
show you how deep the unrestricted toolpath will dive (after calculating the
toolpaths, on tab page V-Carving).
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In case you do not want to cut to this unrestricted depth DeskProto offers
you the option to limit that depth to the Machining depth that you have set
(Vector operation parameters, tab Z Settings). All cutter movements below
this machining depth will be skipped, and DeskProto will fill the resulting
horizontal surface with pocketing toolpaths. 
When you do not limit the depth it will still not be completely unrestricted:
the V-Caving toolpaths will not go below the bottom of the block.

In the image above you can see both the toolpaths and the result. The V-
cutter that is used has a sharp tip, so it is clear that this bottom surface will
not be flat, as you can clearly see in the simulation on the right..

It is possible to make this bottom flat by adding an extra operation: a
Cleanup operation. You can easily add such operation using button "Create
cleanup operation..."  that you can find on tab V-carving of the Operation
parameters. That extra operation uses the same curves and the same
machining depth as the V-Carving operation, however it uses a flat cutter
(instead of a V-cutter) and Pocketing toolpaths. It also contains one special
setting: the XY allowance, set on the Roughing tab, needed as the flat cutter
needs to keep a certain distance away from the curves. This distance depends
on the depth of cut and the angle of the cutter, as explained on the Cleanup
operation help page just mentioned. For a 45 degree conical cutter this is
easy: the allowance must be exactly as large as the machining depth.

As you can see in the image above: not the complete bottom will be made
flat. The end mill (flat cutter) cannot reach into sharp inner corners any
further than its radius allows.
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The result of a V-Carving operation can be completely changed by adding
one closed vector curve around the complete vector drawing. Like in the
image above the square around the "e". When you now (again) select All
curves the background of this "e" will be V-Carved, as shown above. Which
again is a great result !

Obviously this will take longer as the toolpath now is much longer. 

Here as well you can add a Cleanup operation to make the bottom surface
flat.

As said this toolpath type is a great tool for creating signs: you will be amazed
how quickly you can machine an absolutely good-looking sign using V-
Carving. It can of course also be used for graphic designs other than just text.
It can also very well be used for Inlays. 
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5.4.7 Inlays (wood-in-wood)

A wood-in-wood inlay uses two kinds of wood, in different colors, to achieve
a part with a graphic image on its top surface. The photo above shows a nice
inlay of a rose icon. The image can of course also be a text.

Creating a wood inlay involves cutting a pocket in the flat top surface of the
base (the female part), and cutting a part that will exactly fit in that pocket
(the male part, also called the plug). The plug then is glued on its position
inside the pocket, and finally the top surface is finished to make it smooth
and even.

We have found that V-Carving is a great way to create perfect inlays. When
using a V-bit, both the base and the plug will have side walls at a certain
angle, which makes the gluing process very easy. All male pieces to be
inserted are present on one large part. When gluing, the two parts simply are
guided to their correct position, and the process is forgiving when they are
not perfectly aligned. Due to these angled walls this type of inlay is also
called a prismatic inlay.
The other important advantage is that due to the V-bit's sharp point it is
possible to create inlays with sharp corners.
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How it is done

For the male part two extra settings are needed:
1. the artwork needs to be mirrored, as the plug will be used upside-down.
2. an extra curve needs to be selected: a rectangle around the complete
design. As a result all material between the artwork curves and that rectangle
will be removed. 

The schematic drawing above shows what happens when you simply machine
both the male part and the female part with the same V-Carving settings. The
design is a groove of 10 mm wide, and the cutting depth is limited to 4 mm. In
both case the artwork is positioned on the top of the material block.It will be
immediately clear that the plug (the male part) will not fit in the base (the
female part). So an extra setting is needed: the curve depth.

The female part was already correct: the artwork curves are present at the
top surface, which will be the surface that is visible in the result. So the result
will show the original artwork.

For the male part we used this extra setting, and entered a Curve depth of 3
mm. The cutting depth limitation still is 4 mm, just as for the female part. In
the drawing you can see what happens when the artwork curves are located 3
mm below the top of the block: the plug now nicely fits in the base, with 3
mm overlap.

On both sides a gap of 1 mm remains:
- the sawing gap is used to easily saw off the remainder of the plug
- the excess gap provides room for an excess of glue
With in-between the gluing overlap, where both parts will be touch (under
pressure while gluing) to make a tight connection.
Both gaps also provide room for the remaining cusps on the horizontal
surfaces: the  V-bit cutter with a sharp tip cannot make these surfaces flat, so
in-between the toolpaths cusps will remain (unless you also use a cleanup
operation).
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An excess gap is not absolutely needed: you can also machine the female part
without depth limitation (the block needs to be thick enough), and for the
male part use a curve depth that is equal to the unrestricted depth of the
female part. As depth limitation for the male part use a Z-depth that is a bit
lower: to create the sawing gap.

The image above shows the two parts for the rose inlay, just before gluing. As
both parts have been machined using the same cutter the angle of the side
walls is identical. The shapes on the male part (the part on the left) may seem
a bit small: that is because the artwork is positioned 3 mm below the top of
the block. So the shapes that you see on the top of this block are indeed
smaller than in the artwork.

The exact depth values to be used for creating an inlay will depend on the
size of your inlay and the type of wood. The values that are shown on this
page anyway provide a good start.

The male part (the plug) typically has a large area where all material needs to
be removed (up to the depth limitation). The V-bit cutter is not an efficient
tool to machine such large horizontal area. You can add a Pocketing
operation with a flat endmill to flatten that area, as explained on page V-
Carving. For that pocketing operation you then need to set an Allowance
(Roughing tab), as the flat cutter needs to stay away from the artwork curve
in order not to remove the lowest part of the angled side walls that the V-bit
machined.
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5.4.8 Hot Wire cutting

A hot wire cutter is a machine for cutting PS foam (PolyStyrene)  It uses a
thin metal wire that is heated and can be used to create a thin cut through a
block of EPS by melting the material. On CNC machines the path of the hot
wire is CNC controlled. The wire on such machine always is a straight line, in
most cases horizontal. 

The image above shows a very basic image of such machine: the orange line
is the hot wire. This machine can control the Z-position of the wire as that
can move up and down along the two columns, The columns can move to the
left and to the right to control the X position: so each end of the wire can
make a 2D movement (XZ). DeskProto creates hot wire toolpaths where both
ends of the wire (both columns) make the same 2D movement.

Clients who CNC machine large parts in EPS foam can make their production
process much more efficient by combining CNC machining with hot wire
cutting, using either two separate machines or one machine that combine
both technologies. They remove as much PS foam as possible using a hot
wire, which is faster than by machining, and greatly reduces the amount of
chips and dust that is created. This works best when combined with a rotation
axis, as then the hot wire can make a number of cuts, at different angles. The
finishing then can be done using a milling cutter, with standard DeskProto
toolpaths.

Configuration
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DeskProto supports using such hot wire for Geometry machining and for
Bitmap machining (so not for vector data). Though it will be applied primarily
for rotary machining of geometry data.

In order to use hot wire cutting the following things need to be configured
first:
1. In your postprocessor you need to enable and configure the hot wire
option, see below (on tab page Hot wire).
2. In your machine definition you need to enable the hot wire option (in the
machine's Hot wire settings).
3. You need to define one or more hot wire cutters.

Project settings

After that you will be able to select one of these hot wire cutters in the
Operation parameters.
This will change the following options in the settings that this dialog offers:
- for 3-axis machining the Distance between toolpaths is disabled, as then
only one toolpath is generated 
- for 4-axis machining the pre-set values for Distance between toolpaths are
different, see below
- the Spindlespeed setting is disabled
- most Strategies are disabled: only parallel toolpaths along X are possible
- most Roughing options are disabled
- the Dynamic feedrate is disabled.

The toolpaths will be different as well: 

Here is an example DeskProto project, featuring sample geometry Bottle.stl
and a hot wire cutter with a 1.5 mm diameter (for a hot wire cutter this is not
the diameter of the wire but the width of that path that is melted). From left
to right you see the geometry, the toolpath (strategy Parallel along X, only X
and Z are used) and the simulation. Only one toolpath will be generated, as
this cutter is assumed to be long enough to cut the complete block in one path
(in the cutter definition this is called "Auto length"). The toolpath is two-
dimensional, and when writing the NC file DeskProto will suppress the third
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coordinate (in this case the Y). That is, unless in the postprocessor you have
defined that it is a required coordinate.

When you select a hot wire cutter you will see that only Parallel along X is
available as Strategy, which makes sense for this one toolpath. In addition the
Roughing layers will be disabled: after cuttings this toolpath the excess
material needs to be removed by hand. When using a milling cutter all that
material would need to be converted to chips, using roughing layers. Ramping
is disabled as well, as that would create unwanted extra movements. Of the
two precision settings only the Stepsize can be set, as a Toolpath distance is
not present. The Stepsize needs to have a low value, as the diameter of a hot
wire cutter (the widths of the groove) is small. That is not a problem as
DeskProto will filter unneeded points from the toolpath.

The simulation in the above image shows a limitation of using a hot wire for
roughing: at the curved surface to the front side and to the back side of the
bottle no material has been removed. So it may well be that in the first
operation with a milling cutter it is needed to use roughing layers. DeskProto
will not do so automatically (it will warn you though).

Using a rotation axis

The 2D toolpaths as described above are pretty standard for hot wire cutting:
any user of such machine will already have software that can create this type
of toolpaths. The situation is different when the machine also has a CNC
controlled rotation axis: this is where DeskProto stands out, and in practice
rotary cutting is the main use of DeskProto's hot wire option.

In order to use this you simply check the option "Use rotation axis" in the
Part parameters. In the Geometry Operation parameters you select a hot wire
cutter. You will see that now you can again set the Distance between
toolpaths (which for the three-axis toolpaths as described above was not
possible). The values that you can choose from now are not based on the
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cutter diameter (as they normally are), but on the circumference of a cylinder
around the part. Simply ignore the actual value and look at the denominator
of the fraction that is shown. For instance option "c/4" will make DeskProto
calculate 4 toolpaths, evenly spaced around the rotation axis, so at 90 degree
angles of the A-axis. The image above shows four rotary hot wire toolpaths
for the bottle geometry.
 
Postprocessor

The NC file that DeskProto will create for hot wire toolpaths (using a G-code
based postprocessor) will include coordinate values for X, for Z and (for
rotary toolpaths) for A. However, we have seen that some hot wire cutting
machines use different coordinates. For instance: for a machine as shown on
the top of this page some controllers use X and Y (Y for the height of the
wire), instead of the X and Z that DeskProto uses. For such machines Z is the
length of the wire.  Other machines use A, B or C to control the hot wire. To
accommodate such machines you can configure this in the postprocessor.

As the hot wire toolpath is a 2D toolpath DeskProto will automatically
suppress the third coordinate (column Y). Note that you should not make this
coordinate required (by marking it with a + in field Order/Required). A and B
coordinates are written only when needed. 
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5.5 Various

5.5.1 Sample files

Every DeskProto installation will put a number of sample files on your
computer, both CAD files and DeskProto projects. These allow you to
immediately start working with DeskProto, even if you do not yet have CAD
data to load. They are also used in the DeskProto tutorials (PDF book and
video tutorials). In addition a number of larger CAD data files can be found
on the DeskProto website, as free downloads.

The sample project files (DPJ files) have been prepared to be used as sample
by removing the following settings:
- the path to the CAD data file(s)
- the machine to be used
- the feedrate and the spindlespeed
When DeskProto opens such prepared sample project it will load the CAD
data from the current folder (which is the Samples folder), it will use the
machine that you have set as your default machine, and it will use the default
speeds for that machine.

The sample files are copied to the location that your operation system
prescribes for such files, making it difficult to find them (sorry). Quickest
way to find the sample files is via the DeskProto Start Screen: simply check
"Use samples folder" on this screen. The Sample file location is:
Windows: C:\ProgramData\DeskProto 8.0\Samples\
MacOS: ~/Library/Application Support/Delft Spline
Systems/DeskProto/8.0/Samples/
Linux:  ~/.local/share/Delft Spline Systems/DeskProto/8.0/Samples/

The following sample files have been installed with DeskProto (for most
samples a metric version and an inch version):

A nice Beer tray, files:
2D_DpBeerTray.dxf  DpBeerTray.dpj  DpBeerTray_FreeEdition.dpj
2D_DpBeerTray_inch.dxf  DpBeerTray_inch.dpj  DpBeerTray_FreeEdition-
inch.dpj

A small perfume Bottle, files:
Bottle.stl  Bottle.dpj  Bottle_FreeEdition.dpj  Bottle-RotAxis.dpj  Bottle-
withShellRelief.dpj
Bottle_inch.stl  Bottle_inch.dpj  Bottle_FreeEdition_inch.dpj  Bottle-
RotAxis_inch.dpj  Bottle-withShellRelief_inch.dpj

A very simple metal Casting, files:
Casting.stl  Casting.dpj
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Casting_inch.stl  Casting_inch.dpj

The DeskProto logo as vector data, files:
2D_DeskProtoLogo.dxf  DeskProtoLogo.dpj  DeskProtoLogo_inch.dpj

A Die, as sample project for 5-axis machining, files:
Die-5axisVideo.stl  Die-5axisVideo_inch.stl  Die-5axis.dpj  Die-
5axis_inch.dpj
Take care: these settings are for a specific machine, for your machine you
will need to change them.

A very simple Flat test surface (can be used for toolpaths to flatten the top
of your block), files:
Flattest.stl  Flattest.dpj  Flattest_inch.dpj

Set of custom Insoles (only in mm), files:
Insoles.stl  Insoles.dpj

A nice Picture frame, files:
DpPictureFrame.stl  DpPictureFrame.dpj
DpPictureFrame_inch.stl  DpPictureFrame_inch.dpj

A Ring, as sample jewelry wax model, files:
SampleRing.stl SampleRing.dpj

A simple Sphere, files:
Sphere.stl  Sphere.dpj
Sphere_inch.stl  Sphere_inch.dpj

A human Torso (work of art), files:
Torso.stl  Torso.dpj  Torso-FourSides.dpj
Torso_inch.stl  Torso_inch.dpj  Torso-FourSides_inch.dpj

The Utah teapot, famous in computer graphics history, files:
Teapot.stl  Teapot.dpj
Teapot_inch.stl  Teapot_inch.dpj

A V-Carving project, with parts for for engraved text and for elevated text.
2D_TimesNewRoman_200x30mm.dxf  V-Carving_TimesNewRoman-
mm.dpj  V-Carving_TimesNewRoman-inch.dpj

As simple bitmap project the XYZ logo, files
XYZlogo.png  XYZlogo.dpj  XYZlogo_inch.dpj

Various Vector files:
2D_Square.dxf  2D_Square_inch.dxf  2D-CircleD5.ai  2D-CircleD5.eps 
3D_Polyline_Helix.dxf
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Various Geometry files:
Cube10x10x10.stl

Various Bitmap files:
Radetzky.jpg  Shell1.jpg  Shell2.jpg
Radetzky.dpj

5.5.2 Editions / Trial mode

DeskProto is offered to you as 'Freemium' software:
you are welcome to use the basic functionality DeskProto free of charge in
the Free edition, the advanced features are available as premium extras in
the three paid editions.
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Four different Editions are available:
· Free Edition
· Entry Edition
· Expert  Edition
· Multi-Axis Edition
of which the first is free while for the other three you need to buy a license.
The Free edition can be used as free CAM software, as long as you like. As
said: it offers only basic CAM functionality. It also allows you to Trial
(evaluate) the higher editions; when running in trial mode the resulting
toolpath will add a Trial cross (watermark), visible on each part that is
machined.

The Free Edition is available for anyone: free of charge, without any
obligations attached. It's functionality is limited, still it offers all you need for
basic CNC machining: Profiling toolpaths based on Vector Data, Parallel
toolpaths over Geometry Data, and machining reliefs based on Bitmap data.
In the Free edition a project may contain maximum one part and one
operation.
Many parameters as described in the Help file are not available in the Free
Edition. Still the most important parameters are there, and for many users this
free CAM program will be all they need.

The Entry Edition is the lowcost version of DeskProto, offering limited
options, at a very low price.
Compared to the Free edition a few important extra options are present:
Pocketing, Drilling and V-Carving for Vector operations, and Roughing for all
operation types. Projects also may contain any number of parts and
operations.

The Expert Edition includes all parameters except for the rotation axis
options. So the fourth axis and the fifth axis are not available in this edition.

The Multi-Axis Edition is the most complete version: all parameters are
present, including support for the A-axis and B-axes rotation axes.

More information about higher editions can be found in the Upgrade dialog. 
An edition comparison table can be found on www.deskproto.com 

A license for a paid edition can be activated in the Activate dialog.
After activating your license this Edition select dialog will no longer be
displayed.

https://www.deskproto.com
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5.5.3 Trial Cross

The Free edition allows you to Trial (evaluate) the higher Editions: when
running in trial mode the resulting toolpaths will leave a Trial cross
(watermark) on each part that is machined.

The effect of this Trial cross (displayed in purple) can be seen in the above
images:
For a Vector operation no toolpaths will be present in the area below this
purple cross: the toolpaths will simply be interrupted.
For a Geometry operation and a Bitmap operation all Z-positions below this
purple cross will be made a bit lower, resulting in two "ribbons" pressed into
the surface of the part, displaying the text "DeskProto Trial version".
So in all cases you can clearly see if the resulting parts will suit your needs,
however the trial cross will make really using the parts impossible.

Note that the project files (DPJ files) that are saved when in trial mode do not
have a trial limitation. So you can run in trial mode to prepare a project and
then use a paid license on a different PC to calculate the NC file. For schools
this makes a very lowcost classroom license possible: one paid educational
license on the PC next to the machine, plus many free licenses running on the
student PC's.

In order to use one of the higher editions you need to buy a license.
Such license for a higher edition can be activated in the Activate dialog.
After activating your license the trial cross will no longer be applied.

5.5.4 Graphically finding the rotation

Finding the correct XYZ rotation values to correctly orientate a Geometry as
required can be very difficult, especially when angles other than 90 degrees
are involved. Reason is that DeskProto uses absolute rotations: for each new
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orientation DeskProto starts with the original CAD orientation, first applies
the X-rotation, next the Y-rotation and finally the Z-rotation. 

Here is a tip to easily find these three rotation values by first rotating the
geometry on screen.
Follow the following steps:

1. Set the rotation settings for the Part to [X=0, Y=0, Z=0].
(Part Parameters, tab page Transform)

2. Rotate the geometry to the required orientation (using the mouse) as seen
from above (assuming the X-axis of the machine to be horizontal on the
screen, and the Y-axis of the machine to be vertical on the screen). So
imagine that your viewpoint is above the machine: you are looking downward
from the positive Z-axis.

3. Now simply copy the rotation settings from the view (View menu >>
Viewpoint >> Custom) and enter them as the rotation settings for the part
(Part Parameters, tab page Transform).

4. Finally check whether the rotations are exactly the way you want (by
looking at some default views for example).

A different feature that you can use to find the orientation that you need is
the option called Show downward faces in the Items visible dialog.

5.5.5 Postprocessor

The postprocessor is the part of the software that 'formats' the NC file. So it
translates the toolpath information into the format that your machine can
understand.  Using the word 'postprocessor' is common in the world of CAM
software and CNC. In the world of computers and printers you might call this
a 'device driver'.

The image above shows exactly the same toolpath in three different NC
formats. It is a simple square of 100 x 100 mm, 1 mm below zero. Left you
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see standard G-code, in the middle a proprietary format of a large machine
manufacturer, right a type of plotter control language. The postprocessor
determines the format that will be used when writing an NC file.

Important to know is that DeskProto does not use one unique postprocessor
for every machine (like some other CAM programs do). In practice you will
see that many different machines can work using the same NC file format.
For instance a series of machines by one manufacturer that only change in
size.  Also: machines from various manufacturers can use the same controller
(and/or the same control software, like for instance Mach3). So it makes
sense to make different definitions for the machine and for the postprocessor,
which is what DeskProto does. Various machines then can share the same
postprocessor: for instance more than 20 machines (by various
manufacturers) are installed that use the Mach3 postprocessor.

In DeskProto the machine definitions can be configred in the Library of
Machines.
and the postprocessors can be configured in the Library of Postprocessors.
One of the settings in the machine definition is which postprocessor needs to
be used.

5.5.6 Postprocessor placeholders

The option to use Placeholders is a very powerful feature in DeskProto. A
placeholder is a bit of text that you enter, which when the NC file is written
will be replaced by the current value of some parameter.
An example: you can enter {DATE} , which in the NC file will be replaced
by the current date.

In DeskProto placeholders are enclosed in curly braces (curly brackets).
They can be used in the Postprocessor definition and in the operation
Start/End commands

Some of the placeholders can be used in code that is processed by the
machine, like Feedrate and Spindlespeed. Other placeholders can only be
used in comment lines: these can of course be used only if your machine or
your control software supports comment lines (for instance lines that start
with a semicolon, or all code between parentheses). Consult your machine's
manual to find out.

This is the list of placeholders that can be used in DeskProto V8.0:

Project information:
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{PROJPATH} The complete file specification of the project file
(.dpj), including disk and path

{PROJNAME} Name of the project

{MACHINENAME} Name of the machine that has been selected for
this project

{POSTPROCNAME} Name of the postprocessor that is used (so that is
configured for this machine)

Part information:

{PARTNAME} Name of the current part

{BLOCKXSIZE} Size of the material block along X. Sizes are given
in the units as defined in the Preferences, used in
DeskProto's user interface.

{BLOCKYSIZE} Size of the material block along Y

{BLOCKZSIZE} Size of the material block along Z

{BLOCKDSIZE} Diameter of a cylinder shaped block (only for parts
with rotation axis toolpaths: no output for 3-axis
parts).

{BLOCKRSIZE} Rmax minus Rmin, for a cylinder shaped block.
For a tube this is the material thickness., for a solid
cylinder the Radius (only for parts with rotation
axis toolpaths: no output for 3-axis parts).

{BLOCKXSIZE_IN_
NCFILE_UNIT}

Size of the material block along X. Sizes are given
in the units as defined in the Postprocessor to be
used in the NC file.

{BLOCKYSIZE_IN_
NCFILE_UNIT}

Size of the material block along Y

{BLOCKZSIZE_IN_
NCFILE_UNIT}

Size of the material block along Z

{BLOCKDSIZE_IN_
NCFILE_UNIT}

Diameter of a cylinder shaped block (see above).

{BLOCKRSIZE_IN_
NCFILE_UNIT}

Rmax minus Rmin, for a cylinder shaped block
(see above).

{PARTMACHTIME} Estimated machining time for the part

Operation information:
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{OPERNAME} Name of the operation to which the current
toolpath belongs

{TOOLNUMBER} Number of the current cutter (as set in the cutter
definition)

{TOOLNAME} Name of the current cutter

{FEEDRATE} Feedrate, in the units as defined in the Preferences,
used in DeskProto's user interface. Only the
number if written, without the Feedrate command
(like "F")

{FEEDRATE_IN_NC
FILE_UNIT}

Feedrate, in the units as defined in the
Postprocessor to be used in the NC file.

{F} Same as line above

{SPINDLESPEED} Spindlespeed - only the number if written, without
the Spindle command (like "S")

{S} Same as line above

{OPERMACHTIME) Estimated machining time for the operation.

NC file relevant information:

{PROGNUMBER} Number of the NC program: some controllers
require a unique program number as
identification.

{TOOLPATHXMIN} Minimum X-value in the toolpath, in user-
interface coordinates, as set in the Preferences.

{TOOLPATHXMAX} Maximum X-value in the toolpath.

{TOOLPATHYMIN} Minimum Y-value in the toolpath, 

{TOOLPATHYMAX} Maximum Y-value in the toolpath.

{TOOLPATHZMIN} Minimum Z-value in the toolpath, 

{TOOLPATHZMAX} Maximum Z-value in the toolpath.

{TOOLPATHXMIN_I
N_NCFILE_UNIT}

Minimum X-value in the toolpath, in NC-file
coordinates, as set in the Postprocessor.

{TOOLPATHXMAX_I
N_NCFILE_UNIT}

Maximum X-value in the toolpath.
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{TOOLPATHYMIN_I
N_NCFILE_UNIT}

Minimum Y-value in the toolpath, 

{TOOLPATHYMAX_I
N_NCFILE_UNIT}

Maximum Y-value in the toolpath.

{TOOLPATHZMIN_I
N_NCFILE_UNIT}

Minimum Z-value in the toolpath, 

{TOOLPATHZMAX} Maximum Z-value in the toolpath.

Other relevant information:

{N} Newline: forces DeskProto to continue on a new
line

{DATETIME} Date and time, for instance "2021-02-12 14:07"

{DATE} Date, for instance "2021-02-12"

{TIME} Time, for instance "14:07"

{{}   or   {}} This is the trick if you need a curly bracket to
appear in your NC file.

The application of the above placeholders will be clear, except perhaps for
the Program number: DeskProto can't know which program number you want
to use so it cannot replace this placeholder on the fly.
So when you have used the placeholder {PROGNUMBER} in your project and
then write an NC file, the NC-Program File Number dialog will pop up,
asking you to enter the program number that you want to use for this NC
program. For many machines this number need to be preceded by a capital
"O": do not forget to write that just before the placeholder.

The PROGNUMBER placeholder needs to be placed in the Start commands
of the postprocessor, as this program number is needed at the start of the
program.  When you use this placeholder in the Operation Start/End
commands the NC Program File Number dialog will not pop up.

Example:
So the Start commands of your G-code postprocessor can for instance be:

%
O{PROGNUMBER}
; NC program written by DeskProto on {DATE},
; for machine "{MACHINENAME}".
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; Start with cutter "{TOOLNAME}".

The resulting G-code then would start with something like

%
O1234
; NC program written by DeskProto on 2021-02-12,
; for machine "ISO plain G-codes - mm".
; Start with cutter "Ball nose, radius 3 = diameter 6
mm".

Upwards compatibility.
The use placeholders has been added in DeskProto V7.1
Previous DeskProto versions offered only two optional placeholders in the
postprocessor, using a different format:
- the string “^\N” started a new line, 
- the string “^\V” would again output the parameters value of that tab page
(for instance the Spindlespeed).

These old placeholders are no longer supported in DeskProto V8  When
opening an old postprocessor file DeskProto V8 will automatically convert
these to the new placeholders.
For instance a Start command “ S ^\V^\N R” on the Spindle tab page will
be converted to " S {S}{N} R". The postprocessor file will be saved in the
V8 format only when other changes have been entered.
A postprocessor file in the new V8 format can no longer be used in older
DeskProto versions.

The conversion and compatibility just described also applies to DPJ files
(DeskProto project files) that use “^\N” in the Operation Start/End
commands.
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5.5.7 Custom Wizards

In addition to the series of predefined Wizards DeskProto also offers Custom
wizards: wizards that any user can add and/or edit. A number of these
custom wizards already have been installed, these can be started via File
menu command Start Custom wizard.
You can also start a Custom Wizard by calling it's DPW-file as a  command
line parameter.

Custom wizards are not available in MacOS and in Linux: only in Windows,
sorry about that.

The Custom wizard is a very powerful option, making it possible to add your
own Wizards to DeskProto. Such wizard can make it easy to use a special
machine, or to create a special type of product. A good example are the four
wax ring wizards that come with DeskProto



Concepts

Page 425

DeskProto Reference

123 Wax
Ring

for the 123WaxRing fixture

4 axis Wax
Ring

for any machine with a 4th axis

HollowWax
Ring

for the 5th axis of the Roland
JWX-10 machine

JWX30 Wax
Ring

for the Roland JWX-30 machine

Total 7 custom wizards haven been installed by the DeskProto Setup, you are
free to edit these wizards and/or use them as examples for your own script
wizards.

A valid Custom Wizard consist of one DPW file (DeskProto Wizard) and a
subdirectory with the same name. The custom wizards shown in the image
above are already present, and can be found in folder
C:\ProgramData\DeskProto 8.0\CustomWizards\
For instance the file Basic3D.dpw and the subfolder Basic3D

The DPW file specifies the name of the Wizard, how many pages are
present, the page definition file for each page, version information. The page
definition files are QML files, present in the folder just mentioned.  For
instance the file that shows the Load geometry page in the Basic3D custom
wizard is 
C:\ProgramData\DeskProto 8.0\CustomWizards
\Basic3D\WizPageLoadGeometry.qml

The wizard pages are written in QML (the Qt Modeling Language), which is
a framework for developing applications offered by the QT Company. As
DeskProto is built using the QT toolkit this is the most efficient choice for a
framework. For each custom wizard page one QML file is needed. This file
contains both the user interface (dialog design, texts, edit boxes, etc) and the
script that defines the actions to be performed. As scripting language
JavaScript is used. You may also use .QMLC files: compiled versions of the
.QML files, used as cache for a better performance (faster display) of the
wizard pages. About QML and about JavaScript plenty of information is
available via the Internet.

So basically all you need to add a Custom wizard to DeskProto is a plain text
editor. Copy the resulting files to the locations specified above, and
DeskProto will show your new wizard. 

For more information on scripting see the Scripts page and the DeskProto
Script Documentation: email us to receive a copy. Remember that an easy
way to create a Script wizard is to copy and rename one of the sample Script
wizards: then the correct structure  already is present.
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For software specialists: 
you can set the location of this custom wizard directory as follows: in the
Registry editor change registry key
HKCU\Software\Delft Spline Systems\DeskProto\8.0\Preferences\File
Locations\WizardsLocation
Only edit the registry when you are qualified and know exactly what you are
doing !

5.5.8 Scripts

A Script or Macro is a program: a series of commands for DeskProto that
will be executed one by one. Programs are written in a programming
language: DeskProto scripts need to be written in JScript (JavaScript), with
file extension .dps. 
Other ways to automate DeskProto are Template projects and Command line
parameters.

A script can be called in DeskProto using the command Run Script...  in the
File menu, which will show this dialog.
You can also start a Script by calling it as Command line parameter.

Default folder for script files is the Scripts subdirectory of DeskProto:
Windows: C:\ProgramData\DeskProto 8.0\Scripts\
MacOS: ~/Library/Application Support/Delft Spline
Systems/DeskProto/8.0/Scripts/
Linux :   ~/.local/share/Delft Spline Systems/DeskProto/8.0/Scripts/

A Script is an ASCII text file with a number of lines: each line contains a
command (or part of a command) to be executed. The script can call a
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number of objects (functions) that DeskProto has made available via its
Scripting Interface. Most of these objects are Properties (a variable that can
be set or read) and Methods (a function with one or more parameters).

A very simple example of a DeskProto script file is present already
(ScriptedBottle.dps):

MinDeskProtoVersion = 7.1;
MinDeskProtoRevision = 7828;
var strSamplesLocation = DPPreferences.getSamplesLocation();

DPProject.loadGeometryFile(strSamplesLocation + "Bottle.stl");
DPActivePart.setGeometryRotation(-90.0, 0.0, 0.0);
DPActivePart.materialBlockMethod = 2;
DPProject.calculateToolpaths();
DPProject.writeNCProgram( "ScriptOutputNCfile.ext" );
DPProgram.exit();

This script will load the Bottle geometry, orientate it correctly for machining,
set the Material block to Use the upper half only, calculate the toolpaths
using the default Operation parameters, save these toolpaths in an NC
program file and exit.  
The parameter of function LoadGeometry could have contained the complete
path in one string. However as the location of the Samples folder is different
per Windows version (sorry: thanks to Microsoft) this solution is better.
The parameter of function writeNCProgram does not include a path: the file
now will be save in the folder that is specified in the Preferences (tab NC
Output). The file extension defined in this parameter will overrule that
extension that is set in the postprocessor.

The available scripting objects are described in the DeskProto Script
Documentation: a series of HTML files that can be found in the directory
\DPScript\html\ on the DeskProto CD.  Open the file
\DPScript\html\index.html to start reading. If you do not have this CD then
please email us.

A special type of Script that is available in DeskProto is the Custom Wizard.
This is a very powerful option, making it possible to add you own Wizards to
DeskProto. Custom wizards can be started via Start Custom Wizard in the
File menu.

For software specialists: 
you can set the location of this scripts directory as follows:
For Windows change registry key HKCU\Software\Delft Spline
Systems\DeskProto\8.0\Preferences\File Locations\ScriptsLocation
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For MacOS change line "8·0.Preferences.File Locations.ScriptsLocation" in
file DeskProto.plist 
For Linux change line "Preferences\File%20Locations\ScriptsLocation" in
section "[8.0]" of file DeskProto.conf.
Only edit the registry or these files when you are qualified and know exactly
what you are doing !

5.5.9 Command Line Parameters

It is possible to run DeskProto with one or two command line parameters. 
This feature is not meant for ‘normal’ users, but rather for application
builders who need to include toolpath calculations in their application and/or
want to automate that process. So when you do not know what a command
line parameter is please ignore this paragraph.
Other ways to automate DeskProto are Template projects and Scripts.

Command line parameters for DeskProto need to be file names (valid file
specifications, including the path). When the file is not found or invalid an
error message will be shown. For the first parameter only a limited number of
file-types is possible (DeskProto uses the file-extension to decide what to do
with the file), for the second parameter any file extension is possible.
In addition two extra parameters are possible, see below

1. First parameter:

Supported file-types for the first parameter are:

DPJ
This is a DeskProto project file - the project will be automatically loaded.
For instance:
"C:\Program Files\DeskProto 8.0\deskproto.exe"  C:\torso.dpj
This project may also be a Template project.

DPW
This is a DeskProto Custom wizard file - the custom wizard will be
automatically started. For instance:
"C:\Program Files\DeskProto 8.0\deskproto.exe"  "C:\Program
Files\DeskProto 8.0\Wizards\123waxRing.dpw"

DPS
This is a DeskProto Script file - the script will be automatically started. For
instance:
"C:\Program Files\DeskProto 8.0\deskproto.exe"   "C:\Program
Files\DeskProto 8.0\Scripts\ScriptedBottle.dps"
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DXF, AI, EPS, SVG
These are CAD-files containing Vector data - the vector file will be
automatically loaded. For instance
"C:\Program Files\DeskProto 8.0\deskproto.exe" "C:
\ProgramData\DeskProto 8.0\Samples\DpBeerTray.dxf"
The default project needs to be a Vector project.
Note that DXF can contain Vector data and/or Geometry data. The default
project type decides how the file is loaded.

STL, 3MF, DXF
These are CAD-files containing Geometry data - the geometry file will be
automatically loaded. For instance
"C:\Program Files\DeskProto 8.0\deskproto.exe" "C:
\User\STLdata\medaillon.stl"
The default project needs to be a Geometry project.
Note that DXF can contain Vector data and/or Geometry data. The default
project type decides how the file is loaded.

BMP, GIF, JPG, JPEG, PNG, TIF, TIFF
These are CAD-files containing Bitmap data - the bitmap file will be
automatically loaded. For instance
"C:\Program Files\DeskProto 8.0\deskproto.exe" "C:
\ProgramData\DeskProto 8.0\Samples\XYZlogo.png"
The default project needs to be a Bitmap project.

You can test command line parameters by entering these command lines in
the Search dialog of the Windows Start button. Or you can use the Windows
Command window (start by entering CMD in the Search dialog) and enter the
command in MS-Dos.

2. Second parameter:

The above options start DeskProto and load data, nothing more (except of
course in scripts). Calculating toolpaths and writing the NC file still has to be
done by the user. DeskProto allows you to automate this as well. You then
need to start DeskProto with TWO command line parameters, the second
being the name of the NC file.

For instance: issue the following command:
"C:\Program Files\DeskProto 8.0\deskproto.exe"  C:\casting.stl  C:
\casting.nc
As a result DeskProto will be started, the file casting.stl will be loaded,
toolpaths will be calculated, the NC file casting.nc will be written, and
DeskProto will be shut down automatically. The user just sees DeskProto
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coming up and closing down again. The file extension of the NC-file needs
not be the one that is prescribed by the postprocessor: the name on the
command line will overwrite that.

The toolpath calculations are done using the parameters as set in the
defaults. This works great when the application involves repeating the same
job with a slightly different geometry. This is for instance used for making
custom insoles: each sole is different, however all soles can be machined
using exactly the same parameters.

This means that DeskProto can be included in an application without
bothering the end-user about any DeskProto setting. When the end-user
presses the "NC button" the application just needs to start DeskProto with the
correct command line parameters. The result will be an NC file that the
application then can send to the machine.

Extra parameters:

Two extra parameters are supported that are no file specifications. These
flags may be added on any position on the command line, and do not count as
first or second parameter.

"/nocalculationwarnings"  will make DeskProto suppress calculation
warnings.
This option is useful in case of automated processes, where it should not be
needed for the user to give input (press OK) on warnings that are normal for
that process. Only non-critical warnings are suppressed, for instance "The
selected curves of the operation go 5.00 mm outside of the material block."

"/userinteractionsuppressed"  will make DeskProto suppress all user
interaction (except for error situations). This option includes
the /nocalculationwarnings setting. Now also suppressed are the wizard
interface, the chain warning, the dialogs for Load CAD data and Transform
CAD data.

As said above, the first command line parameter may be a DPJ file. When a
DPJ file is loaded the parameters in this file will of course be used, not the
current DeskProto defaults. This can be used when the CAD-file used has the
same name for all models.
This option allows you to achieve full automation like mentioned above, but
now for more than one set of default settings.
For instance:
"C:\Program Files\DeskProto 8.0\deskproto.exe"  C:\TwoSided.dpj  C:
\TwoSided.nc
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When you do this with a template project file DeskProto will prompt the user
to browse an STL file.
The project may not be a wizard-made project, as then on opening the project
the Wizard will be started which will stop the automation. So when you
created the project using a wizard make sure to make (at least) one small
change in the dialog-based interface before saving the DPJ file.

We strongly advise to define both command line parameters including a path
specification. In case the first parameters comes with a path and the second
does not, the NC file will be written in the directory of the first (STL or DPJ)
file, as then that has become the "current folder".

The second command line parameter also works in case the project causes
DeskProto to save more than one NC program file (for instance because of a
toolchange): the standard DeskProto naming conventions will be used for the
NC files.
In case the DPJ file that is loaded contains more than one part, then for all
parts NC files will be written. Extra file names will be generated by extending
the NC filename using the standard DeskProto naming conventions for
multiple NC files.

5.5.10 Template projects

Some applications need DeskProto projects that all very much look like each
other: all settings equal, only the CAD-data are (slightly) different. In that
case you don’t want to again and again set all parameters for each next
project. 

A first possible solution is to enter all parameters as Defaults (Default Part
and Default Operation). When you then start DeskProto and load the CAD-
data (vector, geometry or bitmap) for the new project, all parameters have
already been set and you can immediately calculate the toolpaths. This even
makes it possible to fully automate DeskProto: see the paragraph on
Command Line Parameters.  

Examples where the defaults can be successfully used:
- production of custom insoles: all products are machined with exactly the
same settings, only the Geometry file is different.
- production of name-tags: again the setting are equal for all tags, only the
Vector file is different for each product.

The above solution is useful only if all your projects need these same
parameters. In case you have several types of projects, then the alternative
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solution is to create a project-file without CAD-data, which is called a
Template project.  In order to create such template project you will still
need to load CAD data (vector, geometry or bitmap), as without CAD-data it
will not be possible to set any Part parameters. When you have set all
parameters that you need you can remove your CAD-data file (in the Project
parameters), and then save the project.

DeskProto will warn you that no Vector-data / Geometry-data / Bitmap-data
is present, and ask you if you want to create a template project: Yes.  When
you later open such template project, DeskProto will immediately show a
File-Open dialog to load a CAD file into the project.

In DeskProto the first operation of a part defines the type of the project:
when the first operation is a Vector operation the project is a Vector project.
Same for template projects, which means that in these three cases DeskProto
will treat a project that it opens as template project: 
- first operation is a Vector operation, however no Vector-file is present
- first operation is a Geometry operation, however no Geometry-file is
present
- first operation is a Bitmap operation, however no Bitmap-file is present

Here some examples where template projects may be useful:
· You may want to define template projects that you can use for various

materials. For instance when you always machine dental models your
settings are always the same. However some models are in zirconium and
some in wax, needing different settings.

· You may want to define a template project for molds, using inverse
milling.

· You may want to define a template project with two parts, for two halves
of one model: one part for the left halve, the other part for the right halve
(with correct transformations), each containing one operation for roughing,
and one for finishing.

After opening a template project and loading the CAD file that you want to
use you need to take care NOT to save the project, as that will over-write
your template project. If needed to save use Save_As, and a different name.

A second way of using template project files is to always use the same name
for the CAD file. Your template project than will open this file when starting
DeskProto: you just need to make sure that you have saved the CAD-data to
be used in that CAD file before starting DeskProto.
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Index

3
3D face 368
3Dconnexion 336
3MF 367

4
4th axis  

commands 240
settings 249
use 137

5
5-axis 399
5th axis  

commands 240
settings 249
tilt angle 219

A
About box 114
Activate license 110, 296
Add  

bitmap data 41
geometry 39
vector data 38

AI 362
AI file 364
Air assist 271
Aligning bitmap data 167
Aligning vector data 167
Always show  

restore 129
Always show message 336
Always stay low 206
Ambient 205
Ambient area 151
Ambient level 151
Ambient skipping 213
Angle with X-axis 190

Angular feedrate 264, 267
Animation 353, 386

show 81
Anti-aliasing 336
Area  

DXF-file 233
freeformed 233
nested 233

Area to be machined 202
Autocad 364, 368
Automatic Tool Changer 269
Automation 426, 428

B
Backfaces 370

skip 125
bak1 file 314
Betmap data  

save as 41
Bitmap 307

contour 238
dimensions 142, 324
DPI 142
freeform area 238
position 142
project on part 144
sample files 413
size 142
Z-values 144

Bitmap data 360, 370
add 41
load 41
size 62

Bitmap file 127, 370
Bitmap operation 381

default 96, 382
Bitmap operation parameters 221
Bitmap relief 370
Bitmap Settings 136
Block  

dimensions 324
size 146
size (two sided wizard) 335

Block size 165
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Block toolpaths 190
BMP-file 372
Borders 205
Bottom level 139
Buffering (graphic) 336
Button size 60
Buttons 22, 57

C
CAD data  

bitmap 360
geometry 360
vector 360

CAD file 302
Calculate  

toolpaths 76
Calculation precision 232
Camera position 356
Center 237
Center geometry 139
Centre 237
Chaining 128, 186
Check for update 113
Circular strategy 237
Circular toolpaths 190
Cleanup operation 230, 402
Climb milling 206
Clipboard 55
Collet collision 213
Colors 331
COM Port 332
Command line parameters 428
Compare wth geometry 156
Context menu 28, 63
Contour 202
Contour only toolpath 190
Conventional milling 206
Coordinates on screen 33, 62
Copy image 55
Copyright 6
Correction factor (time) 81
Corrupt geometry 370
Crosswise toolpaths 190
Current  

part 378
Curve depth  

V-Carving 177
Curve direction 123
Curve selection 222
Custom wizard 50, 120, 424
Customizing DeskProto 52
Cutter 186

dimensions 275, 280
hot wire 409
lens-type 275
missing 318
multiple diameter 275, 280
tapered 275
type 275, 280
vector operation 168

Cutter-file 290
Cutting direction 172, 175

D
Deactivate license 110, 296
Default  

bitmap operation 382
bitmap operation parameters 96
geometry operation 380
geometry operation parameters95
items visible 99
machine 304
part 378
part parameters 93
project 376
project parameters 92
vector operation 379
vector operation parameters 94
viewpoint 98

Delft Spline Systems 16
Depth cueing (fog) 331
Dimensions  

measuring 70
Direction of milling 206
Disclaimer 5
Distance between toolpaths 186
Downward faces 307
DPJ file 302, 374, 376



DeskProto Reference Index

Page 435

DPS file 52, 426
DPT file 374, 376
DPW file 424
Drilling 180

curve selection 222
Driver  

missing 316, 318
newer 321
old 323

Drivers  
file location 327

DXF 362, 367
DXF-file  

2D 364
3D 368
freeform area 233
geometry 368
vector 364

Dynamic drawing 336
Dynamic feedrate 206

E
Edition  

entry 298, 415
expert 298, 415
free 298, 415
multi-axis 298, 415

Editions 111
End commands 240, 243

postprocessor 261
Engraving 400
Entry edition 298, 415
EPS 362
EPS file 364
Essentials 8
Exit 54
Expert edition 298, 415
Export  

Simulation 85
Z-grid 85

Export settings 336
External program 332

F
Feedrate 168, 186, 246

angular 264
default 275
dynamic 206
first movements 206
high chip loads 206
inverse time 264
plunge movements 206
units 330

Feedrate command 264
File  

locations 327, 332
new 35
not found 302
open 36
recent 37
save 37
save as 38

Filetypes 10
bitmap 370
DeskProto project 376
geometry 367
vector 362

Fill gaps 190
Five axis 399
Five axis machining 240
Flip normals 125
Fog 331
Free edition 298, 415
Free movement height  

geometry 206
vector 170

Freeform area 202
bitmap contour 238

Freeformed area 233

G
G00 264
G01 262
G93 266
Geometry  

add 39
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Geometry  
corrupt 370
dimensions 324
load 39
points only 307
rendered 307
sample files 413
save as 40
size 62
wireframe 307

Geometry data 360, 367
Geometry file 125, 367
Geometry information 62
Geometry operation 380

default 95, 380
Geometry operation parameters 186
Geometry Settings 136
Geometry transformation 132
GIF-file 372

H
Hardware specification 10
Helix toolpath 190
Help  

topics 101
Hidden lines 307
Hot wire  

machine settings 255
on/off 273
postprocessor 273

Hot wire cutting 409

I
IGES-file 368
Import  

area 233
region 233

Import settings 336
inch 327, 330
Indexed machining 240, 398
Initial Settings 304
Inlay 406
Inverse milling 139
Inverse time feedrate 264, 266

Items visible 68, 307
default 99

J
JPG-file 372

K
Keep settings 312

L
Lamp icons 28, 63
Language setting 327
Large buttons 60
Laser 400

air assist 271
machine settings 256
on/off 271
postprocessor 271

Laser cutter 170, 268
Layer thickness 199
Layout  

view 68
Liability 5
Library  

cutter 275
cutters 91
how to use 245
machine 246
machines 87
notes 290
postprocessor 258
postprocessors 89

Library, external 6
License 6
License key 110, 296
Line numbers 259
Linux 8, 102
Load  

bitmap data 41
geometry 39
vector data 38

LPT Port 332
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M
Machine  

advanced settings 257
configuration 246
hot wire settings 255
laser settings 256
missing 316
ready to receive 313
rotary settings 249
select 122
send toolpaths to 79

Machine-file 290
Machining  

5-axis 399
indexed 398
rotary 396
two-sided 392

Machining level 170
Machining time 81

correction factor 246
Machining time estimation 300
MacOS 8, 10, 102
Macro 426
Material block 146, 307
Material block size 165
Maximum layering height 199
Meander milling 206
Measuring 70
Menu bar 21
Migrate settings 314
Mirror 139
Missing cutter 318
Missing machine 316
mm 327, 330
Moiré effect 136, 370, 372
Mold 139
Mould 139
Mouse  

rotate/pan/zoom 70
settings 336

Mouse coordinates 33, 62
Movement command 262
Mulit-axis edition 298, 415

N
NC files window 31, 66
NC Output 332
NC-program 390

creating 390
write 78

New  
project 35

Newer driver 321
Normals 370

flip 125

O
Offset toolpaths 190
Open  

file location 327
project 36, 376

Open GL 336
OpenGL  

driver warning 292
extension warning 294

Operation  
bitmap 381
geometry 380
number of 137
parameters 74
to be simulated 349
vector 378
visible 379, 380, 381

Operation parameters  
bitmap 221
geometry 186
vector 168

Optimization 206
Orientator 307

P
Parallel toolpaths 190
parameters  

operation 74
part 73
project 73

Part 377
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Part 377
current 378
default 93, 378
number of 122
parameters 73
rotation 417
size 62

Part information 324
Part parameters 136
Peck drilling 168, 180
Placeholder 419
Plotfile 362
Plunge 206
Plunge rate  

vector 184
PNG-file 372
Pocketing 175

curve selection 222
Points on curve 307
Points on toolpath 307
Polyface mesh 368
Positive coordinate values 153
Postprocessor 246

configuration 258
end commands 261
file extension 259
file size 259
hot wire 273
laser 271
placeholder 419
program number 419
start commands 261

Postprocessor-file 290
Postscript 364
Precision 186, 232
Preferences 100, 327
Print  

image 42
preview 42, 43
project 43
setup 42, 44

Printer driver 332
Problem report 108
Profiling 172

curve selection 222
Profiling tabs 225
Profilink tabs  

default 229
Program number 320, 419
Project  

default 92, 376
NC-program 390
opening 376
parameters 73
sample files 413
saving 376
structure 374
template 431
toolpath 384
type 374

Project file 302, 374
Project parameters 122
Project tree 28, 63
Project vector curves 170
Properties 55
Protect vertical surfaces  

roughing 199

Q
Quick Start 102

R
Radial strategy 237
Radial toolpaths 190
Ramping 199

vector 182
Rapid movement command 264
Recent file list 37
Redo 233
Reduced feedrate 206
Region 202
Register 110, 296
Relief 370
Relief height 144
Report 108
Requirements 10
Rest material 156
Restore  
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Restore  
always show settings 129

Retained mode graphics 336
Retraction value 180
Rhino 336
Right-click 28, 63
Rotary machining 396
Rotate 139
Rotation 417
Rotation axis 246, 396

tilt option 137
use 137

Roughing 199
vector 182

S
Sample  

files 45, 351
projects 45, 351

Sample files 413
Save  

bitmap data as 41
file location 327
geometry as 40
geometry transformations 135
project 37, 376
project as 38
vector data as 39
vector transformations 134

Scale 139
Screen layout 17
Script 426
Scripting 52
Send NC program to ... 83, 332
Send toolpaths to ... 79
Settings  

bitmap 136
geometry 136
initial 304
keep 312
migrate 314
vector 136

Settings, import/export 336
Show downward faces 307

Simulation 307, 387
animation 353
calculating 387
compare with geometry 387
export 85
level of detail 387
settings 156
show 81
which operations 349

Skin 199
Skip backfaces 125
Smooth transitions 190
Smoothing contour 190
Sort 206
SpaceMouse 336
Specifications 10
Speed 246
Spindle speed 168, 186, 246

default 275
maximum 275

Spindle speed command 268
Spiral strategy 237
Spiral toolpaths 190
Start commands 240, 243

postprocessor 261
Start depth  

V-Carving 177
Start screen 45, 351
Start/End  

geometry 213
Start/End commands  

vector 184
Status bar 33, 62
STEP-file 368
Stepover  

geometry 186
pocketing 175
V-Carving 177

Stepsize along toolpath 186
STL 367
STL-file 368
Strategy 190
Support 15

problem report 108
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Support tab 150, 158
geometry 163
synchronize 163

Support tabs 172
Surface sampling refinement190, 232
SVG 362
SVG file 364

T
Tab  

geometry 150, 158, 163
vector 172, 225
vector, default 229

Template project 431
thumbwheel 67
Thumb-wheels 26
TIFF-file 372
Tilt angle 219
Title 307
Title bar 19
Toolbar 22, 57
Toolchange command 269
Toolpath 384

calculation 384
Toolpaths  

animation 353
calculate 76
calculate all 82, 83

Trademark 5
Transformation  

geometry 132
save geometry 135
save vector data 134
vector data 131

Translate 153
bitmap 142

Translation (language) 327
Translucent 307
Tree 28, 63
Trial cross 417
Trial limitation 417
Two sided wizard (block size) 335
Two-sided machining 392

U
UHD displays 336
Units 304, 327, 330

postprocessor 262
Update 113
Upgrade 314
Upgrading 111
Upper half of geometry 146
USB Port 332

V
V-Carving 177, 402, 406

cleanup 230
Vector  

curve direction 123
drilling 180
free movement height 170
laser engraving 400
pocketing 175
profiling 172
project on 3D 170
roughing 182
sample files 413
v-carving 177, 402
Z-values 123

Vector curves 307
Vector data 360, 362

add 38
dimensions 324
load 38
save as 39
size 62
Z-values 355

Vector data transformation 131
Vector file 123, 362
Vector operation 378

default 94, 379
Vector operation parameters 168
Vector Settings 136
Vertical surfaces 213

roughing 199
View 70

layout 68
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View 70
Subjects dialog 307

View window 26
Viewpoint 69

custom 356
default 98
dialog 356

Views layout 358
Visible items 68

main screen 307
set graphically 164

Visible operation 379, 380, 381
VRML 367
VRML-file 368

W
Waterline toolpaths 190
Watermark 417
Windows 8, 10, 102
Wireframe 307
Wizard  

bitmap 47, 117
choose type 47, 117
custom 50, 424
geometry 47, 117
html 50, 424
introduction 12
multiple sides 47, 117
preferences 335
rotary 47, 117
script 50, 424
two-sides 47, 117
vector 47, 117

Wizard, custom 120
Working area 246
Workpiece zero point 153

indication 307
Write  

NC program 78
Write NC 332

Z
Zero point 153
Z-grid 383

calculate 82
calculation 383
export 85

Zoom 70
Zoom speed 336
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